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Safety Instructions

Be sure to read these instructions in order to operate the product safely. Follow these instructions to prevent
injury or harm to the operator of the product or others.

/N\ WARNING

Denotes the risk of serious injury or death.

e Stop using the product in any case of unusual circumstances such as the presence of smoke or a strange

smell.

Do not touch any exposed internal parts.

Do not get the product wet. Do not insert foreign objects or liquids into the product.

Do not touch the product connected to a power outlet during lightning storms. This may cause electric shock.

e Do not disassemble or modify the product.

¢ Do not expose the product to strong shocks or vibration.

¢ Do not use organic solvents such as alcohol, benzine or paint thinner to clean the product.

Do not use the product where flammable gases may be present. This may cause electric shock, explosion or

fire.

Use only power sources specified in this instruction manual for use with the product.

Observe the following instructions when using a battery charger or AC adapter.

- Do not touch the battery charger or AC adapter connected to a power outlet during lightning storms.

- Do not use the product if the power plug is not fully inserted into the power outlet.

- Do not unplug the product by pulling the power cord.

- Do not plug in or unplug the product with wet hands.

- Do not place heavy objects on the power cord. Do not damage, break or modify the power cord.

- Do not leave the product connected to a power source for long periods of time.

- Do not expose the power plug and terminals to dirt or let them come into contact with metallic pins or other
metal objects.

- Do not charge batteries/battery packs at temperatures outside the range of 5 - 40 °C (41 - 104 °F).

Observe the following instructions when using commercially available batteries or provided battery packs.

- Do not use leaking batteries/battery packs.
If a battery/battery pack leaks and the material contacts your skin or clothing, flush the exposed area
thoroughly with running water. In case of eye contact, flush thoroughly with copious amounts of clean
running water and seek immediate medical assistance.

- Use batteries/battery packs only with their specified product.

- Do not heat batteries/battery packs or expose them to fire.

- Do not charge batteries/battery packs using non-authorized battery chargers.

- Do not expose the terminals to dirt or let them come into contact with metallic pins or other metal objects.

- Keep batteries out of the reach of children.

- When disposing of batteries/battery packs, insulate the terminals with tape or other means.

Do not shoot the sun directly or point a lens or a camera with a lens attached at the sun. Even when the sun

does not appear on the screen or is behind the subject, the lens may concentrate the sunlight and cause a

malfunction or fire.

® Do not leave a lens or a camera with a lens attached, exposed without the lens cap attached. The lens may

concentrate the light and cause fire.

Do not leave the lens exposed without the lens cap attached.

Do not wrap the product in cloth or other materials when in use or shortly after use when the product is still

warm in temperature.

Do not allow the product to maintain contact with the same area of skin for extended periods of time during

use. This may result in low-temperature contact burns, including skin redness and blistering, even if the

product does not feel hot. The use of a tripod or similar equipment is recommended when using the product in

hot places and for people with circulation problems or less sensitive skin.

Keep the product out of the reach of young children.

e A strap wrapped around a person’s neck may result in strangulation.




* The parts or provided items of cameras or accessories are dangerous if swallowed. If swallowed, seek
immediate medical assistance.
- The battery is dangerous if swallowed. If swallowed, seek immediate medical assistance.
- The accessory shoe cover is dangerous if swallowed. If swallowed, seek immediate medical assistance.
¢ Periodically remove any dust buildup from the power plug and power outlet using a dry cloth.

e Follow any indications to turn off the product in places where its use is forbidden. Not doing so may cause
other equipment to malfunction due to the effect of electromagnetic waves and even result in accidents.

e Before installing, be sure the surface is capable of supporting the total weight of the camera and connected
devices, and sufficiently reinforce the surface if necessary.

A\ cauTions
Follow the cautions below. Otherwise physical injury or property damage may result.

e Strap is intended for use on the body only. Hanging the strap with any product attached on a hook or other
object may damage the product. Also, do not shake the product or expose the product to strong impacts.
This may cause injury or damage to the product.

¢ Do not leave the product in places exposed to extremely high or low temperatures. The product may become
extremely hot/cold and cause burns or injury when touched.

¢ Only mount the product on a tripod that is sufficiently sturdy.
e Do not fire the flash near the eyes. It may hurt the eyes.

* Do not look at the screen or through the viewfinder for prolonged periods of time. This may induce symptoms
similar to motion sickness. In such a case, stop using the product immediately and rest for a while before
resuming use.

e Flash emits high temperatures when fired. Keep fingers, any other part of your body, and objects away from
the flash unit while taking pictures. This may cause burns or malfunction of the flash.

e Do not apply strong pressure on the lens or allow an object to hit it. This may cause injury or damage to the
product.

e Do not carry the product when it is mounted on a tripod. This may cause injury or may result in an accident.
e Do not touch any parts inside the product. This may cause injury.

e |f any abnormal skin reaction or irritation occurs during or following the use of this product, refrain from further
use and get medical advice/attention.
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Introduction

About this Manual

Thank you for purchasing the Canon EOS R5 C. Please read this manual carefully before you use the camera
and retain it for future reference. Should the camera fail to operate correctly, refer to Troubleshooting (11 212).

Before Using the Camera

e Before making important recordings for the first time, make test recordings using the video configuration(s)
you plan to use to check that the camera operates correctly. Should it fail to operate correctly, refer to
Troubleshooting (1 212).

Copyright notice: Unauthorized recording of copyrighted materials may infringe on the rights of copyright
owners and be contrary to copyright laws.

Notes on privacy and publicity rights regarding the use of video: \When using the camera, exercise proper
caution in order to protect privacy and avoid any violation of publicity rights.

About the LCD screen, viewfinder and LCD panel: The screen is produced using extremely high-precision
manufacturing techniques, with more than 99.99% of the pixels operating to specification. Very rarely, pixels
may misfire or light up permanently. This has no effect on the recorded image and does not constitute a
malfunction.

About CFexpress cards: CFexpress cards can become hot due to the high operating temperature inside the
camera. Removing a CFexpress card immediately after using it for recording may cause burns or cause you
to drop the card, resulting in damage to the card.

About the access indicator: Observe the following precautions while an access indicator ([11 34) is illuminated
or flashing in red. Failing to do so may result in permanent data loss.

- Do not turn off the camera and do not remove the battery or other power source.

- Do not open the card compartment cover.

The camera has two operation modes: PHOTO mode and VIDEO mode.

Set the power switch to PHOTO to set the camera to PHOTO mode, or to VIDEO to set the camera to
VIDEO mode. Software compatible with either PHOTO mode or VIDEO mode can only be used when the
camera is set to the corresponding mode, so switching the camera's operation mode when using said
software will end the connection to the camera.
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About this Manual

Conventions Used in this Manual

¢ @ IMPORTANT: Precautions related to the camera’s operation.
. @ NOTES: Additional topics that complement the basic operating procedures.
¢ [11: Reference page number.
® The following terms are used in this manual.
- “Screen” refers to the LCD monitor's screen and the viewfinder screen.
- “Battery” refers to a supplied or optional battery pack.
- “SD card” refers to an SD, SDHC or SDXC memory card.
- “Recording media” or “card” alone, not specified: refers collectively to CFexpress cards and SD cards.
- “CAMERA mode”: operating mode for making recordings (shooting mode).
“MEDIA mode”: operating mode for playing back and managing recordings (playback mode).
- “RAW’ refers to the data recorded using Cinema RAW Light.
- Unless indicated otherwise, shooting functions are utilized in CAMERA mode.
e Unless indicated otherwise, illustrations in the manual show the Canon EOS R5 C camera with a Canon
RF24-105mm F4 L IS USM lens attached.
e Photographs in the manual are simulated pictures taken with a still camera.
e Some screenshots have been altered to make them easier to read. Furthermore, screenshots used are from a
product in development and may differ slightly from the actual screens due to product enhancement.



Supplied Accessories

Supplied Accessories

The following accessories are supplied with the camera. For accessories sold separately, please refer to System
Map ([ 228). Unless indicated otherwise, accessories mentioned in this manual are the ones supplied with the

camera.

=
: J]:%
e — <« 3 canon =P

canon

LC-E6/LC-E6E Battery Charger1 LP-E6NH Battery Pack (incl. terminal IFC-100U Interface Cable
cover)

S

$S-1200 Shoulder Strap Multi-Function Shoe Cover? Body Cap?

1 LC-E6 or LC-E6E Battery Charger is provided. (The LC-EBGE comes with a power cord.)
2 Comes pre-attached to the camera.

About the Instruction Manual

Cable Protector

Instruction Manual

The Instruction Manual included with the camera provides basic instructions for the camera.

Complete instructions are provided in the Advanced User Guide. This document is the Advanced User Guide for
VIDEO mode (VIDEQO edition). For details on recording photos, please refer to the Advanced User Guide for

PHOTO mode (PHOTO edition).

PHOTO edition: Provides detailed instructions for the camera in PHOTO mode. Set the power switch to PHOTO

to set the camera to PHOTO mode.

VIDEO edition: Provides detailed instructions for the camera in VIDEO mode. Set the power switch to VIDEO to

set the camera to VIDEO mode.

For the latest Advanced User Guide, refer to the following website:
https://cam.start.canon/

11
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Names of Parts

Names of Parts

y
2

Camera

Assignable button Camera 7* ([1] 121)
Assignable button Camera 10 ([J] 121)

e Can be assigned as a REC button ([J] 121)

3

4
5

6

10
11
12
13
14
15
16
17
18

LOCK button ([1] 25)/ Assignable button
Camera 9* ([11 121)

Grip control dial* (] 74, 78)

FUNC (main functions) button ([J1 57)/
Assignable button Camera 11* ([1] 121)
REC (start/stop recording) button* ([11 47)
:8: (LCD panel info switching/illumination) button/
Assignable button Camera 8* ([1] 121)
Self-timer lamp/AF-assist beam (exclusive to
PHOTO mode)

Remote control sensor

Grip (Battery compartment)

DC coupler cord hole
Assignable button Camera 12* ([1] 121)
Lens contacts ([I] 26)

Lens mount

LCD panel

RF lens mount index ([11 26)
Tally lamp (11 47)

Power switch
VIDEQ: Turns on the camera in VIDEO mode.
PHOTO: Turns on the camera in PHOTO mode.
OFF: Turns off the camera.

* Names and functions differ in PHOTO mode.

19 Strap mounts
Pass one end of the SS-1200 Shoulder Strap
through the strap mount and adjust the length of
the strap.

20 ¢ Focal plane mark
21 Microphone ([J] 102)

22 Shutter curtain/lmage sensor
23 Lens release button ([1] 26)
24 Lens lock pin

25 Remote control terminal

26 Body cap
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9

Names of Parts

Multi-function shoe (with shoe cover)

Flash sync contacts

Speaker (1] 139)

Terminal cover

Eyecup

Top control dial* (1] 75, 79)

AUTO IRIS (momentary automatic aperture) button
(1 80)/Assignable button Camera 5* ([1] 121)
AF LOCK button ([Z1 90)/

Assignable button Camera 6* ([1] 121)
Viewfinder eyepiece

10 Eye sensor*
11 LCD monitor (11 19)

* Names and functions differ in PHOTO mode.

EXHAUST VENT

37/ 57/ 47 &

12 MENU button (1] 22)
13 % (white balance adjustment) button ([ 82)/
Assignable button Camera 13 (1] 121)
e Can be assigned as a REC button ([J] 121)
14 Exhaust ventilation outlet (1] 43)
15 TIME CODE terminal (11 100)
16 MIC (microphone) terminal (1] 103)
17 «<%> (digital) terminal
For connecting the optional PD-E1 USB Power
Adapter or GP-E2 GPS Receiver.
18 HDMI OUT terminal (11 147)
19 () (headphone) terminal (1] 105)
20 PC terminal (exclusive to PHOTO mode)

13
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Names of Parts

OO~ NN
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Dioptric adjustment knob ([T] 30)

Accessory positioning hole

Tripod socket

Air intake vent ([T 43)

Voice memo microphone (exclusive to PHOTO
mode)

Serial number

MEDIA button* ([1] 135)

When the camera is on, press to toggle the
camera between CAMERA mode (shooting) and
MEDIA mode (playback).

Joystick* (1] 22)

You can push the joystick in 8 directions (up/
down, left/right, or diagonally) and press the
joystick itself to confirm.

MAGN. (magnification) button* ([1] 87)/
Assignable button Camera 2 ([1] 121)

@ nrorTANT

* Do not use tripods and other accessories with mounting screws exceeding the depth of the screw holes on

the camera as this may damage the camera.

* Names and functions differ in PHOTO mode.

10 AF-ON button (11 88)/
Assignable button Camera 1* (1] 121)
11 Strap mounts
12 DISP (display) button (11 49)/
Assignable button Camera 3* (1] 121)
13 MENU button (L1 22)/
Assignable button Camera 4* (7] 121)
14 Card slot cover
15 SELECT dial* (11 22)
16 SET button ([1] 22)
17 Card slot 2 (SD card) (11 34)
18 Card slot 1 (CFexpress card) (11 34)
19 Card eject button
20 Battery compartment cover lock
21 Battery compartment cover
22 Access indicator ([1] 34)
23 CANCEL button* (11 22)



Preparations

Preparing the Power Supply

You can power the camera using a battery or a power outlet. You can check in advance the required type of
power source for the camera's configuration (attached lens/accessories and recording settings in use) (11 29).

Using a Battery

You can power the camera using the LP-EGNH Battery Pack (or the LP-E6N/LP-E6 Battery Pack). When using a
battery for the first time, charge it fully and then use the camera until the battery is completely depleted.

Charging the Battery

Charge battery packs using the LC-E6/LC-E6E Battery Charger. Before charging, remove the terminal cover of
the battery pack.

1 Fully insert the battery into the charger.
e Do the opposite to remove the battery.

2 Recharge the battery.

For LC-E6

¢ As shown by the arrow, flip out the battery charger's
prongs and insert the prongs into a power outlet.

For LC-E6GE

e Connect the power cord to the charger and insert the plug
into a power outlet.

¢ Recharging starts automatically and the charge lamp blinks in
orange.

15
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Preparing the Power Supply

Charge Lamp
Charge Level
Color Display
0-49% Blinks once per second
50-74% Orange Blinks twice per second
75% or higher Blinks three times per second
Fully charged Green Turned on

@ wPoRTANT

¢ Do not connect to the battery charger any product that is not expressly recommended for use with this
camera.

¢ To prevent equipment breakdowns and excessive heating, do not connect the battery charger to voltage
converters for overseas travels or special power sources such as those on aircraft and ships, DC-AC inverters,
etc.

e After removing the battery charger from the power outlet, avoid touching the charger's plug for approximately
ten seconds.

e Battery packs other than the LP-EGNH/LP-E6GN/LP-E6 cannot be charged using the included battery charger.

(i) NoTES

® The approximate charging time for a fully depleted battery pack is 2 hours and 30 minutes at room
temperature (23 °C) (73 °F). Charging times vary greatly depending on the ambient temperature and remaining
charge.

Charging times will be longer (up to approximately 4 hours) in low temperatures (5 °C to 10 °C) (41°F to 50 °F)
in order to ensure a safe charge.

Charge the battery pack before use. The battery pack is not fully charged at the time of purchase.

For handling precautions regarding the battery, refer to Handling Precautions (11 225).

For approximate charging times / usage times, refer to the Reference Tables ([11 239) and Approximate
Continuous Recording Times ([ 238).

Charged batteries continue to discharge naturally. Therefore, charge them on the day of use, or the day
before, to ensure a full charge.

Once fully charged, remove the battery pack from the charger and unplug the power cord from the power
outlet.

Remove the battery pack from the camera when not in use. A small amount of electrical current flows when
the battery pack is left attached to the camera for long periods of time, causing overdischarge and shortening
its battery life. Be sure to attach the terminal cover when storing the battery pack. Storing a fully charged
battery pack may shorten its lifespan.

A fully charged battery pack that is depleted immediately after use has reached the end of its lifespan. Check if
the battery pack has reached the end of its battery life. If so, buy a new battery pack.

Repeatedly charging and completely depleting a battery will eventually shorten its battery life. You can check
the battery life on the [§ System Setup] status screen ([J1 202). Fully charging the battery and then depleting
it completely will give you a more accurate reading.



Preparing the Power Supply

Attaching the Battery

1 Turn off the camera.

OFF
PHOTO] VIDEO

2 Slide the battery compartment cover lock and open the cover.

3 Insert the battery.
¢ |nsert the end with the electrical contacts.
¢ |nsert the battery until it locks in place.

4 Close the cover.
e Press the cover until it snaps shut.

Removing the Battery
1 Turn off the camera.

2 Open the cover and remove the battery.

e Press the battery lock lever as shown by the arrow and remove the
battery.

e To prevent short-circuits, always attach the included protective cover
to the battery.

@ vPoRTANT

e Using a genuine Canon Battery Pack LP-E6NH is recommended. If you use batteries that are not genuine
Canon products, the camera's full performance may not be attained or malfunction may result.

(i) NoTES

e The remaining recording/playback time (in minutes) may not match the remaining battery charge (in
percentage).

¢ The remaining battery charge may differ in VIDEO and PHOTO mode. Additionally, it may not match the charge
indicator on the supplied charger.

17
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Preparing the Power Supply

¢ Depending on the camera and battery conditions, the remaining recording/playback time (in minutes) and
battery charge (in percentage) may decrease suddenly.
¢ The remaining recording/playback time (in minutes) and battery charge are approximate.

Using a Power Outlet

You can also power the camera directly from a power outlet using the optional DR-E6C DC Coupler and CA-946
AC Adapter. For details on how to connect said accessories, refer to their respective instruction manuals.



Using the LCD Screen

Using the LCD Screen

This section explains how to adjust the LCD monitor. You can adjust the direction of the screen as shown below,
as well as image settings such as brightness or contrast. Additionally, you can use the touch screen to select the
subject or perform a variety of settings using direct touch control ([1] 56).

1 Open the LCD monitor 180 degrees (D) and adjust to the desired angle (2).

2 When the screen is facing the subject (®), you can also place it back in its original position with the
screen facing out (@).

(i) NoTES

e You can adjust the brightness, contrast, color saturation, sharpness and luminance of the LCD screen with the
respective settings in the MENU > [[Z) Monitoring Setup] menu ([I1 190).

¢ In CAMERA mode, you can use the MENU > [[Z)) Monitoring Setup] > [B&W Image: LCD] setting to change
the image on the screen to black and white display. Even when the captured image is displayed in black and
white, onscreen displays and icons will be shown in color.

¢ You can use the MENU > [ System Setup] > [Touch Screen Response] setting to adjust the LCD monitor’s
response to touch input.

e Adjusting the brightness does not affect the brightness of recordings.

¢ When the LCD screen is rotated 180 degrees toward the subject, you can set MENU > [[Z)) Monitoring
Setup] > [LCD Mirror Image] to [On] to flip the image horizontally so it shows a mirror image of the subject.

e For details about how to take care of the LCD monitor, refer to Handling Precautions (11 225), Cleaning

(00 227).

19
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Date, Time and Language Settings

Date, Time and Language Settings
Setting the Date and Time

You will need to set the date and time on the camera the first time you power it on, or after the camera's settings
have been reset. The [Date/Time] screen will appear automatically when the camera’s clock is not set. Refer to
Using the Menus ([ 22) for instructions on how to operate the menus.

Date/Time

A

UTC-05:00 | Jan. 1 , 2022 12 : 00

v

New York

1 Select the desired time zone* using the joystick or the SELECT dial, and confirm by pressing the SET
button or the joystick itself.

* The cursor will move to the next field.
e You can also touch [ A 1/['¥] on the screen to select the desired value.

¢ You can also push the joystick left/right to move between the fields, or touch the desired field.

* The default time zone is [UTC-05:00] (New York) or [UTC+01:00] (Central Europe), depending on the country/region of
purchase. Time zones are based on Coordinated Universal Time (UTC).

2 Change the rest of the fields in the same way.

3 Select [Set] and then press SET.

e You can also touch the onscreen [Set] button to confirm, for example to match precisely a speaking clock or
other signal.

(i) NOTES

¢ You can display the date/time with the MENU > [[Z)) Monitoring Setup] > [Custom Display 2] or [Custom
Display] > [Date/Time] setting.

¢ With the following settings, you can make changes after the initial setup. You can also change the date format
and clock format (12 or 24 hours).
- MENU > [¥ System Setup] > [Time Zone], [Date/Time] and [Date Format]

e Settings adjusted in VIDEO mode will also be applied to PHOTO mode.

* Resetting the camera's settings in VIDEO mode by selecting MENU > [ System Setup] > [Reset] > [All
Settings] will also reset the date and time settings in PHOTO mode.

¢ \When you do not use the camera for about 3 months, the built-in backup battery may be depleted completely
and the date and time setting may be lost. In such case, recharge the built-in backup battery ((11 226) and set
the time zone, date and time again.

e Using the GP-E2 GPS Receiver, you can have the camera adjust settings automatically according to the UTC
date/time information received from the GPS signal (11 195).



Date, Time and Language Settings

Changing the Language

The camera’s default language is English. You can change it to German, Spanish, French, Italian, Polish,
Portuguese, Russian, Ukrainian, Simplified Chinese, Korean or Japanese. Please note that some settings and
screens will be displayed in English, regardless of the language setting.

Refer to Selecting an Option from the Menu (11 22) for details on how to navigate the menu to complete this
procedure.

1 Select MENU > [¥ System Setup] > [Language & ].
2 Select the desired language and press the MENU button to close the menu.

21
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Using the Menus

Using the Menus

Many of the camera’s functions can be adjusted using the menus. In CAMERA mode, you can also register
frequently used menu settings in a customized menu (My Menu) for easy access. For details about the available
menu options and settings, refer to Menu Options ([11 185).

Grip control dial

When the menu is open, turn the
dial to move to the next/previous
menu page.

Top control dial
When the menu is open, turn the dial to
move to the next/previous setup menu.

Joystick

When making a menu selection, push the
joystick to move the orange selection frame in
the menu. Then, press the joystick itself to
select the menu item indicated by the orange
selection frame.

SELECT dial
Turn the dial to move the orange selection
frame in the menu.
| SET % - SET button

MENU button Press the SET button to confirm a selection.

Press the button to open the setup

menus and then press again to close s

the menu after adjusting desired @— CANCEL button

settings. Press to return to the previous menu/submenu

level or to stop some operations that are in
progress.

Selecting an Option from the Menu

The following is a step-by-step explanation of how to select a typical option from the setup menus. Some menu
items may require additional steps. Such operations will be explained in the respective section of the manual.
For brevity's sake, references to menu settings throughout the manual will be abbreviated as follows:

MENU > [¥ System Setup] > [Language &3 ] > Desired option

1 Press the MENU button.
¢ The menu opens. The icon displayed in orange is the menu item that was selected the last time the menu
was closed (unless the camera was turned off).
e \When a menu icon is not selected, first push the joystick up or press the CANCEL button to move the
orange selection frame to one of the icons.
2 Push the joystick left/right to select the icon of the desired setup menu.
e You can also use the top control dial.
¢ You can also touch the desired menu icon.
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3 Press the joystick or the SET button to confirm your selected setup menu.
e The cursor moves to the first item on the first page of the selected setup menu.
e You can also push the joystick down to move the cursor to the list of menu items.
® You can also touch the desired page or menu item.
e Going forward, this operation will be referred to as “press SET” in this manual.

4 Select the desired menu item ([Language & ], in the example) and then press SET.
e Joystick operation:
- Push the joystick left/right to scroll through the menu pages. Moving left/right from the first/last page will
move to the previous/next setup. You can use the grip control dial.
- Push the joystick up/down to move the cursor over the menu items on the page.
e Dial operation:
- Turning the SELECT dial will scroll through the menu items on the page. Scrolling beyond the first/last
menu item in the list will move to the previous/next menu page.
- Scrolling beyond the first/last page will move to the previous/next setup menu.

e Touch screen operation:
- You can also drag the screen left/right to navigate pages, or drag the screen up/down to move the orange
selection frame. You can also select a menu item by lifting your finger when you get to the desired item.
5 Push the joystick up/down or turn the SELECT dial to select the desired setting option and then
press SET.

e During the selection, the currently selected option is indicated with a b mark. Press SET to confirm your
selection and go back to the previous screen.

¢ \When many options are available, a scroll bar will appear on the right. Scroll up or down to see other
options.

¢ You can also touch the desired option.

¢ Press the CANCEL button or select [©] and press SET to return to the previous menu level.

6 Press the MENU button to close the menu.
e Pressing the MENU button at any time closes the menu.

(i) NoTES

* Unavailable items may appear grayed out.

e On some screens, the following icons may be displayed as a guide: (SET), (MENU), ANCED - They refer, respectively,
to pressing the joystick, the MENU button (or touching the onscreen guide) and the CANCEL button.

¢ You can check most of the current settings on the status screens (11 197).

e You can set MENU > [ System Setup] > [Ctrl Dial in Menus] to [Disable] to disable the use of the top and
grip control dials while browsing the menus. In such case, use the SELECT dial to move between menus.
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Using the Customized Menus (My Menu)

In CAMERA mode, you can register up to 6 frequently used menu settings under a My Menu page for easy
access. You can save up to 5 separate sets of My Menu settings each with 6 options for different shooting
situations. Furthermore, if you set an assignable button to [My Menu] (11 121), you can press the button to
access your registered menu settings even faster and more easily.

Adding Menu Settings
1 Select MENU > [% My Menu] > Desired menu page > [Edit] > [Register].
¢ A screen will appear where you can select the menu setting you want to add.
¢ Press the CANCEL button to cancel the operation and return to the regular menu.
2 Select the menu setting you want to add.
3 Select [OK].
e The menu setting you registered will now appear under the currently selected My Menu set.

Rearranging Menu Settings
1 Select MENU > [% My Menu] > Desired menu page > [Edit] > [Move].

2 Select the menu setting you want to move.
e The & icon will appear next to the setting you selected to move.

3 Move the menu setting to the desired position and press SET.

Removing Menu Settings
1 Select MENU > [ My Menu] > Desired menu page > [Edit] > [Delete].
2 Select the menu setting you want to remove and then select [OK].

Resetting All the My Menu Sets
Reset all the menu settings registered to the currently selected My Menu set.
Select MENU > [% My Menu] > Desired menu page > [Edit] > [Reset All] and then select [OK].

Renaming My Menu Sets

You can give each of the 5 My Menu sets a more descriptive name to make them easier to identify.
1 Select MENU > [% My Menu] > Desired menu page > [Edit] > [Rename].

2 Enter the desired name (8 characters long) using the keyboard screen (see the following sidebar).
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Entering text and numbers
There are two types of screens used to enter text and numbers — the keyboard screen, and the data entry
screen. Which screen is used, as well as the available characters will depend on the menu setting.

Keyboard screen 25
1 Touch the character you wish to enter.
e The characters you entered will appear in the input area at the top of the screen.

Key Function CAMERA
“-/n Moves the cursor in the input area.

H Shift key

ﬁ,} / A®1 | Switches between letters, numbers and special characters.

— Space key

« Backspace key

¢ You can also move the cursor with the SELECT dial or the joystick, and select the desired character by
pressing SET.

2 After entering the desired text, touch [OK] to confirm.
Data entry screen
Use the SELECT dial or the joystick to select characters. Metadata > Reel Number
1 Select a character and then press SET to confirm.

® The cursor will move to the next field.

e You can also push the joystick left/right to move between the fields.

* You can also touch the A /V buttons on the screen to select the
desired character, or move the cursor by touching the character
itself.

e Change the rest of the characters in the same way.

2 Select [Set] to confirm the text or value.
e You can also confirm your selection by touching the onscreen SET button.
e Press CANCEL to stop entering text.

Locking the camera's controls (key lock)

You can lock all the camera's buttons* and switches. This is useful in preventing settings from being changed

due to inadvertently pressing one of the buttons. When the camera's controls are locked, you can still operate
the camera using the Browser Remote application. Turning off the camera will reactivate the controls, but it is

possible to change this setting so that the controls remain locked.

* REC buttons are not locked by default but you can choose to lock them too.

Press the LOCK (key lock) button
e @ is displayed on the screen and is displayed on the LCD panel.
¢ Press the LOCK button again to reactivate the controls.

Keeping Key Lock at Shutdown
Select MENU > [¥ System Setup] > [Keep Key Lock at Shutdown] > [On].

(i) NoTES

¢ |n the following cases, key lock settings will not be saved by setting [Keep Key Lock at Shutdown] to [On].
- When no assignable button has been set to [Key Lock].
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Preparing the Camera

This section details how to prepare the camera for the first time, including how to mount and remove lenses, as
well as how to adjust the viewfinder.

Preparing the Lens

As much as possible, attach and remove the lens quickly and in a clean environment free of dust. You can also
use an EF lens by attaching a mount adapter to the RF lens mount. Refer also to the instruction manual of the
lens/mount adapter used.

You can check in advance the lenses supported with the camera's configuration (attached accessories,
recording settings and type of power source in use) (11 29).

@ nvrorTANT

¢ When attaching/removing a lens, avoid direct sunlight or strong light sources. Also, be careful not to drop the
camera or lens.

(i) NoTES

o After removing a lens/When a lens is not attached to the camera:
- Do not touch the lens’s surfaces, the lens mount or any components inside the lens mount area.
- Place the body cap back on the lens mount and the dust caps on the lens. Clean any dust or dirt from the
body cap and dust caps before using them.

Attaching a Lens
1 Turn off the camera.

2 Remove the body cap from the camera and the dust
caps from the lens.

3 Attach the lens to the camera and turn the lens in the
direction of the arrow until it clicks in place.

¢ Align the red mark on the lens with the red lens mount
index mark on the camera.

Removing a Lens
1 Turn off the camera.

2 Hold down the lens release button and turn the lens all the way in the
direction of the arrow until it stops.

3 Remove the lens.

4 Place the body cap back on the lens mount and the dust caps on the
lens.
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(i) NnoTes

¢ Turning on the image stabilization function of a lens may reduce the effective usage time of the battery pack.
When image stabilization is not necessary, for example if the camera is fixed to a tripod, it is recommended to
turn it off.

e Depending on the lens used, you may experience one or more of the following limitations.
- The lens model name may be shortened when displayed on the screen.
- You may not be able to focus manually when the focus mode switch of an EF lens is set to AF.
- You may not be able to use the focus preset function on an EF lens (super telephoto lenses).
- You may not be able to use the power zoom function on EF lenses with that function.

e This camera’s sensor is larger than the sensor size for which EF-S lenses are designed (APS-C). When using
EF-S lenses with this camera, you may notice peripheral illumination fall-off or vignetting (11 186).

¢ When using a compatible lens, you can use the MENU > [ System Setup] > [Retract Lens] setting to retract
the lens automatically when the camera’s power is turned off with the lens's focus mode switch set to AF.

Using the EF-EOS R 0.71x Mount Adapter

e You can use the EF-EOS R 0.71x Mount Adapter to attach a compatible EF lens to the camera (when the
camera's sensor mode is set to [Super 35mm (Cropped))/[Super 16mm (Cropped)]) and shoot video with an
angle of view equivalent to full frame. Additionally, you can use autofocus, peripheral illumination correction

and chromatic aberration correction. For details on compatible lenses, visit your local Canon website.
* Setting the camera's sensor mode to [Full Frame] causes vignetting.

¢ \When using the EF-EOS R 0.71x Mount Adapter with some EF lenses, a frame that limits the AF range may be
displayed.

Updating the Firmware of a Lens/Mount Adapter

You can update the firmware of the lens/mount adapter attached to the camera (only in CAMERA mode). For
details about firmware updates, visit your local Canon website. The following example explains how to perform a
firmware update for lenses.

1 Download the lens/mount adapter firmware update file from the Canon website and save it on the root
directory of an SD card. Insert the SD card containing the firmware update into the camera's SD card slot 2
(1 34).

2 Attach the lens/mount adapter you want to update and turn on the camera in CAMERA mode.

e Attach a lens also when updating the firmware of the mount adapter.

3 Select MENU > [ System Setup] > [Firmware] > [Lens] or [Mount Adapter].

e The current lens/mount adapter firmware version will appear on the screen.

e |f the menu option is grayed out, the attached lens/mount adapter may not support firmware updates or the
SD card used may not contain a valid lens firmware file. Check the lens/mount adapter and SD card and
repeat the procedure from the beginning.

4 Select [OK].
5 Select the lens firmware file (.LFU or .AFU file).
6 Select [OK].
¢ The firmware will be updated. Once in progress, the lens firmware update cannot be canceled.
7 When the confirmation message appears, press SET.

@ vPoRTANT
¢ Be sure to observe the following precautions while the lens firmware is being updated.
- Do not turn off the camera and do not remove the battery pack or other power source.
- Do not remove the lens/mount adapter.
- Do not operate any buttons or controls on the camera.
- Do not open the card compartment cover and do not remove the SD card.
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(i) NoTES

¢ The lens firmware cannot be updated while pre-recording is activated.

e Power the camera through a power outlet using a DC coupler and AC adapter, or a sufficiently charged battery
pack.

¢ When using an EF extender, remove the extender before performing the procedure.

In-Camera Lens Correction

Depending on the characteristics of the lens used, the corners of an image frame may be darker than the center
due to light fall-off (peripheral illumination drop), color shift/color fringing may be visible along high-contrast
edges in the image (chromatic aberration), the image produced may not be as sharp at certain apertures (lens
diffraction), or the image might appear distorted (distortion aberration). In CAMERA mode, you can apply a
correction to compensate as necessary. To apply peripheral illumination or chromatic aberration correction,
correction data for the lens used is necessary. Automatic chromatic aberration correction is available for
broadcast lenses compatible with L.C.A.C. Chromatic aberration and diffraction correction are not applied to
RAW recordings but will be applied to proxy clips recorded simultaneously with RAW clips. Distortion aberration
correction is only possible for compatible RF lenses.

1 Attach the lens you want to use and set the power switch to VIDEO.

2 Select MENU > ["™ Camera Setup] > [Periph. lllum. Corr.], [Chromatic Aberr. Corr.], [Diffraction

Correction], or [Distortion Aberr. Corr.].

e |f correction data is not available, [Periph. lllum. Corr.] or [Chromatic Aberr. Corr.] will appear grayed out. Visit
your local Canon website and check if there is correction data available for the lens you are using. If so,
download the necessary update package, update the camera’s firmware version and repeat the procedure
from the beginning.

e |f the appropriate correction data for distortion aberration is not available for the lens attached, [Distortion
Aberr. Corr.] will appear grayed out.

3 Select [On].
e The camera will apply the correction for the attached lens to all future recordings.

(i) NOTES

¢ About in-camera lens correction data: The camera contains a register of correction data for compatible lenses
that were available at the time the camera went on sale. Correction data for future lenses will be made
available as part of the regular updates released for the camera’s firmware. For more details, visit your local
Canon website.
e Peripheral illumination/chromatic aberration correction cannot be applied in the following cases:
- When the appropriate correction data is not available for the lens attached.
- When using non-Canon lenses. Even if the corresponding menu setting is available (not grayed out), setting
it to [Off] is recommended.
e Diffraction correction cannot be applied when the camera cannot obtain the current aperture value of the lens.
¢ When peripheral illumination/diffraction correction is activated:
- Depending on the recording conditions, noise may appear in parts of the image.
- The level of correction will be lower for lenses that cannot provide distance information.
- The level of correction will be lower the higher the ISO speed/gain setting used.
- When using EF-S lenses, peripheral illumination fall-off may be more pronounced.
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Checking the Required Type of Power Source (Power Source Navigation)

Using the power source navigation function you can check the recording settings that are available based on the
lens/accessories attached, current recording configuration (recording format/frame rate) and the power source
used.

Types of power source: Battery pack, PD-E1 USB Power Adapter and DR-E6C DC Coupler.

Checking the Power Source
1 Select MENU > [¥ System Setup] > [Power Source Navigation] > [Check the required power source.].
2 Select the type of lens.
3 Select the recording format and frame rate combination (multiple selection is possible).
e The required power source configuration is displayed.

Checking the Recording Settings
1 Select MENU > [ System Setup] > [Power Source Navigation] > [Check the available recording settings.].
2 Select the type of lens.

3 Select the type of power source.

e [f you use a commercially available accessory compatible with the multi-function shoe (e.g. the XLR
Microphone Adapter), check the [Power XLR Mic Adapter from Camera] checkbox when supplying power
from the camera.

e The available recording format/frame rate is displayed.

RF/EF Lenses: Available Recording Settings and Power Source Configuration
Other power sources: PD-E1 USB Power Adapter, DR-E6C DC Coupler

; 1
System frequency/Frame rate Using a battery pack

High: 59.94 Hz - Other power
Medium: 50.00 Hz Power supply to a commercially sources
Low: 24.00 Hz available accessory

Yes No

Recording

e Resolution

Sensor mode

31-60
26-60 - - o2
RAW ST 25-60
RAW LT 1-30
1-25 o [ ) o
1-24

8192x4320

29.97,23.98
HDMI RAW 25.00 [ J [ [
24.00

1-30
MP4 (HEVC) 1-25 ° ° [
1-24

31-120

4096x2160 26-120 o3 ) o
XF-AVC 3840x2160 25-120

MP4 (HEVC) 2048x1080

MP4 (H264) | 1920x1080 1-30
1280x720 1-25 ® ® o

1-24

Full frame
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; 1
System frequency/Frame rate Using a battery pack
Recording . High: 59.94 Hz - Other power
Sensor mode format Resolution Medium: 50.00 Hz Power supply to a commercially sources
Low: 24.00 Hz available accessory
Yes No
31-60
26-60 - [ X L J
RAW HQ 25-60
RAW ST
RAW LT 1-30
1-25 @ o o
1-24
5952x3140
59.94
50.00 - ( X [ )
Super 35mm -
HDMI RAW
(Cropped) 29.97,23.98
25.00 [ J o ([ J
24.00
31-120
4096x2160 26-60", 26-120 L 3 o °
XF-AVC 3840x2160 25-604, 26-120
MP4 (HEVC) 2048x1080 130
MP4 (H.264) 1920x1080 -
1280x720 1-25 L4 o L4
1-24
RAW HQ
RAW ST 1-120 [ J (] o
RAW LT
297661570 59.94,29.97, 23.98
Super 16mm |y Raw 50,00, 25.00 ° ° °
(Cropped) 24.00
XF-AVC 2048x1080
MP4 (HEVC) 1920x1080 1-120 [ J o ([ J
MP4 (H.264) 1280x720

' Differs depending on wether the camera is supplying power to an accessory or not, when using a battery pack and a
commercially available accessory (compatible with the multi-function shoe) is attached to the camera.
2 Not avalable when using a USB power adapter and an EF lens is attached to the camera.
Not available when an EF lens is attached to the camera. It may also be unavailable when attaching some RF lenses.
4 When the resolution is 4096x2160 or 3840x2160.

Using the Viewfinder

The camera's viewfinder features an OLED screen that turns on automatically when you look through the
viewfinder and turns off shortly after you move your eye away from it.

Turn on the camera and adjust the viewfinder by turning the dioptric
adjustment knob left or right.

(i) NOTES

® You cannot use the viewfinder and the LCD monitor at the same time.

¢ You can adjust the brightness, contrast, color saturation, sharpness and
luminance of the viewfinder with the respective settings in the MENU >
(=) Monitoring Setup] menu ([T 190).




Preparing the Camera

¢ In CAMERA mode, you can use the MENU > [[E) Monitoring Setup] > [B&W Image: VF] setting to change the
image on the screen to black and white display. Even when the captured image is displayed in black and
white, onscreen displays and icons will be shown in color.

e Adjusting the brightness does not affect the brightness of recordings.

Setting the Display Device

When using the LCD monitor, you can determine the display device in order to prevent an unintended response
from the eye sensor.

Select MENU > [[Z) Monitoring Setup] > [LCD/VF Output] > Desired option.

Options

[Auto1 (=0 3J: LCD Only)]:
Sets the LCD monitor as the output device (when open at a certain angle), but switches
automatically when you look through the viewfinder (if the LCD monitor is stowed, facing the
subject).

[Auto2 (=0 J: Auto Switching)]:
Sets the LCD monitor as the output device, but switches automatically when you look through
the viewfinder.

[LCD Only]: Sets the LCD monitor as the only output device. Switches automatically if you look through the
viewfinder only if the LCD screen is closed.

[VF Only (Eye Sensor ON)J:
Sets the viewfinder as the only output device. The viewfinder turns off shortly after you move
your eye away from it.

[VF Only (Eye Sensor OFF)]:
Sets the viewfinder as the only output device.

Reducing the Viewfinder's Image Shaking

You can reduce the image shaking on the viewfinder caused when the set frame rate is low, and the camera is
moved horizontally.

Select MENU > [[Z) Monitoring Setup] > [Run VF at x2 Speed] > [On].

(i) NoTES

¢ When set to [On], the supported camera configuration (available lenses, accessories, recording settings,
power sources) may change.

¢ The [Run VF at x2 Speed] setting cannot be used in the following cases.
- When the frame rate is set to an option other than 29.97P/25.00P/24.00P/23.98P.
- When using slow & fast motion recording, frame recording or interval recording.
- When the recording format is MP4 and the resolution is set to 8K (8192x4320, 7680x4320).
- In MEDIA mode.

¢ The [Run VF at x2 Speed)] setting cannot be changed while you are recording (while [@ REC] appears on the
screen).
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Checking the Camera's Inclination

You can display the level of the effective inclination compensation of the camera. You can check the vertical
inclination of the optical axis (tilt), and the amount of rotation around the optical axis (roll).

Select MENU > [[Z) Monitoring Setup] > [Custom Display 1] > [Level] > Desired option.
e The level is displayed.

Attaching an Accessory Compatible with the Multi-Function Shoe

For details on how to attach and use accessories, refer to the instruction manual of the accessory in use.

Remove the multi-function shoe cover (1) and slide the
accessory's connecting terminal into the multi-function shoe

@

* \When attaching accessories that communicate through contacts
of the multi-function shoe, insert the accessory's mounting foot
until it clicks into place, then slide the mounting foot locking lever
to secure it.

@ nrorTANT

¢ Protecting the multi-function shoe:
- After removing accessories from the multi-function shoe, reattach the shoe cap to protect the contacts from
dust and water.

- Blow off any foreign material on the multi-function shoe with a commercially available blower or similar tool.
- Allow the multi-function shoe to dry before use if it gets wet.
e Using accessories with screws may damage the multi-function shoe.
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Preparing Recording Media

* K

In VIDEO mode, the camera records clips, photos and other files on CFexpress cards/SD cards®. “Primary clips”
(generally speaking, deliverable files) are recorded on a CFexpress card. “Proxy clips” (smaller files, mainly
intended for offline editing) are recorded on the SD card.

Initialize cards ([J] 35) when you use them with this camera for the first time.

* The SD card is used also to save/read other files such as custom picture files. Additionally, recording is only possible when the bit
rate is 650 Mbps or lower ([1] 59).

Compatible Recording Media

The following types of memory card can be used with this camera. For the latest information about recording
media tested for use with this camera, visit your local Canon website.

CFexpress cards

CFexpress cards compliant with CFexpress 2.0 Type B specifications.

However, it may not be possible to record on the card depending on the camera mode and bit rate used. For
details about CFexpress cards tested for use with this camera, visit your local Canon website.

SD cards
Recording in RAW format on SD cards is only possible when using SDXC cards.
SD card type: Sa® 5D cards, =2 SDHC cards, 222 SDXC cards

UHS Speed Class*: U3
Video Speed Class*: V30, V60, V90

* UHS and Video Speed Class are standards that indicate the minimum guaranteed data transfer rate of SD cards.

Recommended speed class by video configuration

Video configuration
Recommended speed class

Recording mode Recording format Resolution/Bit rate
Slow & fast motion recording - - V90
RAW HQ, RAW ST, RAW LT - V90
XF-AVC YCC422 10 bit 4096x2160, 3840x2160 V60, V90
or Intra-frame
Other than slow &
fast motion recording 8192x4320, 7680x4320 V90
MP4 (HEVC) YCC422 10 hit
4096x2160, 3840x2160 V60, V90
MP4 (HEVC) YCC420 10 bit 8192x4320, 7680x4320 V60, V90
@ wPoRTANT

e CFexpress cards can become hot due to the high operating temperature inside the camera. Removing a
CFexpress card immediately after using it for recording may cause burns or cause you to drop the card,
resulting in damage to the card.

e After repeatedly recording, deleting and editing clips (if the memory is fragmented), you may notice slower
writing speeds to the card and recording may even stop. In such case, save your recordings and initialize the
card with the camera. Be sure to initialize cards especially before shooting important scenes.
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¢ About CFexpress cards/SDXC cards: You can use SDXC cards with this camera but these cards are initialized by
the camera using the exFAT file system.
- When using exFAT-formatted cards with other devices (digital recorders, card readers, etc.), make sure that
the external device is compatible with exFAT. For more information on compatibility, contact the computer,
34 operating system or card manufacturer.

- If you use exFAT-formatted cards with a computer OS that is not exFAT-compatible, you may be prompted
to format the card. In such case, cancel the operation to prevent data loss.

(i) NoTES

e Proper operation cannot be guaranteed for all cards.

Inserting a Memory Card

1 Wait until the card access indicator is off.

2 Slide the card compartment cover to open it (D), @).

3 Insert the card.

e The card in the rear card slot is [[1]]
(CFexpress card), and the one in front of it is
[[A] (SD card).

e CFexpress card: With the card label facing
you, insert the open side of the card (®)) into
the card slot. Inserting cards the wrong
way may damage the camera.

e The gray card-eject button pops out.

e SD card: With the card label facing you, insert
the card into the card slot until it clicks into
place.

) [i] CFexpress card A SD card

4 Close the card compartment cover (@), ().
¢ Do not force the cover closed if the card is not correctly inserted.

@ nrorTANT

¢ Cards have front and back sides that are not interchangeable. Inserting a card facing the wrong direction can
cause a malfunction of the camera. Be sure to insert the card as shown in the illustration.
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e |f you set MENU > [¥ System Setup] > [Card Access LED] to [Off], the card access indicator will not
illuminate.

Removing a Memory Card

1 Set the power switch to OFF.
2 Make sure the card access indicator is off.
3 Slide the card compartment cover to open it (D, (2).

4 Remove the card.
e CFexpress cards: Push the CFexpress card release button.

e SD cards: Push the card once to release it. When the card springs
out, pull it all the way out.

\ JVAVAVAVAVAVAV]

Card release button

Initializing Cards

Initialize cards when you use them with this camera for the first time. You can also initialize a card to permanently
delete all the recordings it contains.

1 Select MENU > [£% Recording/Media Setup] > [Initialize Medial].
2 Select the desired card.

3 Select [OK].
e The card is initialized and all the data it contains is erased.

@ vPoRTANT

e SD cards are initialized using the FAT file system, SDHC cards using the FAT32 file system, and SDXC cards
using the exFAT file system.

e Initializing a card will permanently erase all data, including photos and protected custom picture files. Lost data
cannot be recovered. Make sure you save important recordings in advance.

¢ Depending on the card, initialization may take up to a few minutes.
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(i) notes

¢ If you set an assignable button to [Initialize Media] (] 121), you can press the button to open the [Initialize
Media] submenu.

Setting a Card’s Volume Label

You can set the volume label for CFexpress cards and SDXC cards, when recording RAW/XF-AVC clips, in order
to make it easier to identify and organize them later.

1 Select MENU > [£% Recording/Media Setup] > [Volume Label] > Desired option.
2 Initialize the card ([1] 35).
3 If necessary, set the RAW/XF-AVC clip file name’s metadata elements ([ 40).

4 Record clips on the card.
e The card’s volume label changes when the first RAW/XF-AVC clip is recorded on a just initialized card.

Options
[Canon]: The card’s volume label will be “CANON” regardless of the clip file name settings.

[Canon + Metadatal:
The card’s volume label will be “CANON”, plus the camera index number and the reel number

(11 40).

Switching Between Card Slots
If both slots contain a card, you can switch the card used for recording/playback as necessary.

1 Assign the [Slot Selection] function to an assignable button ([J] 121).
2 Press the assigned button during record standby mode (STBY) or on the index screen.

(i) NoTES

* You can also use the MENU > [ £¥ Recording/Media Setup] > [Main Recording Destination] setting.
¢ You cannot use the button assigned to [Slot Selection] to switch between card slots while recording or playing
back.

¢ You can also perform this function remotely using Browser Remote ([1] 179).

Checking the Remaining Recording Time on a Card

The display on the upper left of the screen shows the card icons and the remaining recording time* (in minutes)
on each card ([] 50).

Onthe [£¥ Recording/Media Setup] status screen (1] 2083), you can check the total space, used space and
approximate remaining recording time* of each card. The approximate remaining number of photos (SD card B
only) and speed class will be displayed as well.

* Remaining recording times are approximate and calculated based on the current video configuration used.
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Recovering Recordings

Some actions, such as suddenly turning off the camera or removing the card while data is being recorded, can
cause data errors in the recorded file. You may be able to recover recordings with corrupted data using the
following procedure.

1 Switch to MEDIA mode and open the index screen with the recordings you wish to recover ([1] 135).
2 Select the desired recording (with the 2 icon).

3 Press SET to open the file menu and select [Recover] > [OK].
® The camera will attempt to recover the corrupted data.

(i) NoTES

¢ |In the RAW/MP4 index screen, recovered clips appear with a B> icon instead of the usual thumbnail.

¢ The file may not be recorded if the power is cut or if the SD card is removed immediately after starting
recording. Even if a partial recording was made, such files may be deleted if file recovery is attempted.

® |n some cases, it may not be possible to recover the data. This is more likely when the file system is corrupted
or the card is physically damaged.

e Only clips, WAV files and News Metadata files recorded with this camera can be recovered. Photos cannot be
recovered.

37



Selecting the Video Recording Method

Selecting the Video Recording Method

This camera features various recording modes, as well as video recording methods using two cards. You can
also stream the audio/video while recording it on a card ([J1 175). Below is an overview. For details, refer to each
function’s section.

Recording modes
You can select the video recording method for the card selected for recording.

[Recording Mode] Description A

) Normal recording. Records a clip in the selected recording format. The most basic video recording 47
[Normal Recording]

method.
[Slow & Fast Motion], Slow & fast motion recording. Records using a frame rate that is different from the playback frame 113
[S&F Clip / Audio (WAV)] rate (overcrank/undercrank shooting). Audio (WAV) can also be recorded.

Pre-recording. Records onto a temporary memory (3 seconds) so the clip will contain a few seconds | 115

[Pre-Recording] of video and audio recorded before you perform the recording operation.

[Frame Recording] Frame recording. Records a pre-defined number of frames. Sound is not recorded in this mode. 116

Interval recording. Automatically records a pre-defined number of frames at a pre-defined interval. 117

(interval Recording] Sound is not recorded in this mode.

Continuous recording. Card 1 is used for normal recording, and card 2 is used for continuous 118

[[i] Main / [2) Continuous Rec] recording.

Second card recording Functions
These are the recording methods for the other SD card.

[2nd Card Rec Functions] Description @M
Proxy recording. Simultaneously records a proxy clip (to card 2, while the main clip is recorded to 70
[ [i] Main / [2) Proxy Rec] card 1) with a smaller file size for offline editing. The proxy clip is recorded with a file name associated

with the main clip.

Sub recording. Simultaneously records a clip to card 2 with a different video configuration from that of | 63

(L] Main / [21Sub Rec] the main clip on card 1.

Audio recording. Simultaneously records a WAV file* to card 2, while the main clip is recorded to 103
[ [1] Main / [2) Audio Rec] card 1.
* Differs from the WAV files that can be recorded together with slow & fast motion recording.

Relay recording. Continues recording on the other card without interruption when the card you are -

[Refay Recording] using becomes full. It is available from card 1 to card 2 and vice versa.

Double slot recording. Records the same clip simultaneously to both cards, which is a convenientway | —

[Double Slot Recording] to make a backup copy of your recordings.

1 Select the recording mode
e Use direct touch control (11 56) or in the menu, select MENU > [£% Recording / Media Setup] >
[Recording Mode] > Desired option.
2 Select the second card's recording function

* Use direct touch control (1] 56) or in the menu, select MENU > [£% Recording / Media Setup] > [2nd
Card Rec Functions] > Desired option.

¢ Relay recording cannot be used when the main recording format is RAW.
e Proxy recording cannot be used when the main recording format is MP4 (HEVC).
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Available simultaneous recording configurations

Second card recording function

off Proxy Sub Audio Relay Double Slot

Recording Recording Recording Recording1 Recording1
Normal Recording o o o o o o
Slow & Fast Motion Recording [ J o’ ('Y - - -
Recording Pre-recording o o’ o’ - ® ®
mode Frame Recording () - - - ] o
Interval Recording ([ J - - - o o
Continuous Recording ([ J - - - - -

e Simultaneous recording is available only with normal recording while connected to a network with IP streaming
activated.

1 Cannot be used when recording to an SD card with a bit rate higher than 650 Mbps.
2 Only when the main recording format is RAW.
3 Only when the main recording format is XF-AVC or MP4.

(i) NoTES

¢ |t is not possible to switch between card slots when proxy recording, sub recording, continuous recording or
audio recording is activated.

e |f a card becomes full during double slot recording, recording on both cards will stop. On the other hand, if an
error occurs with one of the cards, recording will continue on the other card.

Video Recording and Outputs (Diagram)

HDMI © Main recording
RAW (HDMI RAW)

Image © View I—» HDMI OUT

> - > assistance: .
n
processing (HDMI) terminal

Sensor

© Custom Picture © View

assistance:  |— LCD monitor
A (LCD)
O Proxy
recording color © View
conversion assistance: —p Viewfinder

L y y ‘ (VF)
XF-AVC XF-AVC XF-AVC
RAW or or or
MP4 MP4 MP4

@ Main recording @ Main recording © Sub recording @ Proxy recording
(RAW) (XF-AVC/ MP4)

@ Select the main recording format ([1 61)

@ Second card recording functions ([T] 38)

¢ Audio recording, relay recording and double slot recording are also available. Some functions are not
available depending on the main recording format and recording mode.

@ Custom picture settings ([11 125)

® You can control various aspects of the image produced using custom picture files.
O For proxy clips: select the proxy recording color conversion ([I] 70)

e Changes the gamma and color space settings.

© Apply the view assistance function to the image displayed ([1] 151)
e Changes the gamma and color space settings.
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Setting the File Name for Recordings

This section explains how to set the file names for RAW clips, XF-AVC clips, MP4 clips and photos.

RAW/XF-AVC Clips File Names

The camera allows you to change several settings that determine the clip file name of recorded RAW/XF-AVC clips
(only in CAMERA mode). For more details on how to enter characters, see Entering text and numbers ([1] 25).
The basic file name structure is as follows.

A001C001 _yymmddXX _CANON_O01P

1 2 3 4 5 6 7

Camera index: One character (A to Z) that
identifies the camera used.

Reel number: 3 characters (001 to 999) that
identify the card used. The number is assigned
automatically but you can set the initial number.
After you insert a new card (just purchased or
initialized), the number advances by one when the
first recording is made.

Clip number: 4 characters (C001 to D999). The
clip number advances automatically with each
clip recorded (switching to DO01 after C999), but
you can set the initial clip number and select the
clip numbering method.

Recording date (set automatically by the camera).

Random component: 2 characters (hnumbers O to
9 and capital letters A to Z) that change randomly
with each clip.

User defined field: 5 characters (numbers 0 to 9
and capital letters A to Z) for any other
identification purposes.

Proxy clips only: The camera will automatically
add the suffix “_P” to the file name of proxy clips.
Additionally, when an SD or SDHC card is used to
record proxy clips, a stream number (01 to 99) will
be added before the “P”. The stream number will
advance every time the video (stream) file within
the clip is split and recording continues on a
separate stream file.

e Apart from the suffix "_P" in component number 7, the file name of the primary clip (RAW or XF-AVC) and the
proxy clip will be identical.

e Apart from component number 2, the file name of the primary clip and the sub recording clip will be identical.

* The file name of double slot recording clips will be the same on both cards.

e Apart from the .WAV extension, the file name of the WAV files recorded during slow & fast motion recording or
the second card recording functions will be the same as that of the main clip, and will be saved on the
"/PRIVATE/AUDIO" folder.

To set the camera index
Select MENU > [£% Recording/Media Setup] > [Metadata] > [Camera Index] > Desired camera index ([1] 25).

To set the clip numbering method

Select MENU > [ g% Recording/Media Setup] > [Metadata] > [Clip Numbering] > [Reset] or
[Continuous].

Options
[Reset]: The clip number will restart from 001 every time you insert a new card.
[Continuous]:  Clip numbers will start from the initial number set with [Clip Number] (following procedure) and

continue across multiple cards.
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To set the reel number or initial clip number

1 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Reel Number] or [Clip Number] > [Changel.
¢ To return to initial settings, select [Reset] instead.

2 Enter the reel/clip number using the data entry screen ([1] 25).

To set the user-defined field

1 Select MENU > [£8 Recording/Media Setup] > [Metadata] > [User Defined] > [Changel.
e To return to initial settings, select [Reset] instead.

2 Enter the desired text string using the data entry screen (11 25).

MP4 Clip and Photo Numbering

MP4 clips and photos are automatically assigned consecutive numbers and stored on the SD card in folders.
You can select the numbering method to be used.

MP4 clip/photo folder names and file names

MP4 clip/photo number

XXX -nnnn :“xxx”indicates the folder number (from 100 to 999), and “nnnn” indicates the consecutive
— I—'—' number assigned to the MP4 clip/photo (from 0001 to 9999).

xxx_mmdd : Folder name. “mmdd” indicates the month and day of recording.

—— MV I_'m;I .MP4 : Primary clip (MP4) file name.

F—— MVISnnnn.MP4 : Sub recording clip (MP4) file name.
F——MVIPnnnn.MP4 : Proxy clip (MP4) file name.
F——MVICnnnn.MP4 : Continuous recording clip (card 2) file name.
MVI_nnnn.XML : Metadata/News Metadata (XML) file name.
—— IMG_nnnn.JPG : Photo file name.

e For sub recording clips, the folder name and consecutive number (“nnnn”) will be the same in both cards.
e For double slot recording clips, the folder name and file name will be the same in both cards.

* The WAV files recorded during slow & fast motion recording will have the same file name as that of the primary
clip with the addition of "_yyyymmddHHMMSS" (year, month, day, hour, minute, second), and will be stored in
the “/PRIVATE/AUDIO/” folder of the card.

e The WAV files recorded when using the second card recording functions will have the same file name as that of
the primary clip with the addition of "_yyyymmddHHMMSS" (year, month, day, hour, minute, second), and will
be stored in the “/PRIVATE/AUDIO/” folder of the card.

e The "MVIP" part of metadata/News Metadata (XML) file names may also be "MVIS" or "MVIC".

Select MENU > [ 2% Recording/Media Setup] > [MP4 Clip/Photo Numbering] > Desired option.
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Options

[Reset]: Recording numbers will restart from 100-0001 every time you insert a new card. If a card already
contains previous recordings, numbers will continue from the number following that of the last
MP4 clip/photo on the card.

[Continuous]:  Recording numbers will continue from the number following that of the last MP4 clip/photo
recorded with the camera. This setting is the most convenient for managing files on a computer.
We recommend using the [Continuous] setting.

(i) NoTES

e Fach folder can contain up to 500 files. When that number is exceeded, a new folder is created automatically.
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Using the Fan
The camera uses a cooling fan to lower the camera’s internal temperature. In CAMERA mode, you can change

the fan’s operation mode and speed. In MEDIA mode, the fan runs at all times but you can select its speed.

Setting the Fan’s Operation in CAMERA Mode
1 Select MENU > [¥ System Setup] > [Fan Modg] > Desired option.

If you selected [Always On]
2 Select MENU > [§ System Setup] > [Fan Speed (Always)] > Desired fan speed.

If you selected [Automatic]
2 Select MENU > [ System Setup] > [Fan Speed (STBY)] > Desired fan speed in record standby mode.
3 Select MENU > [¥ System Setup] > [Fan Speed (REC)] > Desired fan speed while recording.

e The [Maximum)] option offers the maximum cooling effect but is available only for [Fan Speed (STBY)], as it is
noisier.

Options for [Fan Mode]

[Automatic]: The fan runs while the camera is not recording and is automatically turned off while the camera
is recording. However, if the internal temperature of the camera is too high, the fan will be
activated automatically (in that case, will appear). When the camera’s temperature has
decreased sufficiently, the fan will be turned off. Use this setting when you do not want the
camera to pick up the fan’s operating sound.

[Always On]:  The fan runs at all times.

Setting the Fan Speed in MEDIA Mode
1 Select MENU > [¥ System Setup] > [Fan Speed].
2 Select the desired option.

@ PorRTANT
¢ While the fan is running, the exhaust vent will emit warm air.
¢ Be careful not to obstruct in any way the fan’s air vents ([J1 13, 14).

(i) NoTES

¢ Depending on the ambient temperature and other shooting conditions, the fan may not turn off even if you set
its operating mode to [Automatic].
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Adjusting the Black Balance

In CAMERA mode, you can have the camera adjust the black balance automatically when ambient temperature
changes considerably or if there is a noticeable change in a true black video signal.

1 Attach the body cap to the lens mount and set the camera to CAMERA mode.

¢ |f alens was attached, turn off the camera and remove the lens. Place the body cap back on the lens mount
and turn on the camera.

2 Select MENU > ["™ Camera Setup] > [ABB] > [OK].
¢ The automatic black balance procedure will start. It may take about 1 minute depending on the frame rate.

e |f the sensor is not completely shielded from light, [Error] will appear on the screen. Repeat the procedure
from the beginning.

(i) NOTES

Adjusting the black balance is necessary in the following cases:
- When using the camera for the very first time or after a long period of not using it.
- After sudden or extreme changes in ambient temperature.
- After changing the sensor mode.
- After activating or deactivating slow & fast motion recording (including switching to another special recording
mode).
- After changing the shooting frame rate, when slow & fast motion recording is activated.
- After resetting the camera’s settings.
¢ During the adjustment of the black balance, you may notice some irregular displays appear on the screen. This
is not a malfunction.
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Sensor Cleaning

The front part of the image sensor can be cleaned when turning on the camera by setting the power switch to
VIDEO, or when turning it off.

Select MENU > [ System Setup] > [Sensor Cleaning] > Desired option.

Options

[At Power ON/OFF]:
The sensor is cleaned when turning on the camera by setting the power switch to VIDEO, or
when turning it off.

[At Power OFF]: The sensor is cleaned only when the camera is turned off.

[Off]: Disables sensor cleaning.
An indication will appear on the screen while the sensor is being cleaned.
(i) NoTES

e For better results, placing the camera on a flat surface such as a desk is recommended.
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Recording

Recording Video

This section explains the basics of recording clips*. For details on recording audio, refer to Recording Audio

(01 102).

* “Clip” refers to a single movie unit recorded with a single recording operation. You can also include metadata and News
Metadata ([J1 111) with the clip.

Recording

OFF
PHOTO| VIDEO

REC button

INNIY

8NN

Power indicator/
Tally lamp

Access indicator

* Can be assigned to function as a REC button ([T1 121).

1 Set the power switch to VIDEO.

e The message [Be careful when taking CFexpress out. It may become hot after recording.] is displayed when
turning the camera on in VIDEO mode for the first time, or when resetting the camera's settings. Select [OK]
to close the screen.

e The camera turns on in CAMERA mode and enters record standby mode ([STBY]). The power indicator (tally
lamp) illuminates in green.

e The access indicator will illuminate momentarily in red, then go out afterwards.

2 Press the REC button to begin recording.
e Recording starts. The tally lamp changes from green (power indicator) to red and the recording indicator at
the top of the screen changes from [STBY] to [@ REC].
e The access indicator will illuminate in red.
¢ You can also perform this function remotely using Browser Remote on a connected network device ([T 180).

3 Press the REC button to stop recording.
e The clip is recorded and the camera enters record standby mode. The tally lamp changes from red to green
(power indicator).
® The access indicator goes out.
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@ nvrorTANT
e Be sure to save your recordings regularly, especially after making important recordings. Canon shall not be
liable for any loss or corruption of data.

(i) NoTES

e |f you record using metadata or News Metadata settings, those settings will be recorded with the clip. For
more details, refer to Using Metadata (11 110).

¢ |f the camera switches to the other card while recording video due to the relay recording function ([J1 38), the
two parts (before/after the switch) will be recorded as separate clips.

* A single clip can be recorded continuously for up to 6 hours. At that point, a new clip will be created
automatically and recording will continue on a separate clip (XF-AVC/MP4 format only).

¢ You can use the review function ([11 55) to play back part or all of the last clip recorded without having to
switch to MEDIA mode.

¢ \When recording clips on SDHC cards, the video (stream) file in the clip will be split approximately every 4 GB.
Playback with the camera will be seamless.

e You can assign the [REC] function to assignable button Camera 10/13 and use it to start/stop recording.

* You can set MENU > [¥ System Setup] > [Onscreen REC/STBY Button] to [On] to use the onscreen
[@REC)/[STBY] touch buttons to stop and start recording respectively.

To take photos
While the camera is in record standby mode, you can record photos on the SD card.

1 Set an assignable button to [Photo] (1] 121).

2 When the camera is in record standby mode, press the assignable button.
® »[2) appears on the screen and the photo is recorded on the SD card.
¢ The access indicator will illuminate in red.

e The size of the recorded photos depends on the video configuration currently in use. For details, refer to
Specifications ([1] 232).

Available photo shooting resolution

Sensor mode Main recording format* Main resolution Photo resolution
RAW - 4096x2160
8192x4320 8192x4320
MP4
Full frame 7680x4320 7680x4320
XF-AVC 4096x2160, 2048x1080 4096x2160
MP4 3840x2160, 19201080, 1280x720 3840x2160
RAW - 4096x2160
Super 35mm
(Cropped) XE-AVC 4096x2160, 2048x1080 4096x2160
MP4 3840x2160, 1920x1080, 1280x720 3840x2160
RAW - 2048x1080
Super 16mm
(Cropped) XE-AVC 2048x1080 2048x1080
MP4 1920x1080, 1280x720 1920x1080

* MENU> [ £¥ Recording/Media Setup] > [Main Rec Format] setting.
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(i) Nnotes

¢ Photos cannot be recorded in the following cases
- While recording a clip, or when slow & fast motion recording is activated.
- When pre-recording is activated.
- While using the camera as a web camera.
- While Browser Remote is activated.
- While color bars are displayed.

Onscreen Displays

Refer to this section for an explanation of the various screen displays that appear in CAMERA mode. You can
use the custom display function (1 190) to turn off individual onscreen displays if they are not required. The
menu item that controls each display is given in the following tables (1: indicates a menu item under [Custom
Display 1] and 2: indicates a menu item under [Custom Display 2]).

The position of some icons and onscreen displays may change depending on the display level settings, which
can be set to level 1, level 2 or level 3. The following screenshot and tables describe the onscreen displays at
display level 1 with the [All Displays] setting ([1] 52).

32 min (@0 < / I 1/59.94P @ :00:00:00
28 min 0

P
8192x4320
YCC422 10bit

r 2

AE+0.25 [FH3+4/CH3+4
Dclosed @1s010240f)  250.40 Hz

AF frames
You can turn AF frames on/off with the MENU > [(Z) Monitoring Setup] > [Custom Display 1] > [Focus Mode]
setting.

Continuous AF frame — in white Eye detection: Main subject's
when [AF Frame] is set to either eyes (1] 91)

[Large] or [Small] ([T] 88)
Continuous AF frame (only near
focus) — in yellow: manual
adjustment range; in white:
automatic adjustment range; in red:
nearer focus is not possible. (1] 89)

Face AF: Main subject (1] 91)

Tracking: Subject selection ([T 92) Face AF:

i Only one face detected or faces
Frame shown when focus adjustments other than the main subject
are not possible: in red. You cannot

focus nearer when [AF Mode] is set to
[Continuous] and [AF Frame] is set to

[Whole Areal.

Tracking: During tracking Focus guide frame ([1] 86)
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Left side of the screen

Icon/Display Description Custom Display
(MF), Focus mode (1] 85). 1: [Focus Mode]
8 & Face AF (10 91).
(U (g &l Image stabilization enabled/disabled (1] 93). 1: [Digital 1S]
@& (Lens information) Lens information. 1: [Lens]

e Depending on the lens, the information displayed may differ.

[R4MY (in red)

Lens error warning ([1 214).

(in yellow) « Displayed in yellow when the attached lens cannot be used. [The lens does not

work.] is also displayed.
[€ 00 Custom picture file selected ([T 125). 1: [Custom Picture]
[CLOG3), [PQ), (HLG), (WideDR), [Gamma/Color Space] setting in the custom picture file (11 129).
(NorM), (std), (C.Gamut], (BT:2020],
Look Files (11 127).
2N Light metering mode (11 81). 1: [Light Metering]
View assistance. 1: [View Assist]
Status of the accessory attached to the multi-function shoe ([11 32). 2: [Multi-Function Shoe]

e Appears in red in case of a communication error or if the attached accessory is

turned off.

& GPS signal: continuously on - satellite signal acquired; flashing - satellite signal not | 2: [GPS]

acquired.
¢ Displayed only when a GP-E2 GPS Receiver is connected to the camera.

Fan operation: in white — normal (] 43); in red — fan warning (1 214).

Temperature warning ([11 43).
e When the camera internal temperature rises above a certain level, & will
appear in yellow. If the temperature rises further, B will appear in red.

2: [Temperature/Fan]

User memo (11 110).

2: [User Memo]

Top of the screen

Icon/Display

Description

Recording media status, estimated remaining recording time and recording format

1], [ (in green)
000 min

[1]: CFexpress card / [2): SD card

The card’s status is indicated by the icon’s color: in green — can record; in yellow —
card almost full (less than 6 minutes); in red — card almost full (less than 1 minute);
in white — reading the card.

e The card selected for recording is indicated with a P mark.

Custom Display
2: [Remaining Rec Time]

[11, [2) (in red) END Card is full.

1S, [2s (inred) No card or cannot record on the card.

[RAW BIXF-AVCIMP4} Video format ([ 61).

Audio files (C11 113).
=, M, Network connection status ([T] 173). 2: [Network Functions]
FTP L 3\l
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Icon/Display Description Custom Display

D] Double slot recording ([ 38). 2: [Recording Mode]
Recording operation

STBY, @REC Clip recording: record standby, recording.

S&F STBY, Slow & fast motion recording (] 113): record standby, recording.

S&F @REC

PRE STBY, Pre-recording ([J1 115): record standby, recording.

PRE @ REC

FRM STBY, Frame recording (1 116): record standby, recording.

FRM @ REC,

FRM @ STBY

INT STBY, Interval recording ([ 117): record standby, recording.

INT @ REC,

INT @WAIT

CONT, @ CONT Continuous recording ((1] 118)
1s to 10m00s Interval counter. 2: [Interval Counter]
L2 Recording command ([ 147). 2: [Rec Command]
00.00P, 00.00i Frame rate ([11 62). 2: [Frame Rate]

When slow & fast motion recording is activated, the shooting frame rate is also
displayed (000/00.00P).

a Key lock (11 25). 1: [Key Lock]
00:00:00.00 / 00:00:00:00 Time code ([T 98). 2: [Time Code]
R,PFE Time code status (1 99).
Power supply level indicator 2: [Remaining Battery]

— o - Remaining battery charge of a LP-E6NH/LP-E6N/LP-E6 Battery Pack and

- {1 - remaining usage time (in minutes) ([0 17).

(in red) s When is displayed, replace the battery pack with a fully charged one.

000 min

Appears when the WFT-R10 Wireless File Transmitter is attached. -
0000 mm Approximate focal length of the lens. 1: [Focal Length]
000.0 m Object distance (numeric). 1: [Object Distance

e Only when an RF lens or certain EF Cinema lenses are attached.

(Numeric)]

Object distance (bar).
¢ Only when an RF lens is attached to the camera.

1: [Object Distance (Bar)]

Right side of the screen

Icon/Display Description Custom Display
USB PD PD-E1 USB Power Adapter ((11 207). -
(Full), (Super3s), Sensor mode (11 61). 2: [Sensor Mode]
0000x0000 Resolution (] 62). 2: [Resolution/
YCC000 00 bit Color depth, color sampling ((I] 61). Color Sampling]
HQ / ST/ LT 00 bit RAW mode ([11 59).
» [2) (in green) Photo recorded on the SD card ([ 48). 2: [Photo]
» 2 (in red) No SD card or cannot record photos on the SD card.
60(24)fps, Video output ([ 121). 2: [Output Terminals
60(30)fps Status]

PIE (in yellow)

Output onscreen displays (11 149).

2: [0SD Output]

1T (in yellow) Magnification ([] 87). 1: [Magnification]
[PEAK1 8 (in yellow) Peaking (11 87). 1: [Peaking]
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Icon/Display Description Custom Display
' Audio level meter ([T 104). 2: [Audio Level Indicator]
)00, (O Headphone volume (1] 139). -
Date/time 2: [Date/Time]
CHO/CHo, Audio output channels (1] 153). 2: [Monitor Channels]
CHO+CHO/CHO+CHO
1/0000.00, 000.00°, 000.00Hz | Shutter speed (1] 72). 1: [Shutter]

Bottom and center of the screen
Icon/Display Description Custom Display

O

Direct touch control ([ 56)

A001C001 to Z999D999

Clip identification. Includes the camera index, reel number and clip number
components of the clip file name (] 40).

2: [Reel/Clip Number]

00 00 00 00 User bit (11 99). 2: [User Bit]

Base 0000 Base IS0 (11 75). 1: [Base IS0]

e Exposure bar ([J1 81). 1: [Exposure Bar]

AE +0.00 AE shift (11 81). 1: [AE Shift]

NUA/ B, 3oz, 38 [4, | White balance (C] 82). 1: [White Balance]

AWB

00000K +0

[, F00.0 /T00.0, closed Aperture value ([] 78). 1: [Iris]

10 000000, 00.0dB ISO speed/Gain value ([1] 74). 1: [ISO/Gain]
Level (11 32). 1: [Level]

(horizontal/vertical)

Selecting the Onscreen Display Level

You can press the DISP button to control de amount of information shown
over the image. Repeatedly pressing the DISP button will change the
display level: Display level 1 — Display level 2 — Display level 3 = Display
level 1. In CAMERA mode, you can change the information displayed at
each display level in the menu ([ 190).

[Main Recording Displays] option



Recording Video

CAMERA mode
Display level! Options Description
[DISP Level 1] | [All Displays] All onscreen displays at a larger size.
[All Displays (Periph. Border)] | All onscreen displays at a smaller size, more appropriate for use with the peripheral border. 53

[DISP Level 2]2 [Main Recording Displays] Only the onscreen displays most relevant for shooting.

[Only FUNG/MENU] Only markers, focus frames/tracking frame, and video scopes are displayed. When the FUNC
button, MENU button or an assignable button is pressed, the necessary information will be
displayed.

[DISP Level 3]2 [Only REC/STBY] No onscreen displays except for the recording operation (REC/STBY).

[No Displays] No onscreen displays at all.

' MENU > (=D Monitoring Setup] > [DISP Level 1], [DISP Level 2] or [DISP Level 3].
2 Smaller onscreen displays (same size as when set to [All Displays (Periph. Border))).

MEDIA mode
Display level During clip/photo playback Index screen/During audio playback
[DISP Level 1] All onscreen displays.
[DISP Level 2] No onscreen displays. All onscreen displays.

[DISP Level 3] -

(i) NoTES

¢ The zebra pattern and false color display will appear on the screen regardless of the selected display level.
¢ You can change the transparency level of onscreen displays ([1] 149).

Peripheral Border Display

You can apply the peripheral border display to all display levels. With the peripheral border display, the camera’s
image is reduced slightly so the onscreen displays are shown mostly around it and not on top of it, partially
hiding it. The peripheral border is linked with the display level. You can select the levels that use the peripheral
border with the MENU > [[E) Monitoring Setup] > [Apply Peripheral Border] setting.

Full-screen display Peripheral border display



54

Recording Video

Onscreen Displays in Portrait Mode

When shooting in portrait mode, you can change the orientation of the onscreen
displays.

59.94p
00:00:00.00P

[Full}
3840x2160

Select MENU > [[E) Monitoring Setup] > [OSD Orientation: LCD/VF] > ’ vecazz 10m
[ 2=} 90 Degrees Right] or [ ¢« 90 Degrees Left].

(i) NoTES

¢ For video output from the HDMI OUT terminal, select MENU > [[E) Monitoring
Setup] > [OSD Orientation: HDMI] > Desired option (only when rotating the LCD
monitor/viewfinder onscreen displays).

e The menu and status screens cannot be rotated.

¢ Direct touch control and the peripheral border display cannot be used when the

CAMERA mode screen is rotated. =

=, A 5600K 0
F1.4

A004C006

e+

LCD Panel

By pressing the 8 (LCD panel info switching) button, you can switch the information displayed on the LCD
panel.
During direct setting mode, using the FUNC button, a white frame appears on the selected item.

1 White balance 6 Battery level

2 Key lock 7 WFT battery level

3 Aperture value 8 Network connection status / Functions
4 1SO speed 9 Recording operation

5 Shutter speed



Recording Video

14 lﬂ 164min
B— 21 9999min

s8—00:00:00.00P
T

1 Card 1 (CFexpress card) / Recording time 3 Time code, time code status
available 4 4 Frame rate
2 Card 2 (SD card) / Recording time available

Reviewing a Recording

If you set an assignable button to [Review Recording] in advance, you can review all or part of the last clip
recorded even with the camera set to CAMERA mode.

1 Set an assignable button to [Review Recording] (11 121).
2 Select MENU > [¥ System Setup] > [Review Recording] > Desired option.

3 After you finish recording a clip, press the assignable button.

* The last clip that was recorded is played back for the selected duration. [ REVIEW] appears on the
screen.

* There will be no sound from the built-in speaker but the audio will be output from the () (headphone)
terminal and HDMI OUT terminal.

e You can use the joystick to jump back/forward within the clip. You can also touch or slide the onscreen
progress bar to move to a different position in the video (11 138).

e Press CANCEL or flick down on the screen to stop reviewing the clip.
e After the clip finishes playing back, or if you stop reviewing the clip, the camera returns to record standby
mode.
Options
[Entire Clip]: Allows you to review the entire clip.
[Last 4 sec]:  Allows you to review just the last 4 seconds of the clip.

(i) NoTES

e |f the camera switched cards during a recording, the camera will play back the clip on the card most recently
recorded on.

¢ You cannot review clips when continuous recording is activated.
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Adjusting Camera and Recording Settings

Adjusting Camera and Recording Settings

Using direct touch control, you can perform a variety of settings (camera, recording, assistance functions, etc.) in
CAMERA mode. White balance and exposure related settings can also be modified with the direct setting mode,
using the FUNC button.

Performing Basic Settings with Direct Touch Control

With direct touch control you can change commonly used settings such as camera and recording settings and
assistance functions. For details about each function, refer to the respective section on the manual.

Available Direct Touch Control Settings

Touch button Available settings

White balance White balance mode (custom, preset, color temperature, automatic (AWB)), color correction value.

Aperture Adjustment of the F value/T value.

ISO/Gain Adjustment of ISO or gain value/adjustment value preset.

Shutter speed Adjustment of the value in the current shutter mode.

(assistance functions) Focus guide (on/off), peaking (type), WFM, zebra (type), false color (on/off), markers (on/off), view assistance (on/
off).

% (recording settings) Sensor mode, recording mode, second card recording functions, main recording destination, continuous
recording" 2 slow & fast shooting frame rate, frame recording frame rate, interval recording frame rate, interval
recording time interval, main recording format, file selection, main resolution/bit rate, frame rate,

[2) recording format,[2) resolution/bit rate, [2) frame rate, proxy recording color conversion.

1 Only when the main recording format is MP4.
2 Only when the [Continuous Recording] setting (1 118) is changed from [STBY] to [REC].

Recording settings == i 25 = 59.94P  00:00:00.00P
JFuil

160
0 bit

[Fan]

Opening ((v3)/ Closing (X) the —g

004C006 N —————
direct touch control interface [ |

Camera settings

Assistance functions
]

Turn on/off the Direct Touch Control Interface

Even when the direct touch control interface is displayed, you can still use other functions such as recording,
menu settings, direct setting mode or status screens.

1 Touch (v to open the direct touch control interface.
2 Touch X to close the direct touch control interface.
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Changing Camera Settings
1 Touch the setting you want to adjust, then select the desired value/
setting.
e Once the settings menu is displayed, touch to select the desired
value/setting as needed.

¢ When the slider appears, drag the slider left/right or touch the 4/ S :
P buttons to adjust the desired value. [ Fa | sozs0 | 18000

e You can also use the SELECT dial or the control dial. Drag the slider to select the desired value
2 Touch ®.

400

Using Assistance Functions

1 Touch (assistance functions) and then turn assistance functions Focus Guide Peaking WM
on/off, or select the desired assistance function. « o e S L

[ ]
2 Touch 3.
12000 |

Changing Recording Settings
1 Touch % (Recording Settings) %

e The recording settings menu will be displayed. There are three sensor Mode Recordina Mode
pages that can be switched by swiping left and right.

Full Frame Normal Recording

2nd Card Rec Functions

2 Select the desired menu setting and then select the desired option. off
3 TOUCh x . Main Recording Destination

CFexpress

Direct Setting Mode (FUNC Button)

You can adjust main camera functions—white balance, aperture, 1ISO
speed/gain and shutter speed —using the FUNC button (direct setting
mode). This section will explain the basic operation of the direct setting
mode. For details about each function, refer to the respective section on
the manual.

1 Press the FUNC button.

e The onscreen display of the selected function will be highlighted in
orange.

e Press the FUNC button repeatedly or push the joystick left/right to
select a different function (the top control dial can also be used).
2 Push the joystick up/down or turn the SELECT dial to select the
desired value or white balance mode. Ag01C005 ) .
. . n ZFA15600K £0 F1.4 150200 180.00
e You can also use the grip control dial.
3 Press SET.

® The selected value/mode will be set and direct setting mode will end.
e The onscreen display of the selected function will return to normal.
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Adjusting Camera and Recording Settings

(i) NoTes

® The camera will automatically end the direct setting mode in the following cases.
- If no operation was performed for more than 6 seconds.
- If the FUNC button is pressed while selecting the shutter speed.
- If the menu or a status screen was opened.

¢ If you set an assignable button to [White Balance], [Iris], [ISO/Gain] or [Shutter] (] 121), you can press the
button to enter direct setting mode with the respective function highlighted.



Video Recording Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Video Recording Configuration: Video Format, Sensor Mode,
System Frequency, Resolution and Frame Rate

When recording media, you can set the video configuration used for primary clips with the following procedures.
Select the sensor mode, main recording format (video format, color sampling, bit depth), primary resolution/bit
rate and frame rate settings that best match your creative needs. Available options for some settings may
change depending on previous selections for other settings. See the following tables for a summary*.

For details about sub recording clips and audio, refer to Sub Recording Clips ([11 63) and Recording Audio
(T2 102) respectively.

* The cells in color represent a bit rate of 650 Mbps or higher.

RAW
Main System frequency/Frame rate/Bit rate*
Sensor mode  recording Resolution  Color depth 59.94 Hz 50.00 Hz 24.00 Hz
format 5004P  2097P  2398P  50.00P  2500P  24.00P
o o o o
RAW ST - 1980 Mbps | 1580 Mbps |~ 1650 Mbps | 1580 Mbps
Full frame 8192x4320
RAW LT o o o o o o
2570 Mbps | 1290 Mbps | 1030 Mbps | 2140 Mbps | 1070 Mbps | 1030 Mbps
o o o o
RAW HQ - 2120 Mbps | 1700 Mbps | 1770 Mbps | 1700 Mbps
Super 35mm o o o o o o
(Cropped) | PAWST | 5952x3140 Ly | 2090 Mops | 050Mops | 836 Mops | 1750 Mbps | 871 Mons | 836 Mops
|
RAW LT o o o o o o
1360 Mbps | 679 Mbps | 544 Mbps | 1140 Mbps | 566 Mbps | 544 Mbps
RAW HQ o [ ) o o o o
1080 Mbps | 537 Mbps | 430 Mbps | 896 Mbps | 448 Mbps | 430 Mbps
Super 16mm o o o ( J (] (]
(Cropped) | AWST | 2976x1570 520 Mbps | 265Mbps | 212Mbps | 441Mbps | 221 Mbps | 212 Mbps
RAW LT o o o o o o
344 Mbps | 172 Mbps | 138 Mbps | 287 Mbps | 144 Mbps | 138 Mbps

* The camera uses a variable bit rate (VBR).
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Video Recording Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

XF-AVC
Main System frequency/Frame rate
) Sensor Main .
recording ) Bit rate* 59.94 Hz 50.00 Hz 24.00 Hz
P t mode resolution
Lig 59.94P 59.94i 29.97P 23.98P 50.00P 50.00i 25.00P  24.00P
810 Mbps Intra-frame | @ - - - [ ) - - -
4096x2160 | 410 Mbps Intra-frame - - [ J [ J - - [ [ J
3840x2160 | 260 Mbps Long GOP | @ - - - [ ) - - -
160 Mbps Long GOP - - [ J [ J - - [ J ([ J
310 Mbps Intra-frame | @ - - - [ J - - -
Full frame | 2048x1080 | 160 Mbps Intra-frame - - [ J [ J - - [ J o
50 Mbps Long GOP o - [ J [ J [ J - [ [ J
310 Mbps Intra-frame | @ - - - [ - - -
1920x1080 | 160 Mbps Intra-frame - [ J [ J [ J - [ J [ [ J
50 Mbps Long GOP o [ ) [ ) [ ) [ ) [ J [ J o
XF-AVC 1280x720 | 24 Mbps Long GOP () - [ -
YCC422
10 bit 810 Mbps Intra-frame | @ - - - [ J = = =
Super | ynoexo160 | 410 Mbps Intra-frame | — ) ) - @ ®
35mm 40%21
(Cropped) | 3840x2160 | 260 Mbps Long GOP | @ - - - ° - - -
160 Mbps Long GOP - - @ [ J - - [ J ([ J
310 Mbps Intra-frame | @ - - - o - - -
Super | 2048x1080 | 160 Mbps Intra-frame | — - [ [ - - [ ®
35mm _ _
(Cropped) 50 Mbps Long GOP o [ J [ J [ J [ [ J
310 Mbps Intra-frame | @ - - - [ - - -
fgﬁﬁ; 1920x1080 | 160 Mbps Intra-frame | — e o o - e o °
(Cropped) 50 Mbps Long GOP ® ® ® ® ® o o o
1280x720 | 24 Mbps Long GOP o - [ J -

* The camera uses a variable bit rate (VBR). Intra-frame options compress the image after analyzing each frame separately and are
more appropriate for editing. Long GOP options compress the image after analyzing also changes across a group of pictures
and offer better compression (smaller data size).



Video Recording Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

MP4

System frequency/Frame rate
Main recording

format Sensor mode Main resolution 59.94 Hz 50.00 Hz 24.00 Hz
59.94P 29.97P 23.98P 50.00P 25.00P 24.00P
MP4 (HEVC) 8192x4320 - o o - o [ J
YCC422 10 bit / Full frame
YCC420 10 bit 7680x4320 - o o - o @
Full frame 4096%2160 ) ) ) ) ) )
Super 35mm
MP4 (HEVC) (Cropped) 3840x2160 o o o o o [ J
YCC422 10 bit /
YCC420 10 bt Full frame 2048x1080 ° ° ° ° ° °
MP4 (H.264) Super 35mm
YCC420 8 bit (Cropped) 1920x1080 [ J ([ [ J ([ () [
Super 16mm
(Cropped) 1280x720 [ ) - - o - -

(i) Nnotes

¢ For details on the signal output from each terminal, refer to Video Output Configuration ([J] 145).

Selecting the System Frequency

You can change the system frequency also in MEDIA mode if you want to play back clips from a card recorded
with a different system frequency setting.

1 Select MENU > [£% Recording/Media Setup] > [System Frequency].

2 Select the desired option.
e The camera will reset and restart in the selected mode.

Selecting the Sensor Mode
You can change the area of the imaging circle covered by the CMOS sensor to produce the recorded image.

1 Select MENU > [£% Recording/Media Setup] > [Sensor Mode].
* You can also adjust this setting using direct touch control ([I] 56).

2 Select the desired option.

Selecting the Main Recording Format
Select the combination of video format, color sampling and bit depth for primary clips.
1 Select MENU > [£% Recording/Media Setup] > [Main Rec Format].

® You can also adjust this setting using direct touch control ([T 56).

2 Select the desired option.
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Video Recording Configuration: Video Format, Sensor Mode, System Frequency, Resolution and Frame Rate

Selecting the Resolution and Bit Rate of Primary Clips

1 Select MENU > [£% Recording/Media Setup] > [Main Resolution/Bit Rate].
¢ You can also adjust this setting using direct touch control ([11] 56).

2 Select the desired option.

Selecting the Frame Rate
Select the frame rate for the primary clips. This procedure is not necessary when the system frequency is set to
24.00 Hz.

1 Select MENU > [£% Recording/Media Setup] > [Frame Rate].
¢ You can also adjust this setting using direct touch control (1] 56).

2 Select the desired option.

Selecting the Main Recording Destination
1 Select MENU > [£% Recording/Media Setup] > [Main Recording Destination].

2 Select [CFexpress] or [SD Card].
¢ If you set an assignable button to [Slot Selection], you can press it to switch between cards ([T] 121).



Sub Recording Clips

Sub Recording Clips

While recording a primary clip to slot 1 (CFexpress card), you can simultaneously record the same scene to

slot 2 (SD card). When the main recording format is HDMI RAW, the main clip (RAW) is output from the HDMI
OUT terminal and the sub recording clip is recorded on the card in slot 2. See the following table for more details
on the video configuration for sub recording clips. For more details on audio, see Recording Audio (11 102).

You can also use direct touch control to perform this function (11 56).

Video configuration for sub recording clips (Main clip: RAW, sub recording clip: XF-AVC)

Sub recording clip’

Sub recording format, resolution and bit rate

Main recording format Main resolution/Bit rate Frame rate XF-AVC YCC422 10 bit
2120 Mbps 29.97P 4096x2160 / 410 Mbps Intra-frame
4096x2160 / 160 Mbps Long GOP
5952x3140 1770 Mbps 25.00p 2048x1080 / 160 Mbps Intra-frame
1700 Mbps 24.00P, 23.98P 2048x1080 / 50 Mbps Long GOP
RAW HO 1080 Mbps 59.94P 2048x1080 / 310 Mbps Intra-frame
896 Mbps 50.00P 2048x1080 / 50 Mbps Long GOP
2976x1570 537 Mbps 29.97P
2048x1080 / 160 Mbps Intra-frame
448 Mbps 25.00P 20481080 / 50 Mbps Long GOP
430 Mbps 24.00P, 23.98P
1980 Mbps 29.97P 4096x2160 / 410 Mbps Intra-frame
4096x2160 / 160 Mbps Long GOP
8192x4320 1650 Mbps 25.00P 2048x1080 / 160 Mbps Intra-frame
1580 Mbps 24.00P, 23.98P 2048x1080 / 50 Mbps Long GOP
2090 Mbps 59.94P 4096x2160 / 260 Mbps Long GOP
2048x1080 / 310 Mbps Intra-frame
1750 Mbps 50.00P 2048x1080 / 50 Mbps Long GOP
5952x3140 1050 Mbps 29.97P 4096x2160 / 410 Mbps Intra-frame
4096x2160 / 160 Mbps Long GOP
RAW ST
871 Mops 25.00P 2048x1080 / 160 Mbps Intra-frame
836 Mbps 24.00P, 23.98P 2048x1080 / 50 Mbps Long GOP
529 Mbps 59.94p 2048x1080 / 310 Mbps Intra-frame
441 Mbps 50.00P 2048x1080 / 50 Mbps Long GOP
2976x1570 265 Mbps 29.97P
2048x1080 / 160 Mbps Intra-frame
221 Mbps 25.00P 20481080 / 50 Mbps Long GOP
212 Mbps 24.00P, 23.98P
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Sub Recording Clips

Main recording format

RAW LT

Sub recording clip!

Primary clip
Sub recording format, resolution and bit rate
Main resolution/Bit rate Frame rate XF-AVC YCC422 10 bit
2570 Mbps 59.94P 4096x2160 / 260 Mbps Long GOP
2048x1080 / 310 Mbps Intra-frame
2140 Mbps 50.00P 2048x1080 / 50 Mbps Long GOP
8192x4320 1290 Mbps 29.97P 4096x2160 / 410 Mbps Intra-frame
4096x2160 / 160 Mbps Long GOP
1070 Mops 25.00P 2048x1080 / 160 Mbps Intra-frame
1030 Mbps 24.00P, 23.98P 2048x1080 / 50 Mbps Long GOP
1360 Mbps 59.94P 4096x2160 / 260 Mbps Long GOP
2048x1080 / 310 Mbps Intra-frame
1140 Mbps 50.00P 2048x1080 / 50 Mbps Long GOP
5952x3140 679 Mbps 29.97P 4096x2160 / 410 Mbps Intra-frame
4096x2160 / 160 Mbps Long GOP
566 Mops 25.00P 2048x1080 / 160 Mbps Intra-frame
544 Mbps 24.00P, 23.98P 2048x1080 / 50 Mbps Long GOP
344 Mbps 59.94p 2048x1080 / 310 Mbps Intra-frame
287 Mbps 50.00P 2048x1080 / 50 Mbps Long GOP
2976x1570 172 Mbps 29.97P
2048x1080 / 160 Mbps Intra-frame
144 Mbps 25.00P 20481080 / 50 Mbps Long GOP
138 Mbps 24.00P, 23.98P

T Sub recording frame rate is the same as that of the primary clip.

Video configuration for sub recording clips (Main clip: RAW, sub recording clip: MP4)

Mainrecording
format

RAW HQ

Sub recording clip’

Primary clip
Sub recording format, resolution and bit rate
Main resolution / Bit rate Frame rate Y'(\:A(?:Z(ZHE\(;Cgit Y,(\)ngfz((;i%cgit Y'%E%%ﬁgl)t

2120 Mbps 29.97P

5952x3140 | 1770Mbps |  25.00P 42009465%106800//15305|\'/\|Abl:)pss provrm i MESS P03 35 MESE
1700 Mbps | 24.00P, 23.98P
1080 Mbps 59.94pP
896 Mbps 50.00P

2976x1570 537 Mbps 29.97P 2048x1080 / 50 Mbps | 2048x1080 / 35 Mbps | 2048x1080 / 35 Mbps
448 Mbps 25.00P

430 Mbps

24.00P, 23.98P




Sub recording clip!

Sub Recording Clips

Primary clip
Sub recording format, resolution and bit rate
Main recording : o MP4 (HEVC) MP4 (HEVC) MP4 (H.264)
format ManliesclutioniBitrats Hramelrate YCC422 10 bit YCC420 10 bit YCC420 8 bt
1980 Mbps 29.97P
4096x2160 / 135 Mbps | 4096x2160/100 Mbps
8192x4320 | 1650 Mbps 25.00P 11 904841080 / 50 Mbps | 2048x1080 / 35 Mbps
1580 Mbps | 24.00P, 23.98P
2090 Mbps 59.94P  |14096x2160/225 Mbps | 4096x2160 / 170 Mbps | 4096x2160 /150 Mbps
1750 Mbps 5000 | 2048x1080/50 Mbps | 2048x1080 /35 Mbps | 2048x1080 / 35 Mbps
5952x3140 | 1050 Mbps 29.97P
4096x2160 /135 Mbps | 4096x2160/100 Mbps
RAW ST 871 Mbps 25.00P 11 504841080 / 50 Mbps | 2048x1080 / 35 Mbps
836 Mbps | 24.00P, 23.98P
529 Mbps 59.94P
441 Mbps 50.00P
2076x1570 | 265 Mbps 29.97P || 2048x1080 /50 Mbps | 2048x1080/35 Mbps | 2048x1080 / 35 Mbps
221 Mbps 25,00
212 Mbps | 24.00P, 23.98P
2570 Mbps 59.94P  114096x2160/225Mbps | 4096x2160 / 170 Mbps
2140 Mbps 50.00P 2048x1080 / 50 Mbps | 2048x1080 / 35 Mbps
819264320 | 1290 Mbps 29.97P
4096x2160 / 135 Mbps | 4096x2160/100 Mbps
1070 Mbps 25.00P 11 904841080 / 50 Mbps | 2048x1080 / 35 Mbps
1030 Mbps | 24.00P, 23.98P 4096x2160 /150 Mbps
1360Mbps | 59.94P || 4006x2160/225 Mbps | 4096x2160 /170 Mpps | 20+8X1080/ 35 Mbps
1140 Mbps 5000 || 2048x1080/50 Mbps | 2048x1080 /35 Mbps
RAW LT 5952x3140 | 679 Mbps 29.97P
4096x2160 /135 Mbps | 4096x2160/100 Mbps
566 Mbps 25.00P 11 504841080 / 50 Mbps | 2048x1080 / 35 Mbps
544 Mbps | 24.00P, 23.98P
344 Mbps 59.94P
287 Mbps 50.00P
2076x1570 | 172 Mbps 20.97P || 2048x1080 /50 Mbps | 2048x1080/35 Mbps | 2048x1080 / 35 Mbps
144 Mbps 25.00P
138 Mbps | 24.00P, 23.98P

" Sub recording frame rate is the same as that of the primary clip.
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Sub Recording Clips

Video configuration for sub recording clips (Main clip: HDMI RAW, sub recording clip: XF-AVC / MP4)

Main
recording
format

HDMI RAW

Sub recording clip

Primary clip
Sub recording format, resolution and bit rate
Main . . MP4 (HEVC) MP4 (HEVC) MP4 (H.264)
resolution | 'amerate  XF-AVCYCCA2210bit  yees00 10 iy ¥CC420 10 bit YCC420 8 bit
29.97P || 4096x2160 / 410 Mbps
Intra-frame
25.00P | 4096x2160 / 160 Mbps
8192x4320 Long GOP 4096x2160 / 135 Mbps | 4096x2160/100 Mbps
2048x1080 / 160 Mbps | 2048x1080 /50 Mbps | 2048x1080 / 35 Mbps
24.00P,
23.98p Intra-frame
: 2048x1080 / 50 Mbps
Long GOP
59.94P || 4096x2160 / 260 Mbps
Long GOP
2048x1080 / 310 Mbps | 4096x2160/225 Mbps | 4096x2160 / 170 Mbps | 4096x2160/150 Mbps
50.00P Intra-frame 2048x1080 / 50 Mbps | 2048x1080 / 35 Mbps | 2048x1080 / 35 Mbps
2048x1080 / 50 Mbps
Long GOP
5952x3140 | 29.97P || 4096x2160 /410 Mbps
Intra-frame
25.00P 1/ 4096x2160 / 160 Mbps
Long GOP 4096x2160 / 135 Mbps | 4096x2160/100 Mbps
2048x1080 / 160 Mbps | 2048x1080 /50 Mbps | 2048x1080 / 35 Mbps
24.00P,
23.98p Intra-frame
: 2048x1080 / 50 Mbps
Long GOP
59.94P || 2048x1080 / 310 Mbps
Intra-frame
50.00P 2048x1080 / 50 Mbps
Long GOP
2976x1570 | 929.97p 2048x1080 / 50 Mbps | 2048x1080 / 35 Mbps | 2048x1080 / 35 Mbps
: 2048x1080 / 160 Mbps
25.00P Intra-frame
2048x1080 / 50 Mbps
24.00R, Long GOP

23.98P




Sub Recording Clips

Video configuration for sub recording clips (Main clip: XF-AVC, sub recording clip: XF-AVC)

Main recording format

XF-AVC
YCC422 10 bit

Main clip

Main resolution / Bit rate

810 Mbps Intra-frame

Frame rate

59.94P, 50.00P

Sub recording clip!

Sub recording format, resolution and bit rate

XF-AVC YCC422 10 bit

2048x1080 / 310 Mbps Intra-frame
2048x1080 / 50 Mbps Long GOP

260 Mbps Long GOP 59.94P, 50.00P 2048x1080 / 50 Mbps Long GOP
4096x2160 4096x2160 / 160 Mbps Long GOP
410 Mbps Intra-frame | 2>-97P ggggi 24.00F, 2048x1080 / 160 Mbps Intra-frame
. 2048x1080 / 50 Mbps Long GOP
160 Mbps Long Gop | 2%-97P. ggggf, 24.00F, 2048x1080 / 50 Mbps Long GOP
1920x1080 / 310 Mbps Intra-frame2
1920x1080 / 160 Mbps Intra-frame
810 Mbps Intra-frame 59.94P, 50.00P 1920x1080 / 50 Mbps Long GOP3
1280x720 / 24 Mbps Long GOP
1920x1080 / 50 Mbps Long Gop®
2840:2160 260 Mbps Long GOP 59.94P, 50.00P 1280x720 / 24 Mbps Long GOP
3840x2160 / 160 Mbps Long GOP
410 Mops Intra-frame | 29977 25095 24.00 1920x1080 / 160 Mbps Intra-frame
’ 1920x1080 / 50 Mbps Long GOP
160 Mbps Long Gop | 2297P %ggg'; 24.00P, 1920x1080 / 50 Mbps Long GOP
310 Mbps Intra-frame 59.94P, 50.00P
2048x1080 2048x1080 / 50 Mbps Long GOP
160 Mbps Intra-frame 29.97F, 25.00F, 24.00P,
23.98P
} 1920x1080 / 50 Mbps Long GOP
310 Mbps Intra-frame 59.94P, 50.00P 1280x720 / 24 Mbps Long GOP
50 Mbps Long GOP 59.94P, 50.00P 1280x720 / 24 Mbps Long GOP
1920x1080

160 Mbps Intra-frame

29.97P, 25.00P, 24.00P,
23.98P

1920x1080 / 50 Mbps Long GOP

160 Mbps Intra-frame

59.94i, 50.00i

1920x1080 / 50 Mbps Long GOP

' Sub recording frame rate is the same as that of the primary clip.
2 The only available frame rates are 59.94i/50.00i.

3 59.94i / 50.00i can also be selected.
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Sub Recording Clips

Video configuration for sub recording clips (Main clip: XF-AVC, sub recording clip: MP4)

Sub recording clip!

Main clip
Sub recording format, resolution and bit rate
Main recording format Main resolution / Bit rate Frame rate MP4(H.264) YCC420 8 bit
810 Mbps Intra-frame
59.94P, 50.00P 2048x1080 / 35 Mbps
260 Mbps Long GOP
4096x2160
410 Mbps Intra-frame | 29 97p, 25.00P, 24.00P, 4096x2160 / 150 Mbps
160 Mbps Long GOP 23.98P 2048x1080 / 35 Mbps
810 Mbps Intra-frame
P 50.04P. 50.00P 1920x1080 / 35 Mbps
260 Mbps Long GOP 1280x720 / 8 Mbps
3840x2160
410 Mbps Intra-frame | 29 97p, 25.00P, 24.00P, 3840x2160 / 150 Mbps
160 Mbps Long GOP 23.98P 1920x1080 / 35 Mbps
XF-AVC
. 310 Mbps Intra-frame
YCC422 10 bit 59.94P, 50.00P 20481080 / 35 Mbps
50 Mbps Long GOP
2048x1080 160 Mbos Intra-f
ps Intra-frame
29.97F, 25.00P, 24.00F, 2048x1080 / 35 Mbps
50 Mbps Long GOP 23.98P
310 Mbps Intra-frame
P 50.94P, 50.00P 19201080 / 35 Mbps
50 Mbps Long GOP 1280x720 / 8 Mbps
1920x1080 160 Mbos Intra-t
ps Intra-frame
29.97P, 2500, 24.00%, 1920x1080 / 35 Mbps
50 Mbps Long GOP 23.98P
1280x720 24 Mbps Long GOP 59.94P, 50.00P 1280x720 / 8 Mbps

T Sub recording frame rate is the same as that of the primary clip.

Video configuration for sub recording clips (Main clip: MP4, sub recording clip: MP4)

Main recording
format

MP4 (HEVC)
YCC422 10 bit

Sub recording clip’

Main clip
Sub recording format, resolution and bit rate
. o MP4 (HEVC) MP4 (HEVC) MP4 (H.264)
Main resolution /Bitrate Frame rate YCC422 10 bit YCC420 10 bit YCCA420 8 bit
225Mbps | 59.94P, 50.00P || 2048x1080 /50 Mbps | 2048x1080 / 35 Mbps -
4096x2160 29.97P, 25.00P, 4096x2160 / 100 Mbps
135Mbps | 54 00p, 23.98p || 2048x1080/50Mbps | 5446,1080 / 35 Mbps -
1920x1080 /50 Mbps | 1920x1080 / 35 Mbps B
225 Mbps | 59.94P. 50.00P || 000,700 /12 Mbps | 1280x720 /9 Mbps
3840x2160 29.97P, 25.00P 3840x2160 /100 Mb
.97P, 25.00P, X ps _
135Mbps | 54 00p 23.98p || 1920x1080/50 Mbps | *4550,1080 / 35 Mbps
59.94P, 50.00P,
2048x1080 | 50 Mbps | 29.97P, 25.00P, - 2048x1080 / 35 Mbps -
24.00P, 23.98P
1920x1080 / 35 Mbps
59,949, 50.00P | 1280x720/12Mbps | jage 00 S0 NP -
192061080 | SOMops |
4,000 29 98 - 1920x1080 / 35 Mbps -
1280<720 | 12Mbps | 59.94P, 50.00P - 1280x720 / 9 Mbps -




Sub Recording Clips

Sub recording clip’

Main clip
Sub recording format, resolution and bit rate
Mainrecording . . . MP4 (HEVC) MP4 (HEVC) MP4 (H.264)
format M ST B | RO YCC422 10 bt YCC420 10 bit YCC420 8 bit
170 Mbps | 59.94P, 50.00P - 2048x1080 / 35 Mbps -
4096x2160 29.97P, 25.00P,
100 Mops | 5 00 2 Can - 2048x1080 / 35 Mbps -
MP4 (HEVC) B 1920x1080 / 35 Mbps B
YCC420 10 bit 170 Mbps | 59.94P, 50.00P 1280x720 / 9 Mbps
3840x2160 29.97P, 25.00P,
100 Mops | 5 00 2 O - 1920x1080 / 35 Mbps -
1920x1080 | 35Mbps | 59.94P, 50.00P - 1280x720 / 9 Mbps -
59.94P, 50.00P,
4096x2160 | 150 Mbps | 29.97P, 25.00P, - - 2048x1080 / 35 Mbps
24.00, 23.98P
MP4 (H.264) 50.94P, 50.00P - - o8 thobs
i . X S
YCCA208bit | 384050160 | 150 Mbps 2557525007 P
o0 25 98 - - 1920x1080 / 35 Mbps
1920x1080 | 35Mbps | 59.94P, 50.00P - - 1280x720 / 8 Mbps

" Sub recording frame rate is the same as that of the primary clip.

1 Insert a card into each card slot (slot 1 for the main clip, slot 2 for the sub recording clip).

2 Select MENU > [£% Recording/Media Setup] > [2nd Card Rec Functions] > [[i] Main / @ Sub Rec].
3 Select MENU > [£% Recording/Media Setup] > [ Rec Format] > Desired option.

4 Select MENU > [£% Recording/Media Setup] > [ Resolution/Bit Rate] > Desired option.

5 Select MENU > [ 2% Recording/Media Setup] > [[2 Frame Rate] > Desired option.
e Frame rate can only be selected with some main recording formats.

6 Press the REC button to start recording.
e Proxy clips will be recorded simultaneously with the primary clips.

(i) notes

¢ |f there is no card inserted in the slot used for the primary clip, only the sub recording clip will be recorded.
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Proxy Clips

Proxy Clips

While recording a primary clip to slot 1 (CFexpress card), you can simultaneously record the same scene as a
proxy clip to slot 2 (SD card). When the main recording format is HDMI RAW, the main clip (RAW) is output from
the HDMI OUT terminal and the proxy clip is recorded on the card in slot 2. Because proxy clips have smaller

files, they are suitable for offline editing.

You can also use direct touch control to perform this function (1] 56).

Video configuration of proxy clips

Main clip Proxy clip
Sub recording format, resolution and bit rate
Main recording format Main resolution Frame rate . MP4 (H.264)
XF-AVC YCC420 8 bit S
20481080 / 35 Mbps
RAW ST 59.94P, 50.00P Long GOP P
RAW LT 8192x4320
HDMI RAW 29.97P, 25.00P 2048x1080 / 24 Mbps
23.98P, 24.00P Long GOP
29.97P, 25.00P 2048x1080 / 24 Mbps
RAW HQ 23.98P, 24.00P Long GOP
RAW ST 59523140 59.94P, 50.00P 2048"13[?8 Goo MRS 204811080 /9 Mbps
RAW LT
HDMI RAW 29.97P, 25.00P 2048x1080 / 24 Mbps
23.98P, 24.00P Long GOP
RAW HQ 2048x1080 / 35 Mbps
s 59.94P, 50.00P Long GOP
29761570
RAW LT 29.97P, 25.00P 2048x1080 / 24 Mbps
HDMI RAW 23.98P, 24.00P Long GOP
2048x1080 / 35 Mbps
4096x2160 59947, 50.00P Long GOP
2048x1080 / 9 Mbps
2048x1080 29.97P, 25.00P 20481080 / 24 Mbps
23.98P, 24.00P Long GOP
1920x1080 / 35 Mbps
59.94P, 50.00P
XF-AVC 3840x2160 Long GOP 1920x1080/ 9 Mbps
YCC422 10 bit 19201080 1280x720 /9 Mbps
29.97P, 25.00P 1920x1080 / 24 Mbps 1280x720 / 6 Mbps
23.98P, 24.00P Long GOP
. . 1920x1080 / 24 Mbps
1920x1080 59.94i, 50.00i Long GOP -
1280x720 /17 Mbps | 1280x720 / 9 Mbps
1280x720 59.94P, 50.00P Long GOP 1280x720 / 6 Mbps
40962160 59.94P, 50.00P
X.
20481080 29.97P, 25.00P - 2048x1080 / 9 Mbps
23.98P, 24.00P
MP4 (H.264)
YCCA420 8 bit 3840x2160 59.94P, 50.00P 1920x1080 / 9 Mbps
1920x1080 29.97P, 25.00P - 1280x720 / 9 Mbps
23.98P, 24.00P 1280x720 / 6 Mbps
1280x720 59.94P, 50.00P - 1280x720 / 6 Mbps

Frame rate

Same as main clip

1 Insert an SD card into each card slot (slot 1 for the main clip, slot 2 for the proxy clip).

2 Select the main recording format ([I] 61).
3 Select MENU > [£% Recording/Media Setup] > [2nd Card Rec Functions] > [[i] Main / ) Proxy Rec].
4 Select MENU > [£¥ Recording/Media Setup] > [[2 Rec Format] > Desired option.



Proxy Clips

5 Select MENU > [£% Recording/Media Setup] > [[2 Resolution/Bit rate] > Desired option
6 Select MENU > [£¥ Recording/Media Setup] > [Proxy Rec Color Conversion] > Desired option.

7 Press the REC button to start recording.
e Proxy clips will be recorded simultaneously with the primary clips.

Options

[Conform to Custom Picture]:
No change is applied.

[BT.709]: When the gamma curve component of the [Gamma/Color Space] setting in the custom picture
file is set to [BT.709 Normal], [BT.709 Standard] or [BT.709 Wide DR], no change is applied.
When it is set to a different option, it is changed to [BT.709 Wide DR] and the color space
component changes to [BT.709]. If the original gamma was set to HDR, you can adjust the
brightness settings with the MENU > [[Z) Monitoring Setup] > [Gain for HDR—SDR Conv.]
setting (L] 152).

(i) NoTES

e |f the recording of the primary clip stops during simultaneous recording, recording of the proxy clip will stop as
well.
e |f there is no card inserted in the slot used for the primary clip, only the proxy clip will be recorded.
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Shutter Speed

Shutter Speed

You can set the shutter speed according to the shooting conditions. For example, you may want to set slower
shutter speeds in darker environments. The camera offers the following modes.
You can also perform this function remotely using Browser Remote on a connected network device (11 181).

[Speed]: Allows you to set the shutter speed (in fractions of a second). You can select the increment to use when
adjusting the shutter speed between 1/3-stop and 1/4-stop increments.

[Angle]: You can set the shutter angle to determine the shutter speed.

[Clear Scan]: Set the frequency in order to record CRT computer monitors without displaying black bands or
flicker on the screen.

[Slow]: You can set slower shutter speeds to obtain brighter recordings in places with insufficient lighting. This
mode is not available when slow & fast motion recording is activated.

[Off]: The camera uses a standard shutter speed based on the frame rate.

Available shutter speeds
The individual setting options that can be selected will change depending on the frame rate used.

System frequency/Frame rate

Shutter speed mode 59.94 Hz 24.00 Hz 50.00 Hz
50.94P / 59.94i" 20.97P 23.98P 2400P  50.00P/50.00i" 25.00P
1/3-stop 1/1 to 1/2000 (34 setting options in total)
[Speed]z increments
1/4-stop 1/1 10 1/2000 (59.94 Hz/24.00 Hz: 47 setting options in total, 50.00 Hz: 45 setting options in total)
increments
Angl? 360.00°, 240.00°, 180.00°, 120.00°, 90.00°, 60.00°, 45.00°, 30.00°, 22.50°, 15.00°, 11.25°
g Also angle values equivalent to the following shutter speeds: 1/120, 1/100, 1/60, 1/50, 1/40, 3/100, 1/30, 1/25.
[Clear Scan]2 23.98 Hz to 1998 Hz 24.00 Hz to 2003 Hz
1/4,1/8,1/15 1/3,1/6, 1/12
3 y ) ) ) y )
[Slow] 120 114,118, 115 113, 1/6, 1112 s 113, 1/6, 1/12
[Offf2 1/60 1130 1/24 1/50 1125

1 59.94i and 50.00i are available only for XF-AVC (YCC422 10 bit) primary clips when the main resolution/bit rate is 1920x1080
Intra-frame or 1920x1080 Long GOP.

2 Available values depend on the recording frame rate, the slow & fast motion recording frame rate or the [Run VF at x2 Speed]
setting.

3 Not available when slow & fast motion recording is activated and [Run VF at x2 Speed] is set to [On].

1 Select MENU > "™ Camera Setup] > [Shutter Mode] > Desired shutter speed mode.
2 For [Speed] only: Select MENU > ["™ Camera Setup] > [Shutter Increment] > [1/3 stop] or [1/4 stop].

3 Adjust the shutter speed, angle value or clear scan frequency using the direct setting mode ([1 57).
¢ You can also use direct touch control (1] 56).

Using slow shutter mode

When recording in dark surroundings, you can obtain a brighter picture by using slow shutter mode. You can
also use this mode when you wish to add certain effects to your recordings, such as blurring the background
during panning shots or recording a moving subject with an afterimage trail.

* |mage quality may not be as good as when using faster shutter speeds in brighter surroundings.



Shutter Speed

(i) Nnotes

¢ When recording under artificial light sources such as fluorescent, mercury or halogen lamps, the screen may
flicker depending on the shutter speed. You may be able to avoid flicker by setting the shutter speed mode to
[Speed] and the shutter speed to a value matching the frequency of the local electrical system: 1/50* or 1/100
for 50 Hz systems, 1/60 or 1/120 for 60 Hz systems.
* May not be available depending on the frame rate.

¢ Closing down the aperture when recording under bright conditions may cause the picture to appear soft or out
of focus. The following measures may be effective in avoiding the loss of sharpness due to diffraction.
- Using a faster shutter speed.

- Applying diffraction correction ([J] 28). Results may vary depending on the lens used.
¢ \When the shutter speed mode is set to [Slow], bright red, green or blue dots may appear on the screen. In
such case, use a faster shutter speed or select a lower ISO speed or gain value (1] 74).

e The shutter speed mode will automatically change from [Slow] to [Speed] if slow & fast motion recording or the
[Run VF at x2 Speed] function is activated.
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ISO Speed/Gain

ISO Speed/Gain

You may want to adjust the brightness of the image according to the shooting conditions. You can choose
between manual and automatic settings. By choosing manual settings you can change the ISO speed or gain
value to adjust the sensitivity of the sensor. You can also set the camera's base ISO speed by choosing from

three modes.

You can also perform this function remotely using Browser Remote on a connected network device (11 177,

181).

Available settings

1S0/Gain’ Increment? Available settings

[1 stop] 100, 1608, 200, 400, 6403, 800, 1600, 3200, 6400, 12800, 25600, 51200, 102400

[IS0] [1/3 stop] 100, 125, 160, 200, 250, 320, 400, 500, 640, 800, 1000, 1250, 1600, 2000, 2500, 3200, 4000, 5000, 6400,

P 8000, 10000, 12800, 16000, 20000, 25600, 32000, 40000, 51200, 64000, 80000, 102400
[Normal] | . 3
. (3dB) 2 dB°, -6 dB to 54 dB
[Gain] Fine]
ine

(0.50B) -2 dB to 54 dB

Available range

Available range

Base ISO ISO/Gain' Increment? "
Normal range Extended range
[1S0] %‘:)St'lgfld 160 to 25600 100 to 102400
[Auto Selection] [N(ggg?” —2dB to 42dB —6dB to 5408
Gain
[Gain} [Fine]
e 248 to 42dB 248 to 54dB
[1S0] %‘:)St'lgfld 160 to 6400 100 to 25600
[Base IS0 160]/[Base IS0 160 (~2dB)] Nomel]
[Base IS0 400]/[Base IS0 400 (6aB)] b, 248 to 30dB —60B to 42dB
[Base IS0 800]/[Base IS0 800 (124B)] [Gairl] !
(([)F'S"deé) 248 to 30dB 248 to 42dB
[1S0] %‘:)St'lgfld 640 to 25600 400 to 102400
[Base IS0 640]/[Base IS0 640 (~24B)] Nomel]
[Base IS0 1600]/[Base ISO 1600 (60B)] b, 248 to 30dB —60B o 42dB
[Base IS0 3200]/[Base ISO 3200 (12dB)] [Gairl] !
(([)F'S"deé) 248 to 30dB 248 to 42dB

T MENU > ["™ Camera Setup] > [ISO/Gain] setting.
2 MENU > ["™ Camera Setup] > [ISO/Gain Increment] setting.

3 Available only when MENU

> "™ Camera Setup] > [ISO/Gain Extended Range] is set to [Off].

4 Available only when MENU > ["™ Camera Setup] > [ISO/Gain Extended Range] is set to [On].
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Base ISO Speed

Set the ISO speed for the recommended dynamic range. You can choose from one of three base ISO speed
settings: low speed, high speed or automatic selection. Low speed is recommended for normal lighting
conditions, while high speed is recommmended for low lighting conditions. The high speed setting will result in a
high 1ISO/gain value and low noise. Selecting [Auto Selection] will automatically change the base ISO speed
depending on the ISO/gain value.

Select MENU > ["™ Camera Setup] > [Base ISO] > Desired option.

¢ Available values will depend on the [Gamma/Color Space] setting in the custom picture file and the recording
format.

Base ISO settings
MENU > ["™ Camera Setup] > [ISO/Gain]

Gamma curve
[1S0] [Gain]
[Canon Log 3] [Auto Selection], [Base ISO 800], [Base IS0 3200] | [Auto Selection], [Base ISO 800 (12dB)], [Base ISO 3200 (12dB)]
[BT.709 Wide DR]/ | [Auto Selection], [Base IS0 400], [Base ISO 1600] | [Auto Selection], [Base ISO 400 (6dB)], [Base ISO 1600 (6dB)]
[PQ] / [HLG]

[BT.709 Standard] / | [Auto Selection], [Base ISO 160], [Base ISO 640] | [Auto Selection], [Base ISO 160 (-2dB)], [Base ISO 640 (-2dB)]
[BT.709 Normal]

* Available base ISO settings when the main recording format is RAW are the same as when the gamma curve is [Canon Log 3].

Manual ISO Speed/Gain Value
1 Select MENU > "™ Camera Setup] > [ISO/Gain] > [ISO] or [Gain].
2 Select MENU > ["™ Camera Setup] > [ISO/Gain Mode] > [Manual].

3 Depending on your previous selection, select MENU > ["™ Camera Setup] > [ISO/Gain Increment] >
Desired option.

4 Adjust the ISO speed or gain value using the direct setting mode ([I] 57).
* You can also use direct touch control (1] 56).

Using the Control Dial/Control Ring Control dial

You can adjust the ISO speed or gain value using the control dial or the
control ring of an RF lens/mount adapter.

1 Perform steps 1 to 3 in the Manual ISO Speed/Gain Value procedure.
(M 79)

2 Select MENU > [ System Setup] > [Grip Control Dial], [Top Control
Dial] or [Control Ring] > [ISO/Gain].

3 Turn the control dial or control ring to set the desired ISO speed or gain
value.
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ISO Speed/Gain

ISO Speed/Gain Preset
Using direct touch control (1] 56), you can adjust and use up to 3 preset ISO speed/gain values.

Saving a preset value

1 TOUCh @ > Curl’ent |SO Speed/galn Value Touch to register a preset value
2 Adjust the value selected and touch [Register]. Stored preset values
3 Touch the desired position to save the preset value.

e The current value is saved.

Using a saved preset value

1 Touch [ > Current ISO speed/gain value.

2 Touch the desired preset value (above the slider).
e The selected preset value is applied.

(i) NOTES

¢ \When high ISO speeds or gain levels are set, the picture may flicker slightly.

¢ When high ISO speeds or gain levels are set, bright red, green or blue dots may appear on the screen. In such
case, use a faster shutter speed ([ 72) or select a lower ISO speed or gain value.

e When the ISO speed or gain level is changed, some noise may appear momentarily on the screen. Do not
adjust the ISO speed/gain level while recording.

* You can use the MENU > [¥ System Setup] > [Grip Ctrl Dial Dir], [Top Ctrl Dial Dir.] or [Control Ring Dir.]
setting to change the direction of the adjustment when you turn the control dial or control ring.

e |f you set an assignable button to [ISO/Gain Mode] (11 121), you can press the button to switch between
automatic and manual adjustment.

Drag the slider to select the desired value

Automatic ISO Speed/Gain

The sensitivity is automatically adjusted according to the subject. You can also set a sensitivity limit. Automatic
adjustment is not available during slow & fast motion recording.

Automatic ISO speed/gain settings

The sensitivity limit will be set automatically according to the [Gamma/Color Space] setting in the custom picture
file.

Gamma curve Base IS0’ Lower sensitivity limit
[Auto Selection]
[1SO 800 (12dB)]
[Canon Log 3] [Base IS0 800]
[Base IS0 3200] [1SO 3200 (12dB)]
. Auto Selection
[BT.709 Wide DR [ ] 150 400 (64B)]
[PQ] [Base 1SO 400]
[HLG]
[Base IS0 1600] [ISO 1600 (6dB)]
[Auto Selection] 10 160 (-208]
[BT.709 Normal] .
[BT.709 Standard] [Bass IS0 160]
[Base IS0 640] [ISO 640 (-2dB)]

" MENU > ["™ Camera Setup] > [Base ISO] setting.
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Select MENU > ["™ Camera Setup] > [ISO/Gain Mode] > [Automatic].
e The lower sensitivity limit will be the base I1SO.

(i) NoTES

¢ You can set the responsiveness of the autofocus function with the MENU > ["™ Camera Setup] >
[AF Response] setting*.
* Except when using an incompatible lens ([T 234).

Setting an automatic ISO limit
By setting an ISO limit in automatic mode, you can curb the amount of noise and keep a dark ambient.
Select MENU > ["™ Camera Setup] > [Limit for Auto Mode] > Desired option.
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Aperture

Aperture

You can affect the brightness of your recordings or change the depth of field by adjusting the aperture.
Depending on the lens used, the aperture value displayed may differ (F value or T value) and available aperture
values will vary as well ([J] 234). You can select the adjustment increment and even use the smallest iris
increment allowed by the lens.

You can also perform this function remotely using Browser Remote on a connected network device (1] 181).

Manual aperture: Adjust the aperture value manually.
Automatic aperture: The camera adjusts the aperture automatically.

Push Auto Iris: Momentary automatic aperture. During manual aperture, press the AUTO IRIS button to
temporarily adjust the aperture automatically (only while the button is held pressed down).

Aperture Settings of the Lens

To adjust the aperture from the camera, you will need to enable automatic adjustment using the controls on the
compatible EF Cinema/broadcast lens. Required settings vary depending on the lens. Refer to the instruction
manual of the lens used.

Set the lens to automatic aperture.

Manual Aperture: Changing the Aperture Value

1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Manual].

¢ This setting is available only when a lens compatible with automatic aperture is attached to the camera. For
non-compatible lenses, the aperture mode is automatically set to [Manual] and cannot be changed.

2 When using a lens with adjustable aperture, set the lens to automatic aperture mode.

3 Select MENU > ["™ Camera Setup] > [Iris Increment] > [1/2 Stop] or [1/3 Stop].
® You can also set MENU > ["™ Camera Setup] > [Fine Increment] to [On] to use the smallest iris increment
allowed by the lens attached. Nevertheless, the aperture value displayed on the screen will be the closest
value in the selected increment scale.
4 Adjust the aperture value using direct setting mode ([1] 57).
¢ You can also use direct touch control (] 56).
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Using the Control Dial/Control Ring

You can also adjust the aperture settings using the control dial (after assigning the [lris] function) or the control
ring of an RF lens/mount adapter.

1 Select MENU > [§ System Setup] > [Grip Control Dial], [Top Control Control dial
Dial] or [Control Ring] > [Iris].

2 Turn the control dial or the control ring of an RF lens to adjust the
aperture.
e The selected aperture value will appear at the bottom of the screen. =

(i) Nnotes

* You can use the MENU > [¥ System Setup] > [Grip Ctrl Dial Dir.], [Top Ctrl Dial Dir.] or [Control Ring Dir.]
setting to change the direction of the adjustment when you turn the control dial or control ring.
¢ |f you set an assignable button to [Iris +] or [Iris ] (I 121), you can press the button to respectively open up
or close down the aperture.
¢ When using a lens with no lens contacts or an incompatible lens ([1] 234), you cannot adjust the aperture
using the camera. Adjust it using the lens.
¢ \When using a lens that can correct the aperture value according to the position of the zoom, you can use the
MENU > "™ Camera Setup] > [Zoom-Iris Correction] setting to activate this correction.
¢ Using an EF Cinema lens
- The aperture value displayed on the screen will be a T value. The aperture value (T value) displayed on the
screen may differ from the indication on the lens’s aperture scale.
- When the iris is almost fully closed, the aperture value (T value) will appear in gray on the screen.
- When you change the aperture value from a position of fully open or fully closed iris, multiple adjustment
operations may be required until the aperture changes.
e |f you use the EF-EOS R 0.71x Mount Adapter to attach an EF lens, the aperture will be approximately one
level brighter than the value indicated by the lens.

79



80

Aperture

Momentary Automatic Aperture - Push Auto Iris

During manual aperture, you can press the AUTO IRIS button to have the camera temporarily take control and
adjust the aperture automatically for an optimal exposure.
This function is not available when slow & fast motion recording is activated.

1 Select MENU > ["™ Camera Setup] > [Iris Mode] > [Manual].

2 When using a lens with adjustable aperture, set the lens to
automatic aperture mode ([] 78).

3 Press and hold the AUTO IRIS button.

e The camera will automatically adjust the aperture to obtain optimal
exposure as long as you hold the button pressed down, and [ will
appear on the screen next to the aperture value.

¢ \When you release the button the aperture value will be set, automatic
aperture mode will end and the B icon will disappear.

(i) NOTES

¢ You can use the MENU > ["™ Camera Setup] > [AE Response] setting to change how quickly the aperture
changes during automatic aperture mode. This setting has no effect when using an incompatible lens

(00 234).

Automatic Aperture

When a compatible lens is attached to the camera, you can have the camera automatically adjust the aperture.
This function is not available when slow & fast motion recording is activated.

1 Select MENU > "™ Camera Setup] > [Iris Mode] > [Automatic].

e The camera will automatically adjust the aperture to obtain optimal exposure. The selected aperture value
will appear at the bottom of the screen with an [ icon next to it.

2 When using a lens with adjustable aperture, set the lens to automatic aperture mode (] 78).

(i) NoTES

¢ If you set an assignable button to [Iris Mode] (11 121), you can press the button to toggle between the
[Automatic] and [Manual] settings.

e The aperture value may change in the following cases.
- While using the built-in extender or iris compensation function of an EF Cinema lens, when you switch from

automatic aperture to manual aperture.

- When the aperture controls on the lens are switched between automatic/manual mode.

¢ When using EF Cinema lenses that let you adjust the aperture gain, if the aperture gain is set too high, the
aperture adjustment may not be stable (“aperture hunting”), depending on the shooting conditions. In such
case, reset the lens’s aperture gain to its initial value.
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Exposure Compensation - AE Shift

Use AE shift to compensate the exposure in order to darken or lighten the image.

You can also perform this function remotely using Browser Remote on a connected network device (11 181).
1 Select MENU > ["™ Camera Setup] > [AE Shift].

2 Select the desired option.
e The camera will attempt to adjust the exposure accordingly.
® You can select one of 17 AE shift levels from -2.0 to +2.0.

(i) NnoTes

e If you set an assignable button to [AE Shift +] or [AE Shift -] (11 121), you can press the button to adjust the
AE shift level.

The exposure bar Optimal exposure AE+0
The W on top of the exposure bar indicates optimal exposure without any shift P p| a

(AE+0); the scale markings indicate the deviation from optimal exposure in
1/2 EV increments. The indicator inside the exposure bar represents the current ﬁ
exposure. When the difference between current and optimal exposure is larger |

than +£2 EV, the indicator will flash at the edge of the exposure bar. Optimal Current exposure
exposure will change depending on the light metering mode used.

Light Metering Mode

Select the light metering mode to match the recording conditions. Using the appropriate setting will help achieve
a more appropriate exposure level.
1 Select MENU > ["™ Camera Setup] > [Light Metering].

2 Select the desired option.
e The icon of the selected mode (Y or /s\) appears on the screen.

Options

[Backlight]: Suitable when recording backlit scenes.

[Standard]: Averages the light metered from the entire screen, giving more weight to the subject in the center.
[Spotlight]: Use this option when recording a scene in which only a certain part of the picture is lit, for

example, when the subject is lit by a spotlight.

(i) NoTES

e |f you set an assignable button to [Backlight] or [Spotlight] (I 121), you can press the button to toggle
between the respective light metering mode and [Standard].

e Adjust the exposure again if you change the metering mode after adjusting the aperture manually.
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White Balance

White Balance

The camera uses an electronic white balance process to calibrate the picture and produce accurate colors under
different lighting conditions. The camera offers the following ways to set the white balance.
You can also perform this function remotely using Browser Remote on a connected network device (11 179).

Custom white balance: You can use a gray card or white object with no pattern to establish the white balance
and set it to one of two custom white balance positions, 8 A or ®4B. When recording under fluorescent lights,
we recommend setting the custom white balance.

Preset white balance: Set the white balance to 8¢ (daylight) or 3¢ (tungsten lamp). You can further adjust the

gl

color temperature (K) value and the color compensation (CC) value, which adjusts the color along the green/
magenta gradation.

Color temperature: Allows you to set the color temperature between 2,000 K and 15,000 K, and further adjust
the color compensation (CC) value.

Auto white balance (AWB): The camera automatically adjusts the white balance to the optimal level.

(i) NoTES

¢ The [White Balance] and [Color Matrix Tuning] settings in the custom picture file (7] 131) take precedence
over the white balance set with these procedures.

¢ You can use the MENU > ["™ Camera Setup] > [Shockless WB] setting to make the transition look smoother
when you change the white balance settings.

e The color temperatures displayed on the screen are approximate. Use them only as a reference.

White Balance Mode

Select a white balance mode using the direct setting mode ([11 57).
¢ You can also use direct touch control (1] 56).

e If you set MENU > [ System Setup] > [Grip Control Dial], [Top Control Dial] or [Control Ring] to [White
Balance Mode], you can change the white balance mode using the control dials or control ring of an RF lens.

(i) NoTES

e If you set an assignable button to [[[[§ AWB]. [e%1 Set A], [ Set B, [z Daylight], [ Tungsten] or [[4
Kelvin] (17 121), you can press the button to change the white balance mode temporarily. Press the button
again to return to the previous white balance mode.

Custom White Balance

1 Select the %A or B icon ([] 82).

¢ To apply the stored custom white balance setting as is, the rest
of the procedure is not necessary. To set a new custom white
balance, continue the procedure.

2 Point the camera at a gray card or white object so that it fills
the center of screen.

e Use the same lighting conditions you plan to use when
recording.




White Balance

3 Press the o4 button.
® The o4 A or 4 B icon will flash quickly.
* Make sure the gray card or white object fills the center of the screen until the procedure is completed.

¢ Once the icon stops flashing, the procedure is completed. The setting is retained even if you turn off the 83
camera.

(i) NoTES

e Readjust the custom white balance if the light source changes.

e \ery rarely and depending on the light source, x4 may keep flashing (it will change to a slow flashing). In that
case, change the subject brightness and adjust the custom white balance again.

e After the camera registers a custom white balance, the color temperature or CC value may appear in gray. This
indicates that the value registered exceeds the range of values that can be displayed but the white balance is
correctly calibrated and you can continue shooting.

Color Temperature/Preset White Balance
1 Select the s or 8z icon (preset white balance), or the [4 icon
(color temperature setting) ([11 82).

e To apply the stored preset setting or color temperature as is, the
rest of the procedure is not necessary. To adjust the color
temperature or CC value, continue the procedure.

2 Press the 1 button.

e The camera will enter the direct setting mode with the color
temperature highlighted in orange. To adjust the CC value, push the
joystick right.

e You can also adjust the color temperature or CC value using direct
touch control ([T] 56).

3 Select the desired value.

¢ The selected color temperature and CC value will be set and will appear on the screen next to the white
balance icon.

. . Adjustment range
White balance mode/setting

Color temperature (K) Color compensation (CC) value
@ (daylight) 4,300 K to 8,000 K
— -5t0+5
8¢ (tungsten lamp) 2,700 K to 3,700 K
4 (color temperature) 2,000 K to 15,000 K —20 to +20

(i) Nnotes

¢ You can use the MENU > ["®™ Camera Setup] > [C. Temp. Increment] setting to change the units for the color
temperature increment to [Mired] (5-mired increments) or [Kelvin] (100-kelvin increments). Even when [Mired] is
selected, the color temperature is converted to and displayed in kelvins. Changing this setting may change the
white balance setting.

e If you set MENU > [§ System Setup] > [Grip Control Dial], [Top Control Dial] or [Control Ring] to [White
Balance (K)] or [White Balance (CC)], you can adjust the color temperature (K) value and the color
compensation (CC) value using the control dials or control ring of an RF lens.
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Auto White Balance (AWB)

The camera constantly adjusts the white balance automatically to achieve an appropriate level. The camera will
adjust the white balance if the light source changes.

Select the [ icon ([11] 82).

e The color temperature and CC value set automatically by the camera will appear at the bottom of the screen
next to the [ icon.

(i) NoTES

e Custom white balance may provide better results in the following cases:
- Changing lighting conditions
- Close-ups
- Subjects in a single color (sky, sea or forest)
- Under mercury lamps and certain types of fluorescent and LED lights

¢ You can use the MENU > ["™ Camera Setup] > [AWB Responsg] setting to change how quickly the white
balance changes in auto white balance (AWB) mode.

¢ If you set an assignable button to [AWB Lock] (1] 121), you can press the button to lock the current white
balance settings set automatically by the camera. To cancel the lock, press the button again (resume auto
white balance mode) or select a different white balance setting.
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Focus

The camera offers the following ways to focus, depending on the lens used. The camera incorporates Dual Pixel
CMOS AF technology for advanced autofocus performance with compatible lenses. Refer to the list of
compatible lenses and functions that can be used ([J] 234).

You can also adjust the focus remotely using Browser Remote on a connected network device ([1] 181).

Note that some methods allow you to operate aspects of the focus by touching the LCD screen.

* Not available when a manual focus lens is attached to the camera.

Manual focus: Turn the focus ring on the lens to adjust the focus. The camera offers several focus assistance
functions ([11 86) to help you focus more accurately when using the manual focus.

One-shot AF: You will be able to focus manually but still have the option to press the AF-ON button to let the
camera focus automatically once on the subject inside the AF frame.

Continuous AF': The camera automatically keeps the subject inside the AF frame in focus at all times. If you
select [Only Around Focus Point], you can focus manually most of the way and let the camera finish focusing
automatically (same as the [AF-Boosted MF] function).

Face AF': The camera automatically detects a person’s face, focuses on it and can track it if that person moves.

Eye Detection': The camera detects and focuses automatically on a person's eyes, and tracks the subject if it
moves.

Tracking: After you select a subject, the camera keeps focusing it and tracks the subject if it moves.
" You can use the AF lock function ([ 90) to change the composition of the picture while keeping the focus on the selected spot.

Focus Mode on the Lens

Use the switch on the lens to select the lens’s focus mode (automatic, manual). The name of the controls may
differ depending on the lens. Refer to the instruction manual of the lens used.

Set the lens’s focus mode to either automatic or manual.
e Either (automatic) or (MF) (manual) will appear on the screen.

¢ When using a lens without a focus mode switch, select MENU > ["™ Camera Setup] > [Focus Mode] > [AF]
(automatic) or [MF] (manual).

Manual Focus

Focus manually using the focus ring on the lens.

Turn the focus ring to adjust the focus.

(i) NoTES

¢ With some lenses, you may be able to operate the focus ring even when the focus mode is set to automatic.
e |f you operate the zoom after focusing, the focus on the subject may be lost.

¢ |f you focus manually and then leave the camera with the power turned on, the focus on the subject may be
lost after a while. This possible slight shift in focus is a result of the internal temperature rising in the camera
and lens. Check the focus before resuming shooting.

¢ When adjusting the focus, be careful not to touch the front of the lens or moving parts on the lens except for
the focus ring.
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Using the RF lens's focus ring
- You can change the direction of the adjustment when operating the focus ring with the MENU > [§ System
Setup] > [Focus Ring Dir.] setting.
- You can link the amount of focus adjustment when using the focus ring to either the rotation angle or the
rotation speed with the MENU > [¥ System Setup] > [Focus Ring Response] setting.
- When the lens is set to autofocus, you can enable/disable manual adjustments with the MENU >
[¥ System Setup] > [Focus Ring Operation] setting.

Using the Focus Assistance Functions

In order to focus more accurately, you can use the following focus assistance functions: Dual Pixel Focus Guide,
an onscreen guide that shows you if the selected subject is in focus; peaking, which creates a clearer contrast
by emphasizing the outlines of the subject; and magnification, which enlarges the image on the screen. You can
use peaking and the focus guide or peaking and magnification simultaneously for greater effect.

Focus guide

The focus guide gives you an intuitive visual indication of the current focus distance and the direction and
amount of adjustment necessary to bring the selected subject into full focus. When used in combination with
face detection ([J1 91), the guide will focus on the face of the person detected as the main subject. When eye
detection ([11 91) is activated, the guide will focus on the eyes of the person detected as the main subject.

1 Using direct touch control ([1] 56), you can touch the [Focus Guide] switch to turn on/off the focus guide.
e Alternatively, you can use the MENU > [ Assistance Functions] > [Focus Guide] setting or an assignable
button set to [Focus Guide], to display/hide the focus guide.
2 Touch the point where you want to focus on the LCD screen to move the focus guide.
e You can also use the joystick or SELECT dial to move the focus guide’s frame. Press the CANCEL button to
return the focus guide’s frame to the center of the screen.
3 Adjust the focus manually as necessary.
¢ \When the focus guide turns green, the subject is correctly focused.

- " | r
L J L L 4

Focus farther Focus farther In focus Focus closer Focus closer Cannot determine
(large adjustment) (small adjustment) (in green) (small adjustment) (large adjustment) adjustment

(i) NoTES

* With subjects or in situations where autofocus may not work well (11 89), the focus guide may not work
correctly.

¢ The focus guide cannot be used in the following cases:
- While the focus is being adjusted automatically using one-shot AF or continuous AF (including the [Only Around

Focus Point] setting).

- When a manual focus lens is attached to the camera, except for compatible EF Cinema lenses ([1] 234).

¢ When the focus guide and face detection/tracking functions are used together, the focus guide may not focus
the main subject’s eyes correctly, depending on the direction in which the face is turned.
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Peaking
The camera offers two peaking levels.
1 Set an assignable button to [Peaking] ([1] 121).
2 Press the button assigned to [Peaking].
¢ The peaking icon (I or @A) appears on the left of the screen and outlines (contour lines) in the image
that are in focus will be shown highlighted.
e Press the button again to turn off peaking.
¢ You can use direct touch control ([I] 56) to turn the
[Peaking 1)/[Peaking 2] setting on/off.
o Alternatively, you can use one of the MENU > [ Assistance Functions] > [Peaking:] settings to turn the
peaking function on/off separately on the respective terminal/output destination.
3 Select MENU > [f& Assistance Functions] > [Peaking] > [Peaking 1] or [Peaking 2].

Magnification
1 Press the MAGN. button.
U appears on the left of the screen and the center of the screen*
is magnified 2 times.
® The orange frame displayed on the top right of the screen
(magnification frame) shows the approximate part of the image shown
magnified.
e Press SET to change the magnification setting in the following order:
2x = 5x = 10x.
2 If necessary, use the joystick to move around the magnification frame
and check other parts of the image.
e You can also drag your finger across the LCD screen to move the
frame.
® Press the CANCEL button to return the magnification frame to the center position.

® Press the MAGN. button again to cancel the magnification.

* If one of the AF frames or a face detection frame is displayed on the screen, the area around the active frame will be magnified
instead.

(i) NoTES

¢ About Peaking/Magnification:

- You can use the MENU > [ Assistance Functions] > [Peaking 1] and [Peaking 2] settings to set the color,
gain and frequency of the two peaking levels independently of each other.

- You can use the MENU > [ Assistance Functions] > [Magn. Output] setting to select where to show the
magnified image.

- The assistance functions will not affect your recordings.

- Magnification will be turned off if you change the video configuration (11 59), turn MENU > ["™ Camera
Setup] > [Digital IS] on/off, or if you turn slow & fast motion recording on/off while the magnified image is
displayed.

Peaking/magnification are not available while the color bars are displayed.

When MENU > [ Assistance Functions] > [B&W during Magn.] is set to [On], the screen is set to black and

white during magnification. The assistance functions will not affect your recordings.

¢ \When the recording format is MP4 and the resolution is 8192x4320/7680x4320, magnification cannot be
used.
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One-Shot AF

In this focus mode, you will focus manually in most situations but still have the option to have the camera focus
automatically only once on the subject inside the AF frame. You can change the type and position of the AF
frame.

1 Set the focus mode on the lens to automatic ([I] 85).
2 If necessary, change the type and position of the AF frame ([1] 90).

3 Press and hold the AF-ON button.

¢ A white AF frame will appear on the screen (except if [AF Frame]
([ 90) is set to [Whole Area]) and the camera will focus automatically.
When you are using Face AF, the face detection frame around the face
of the person who has been determined to be the main subject will turn
white.

¢ \When correct focus has been achieved, the AF frame turns green. If the
camera cannot focus automatically, the AF frame will turn red.

e |f [AF Frame] is set to [Whole Area], a green AF frame will appear in the
position where correct focus has been achieved. If correct focus is not
achieved, a red AF frame will appear.

¢ The AF frame will disappear when you release the AF-ON button.

(i) Notes

e One-shot AF will not work when Face AF is set to [Face Only] and a face has not been detected.

Continuous AF

The camera will focus automatically on a subject inside the main area of the image (approximately 80% of the
screen’s length and height).

1 Set the focus mode on the lens to automatic ([] 85).

2 Select MENU > ["™ Camera Setup] > [Continuous AF] > [Enable].
¢ A white AF frame will appear on the screen (except if [AF Frame] ([1] 90) is set to [Whole Areal)).
¢ \When you are using Face AF, a white detection frame will appear around the face of the person who has
been determined to be the main subject.

3 If necessary, change the type and position of the AF frame ([1 90).

(i) NoTES

About the autofocus (AF) functions:

e The point where the camera focuses may change slightly depending on shooting conditions, such as subject,
brightness and zoom position. Check the focus before resuming shooting.

¢ Autofocus may take longer in the following cases.

- With some lenses, the camera may take longer to focus automatically or may not be able to focus correctly.
Visit your local Canon website for the latest information.
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¢ You can change the adjustment speed and responsiveness of the autofocus function with the following
settings. Visit your local Canon website for the latest information.

- MENU > ["™ Camera Setup] > [AF Speed] to set the AF speed (the speed at which the focus is adjusted)
to one of 10 levels.

- MENU > ["™ Camera Setup] > [AF Response] to set the responsiveness of the autofocus function to one
of 7 levels.

- While using continuous AF (including the [Only Around Focus Point] setting), you can hold the AF-ON button
pressed down to temporarily adjust the focus using the maximum AF speed and AF response. This is helpful
when you want to focus quickly after focus was lost or to keep a subject in focus while you follow it.

¢ Autofocus will not work in the following cases.

- When slow & fast motion recording is activated, if using lenses not compatible with autofocus.

- When the shooting frame rate in slow & fast motion recording is not set to 24, 25, 30, 48, 50, 60,100 or 120
(fos).

e Continuous AF will not work in the following cases.

- When using an EF lens that does not have a focus mode switch.

e Autofocus may not work well on the following subjects or in the following cases. In such case, focus manually.

- Reflective surfaces - Through dirty or wet windows
- Subjects with low contrast or without vertical lines - Night scenes
- Fast moving subjects - Subjects with a repetitive pattern

- When using small apertures.

- When subjects at different distances appear in the picture.

- When an ISO speed or gain value in the extended range is selected ([1] 74).

- When the gamma curve component of the [Gamma/Color Space] setting in the custom picture file (11 129)
is set to an option other than [BT.709 Normal] or [BT.709 Standard].

- When the main recording format is set to RAW.

AF Only Around Focus Point

In this focus mode, you can focus manually most of the way and let the camera finish focusing automatically.
This is very convenient when you want to make certain that high-resolution clips (4K and higher) are in sharp
focus.

Additionally, with this mode, if the camera cannot evaluate how to adjust the focus, it will not perform unreliable
focus adjustments. This results in a more stable focusing operation overall than with continuous AF.

1 Set the focus mode on the lens to automatic (1] 85).
2 Select MENU > ["™ Camera Setup] > [Continuous AF] > [Only Around Focus Point].
* \When the focus is in the manual adjustment range, a yellow continuous AF frame will appear on the screen.
3 If necessary, change the type and position of the AF frame ([11 90).
4 Turn the focus ring to adjust the focus.
e Focus manually to bring the subject closer into focus. When the focus enters the automatic adjustment
range, the focus frame will turn white and the camera will then finish focusing automatically.
¢ While the focus stays within the automatic adjustment range, the camera will keep the subject in focus
automatically.
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AF Lock

While using continuous AF (including the [Only Around Focus Point]
setting), you can lock the focus on a certain subject and then move the
camera to change the composition.

1 While the autofocus is active, press the AF LOCK button.

e The focus will be locked and and the AF frame will turn gray.
When you are using Face AF, the face detection frame around the
main subject will turn gray.

¢ The frame displayed on the screen will be the focus guide frame if
[Focus Guide] is set to [On].

¢ \When you use a button assigned to [AF Lock (While Pressed)], the
focus will only be locked while the button is held pressed down.

2 Press the AF LOCK button again to cancel the AF lock.

(i) Notes

AF lock will be canceled automatically in the following cases:
- If the camera is turned off or the camera’s system frequency is changed.
- If the lens is removed or replaced.
- If MENU > ["™ Camera Setup] > [Continuous AF] is changed to [Disable].
- When the shooting frame rate in slow & fast motion recording is not set to 120, 100, 60, 50, 48, 30, 25 or 24
(fos).

Changing the AF Frame Type and Position

You can change the type and position of the AF frame that appears on the screen (except for the face detection/
tracking frame) while using one of the autofocus functions. You can select to display an AF frame and change its
size and position to focus on a specific area or subject.

1 Select MENU > "™ Camera Setup] > [AF Frame Position] > Desired option.
2 Select MENU > ["™ Camera Setup] > [AF Frame] > Desired option.

Options for [AF Frame Position]

[Selectable]:  You can move the AF frame by touching the desired point on the LCD screen. You can also use
the joystick (8 directions) or SELECT dial. Press the CANCEL button to return the AF frame to
the center of the screen.

[Center Frame]: A fixed AF frame appears at the center of the screen.

Options for [AF Frame]
[Whole Area]*: No AF frame is displayed. The camera focuses automatically on a subject at the center of the

screen.
[Large]: Standard AF frame size.
[Small]: Smaller AF frame size (about 1/3 the standard size).

* Only available when MENU > ["™ Camera Setup] > [Continuous AF] is set to [Enable] or [Disable].
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Face Detection

When the face detection function is activated, the camera will detect people’s faces. When there are a number of
people in the picture, one person will be determined to be the main subject. The camera will keep tracking the
main subject even when it moves. You can also detect the eyes (eye detection) of the main subject.

You can use face detection with one of the autofocus functions to let the camera focus on the main subject
automatically (Face AF). You can use the focus guide to adjust the focus on the main subject manually. You can
also change the main subject.

1 Select MENU > "™ Camera Setup] > [Face Det. & Tracking] > [On].

2 Select MENU > ["™ Camera Setup] > [Face AF] > Desired option when a face is not detected.
o B (face priority) or @ (face-only AF) will appear on the screen.
e |f [Eye Detection] and [Face Detection AE] are not needed, skip to step 5.

3 Select MENU > ["™ Camera Setup] > [Eye Detection] > [On].

4 Point the camera at a person.

e All detected faces will have a face detection frame. The main subject will be indicated with a face detection
frame with small arrows. A frame will be displayed on the eyes of the main subject if eye detection is
activated.

e Push the joystick (left/right) to select a different person as the main subject. When eye detection is enabled
and both eyes are being detected, you can push the joystick (left/right) to select one eye. During autofocus,
a white or yellow* frame will appear on the face/eyes of the main subject. During manual focus, the frame
will be gray.

* When continuous AF is set to [Only Around Focus Point] and the focus position is within the manual adjustment range.
¢ When [Continuous AF] is enabled, the camera will keep focusing on the main subject’s face.

e During one-shot AF, the camera will focus on the main subject’s face while you hold the AF-ON button
pressed down.

¢ |f you use face detection together with the tracking function, the camera will be able to track the selected
main subject more reliably. When you touch a subject on the LCD screen, tracking will be activated and the
face detection frame will change to a double frame ¢ J (tracking frame). This is better if you want to track a
subject when it is difficult to keep seeing their face.

Options for [Face AF]
[Face Priority]:  The camera focuses according to the current [Continuous AF] setting.
[Face Only]: The camera locks the focus.

Face AF operation by AF mode
MENU > ["™ Camera Setup] > [Face AF]

Focus operation [Face Priority] [Face Only]
Face detected  No face detected  Face detected  No face detected
[One-Shot AF] while the button is not pressed Manual focus
[One-Shot AF] while the button is held pressed down
- Focus on the
[Continuous AF] ([Enable]) Focus on the subject inside Focus on the Manual focus

[Continuous AF] ([Only Around Focus Point]) within the automatic detected face the AF frame detected face
adjustment range

[Continuous AF] ([Only Around Focus Point]) within the manual

adjustment range (yellow AF frame) Manual focus
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(i) NoTes

¢ Typical examples of faces not correctly detected
- Faces extremely small, large, dark or bright in relation to the overall picture.
- Faces that are turned to the side, at a diagonal, partially hidden or upside-down.
® Face detection cannot be used in the following cases.
- When the shutter speed used is slower than 1/30 (59.94 Hz recordings), 1/25 (50.00 Hz recordings) or 1/24
(24.00 Hz recordings or 59.94 Hz recordings with a 23.98P frame rate).
- When slow & fast motion recording is activated.
- When a manual focus lens is attached to the camera.

e The camera may mistakenly detect the faces of non-human subjects. In such case, turn face detection &
tracking off.

¢ |f you set an assignable button to [Face Det. & Tracking], [Face AF] or [Eye Detection] (11 121), you can press
the button to adjust those settings.

Tracking a Specific Subject

You can have the camera track other moving subjects and also combine the tracking function with one of the
[Continuous AF] modes or AF frame types to let the camera focus on the desired subject automatically.

When [Continuous AF] is set to [Enable] and [AF Frame] is set to [Whole Area]

Touch the desired subject on the LCD screen.

¢ A double frame ¢ J (tracking frame) is displayed and the camera will start tracking the selected subject.
¢ Press the CANCEL button to remove the frame and cancel the tracking.

e If tracking fails, [ ] will be displayed. Select the desired subject again.

When [AF Frame] is set to [Whole Area], [Large] or [Small]
1 Set an assignable button to [Tracking] (1 121).
2 Press the assignable button.
¢ The subject selection mark »Z« will appear on the screen.
¢ Press the assignable button again or the CANCEL button to end the subject selection mode.
3 Touch the desired subject on the LCD screen.
e The »7« mark changes to a double frame ¢ J (tracking frame) and the camera will start tracking the selected
subject.

e You can also use the joystick (8 directions) or SELECT dial to place the center of the »Z« mark on the desired
subject and then press SET.

e f the tracking failed, the »Z« mark will turn red momentarily. Select the subject again.
* The subject selected for tracking becomes the target for autofocus functions.

4 Press SET or the button assigned to [Tracking].
e The camera stops tracking and returns to subject selection mode.

¢ Press the CANCEL button to end the tracking function and return the camera to the [Continuous AF] mode
that was used previously.

(i) NoTes

e The camera may start tracking the incorrect subject if there is another subject in the picture with similar color/
pattern characteristics. In that case, select the desired subject again.

® Tracking cannot be used in the same cases in which face detection cannot be used.




Image Stabilization

Image Stabilization

You can use the image stabilizer to compensate for camera shake and achieve steadier shots. The image
stabilizer is more effective at wider angles and the effect is reduced the more you approach the telephoto end.
The camera’s image stabilization is not available for RAW clips. 93

1 Select MENU > ["™ Camera Setup] > [Digital IS] > [On].
e Press the button assigned to [Digital IS] to turn this function on and off.

2 Select MENU > ["™ Camera Setup] > [Digital IS Mode] > Desired option.
o (man (standard) or (a1 (high) will appear on the screen.

3 If the camera cannot obtain the focal length from the lens, select MENU > ["™ Camera Setup] >
[Lens Focal Length] and enter the lens’s focal length using the data entry screen (1] 25).
* The image stabilization is adjusted according to the focal length entered.

4 When using an anamorphic lens, select MENU > ["™ Camera Setup] > [Anamorphic Corr.] >
Squeeze factor to use to correct the image stabilization.

e If you selected [Lens Squeeze Factor], the anamorphic correction will be applied according to the squeeze
factor specified with the MENU > [£% Recording/Media Setup] > [Metadata] > [Lens Squeeze] setting.

(i) Nnotes

e [f the IS function is turned off on the lens, the camera’s image stabilization function is deactivated too and the
&l icon will flash.

¢ |f you set an assignable button to [Pause Digital IS] (11 121), you can press and hold the button to temporarily
stop the camera's image stabilization (&0 or (& will appear grayed out). This will not affect the lens’s
image stabilization.

¢ Depending on the subject and shooting conditions, subject blur may be more prominent (the subject may be
momentarily blurred) due to the use of image stabilization.

e Turning off the camera’s image stabilization is recormmended in the following cases:
- When using TS-E lenses and fisheye lenses
- When the camera is expected to be stable, for example when it is mounted on a tripod

¢ |f the degree of camera shake is too high, the image stabilizer may not be able to compensate fully.

* The camera’s image stabilization will not function when using super telephoto lenses with a focal length
exceeding 1000 mm.
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Zoom

You can use the camera to zoom when an EF Cinema lens compatible with zoom operation ([1] 234) or an EF
lens integrated with a PZ-E1 Power Zoom Adapter is attached to the camera.
You can also zoom remotely using Browser Remote on a connected network device ([1] 181).

Zoom Modes of the Lens
Use the switch on the lens to select the lens’s zoom mode (automatic, manual). The name of the controls may
differ depending on the lens. Refer to the instruction manual of the lens/accessory used.

Set the lens’s zoom mode to automatic.
e Operating the zoom from the camera is enabled.

Adjusting the Zoom
1 Enable automatic zoom mode on the lens.
2 Select MENU > ["™ Camera Setup] > [Camera Grip Zoom] > [On].

3 Select MENU > ["™ Camera Setup] > [Camera Grip Zoom Speed] > Desired zoom speed.
e Zoom speeds are constant; [1] being the slowest and [16] the fastest.

4 Use the joystick on the camera grip to zoom.
e Push the joystick up to zoom in (telephoto) and push it down to zoom out (wide-angle).

(i) NoTES

¢ When using slow zoom speeds, it may take longer for the lens to start moving.



Onscreen Markers, Zebra Patterns and False Color

Onscreen Markers, Zebra Patterns and False Color

Using onscreen markers allows you to make sure your subject is correctly framed and is within the appropriate
safe area. Zebra patterns help you identify areas that are overexposed. The false color overlay allows you to
check if the exposure is correct. You can display the assistance overlays independently on the screen and HDMI
OUT terminal. The assistance overlays will not affect your recordings.

Displaying Onscreen Markers

The camera offers several onscreen markers. You can display multiple onscreen markers simultaneously and
select their color individually.

[Center Marker]: Displays a small marker that indicates the center of the screen. You can select the shape of the
center marker.

[Horizontal Marker], [Vertical Marker]: Displays a horizontal or vertical line to help you compose level shots.
[Grid Marker]: Displays a grid that allows you to frame your shots correctly (horizontally and vertically).

[Aspect Marker]: Indicates various aspect ratios by displaying border lines or by masking the image outside the
selected aspect ratio. The aspect ratio can be set freely by the user.

[Safe Area Marker]: Displays a margin from the edges of the image (using border lines or by masking the image)
to indicate the action safe area, text safe area, etc. You can select the core area used as the basis for calculating
the safe area and a percentage, relative to the side length or area.

[User Marker 1], [User Marker 2]: Displays up to two rectangular frames whose size and position you can set
Safe area 88%

freely and independently of each other.
l--l by side Iength

B Horizontal
marker
ﬁ o

Aspect guide 4:3

User marker ~ Center marker Grid marker
(100, 250) ([Cross 1] type)

1 Select MENU > [ Assistance Functions] > Desired [Markers:] setting > [On].
e Onscreen markers will be displayed on the corresponding video output.
® You can also use direct touch control ([ 56) to turn the [Markers: LCD] setting on/off.
e [f the respective setting is set to [Off], onscreen markers will not be displayed on the corresponding video
outputs even if individual markers are configured.
2 Select the marker(s) you wish to display and configure them with the following procedures.
* You can display multiple markers simultaneously.
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Center Marker / Horizontal Marker / Vertical Marker / Grid Marker

1 Select MENU > [ Assistance Functions] > [Center Marker], [Horizontal Marker], [Vertical Marker] or [Grid
Marker] > Desired marker color.
e Select [Off] to turn off the marker.

2 For [Center Marker] only: Select MENU > [ Assistance Functions] > [Center Marker Type] > Desired marker
shape.

Aspect Marker

1 Select MENU > [T Assistance Functions] > [Aspect Marker] > Desired marker color or transparency of the
masked area.
e Select [Off] to turn off the marker.

2 Select MENU > [ Assistance Functions] > [Marker Aspect Ratio] > Desired option.

3 For [Custom] only: Select MENU > [ Assistance Functions] > [Marker Custom Asp. Ratio] and enter the
aspect ratio using the data entry screen ([1] 25).

(i) NoTES

Aspect markers will not be displayed in the following cases.
- When the resolution is set to 7680x4320 / 3840x2160 / 1920x1080 / 1280x720 and the marker aspect ratio
is set to [16:9].
- When the resolution is set to 8192x4320 / 5952x3140 / 2976x1570 / 4096x2160 / 2048x1080 and the
marker aspect ratio is set to [1.90:1].
- The same applies when the same aspect ratio is set manually using [Custom].

Safe Area Marker

The safe area is displayed using a border line or by masking the image outside the safe area. It can be calculated

as a percentage of the total frame area or as a percentage of the width/height.

1 Select MENU > [ Assistance Functions] > [Safe Area Marker] > Desired marker color/mask opacity level.
e Select [Off] to turn off the marker.

2 Only when an aspect marker is already activated: Select MENU > [ Assistance Functions] > [Basis for
Marker Safe Area] > [Whole Picture] or [Selected Aspect Marker].

3 Select MENU > [ Assistance Functions] > [Marker Safe Area %] > Desired percentage.

e You can select the margin as a percentage of the total frame area [(Area)] or as a percentage of the width/
height [(Side Length)].

User Markers

You can set 2 individual user markers ([User Marker 1] and [User Marker 2]) and adjust their color, size and
position separately.

1 Select MENU > [ Assistance Functions] > [User Marker 1] or [User Marker 2] > Desired marker color.
e Select [Off] to turn off the marker.

2 Select MENU > [ Assistance Functions] > [User Marker 1 Size] or [User Marker 2 Size] and enter the width
[W] and height [H] using the data entry screen ([1] 25).

3 Select MENU > [ Assistance Functions] > [User Marker 1 Position] or [User Marker 2 Position] and enter
the [X] and [Y] coordinates using the data entry screen ([11 25).
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(i) Nnotes

e You can choose the onscreen display level to turn off all other onscreen displays, leaving only the markers
([T 52).

¢ If you set an assignable button to one of the [Markers:] settings ([11 121), you can press the button to turn the
markers on and off on the corresponding video output.

Displaying Zebra Patterns

The camera has a zebra pattern function that shows black and white diagonal stripes over

areas that are overexposed. There are two types of zebra patterns and you can display both \ /
simultaneously. Zebra 1 lets you identify areas within a certain range (5% of a specified level \ /
from 5% to 95%) while zebra 2 lets you identify areas that exceed a specified level (from 0%  Zebral  Zebra2
10 100%).

1 Select MENU > [ Assistance Functions] > One of the [Zebra:] settings
* You can also use direct touch control (] 56) to turn the [Zebra: LCD] setting on/off.

¢ Alternatively, you can press an assignable button set to one of the [Zebra:] settings ([J] 121), to turn the
zebra pattern overlay on and off on the corresponding video output.

2 Select MENU > [ Assistance Functions] > [Zebra] > Desired option.
3 Select MENU > [ Assistance Functions] > [Zebra 1 Level] or [Zebra 2 Level] > Desired option.

Displaying False Color

In CAMERA mode, you can display the false color overlay to check the brightness levels as different colors.

Select MENU > [ Assistance Functions] > Desired [False Color:] setting > [On].
¢ You can also use direct touch control (1] 56) to turn the [False Color: LCD] setting on/off.

e Alternatively, you can press an assignable button ([J] 121) set to one of the [False Color:] settings to turn the
false color overlay on and off on the corresponding output destination.

(i) Nnotes

* You can use the MENU > [& Assistance Functions] > [False Color Index] setting to check an index of the
colors used in the false color overlay.
Color Meaning
Red White clipping
Yellow | Just below white clipping

Pink | One stop over 18% gray
Green | 18% gray (medium gray)

Blue | Just above black clipping
Purple | Black clipping

¢ When the Look File registered to the custom picture file is active, the color displayed might not be that of the
correct brightness level.
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Setting the Time Code

Setting the Time Code

The camera generates a time code signal and records it with the recorded clips. The time code signal can be
output from the TIME CODE terminal or HDMI OUT terminal.

Depending on the frame rate used, you may be able to select between a drop frame an non-drop frame time
code signal (11 99). The default mode varies depending on the country/region of purchase and, though the time
code display style is different for DF and NDF, in this section the NDF display style is used for simplicity’s sake.

Selecting the Time Code Mode
You can select the camera’s time code mode.
Select MENU > [¥ System Setup] > [Time Code Mode] > Desired option.

Options
[Preset]: The time code starts from an initial value you can select in advance. The default initial time code
is 00:00:00:00.
See the following procedures to select the time code running mode and set the initial time code.
[Regen.]: The camera will read the selected card and the time code will continue from the last time code

recorded on the card. The time code runs only while recording so clips recorded consecutively
on the same card will have continuous time codes.

Setting the Time Code Running Mode
If you set the time code mode to [Preset], you can select the time code running mode.
Select MENU > [¥ System Setup] > [Time Code Run] > Desired option.

Options

[Rec Run]: The time code runs only while recording so clips recorded consecutively on the same card will
have continuous time codes.

[Free Run]: The time code starts running the moment you confirm the selection and keeps running

regardless of the camera’s operation.

Setting the Time Code’s Initial Value
If you set the time code mode to [Preset], you can set the initial value of the time code.

1 Select MENU > [¥ System Setup] > [Set Time Code] > [Change].

¢ The time code setting screen appears with an orange selection frame indicating the hours.

e To reset the time code to [00:00:00:00], select [Reset] instead. If the running mode is set to [Free Run], the
time code will be reset the moment you confirm the selection and keep running continuously from
00:00:00:00.

2 Enter the initial time code using the data entry screen ([1] 25).

e |f the running mode is set to [Free Run], the time code will start running from the selected time code the
moment you confirm the selection.
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Selecting Drop or Non-Drop Frame

When the frame rate is set to 59.94P, 59.94i or 29.97P, you can select between a drop frame (DF) or non-drop
frame (NDF) time code, depending on how you plan to use your recordings.

With all other frame rates, the time code is set to non-drop frame (NDF) and cannot be changed.

Select MENU > [¥ System Setup] > [Time Code DF/NDF] > Desired option.

e The time code display will change depending on the setting. When you select [DF], the time code will appear
as [00:00:00.00]; when you select [NDF], it will appear as [00:00:00:00].

About the time code display
A letter may appear next to the time code depending on the setting/status. Refer to the following table.
Letter Description
R The time code mode is set to [Regen.].
P The time code mode is set to [Preset] and the running mode is set to [Rec Run].
F The time code mode is set to [Preset] and the running mode is set to [Free Run].
E The time code signal is coming from an external source.
No letter | Time code during clip playback.

(i) Nnotes

e The frames value of the time code runs from O to 23 (frame rate set to 23.98P or 24.00P), from 0 to 24 (frame
rate set to 25.00P, 50.00i or 50.00P), or from 0 to 29 (all other frame rates).

¢ When slow & fast motion recording/frame recording/interval recording is activated, you cannot select the [Free
Run] running mode. Conversely, when pre-recording is activated, [Free Run] is set automatically and cannot be
changed.

¢ When slow & fast motion recording/frame recording/interval recording is activated, the time code signal will not
be output from any of the terminals.

¢ When you mix drop frame and non-drop frame time codes, there might be a discontinuity in the time code at
the point where the recording starts.

e \When you are using the [Free Run] running mode, the time code will continue running as long as the built-in
backup battery has some charge left, even if you disconnect all other power sources.

e If you set an assignable button to [Time Code] (1] 121), you can press the button to open the
[¥ System Setup] menu page with the time code settings.

Setting the User Bit

You can set a user bit composed of the date or the time of recording or an identification code consisting of
8 characters in the hexadecimal system. There are sixteen possible characters: the numbers 0 to 9 and the
letters Ato F.

The user bit is recorded with clips and can be output from the HDMI OUT terminal. It can be used freely to
categorize and manage recordings or to keep additional information about them.

1 Select MENU > [¥ System Setup] > [User Bit Type] > [Setting], [Date] or [Time].
¢ |f you select [Time] or [Date] the rest of the procedure is not necessary.

2 Select [Change].
e To reset the user bit to [00 00 00 00], select [Reset] instead.

3 Enter the user bit using the data entry screen ([1] 25).
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Synchronizing with an External Device

Synchronizing with an External Device

You can use the camera’s TIME CODE terminal to synchronize this camera’s time code to an external signal.
Using the same external time code signal with multiple cameras allows you to set up a multi-camera recording.
You can also output the time code signal from this camera to other cameras.

Connecting an External Device

When synchronizing a time code signal, connect the external device to the TIME CODE terminal on the camera.
Be sure to set the TIME CODE terminal to input or output in advance.

Connection diagram

TIME CODE terminal

Standard TC signal

>

s DIN-BNC cable (commercially available)

@ vrorTANT

Commercially available DIN-BNC cables and the TIME CODE terminal

There are DIN cables with a long release mechanism (Fig. 1-A), and cables with a short release mechanism
(Fig. 1-B).

If you connect a cable with a short release mechanism to the TIME CODE terminal, it may not be possible to

disconnect it from the camera (Fig. 2). Use a cable with a release mechanism long enough to allow you to grip it
and pull to release even when it is connected to the camera.

Cable tested for use with this camera: Canare D2.5HDC***E-D (“***” indicates length)
For the latest information about DIN cables tested for use with this camera, visit your local Canon website.

Fig. 1 Fig. 2

Release mechanism

Time Code Signal Input

An external SMPTE-standard LTC timing signal received from the TIME CODE terminal can be recorded as the
time code. The user bit of the external timing signal can also be recorded with clips. Before connecting the
device, set the TIME CODE terminal to input with the procedure below and make sure the time code running
mode is set to [Free Run] ([ 98).
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1 Select MENU > [¥ System Setup] > [TC In/Out] > [In].

2 To record the external signal’s user bit, select also MENU > [¥ System Setup] > [User Bit Recording
Mode] > [External].

(i) NoTES

e Synchronize the camera’s time code with an external time code signal that matches the camera’s system
frequency. Use a 24-frame time code signal when the frame rate is set to 23.98P or 24.00P, a 25-frame time
code signal when it is set to 25.00P, 50.00i or 50.00P and a 30-frame time code signal for other frame rates.

¢ \When a suitable external time code signal is received, the camera’s own time code will be synchronized to it
and the synchronization will be maintained even if you disconnect the cable from the TIME CODE terminal.

¢ |f the external time code signal is incorrect or there is no input signal, the internal time code set in the camera
will be recorded instead.

¢ \When an external time code signal is received, the DF/NDF selection will follow the external time code signal’s
settings.

e |f an external time code signal is input while pre-recording is activated, there might be a discontinuity in the
time code of the pre-recorded clip.

e Performing any of the following actions while the cable is not connected will cause the synchronization to be
disrupted; the correct time code will be restored once you reconnect the cable.

- Turning the camera on/off
- Switching to MEDIA mode
- Changing the video configuration

Time Code Signal Output

The time code signal output from the TIME CODE terminal will be a SMPTE-standard LTC timing signal. The user
bit will also be output.

Select MENU > [ System Setup] > [TC In/Out] > [Out].

(i) NoTES

¢ About the user bit output: The user bit set by the user (1] 99) will be output. In MEDIA mode, the user bit is not
output from the TIME CODE terminal.

e The time code and user bit will not be output when slow & fast motion recording/frame recording/interval
recording is activated.

¢ With the MENU > [£% Recording/Media Setup] > [HDMI Time Code] set to [On] you can output the time
code signal from the HDMI OUT terminal (11 147).
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Recording Audio

The camera features the following options for audio recording and playback. You can record audio using an
accessory compatible with the multi-function shoe, an external microphone (MIC terminal), or the built-in
102  microphone.
— The audio signal will be output with the video signal from the HDMI OUT terminal. You can record the audio
signal on an external recorder.

Available audio recording formats

. ) ) Audio format
Video format / audio recording m— T
function Codec ampling Bit depth umber o Bit rate
frequency audio channels
RAW, XF-AVC Linear PCM 24 hit 4 channels 4.5 Mbps
Video . -
recording MP4* Linear PCM 48 kHz 16 bit 4 channels 3 Mbps
AAC 16 bit 2 channels 256 Kbps
Aui For slow & fast motion recording - 48 kHz 24 bit 4 channels 4.5 Mbps
udio
recording For second card recording B .
functions 8 kHz 16 bit 1 channel 128 Kbps
* Audio for proxy clips is recorded in AAC format.
Audio Settings and Recorded Audio Channels
Connected terminal/Audio input device Recorded audio channels/audio sources
Accessory compatible with MIC terminal (external
the multi-function shoe* microphone) CHt Ch2 CH3 Cha
Accessory compatible with the . .
Yes Yes muiti-function shoe MIC terminal (L) | MIC terminal (R)
Accessory compatible with the S
Yes No muiti-function shoe Built-in microphone
No Yes MIC terminal (L) MIC terminal (R) Built-in microphone
No No Built-in microphone Built-in microphone

* For details on the terminal settings (connector pin diagrams, input switching) of accessories compatible with the multi-function
shoe (DM-E1D Directional Stereo Microphone (sold separately) or a commercially available accessory), refer to the instruction
manual of the accessory in use.

(i) NOTES

¢ You can press the button assigned to [Audio Status] to display only the [M) Audio Setup] status screens. On
these status screens ([] 201) you can check the input source selected for each audio channel and other
audio-related settings.

e You can press the MENU button of the DM-E1D Directional Stereo Microphone (sold separately) to display the
audio settings menu screen.

Audio Format for MP4 Clips
Select the audio recording format for MP4 clips (primary clips or sub recording clips).

Select MENU > [ £ Recording/Media Setup] > [Audio Format (MP4)] or [ Audio Format (MP4)] >
Desired option.
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Recording Audio Using the Second Card Recording Functions

You can record audio in a lighter format as a WAV file by using the second card recording functions. The main
clip's 4-channel audio is converted into 1-channel audio at a lower audio quality.
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1 Insert an SD card into both card slots (1 for the main clip, 2 for the audio file).
2 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Normal Recording].
3 Select MENU > [ £ Recording/Media Setup] > [2nd Card Rec Functions] > [[i] Main / [2) Audio Rec].

4 Press the REC button to start recording.
e The main clip and the WAV file will be recorded simultaneously.

(i) NnoTes

e About audio recorded using the second card recording functions.
- Audio is recorded with the following settings: 8 kHz, 16 bit, 1 channel.
- If video cannot be recorded due to a card problem, audio will also not be recorded.
- However, video will be recorded even if audio cannot be recorded due to a card problem.
- Audio will not be recorded if there is an existing WAV file with the same file name.
- Audio recording will stop automatically once it reaches 6 hours (video recording will continue).
- A maximum of 999 WAV files can be recorded.

Connecting an External Microphone or External Audio Input Source to the Camera

To the MIC terminal you can attach condenser microphones with a & 3.5 mm stereo mini plug. To the mullti-
function shoe, you can attach compatible accessories (DM-E1D Directional Stereo Microphone (sold separately)
or other commercially available accessories) (1 32). For details, refer to the instruction manual of the accessory
in use.

For details on commercially available accessories, visit your local Canon website.
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Adjusting the Audio Recording Level

You can adjust the audio recording level of the DM-E1D Directional Stereo Microphone or the MIC terminal. You
can set each audio channel separately or set CH1/CH2* or CH3/CH4* together to automatic or manual.
* When [CH1/CH2 ALC Link}/[CH3/CH4 ALC Link] is set to [Linked].

Audio Level Adjustment for CH1, CH2 or CH1/CH2

1 Select MENU > [ ) Audio Setup] > [Audio Rec Level CH1], [Audio Rec Level CH2] or [Audio Rec Level CH1/
CHZ2] > [Automatic] or [Manuall].
e The following procedures are not necessary if set to [Automatic].

2 Select MENU > [§)) Audio Setup] > [CH1 Level], [CH2 Level] or [CH1/CH2 Level] > Adjust the audio level as
needed.

e For reference, 0 corresponds to —oo, 50 corresponds to O dB, and 100 corresponds to +18 dB.

¢ As a guideline, adjust the audio recording level so that the audio level meter on the screen will go to the right
of the —18 dB mark (one mark right of the —20 dB mark) only occasionally.

Audio Level Adjustment for CH3, CH4 or CH3/CH4
1 Select MENU > [ ) Audio Setup] > [Audio Rec Level CH3], [Audio Rec Level CH4] or [Audio Rec Level CH3/
CH4] > [Automatic] or [Manual].

e |f you selected [Automatic], the rest of the procedure is not necessary. If you selected [Manual], continue the
procedure to set the audio recording level.

2 Select MENU > [)) Audio Setup] > [CH3 Level], [CH4 Level] or [CH3/CH4 Level] > Adjust the audio level as
needed.

¢ For reference, 0 corresponds to —oo, 50 corresponds to O dB, and 100 corresponds to +18 dB.

¢ As a guideline, adjust the audio recording level so that the audio level meter on the screen will go to the right
of the —18 dB mark (one mark right of the =20 dB mark) only occasionally.

Linking the audio level adjustment of CH1/CH2 or CH3/CH4 (MIC terminal)
¢ When using the MIC terminal, you can use the MENU > [P)) Audio Setup] > [CH1/CH2 ALC Link] or [CH3/
CH4 ALC Link] setting to link the audio level adjustment of CH1/CH2 or CH3/CH4.

¢ When linked, different channels can be adjusted together. Adjust the CH1 audio levels to affect both CH1
and CH2 or adjust the CH3 audio levels to affect both CH3 and CH4.

(i) NoTes

* We recommend using headphones when adjusting the audio level. If the input level is too high, audio may
become distorted even if the audio level indicator shows an appropriate level.

e If you set an assignable button to [Audio Level Indicator] (11 121), you can press the button to turn the
onscreen audio level indicator on and off.

Advanced Audio Input Settings

You can adjust the audio input settings for the DM-E1D Directional Stereo Microphone or the MIC terminal. The
corresponding menu settings become available only when the respective audio input is active.

Microphone Attenuator (MIC Terminal)
You can activate the microphone attenuator for an external microphone (20 dB).

Select MENU > [) Audio Setup] > [MIC Att.] > [On].
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Microphone Characteristics (MIC Terminal)
You can choose the microphone characteristics as necessary.

Select MENU > [d) Audio Setup] > [MIC Low Cut] or [Built-in Mic Low Cut] > Desired option. 105
Options

[Off]: For recording audio under usual conditions.

[LCA]: For recording mainly people’s voices.

[LC2]: For reducing the background sound of wind when recording outdoors in windy surroundings (for

example, on a beach or close to buildings). Note that when you use this setting some
low-frequency sounds may be suppressed along with the sound of wind.

Microphone Attenuator (DM-E1D Directional Stereo Microphone)

You can activate the microphone attenuator for an external microphone attached to the multi-function shoe (20
dB).

Select MENU > [I) Audio Setup] > [Shoe Mic Attenuator] > [On].

Microphone Characteristics (DM-E1D Directional Stereo Microphone)

You can choose the microphone characteristics (for microphones compatible with the multi-function shoe) as
necessary.

Select MENU > [ ) Audio Setup] > [Shoe Mic Low Cut] > Desired option.

Options
[Off]: For recording audio under usual conditions.
[On]: For reducing the background sound of wind when recording outdoors in windy surroundings (for

example, on a beach or close to buildings). Note that when you use this setting some low-
frequency sounds may be suppressed along with the sound of wind.

Microphone Directionality (DM-E1D Directional Stereo Microphone)
Select MENU > [) Audio Setup] > [Shoe Mic Directionality] > Desired option.

Options
[Shotgun (Monoaural)]:
Captures clear audio from the front of the microphone.
[90°(Stereo)]:  Captures suitable audio from both the front and the sides of the microphone.
[120°(Stere0)]: Captures audio from a wider angle.

Monitoring the Audio with Headphones

Connect headphones with a & 3.5 mm stereo mini-plug to the
() (headphone) terminal to monitor the recorded audio.

(i) NoTES

* You can adjust the headphone volume with the MENU > [§)) Audio
Setup] > [Headphone Volume] setting. If you set an assignable button to
[Headphones +] or [Headphones -] ([1] 121), you can press the button
to adjust the headphone volume without using the menu.
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Colors Bars/Audio Reference Signal

Colors Bars/Audio Reference Signal

You can have the camera generate color bars and a 1 kHz audio reference signal and output them from the
following terminals. Color bars are not available when the main recording format is set to RAW.

LCD monitor / Viewfinder HDMI QUT terminal () (headphone) terminal
Color bars o o -
Audio reference signal - o o
Color Bars

The camera offers SMPTE, EBU and ARIB color bars.

1 Select MENU > ["™ Camera Setup] > [Color Bars] > [On].
® The selected color bars appear on the screen.

2 Select MENU > ["™ Camera Setup] > [Color Bar Type] > Desired option.
¢ The selected color bars will be recorded when you press the REC button.
e Turning off the camera or changing the operating mode to MEDIA mode will deactivate the color bars.

(i) NoTES

¢ If you set an assignable button to [Color Bars] (11 121), you can press the button to turn the color bars on/off.

Color bars cannot be displayed in the following cases:

- When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to an

option other than [BT.709 Wide DR], [BT.709 Normal] or [BT.709 Standard].

Audio Reference Signal
The camera can output a 1 kHz audio reference signal with the color bars.

Select MENU > [) Audio Setup] > [1 kHz Tone] > Desired option.
¢ You can select one of three audio levels (-12 dB, —18 dB, —20 dB), or [Off] to turn off the signal.

¢ The reference signal will be output at the selected level when you display the color bars, and will be recorded

when you press the REC button.
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Video Scopes

The camera can display a simplified waveform monitor or a vectorscope to check your recordings. The selected
video scope is displayed on the screen and can be output to other monitoring devices as well.
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Displaying a Video Scope

1 Select MENU > [ Assistance Functions] > [WFM Function] > [Waveform Monitor] or
[Vectorscope].

2 Select MENU > [& Assistance Functions] > One of the [WFM:] settings > [On].
® You can also use direct touch control (] 56) to turn the [Waveform Monitor]/[Vectorscope] setting on/off.

* By default, the video scope will appear on the right of the screen. Using the MENU > [ Assistance
Functions] > [Waveform Settings] or [Vectorscope Settings] > [Position] settings, you can select where to
display it (left or right side).

(i) NoTES

¢ The waveform monitor will not be affected even if a LUT is applied to the image, the range is changed or
anamorphic desqueeze is used on the selected video output or screen.

¢ The video scopes will also be displayed while adjusting a custom picture file's image settings (11 126).

Changing the Waveform Monitor Settings

1 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Type] > Desired option.
e |f you selected an option other than [Select Line], skip to step 4.

2 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Select Line].

3 Enter the Y coordinate of the red horizontal line to display using the data entry screen ([11 25).

¢ The available range of lines that can be selected depends on the vertical component of the resolution used.
For 4320: 0 to 4318 (in 2-line increments)
For 2160: 0 to 2158 (in 2-line increments)
For 1080: 0 to 1079 (in 1-line increments)
For 720: 0 to 719 (in 1-line increments)

4 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Vertical Scale for HDR] >
Desired option.
® Select the Y axis (luminance) scale used when displaying the waveform monitor of an HDR image.

5 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Gain] > [1x] or [2X].
e |f you selected [1X], the rest of the procedure is not necessary.

6 Select MENU > [ Assistance Functions] > [Waveform Settings] > [Y Position] > Desired option.

e The display range of the waveform monitor’s Y axis will be reduced by half. Select the minimum luminance
value (in %) shown on the Y axis.

Options for [Type]

[Line]: Sets the waveform monitor to line display mode.

[Line+Spot]: The waveform of the area in the red frame is displayed in red on top of the [Line] mode
waveform.

[Select Line]:  The selected horizontal line (in red) will be displayed along with its waveform.

[RGB]: Shows 3 side-by-side waveforms in an RGB parade.

[YPoLPT]: Shows 3 side-by-side waveforms in a YPbPr parade.
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Options for [Vertical Scale for HDR]

[IRE]: Displays the video scope in IRE units.

[PQ/HLG]: For HDR-PQ images, displays the video scope in nits (cd/mz) and the narrow range’s (video
range) waveform monitor.
For HDR-HLG images, the Y axis shows a relative-index value between 0 and 1000 nits.

(i) Notes

¢ If the waveform monitor is activated and the MENU > [[@d Custom Picture] > [Edit File] > [Knee] > [Point]
setting is changed, when you display the waveform monitor, a horizontal line will appear indicating the
luminance (Y) level* corresponding to the knee point.
* When a Look File registered to the custom picture file is active, the displayed luminance may not be at the correct level.

¢ \When the waveform monitor’'s Y axis is set to display in IRE units, a level of 10 bit 64 maps to 0 IRE and 10 bit
940 maps to 100 IRE, regardless of the custom picture settings.

Changing the Vectorscope Settings
1 Select MENU > [ Assistance Functions] > [Vectorscope Settings] > [Type] > Desired option.
2 Select MENU > [ Assistance Functions] > [Vectorscope Settings] > [Gain] > [1x] or [2X].

Options for [Type]
[Normal]: Displays the usual vectorscope.
[Spot]: The color signal of the area in the red frame is displayed in red on top of the [Normal] mode

waveform.
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Adding Marks to Clips in CAMERA Mode

When the main recording format is set to XF-AVC, while recording, you can add shot marks (H) to flag an
important shot or frame. After recording a clip, you can add an OK mark ([lf) or check mark ([%) to help you
identify particular clips.

You can add and delete marks also in MEDIA mode ([1] 142, 142).

Marks cannot be added to proxy clips.

Adding a Shot Mark while Recording

To add a shot mark to a clip while recording, you must set an assignable button to [Add Shot Mark] in advance.

1 Set an assignable button to [Add Shot Mark] ([1] 121).

2 While you are recording, press the assignable button at the beginning of the shot you wish to mark.
e [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.

(i) NoTES

¢ Up to 100 shot marks can be added to a single clip.

e There may be up to a 0.5 second delay from when you press the button to when the camera adds the shot
mark.

¢ When a clip contains a shot mark, B will appear next to the clip’s thumbnail in the playback index screen.

e When pre-recording is activated or during interval recording/frame recording, you cannot add a shot mark
before the REC button is pressed.

Adding an [l Mark or [ Mark to the Last Clip Recorded

[ marks can be used to protect important clips, as clips with an [l mark cannot be deleted with the camera.
To add a mark in CAMERA mode, you must set an assignable button to [Add [l Mark] or [Add (4 Mark] in
advance.

1 Set an assignable button to [Add [ Mark] or [Add [ Mark] (11 121).

2 After recording a clip, press the assignable button.
o [[[AMark] or [Mark] will appear briefly and the selected clip mark will be added to the clip.

(i) NoTES

¢ A clip cannot have both an [l mark and a M mark at the same time.

¢ When a clip has an [l mark or [ mark, the respective icon will appear next to the clip's thumbnail in the
playback index screen.
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Using Metadata

Using Metadata

When the main recording format is set to XF-AVC/RAW, the camera automatically adds metadata to the
recorded clips. You can use Canon XF Ultility to check and search for specific metadata. You can also add News
Metadata to the recorded clips (I 111).

Metadata components

Entering content Checking content
Metadata Canon XF Content Canon XF Content
Camera \lity Transfer Camera utilty Transfer
Mobile Mobile
User Memo: clip title, creator, location and description. - o' - @ @ -
GPS information: altitude, latitude and longitude. ®:? o’ - @ @ -
Information about the recording: scene and take. ] - - o’ o -
Information about camera settings: shutter speed, ISO 5
. - - - o o -
speed/gain value, etc.
Unique Material Identifiers (UMID): country, organization o _ _ Y _ _
and user codes based on the SMPTE standard. (11 188)
News Metadata (7] 111) - - o o - [ J

1 User memo files need to be created using the software and saved on an SD card in advance.

2 Only when a GP-E2 GPS Receiver is connected to the camera. While recording, GPS information is recorded automatically by
the camera.

3 GPS information can only be added to clips already recorded.

4 Only in CAMERA mode.

5 Recording data is logged automatically by the camera.

Setting a User Memo Created with Canon XF Utility

Before you can add a user memo, you must first install Canon XF Utility ((11 154). Next, create the user memo
and then save it to an SD card. Once you insert the SD card in the camera and select the user memo, it will be
added to clips you record.

1 Use Canon XF Utility to save a user memo to an SD card.
e For details, refer to Managing User Memo Profiles in the Canon XF Utility Instruction Manual.

2 Insert the SD card into the camera’s card slot 2.
3 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Add XML File] > [On].
4 Select MENU > [£% Recording/Media Setup] > [Metadata] > [XML File Format] > [User Memo].

5 Select MENU > [ £% Recording/Media Setup] > [Metadata] > [User Memo] > Desired user memo file.

e The [ED icon appears on the left of the screen. (only when [(Z) Monitoring Setup] > [Custom Display 2] >
[User Memo] is set to [On].)

(i) NoTes

e After you set a user memo, do not remove the SD card while you are recording. If the SD card is removed, the
user memo will not be added to the clip.

® You must set the user memo before you start recording for it to be added to the clips. You cannot change the user
memo already added to a clip using the camera but you can do so with Canon XF Utility.
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Using Metadata

When recording, you can add News Metadata* to the recorded clips. Using Content Transfer Mobile, you can
check and edit News Metadata files. The most recently set News Metadata will be prioritized and added. See the

following table for details on News Metadata settings.

* Refers to a metadata file compliant with the DPP002 Metadata Exchange for News recommendation ver. 1.1.1.

Entering content

Checking content

News Metadata Camera Content Camera Content
Transfer Mobile Transfer Mobile
Story Title, Description, Keyword (Tags), Category, Contributor, Source/
L ) L - o o [ J
Originator, Copyright Holder, Restrictions.
Genre - Y — )
Language - - - @

(i) Nnotes

¢ News Metadata files with file names that exceed 64 characters (extension included) cannot be used.

Setting News Metadata saved on an SD card

Before setting News Metadata, create a News Metadata file and save it to an SD card. Once you insert the SD
card into the camera, select the News Metadata file and start recording. The News Metadata will be added to
the recorded clips.

1 Save the News Metadata file to an SD card.
¢ News Metadata files should be saved in the "/ XMLTAG" folder of the SD card.

2 Insert the SD card into the camera's card slot 2.
3 Select MENU > [£2 Recording/Media Setup] > [Metadata] > [Add XML File] > [On].
4 Select MENU > [ £2 Recording/Media Setup] > [Metadata] > [XML File Format] > [News Metadata).

5 Select MENU > [£% Recording/Media Setup] > [Metadata] > [News Metadata] > Desired News
Metadata file saved to the SD card.
e The selected News Metadata file will be saved to the camera.

(i) notes

® You cannot change the News Metadata already added to a clip using the camera but you can do so using
Content Transfer Mobile.

Setting News Metadata edited with Content Transfer Mobile

Before setting News Metadata, edit the News Metadata file using Content Transfer Mobile. Connect the camera
to a smartphone using the smartphone application (] 155, 184) to transfer and save News Metadata files from
a smartphone to the camera. Once saved to the camera, select the News Metadata to be added to the recorded
clips.

1 Smartphone: edit the News Metadata file with Content Transfer Mobile.
2 Connect the camera to a smartphone ([I] 155, 184).
3 Operate Content Transfer Mobile to transfer the News Metadata file to the camera.
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4 Save the News Metadata to the camera.
¢ News Metadata files transferred from a smartphone will be saved automatically to the camera.

¢ Automatically, MENU > [£¥ Recording/Media Setup] > [Metadata] > [Add XML Filg] will be set to [On], and
[XML File Format] will be set to [News Metadata].

¢ Only the most recently transferred file can be saved.

Resetting News Metadata
You can reset the News Metadata added to clips.

1 Select MENU > [ % Recording/Media Setup] > [Metadata] > [News Metadata Reset All].
2 Select [OK].

@ wPoRTANT

¢ \When the camera is turned off normally, the News Metadata file is saved or a previously saved News Metadata
is reset. In the case of a power outage or if the power is not terminated normally the file will not be saved or
reset.

¢ News Metadata saved to the camera will be reset if you select MENU > [ System Setup] > [Reset] > [All
Settings], or if the camera's firmware is updated.

Entering Slate Information About the Recording
You can enter scene and take information to help identify the recording later on.
1 Select MENU > [£% Recording/Media Setup] > [Metadata] > [Scene] or [Take] > [Change].

2 Enter the desired text using the keyboard screen (11 25).
¢ To clear the scene/take information, select [Reset] instead.
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Special Recording Modes

The camera features the following special recording modes.

Slow & fast motion recording: This mode allows you to change the shooting frame rate to achieve a slow motion
or fast motion effect during playback. Recording audio in WAV format is also possible.

Pre-recording: The camera will start recording a few seconds before you press the REC button. This is especially
useful when it is difficult to predict when to start recording.

Frame recording: The camera will record a pre-defined number of frames every time you press the START/STOP
button. This mode is suitable for recording stop motion animation.

Interval recording: The camera will automatically record a pre-defined number of frames at a pre-defined interval.
This mode is suitable for recording subjects with little movement, such as natural surroundings or plants.

Continuous recording: The camera keeps a continuous recording on the SD card in the second slot (MP4 format
only) to avoid any missed shooting opportunities.

Slow & Fast Motion Recording

The camera can record using a progressive frame rate (shooting frame rate) that is different from the playback
frame rate. Recording a clip with a shooting frame rate higher than the [Frame Rate] setting will result in a slow
motion effect during playback. Conversely, a lower shooting frame rate will result in a fast motion effect.
Sound is not recorded with the clip, but it can be recorded separately as a WAV file. The maximum recording
time of a single clip is the equivalent of approximately 6 hours of playback time. You can record proxy clips
simultaneously with slow & fast motion clips ([1] 71). XF-AVC proxy clips will have the same shooting and
playback frame rates as the primary RAW clips.

You can also use direct touch control to perform this function (1 56).

Available shooting frame rates (RAW)

Sensor mode Resolution Recording format Available range
RAW ST* o - -
Full frame 8192x4320
RAW LT o o _
5 25 RAW HQ* o - -
uper 35mm
5952x3140 RAW ST
Cropped —
(Cropped) RAW LT () [ )
Super 16mm RAWHQ
(gro o) 2976x1570 RAW ST ° ° °
PP RAW LT
Frame rate Shooting frame rate (fps)
59.94P 1,2,3,6,15,30 44, 48, 52, 56, 60 90, 120
1,2,3,6,15,22, 24,26, |32,36,40,44,48,52,56, | 90,120
29.97P 28, 30 60
23.98P 1,2,3,6,12,16,18,20, |32, 36, 40, 44, 48,52, 56, | 72, 96, 120
24.00P 22,24, 26, 28, 30 60
50.00P 1,5,15,25 34, 38, 42, 46, 50, 54, 58, | 75,100, 120
60
25.00P 1,5,15,17,19, 21, 23, 34, 38, 42, 46, 50, 54, 58, | 75,100, 120
' 25, 26, 28, 30 60

* The only available frame rates are 29.97P, 25.00P, 23.98P and 24.00P.
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Available shooting frame rates (XF-AVC)

Sensor mode Resolution

4096x2160
3840x2160
2048x1080

114 Full frame
- 1920x1080

Available range

4096x2160
Super 35mm 3840x2160

(Cropped) 2048x1080
1920x1080

Super 16mm 2048x1080
(Cropped) 1920x1080

Frame rate
59.94P

1,2,3,6,15, 30, 44, 48, 52, 56, 60

Shooting frame rate (fps)

90,120

29.97P

1,2,3,6,15,22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52, 56, 60

90,120

23.98P
24.00P

1,2,3,6,12,16, 18, 20, 22, 24, 26, 28, 30, 32, 36, 40, 44, 48, 52,

56, 60

72,96,120

50.00P

1,5,15, 25, 34, 38, 42, 46, 50, 54, 58, 60

75,100, 120

25.00P

1,5,15,17,19, 21, 23, 25, 26, 28, 30, 34, 38, 42, 46, 50, 54, 58,

60

75,100, 120

Available shooting frame rates (MP4)

Sensor mode Resolution

8192x4320
7680x4320

Avalable range

Full frame 4096x2160
3840x2160
2048x1080
1920x1080

4096x2160
Super 35mm 3840x2160

(Cropped) 2048x1080
1920x1080

Super 16mm 2048x1080
(Cropped) 1920x1080

Frame rate
59.94P

Shooting frame rate (fps)
1,2,3,6,15,30 44, 48, 52, 56, 60

90, 120

29.97P

1,2,3,6,15,22, 24,
26, 28, 30

1,2,3,6,15,22, 24, 32, 36, 40, 44, 48
26, 28, 30 56, 60

, 92, 190,120

23.98P
24.00P

1,2,3,6,12,16, 18,
20, 22,24

1,2,3,6,12,16, 18, 32, 36, 40, 44, 48
20, 22, 24,26, 28,30 | 56, 60

, 92, |72,96,120

50.00P

1,5,15,25 34, 38, 42, 46, 50
58, 60

, 54, 75,100,120

25.00P

1,5,15,17,19, 21, 23,
25

1,5,15,17,19, 21, 23, | 34, 38, 42, 46, 50
25, 26, 28, 30 58, 60

, 54, 75,100,120

1 To record audio, insert an SD card into the card slot where video is not being recorded.
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2 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Slow & Fast Motion] or [S&F
Clip/Audio (WAV)].
e Slow & fast motion recording is activated. [S&F STBY] appears on the screen and the shooting frame rate
appears next to the frame rate setting (the playback frame rate).
3 Select MENU > [£% Recording/Media Setup] > [Slow & Fast Frame Rate] > Desired frame rate.
® You can also choose a preset value (half, same or double the playback frame rate).
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4 Press the REC button to begin recording.
e The tally lamp changes from green (power indicator) to red.
* [S&F STBY] changes to [S&F @ REC] while recording.

5 Press the REC button again to stop recording.
e The clip is recorded on the selected card.
e When [S&F Clip/Audio (WAV)] is selected, a WAV file will be recorded on the card where video is not being
recorded.
¢ The tally lamp changes from red to green (power indicator) and the onscreen display changes back to [S&F
STBY].
6 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off
slow & fast motion recording.

(i) Nnotes

¢ The shooting frame rate cannot be changed while recording.

e |f you change the system frequency, slow & fast motion recording will be canceled and the shooting frame rate

will be reset to its default value.

About the time code when slow & fast motion recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode.

- If the time code running mode was set to [Free Run], the time code running mode will be changed
automatically to [Rec Run] when slow & fast motion recording is activated.

- When the special recording mode is turned off, the time code running mode will return to its previous setting.

- The time code signal will not be output from any terminal.

Recording WAV Files

- Audio is recorded with the following settings: 48 kHz, 24 bit, 4 channels.

- If video cannot be recorded due to a card problem, audio will also not be recorded.

- However, video will be recorded even if audio cannot be recorded due to a card problem.

- Audio will not be recorded if there is an existing WAV file with the same file name.

- Audio recording will stop automatically after reaching 60 minutes (video recording will continue).

- A maximum of 999 WAV files can be recorded.

Pre-recording

When pre-recording is activated, the camera starts recording continuously onto a temporary memory (approx.
3 seconds) so when you press the REC button, the clip will contain also a few seconds of video and audio
recorded before you pressed the button.

You can also use direct touch control to perform this function (] 56).

1 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Pre-Recording].
e [PRE STBY] appears on the screen.

2 Press the REC button to begin recording.
e The tally lamp changes from green (power indicator) to red.
¢ [PRE STBY] changes to [PRE @ REC] while recording.
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3 Press the REC button again to stop recording.

e The clip is recorded. The recorded clip will include a few seconds of video and audio recorded before the
REC button was pressed.

e The tally lamp changes from red to green (power indicator) and the onscreen display changes back to [PRE
STBY].

4 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop pre-
recording.

(i) Notes

e Pre-recording will be canceled if the recording mode is changed.
e About the time code when pre-recording is activated:
- The time code of the clip will start a few seconds before the REC button was pressed.
- The time code will be recorded with the running mode set to [Free Run].
- If the time code mode was set to [Regen.], or to [Preset] with [Rec Run] running mode, the time code
running mode will be changed automatically to [Free Run] when pre-recording is activated.
- When the special recording mode is turned off, the time code running mode will return to its previous
setting.

Frame Recording Mode

Set the number of frames in advance. We recommend operating the camera remotely or stabilizing the camera,
for example, on a tripod. Sound is not recorded in this mode.
You can also use direct touch control to perform this function (11 56).

1 Select > [£% Recording/Media Setup] > [Recording Mode] > [Frame Recording].
e [FRM STBY] appears on the screen (with [FRM] flashing).

2 Select > [ £¥ Recording/Media Setup] > [Frame Rec: Frame Rate] > Desired option.

3 Press the REC button to begin recording.
e The tally lamp illuminates in red.
¢ [FRM STBY] changes to [FRM @REC] while recording.
e The camera automatically records the specified number of frames.
4 Repeat until you finish recording.
5 Select > [ £% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop frame
recording.
® Frame recording mode ends and all of the recorded frames are joined together into one clip.
e The tally lamp illuminates in green and [STBY] appears on the screen.

(i) Notes

e Frame recording cannot be used simultaneously with slow & fast motion recording, pre-recording, interval
recording or continuous recording.

e Frame recording cannot be used when the frame rate is set to 59.94i or 50.00i. When in use, frame recording
will end if the frame rate is set to 59.94i or 50.00i.

e The number of frames recorded cannot be changed while recording.
e Some frames at the point the recording was stopped may be recorded and added to the end of the clip.
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¢ About the time code when frame recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. The time code
advances by the number of frames recorded every time.

- If the time code running mode was set to [Free Run] or the camera was synchronized to an external time
code signal, the time code running mode will be changed automatically to [Rec Run] when frame recording 117
is activated. -

- When the special recording mode is deactivated, the time code running mode will return to its previous
setting.

- The time code signal will not be output from the TIME CODE terminal or HDMI OUT terminal.

Interval Recording Mode

Set the interval and number of frames in advance. Sound is not recorded in this mode.
You can also use direct touch control to perform this function ([1] 56).

1 Select > [£% Recording/Media Setup] > [Recording Mode] > [Interval Recording].
e [INT STBY] appears at the top of the screen (with [INT] flashing).

2 Select > [ £¥ Recording/Media Setup] > [Interval Rec: Time Interval] > Desired option.
3 Select > [£¥ Recording/Media Setup] > [Interval Rec: Frame Rate] > Desired option.

4 Press the REC button to begin recording.
e The tally lamp illuminates in red.
¢ [INT STBY] changes to [INT @REC] while recording.
e The camera automatically records the set number of frames at the specified interval.

5 Press the REC button again to stop recording.
e The tally lamp illuminates in green and [INT STBY] appears at the top of the screen (with [INT] flashing).

6 Select > [ 2 Recording/Media Setup] > [Recording Mode] > [Normal Recording] to stop interval
recording.

(i) NoTES

¢ |nterval recording cannot be used simultaneously with slow & fast motion recording, pre-recording, frame
recording or continuous recording.

¢ |nterval recording cannot be used when the frame rate is set to 59.94i or 50.00i. When in use, interval
recording will end if the frame rate is set to 59.94i or 50.00i.

¢ The interval and the number of frames recorded cannot be changed while recording.

e Some frames at the point the recording was stopped may be recorded and added to the end of the clip.

¢ About the time code when interval recording is activated:

- The time code mode can be set to [Regen.], or to [Preset] with [Rec Run] running mode. The time code
advances by the number of frames recorded every time.

- If the time code running mode was set to [Free Run] or the camera was synchronized to an external time
code signal, the time code running mode will be changed automatically to [Rec Run] when interval recording
is activated.

- When the special recording mode is deactivated, the time code running mode will return to its previous
setting.

- The time code signal will not be output from the TIME CODE terminal or HDMI OUT terminal.
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Continuous Recording

Audio and video are recorded on both cards in this mode, normal recording on card 1, and continuous recording
on card 2. This function can be used when the main recording format is set to MP4. Video will be recorded in
MP4 format and audio will be recorded in linear PCM format.

With the exception of step 5, you can also use direct touch control to perform this function ([J1] 56).

1 Insert a card into each card slot (slot 1 for normal recording, slot 2 for continuous recording).

2 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [[ilMain / QContinuous Rec].
e The continuous recording mode is activated and [CONT] appears on the screen next to the card 2 indicator.

3 Select MENU > [£% Recording/Media Setup] > [Continuous Recording] > [REC].
¢ The tally lamp changes from green (power indicator) to red and continuous recording starts on card 2. The
onscreen display changes to [@ CONT].
4 Press the REC button to start recording.
e Normal recording on card 1 starts.
e |f you press the button before step 3, recording will start on both cards.

5 Select MENU > [£% Recording/Media Setup] > [Continuous Recording] > [STBY].
¢ The tally lamp changes from red to green (power indicator) and recording stops on both cards. The
onscreen display changes to [CONT].

6 Select MENU > [£% Recording/Media Setup] > [Recording Mode] > [Normal Recording] to turn off
continuous recording.

(i) Notes

¢ When continuous recording is activated, if recording on card 2 (continuous recording) is not available, normal
recording will not be possible either.

e Continuous recording will continue even if card 1 becomes full.

e |f [Continuous Recording] is set to [STBY] and the main recording format is changed to an option other than
MP4, continuous recording will be canceled.
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Using Anamorphic Lenses

You can attach an anamorphic lens to the camera and set the anamorphic desqueeze ratio used to display the
image from the camera on monitoring devices while shooting or during playback.

1 Select MENU > [[Z) Monitoring Setup] > Desired [Anamorphic:] setting > [On].
2 Select MENU > [(Z) Monitoring Setup] > [Anamorphic Desqueeze] > Desired option.

3 If necessary, select MENU > [[Z) Monitoring Setup] > [Desqueeze for S&F] > [Reduced Display].

¢ When slow & fast motion recording is activated, the desqueezed image can only be displayed windowboxed
(IReduced Display]).

Options

[Lens Squeeze Factor]:
The desqueeze factor is linked to the MENU > [£% Recording/Media Setup] > [Metadata] >
[Lens Squeeze] setting.

[x2.0]: Stretches the video horizontally by a factor of 2.
[x1.8]: Stretches the video horizontally by a factor of 1.8.
[x1.3]: Stretches the video horizontally by a factor of 1.3.

(i) NoTES

* You can record the lens’s squeeze factor in the clip’s metadata with the MENU > [ £% Recording/Media
Setup] > [Metadata] > [Lens Squeeze] setting.

e |f [Anamorphic: HDMI] is set to [On] when the HDMI OUT terminal’s resolution is set to [4096x2160 /
3840x2160] and the frame rate is set to 59.94P or 50.00P, the video output from the HDMI OUT terminal will
be a 1920x1080 image.

¢ The image displayed during photo playback and the camera’s live view image in the Browser Remote
application will not be desqueezed.
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Web Camera Function

Web Camera Function

You can connect the camera to a computer using an interface cable, and use the camera as a web camera (with
compatible software). Only video can be recorded while using this function. For more details about supported
120 operative systems or software tested for use with the camera, visit your local Canon website. For more details,

— refer to the computer’s instruction manual.

When connecting the camera to a computer, use the included interface cable or a Canon cable.

When connecting an interface cable, also use the included cable protector. Using the cable protector helps

prevent accidental disconnection and terminal damage.

For details on the cable protector, refer to the Advanced User Guide (PHOTO edition).

Computer
USB terminal
Interface cable
Video output configuration
Main resolution Video format Resolution Frame rate
7680x4320, 3840x2160, 1920x1080, 1280x720 ) 1024x576 )
Motion JPEG 30 fps (maximum)
8192x4320, 5952x3140, 4096x2160, 2976x1570, 2048x1080 1088x576

1 Select MENU > [¥ System Setup] > [USB Mode] > [Video Output (UVC)].

2 Connect the camera to a computer.

3 Open the desired compatible software on the computer.

4 When the connection ends, disconnect the interface cable from the camera.

(i) NoTES

¢ This function cannot be used simultaneously with the Browser Remote function (11 177), while shooting
photos or during IP streaming.
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Assignable Buttons

The camera offers a number of assignable buttons to which you can assign various function. Assign often-used
functions to the buttons you find most convenient to personalize the camera to your needs and preferences.
You can find 13 assignable buttons on the camera’s body. In most cases, the names of the buttons printed on
the camera and accessories also indicate their default settings.

Changing the Assigned Function
Functions can be set separately in CAMERA mode and MEDIA mode.

1 Press the MENU button and, while holding it pressed down, press the assignable button whose
function you wish to change.

e A list of available functions appears.
e You can also select the appropriate menu setting from the various pages of the MENU > [@ Assignable
Buttons] menu.
2 Select the desired function.
® The selected function will be assigned to the selected button.

3 If you selected [User Setting], select the menu setting you want to register.

e The selected menu setting will be assigned to the selected button. User-selected settings will be indicated
with a icon in the [@ Assignable Buttons] menu.

4 Press the assignable button to use the assigned function as described in the following table.
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(i) notes

¢ You can check the [@ Assignable Buttons] status screens (11 200) to see what functions are currently
assigned to each button.

¢ You can reset only the functions assigned to the assignable buttons, without affecting other camera settings,
with the MENU > [ System Setup] > [Reset] > [Assignable Buttons] function. All the assignable buttons will
return to their default function.

Assignable functions
Functions whose names include a video output destination (LCD, terminal name) affect only the specified video

output, while [All] indicates the function affects all video outputs.

. _ CAMERA ~ MEDIA

Function name Description mode mode (R
[One-Shot AF] The camera focuses automatically one time only (one-shot AF function). o - 88
[AF Lock] Turns the AF lock function on/off.
[AF Lock (While Pressed)]1 Activates the AF lock function while the button is held pressed down. i - %
[AF Frame] Toggles the size of the AF frame. o - 920
[Focus Mode] Toggles the focus mode between AF (autofocus) and MF (manual focus). o - 85
[Face AF] Toggles the [Face AF] setting between [Face Priority] and [Face Only]. o - 91
[Face Det. & Tracking] Turns the face detection & tracking function on/off. o - 91
[Eye Detection] Turns eye detection on/off. o - -
[Tracking] Enters/cancels tracking standby mode. o - 92
[Focus Guide] Turns the focus guide on/off. o - 86
[Peaking: All],
E::z::::g \I;(;]D] Turns peaking on/off. o - 87
[Peaking: HDMI]
[Magnification],
ng; \I;%D] Turns magnification on/off. o - 87
[Magn.: HDMI]
[Push Auto Iis] ;?:32221::,\, 'crl]lljtomatically adjusts the aperture only while the button is held ° _ 80
[Iris Mode] Switches the aperture adjustment mode between automatic and manual. o - 78
[Iris +], [Iris -] Opens up/closes the aperture, respectively. ( J -
[Base 1SO] Switches between base ISO speed settings. o - 75
[ISO/Gain Mode] Switches between automatic and manual mode. o - 74
[AE Shift +], [AE Shift -] Compensates the exposure making the image brighter/darker, respectively. o - 81
[Backlight], [Spotlight] ::fiiii\:ﬁ, .Ilght metering mode between [Standard] and [Backlight]/[Spotlight], ° _ 81
Egg::? C:_I]] E:g: I:(I;IIDV]II] Turns zebra patterns on/off. o - 97
mm Cg mm I:(I;IKI]II] Turns the selected video scope on/off. o [ ) 107
[View Assist: All],
[%:x 2:2::: \I;(;]D] Turns view assistance on/off. o - 152
[View Assist: HDMI]




Assignable Buttons

. _— CAMERA ~ MEDIA
Function name Description mode mode M
[False Color: Allj,
[False Color: LCD],
[False Color: VF], Turns the false color overlay on/off. ° _ o7
[False Color: HDMI]
[False Color Index] Displays/hides the false color index screen.
(White Balance] Enters the dll’EF)t setting mode with the white balance mode highlighted and P B 82
ready to be adjusted.
[Set White Balance] Starts the white balance calibration for a custom white balance setting. o - 82
[AWB Lock]1 While using auto white balance (AWB), locks the current white balance settings. o - 84
([} AWB],
[n®% Set A], [ Set B], [:8
Daylight], Changes the white balance mode/setting to the respective option. ] - 82
[¢ Tungsten],
[C4 Kelvin]
[Digital IS] Turns the digital image stabilizer (digital IS) on/off. ° 93
[Pause Digital IS]1 Turns digital IS off as long as the button is held pressed down.
(LCD Setup], [VF Setup] Opens the [ Monltorlng Setup] menu page with the settings for adjusting the P P 190
LCD screen/viewfinder.
[OSD Output: HDMI] Turns the camera’s onscreen displays on/off. ] o 149
[OSD Opacity: All],
[0OSD Opacity: LCD], )
(0SD Opacity: VF], Changes the transparency level of onscreen displays. o o 149
[OSD Opacity: HDMI]
[DISP] Changes the onscreen display level. L [ ] 52
. L Changes the onscreen display direction in the following order: standard, _
[0SD Orientation: LCD/VF] 90 degrees rotation (to the left), 90 degrees rotation (to the right). ¢ 54
[Markers: All],
[Markers: LCD], B
[Markers: VF], Turns onscreen markers on/off. o 95
[Markers: HDMI]
[Color Bars] Turns color bars on/off. ] - 106
[IP Streaming] Turns the IP streaming function on/off. o - 175
[Photo]' Records a photo. o - 48
[Review Reo:ording]1 Plays back the last clip recorded in CAMERA mode. o - 55
[Time Code] Opens the [§ System Setup] menu page with the time code settings. o - 98
[Add Shot Mark]' Adds a shot mark to the clip. o ([ J 109,
[Add [Id Mark], . 142,
[Add 1 Mark] Adds an [ or [ mark to the clip. ] o 142
[Headphones +], Increases/reduces the headphone volume, respectively. ] @ 139
[Headphones -]
: - ) -
[Monitor Channels] S\A{ItC.hES the audio channels output from the ) (headphone) terminal and the P ° 153
built-in speaker.
[Audio Level Indicator] Turns the audio level meter on/off. ] o 104
[FUNC] Enters the direct setting mode. ] - 57
[Slow & Fast Motion] Turns slow & fast motion recording on/off.
(Slow & Fast Frame Rate] Whep slow & fast motpn recording is activated, highlights the shooting frame
rate in order to adjust it.

123



124

Assignable Buttons

. _ CAMERA ~ MEDIA
Function name Description mode mode (A
[Output: 60 < 60 (24) fps] 2 When the frame rate is 59.94P or 59.94i, toggles the frame rate of video output
[Output: 60 < 60 (30) f 5]112’ terminals and the LCD screen between said frame rates and 24 fps or 30 fps, (] - -
put p respectively.
. Enters the direct setting mode with the aperture value highlighted and ready to
[Iris] ) [ ] - 78
be adjusted.
[Shutter] En.ters the direct setting mode with the shutter speed highlighted and ready to be ° _ 72
adjusted.
[1S0/Gain] Enters the d|reF:t setting mode with the ISO speed or gain value highlighted and ° _ 75
ready to be adjusted.
[Display Panel Info] Switches the information displayed on the LCD panel. o - -
[Status]' Displays the status screens. o @ 197
i ) i .
[Audio Status]‘ Displays the [ ) Audio Setup] status screens. You can press SET to open the ° PY 201
[dM) Audio Setup] menu.
[Disp. Card Slot Temp. Info]1 Displays the temperature of the card slot. o [ J -
[MENU] Displays the menu. o [ J -
[Custom Picture] Opens the [[®@& Custom Picture] menu. o - 125
[Assignable Button Setting] | Displays the assignable button settings. o [ J -
[My Menu] Opens the [ Y& My Menu] customized menu. o - 24
[Initialize Media] Opens the [Initialize Media] submenu. o [ J 35
[Play/Pause] Pauses and resumes the playback. - [ J 136
[INDEX/Cancel Resume] Returns to the index screen. The next time the clip is selected, playback will start
from the beginning. ° 136
[INDEX] Returns to the index screen. The next time the clip is selected, playback will start
from the frame where it stopped.
[Key Lock] Turns key lock on/off. Can only be assigned to assignable button Camera 9. o [ J 25
[REC] Functions as the REC button. Can only be assigned to assignable button ° _ 47
Camera 10/13.
[Slot Selection] Switches between card slots. o [ J 36
((E0 User Setting]1 Customizable slot. Assign to the button any menu setting you would like to ° PY _

register.

! Function can be used only by assigning it to a button.
2 Only during normal recording/frame recording/interval recording.



Custom Picture Settings

Custom Picture Settings

The camera lets you change many settings (11 129) that control various aspects of the image produced. As a
set, all these settings are treated as a single custom picture file. After adjusting the desired settings to your
preference, you can save up to 20 custom picture files (in the camera or on an SD card), and load them later to
apply exactly the same settings ([J1 128). You can also save the custom picture file as part of the metadata

recorded with XF-AVC clips (1] 128).

Custom picture settings do not affect the recording or output of RAW clips.

Selecting Custom Picture Files

In CAMERA mode, select a custom picture file to apply its settings to your recordings or to edit, rename, protect,

or transfer it.

1 Select MENU > [[@d Custom Picture] > [Select File].
e The custom picture file selection screen is displayed.

e Select one of the custom picture files saved in the camera (C1 to C20). To use the settings of a custom
picture file saved on an SD card, copy the file to the camera in advance ([J] 128).

* You can also use direct touch control's g% recording settings (11 56).
2 Select the desired file.
* \When you close the menu, the selected custom picture file’s settings will be applied.

Preset Picture Settings

The following settings are saved to custom picture files C1 to C20 as preset custom picture settings. Custom
picture files C1 to C7 are protected by default and need to be unprotected before they can be edited.

Pre; et cugtom [Gamma/Color Space]  [Color Matrix]  [Look File] Characteristics
picture file
C1: [BT.709 [BT.709 Wide DR / Neutral] B These settings produce a wide dynamic range and are appropriate
Wide DR] BT.709] for playback on BT.709 compliant monitors.
[Canon Log 3 / These settings use Canon Log 3 gamma and require post-
C2: [Canon Log 3] 9 [Neutral] - production processing. They keep the [Canon Log] gamma
C.Gamut] L . . .
characteristics while expanding its dynamic range.
) B These settings use a high dynamic range gamma curve compliant
C3: POy [PQ/BT.2020] [Neutral with the PQ standard defined by ITU-R BT.2100.*
) _ These settings use a high dynamic range gamma curve compliant
C4: HLG] [HLG / BT.2020] Neutral] with the HLG standard defined by ITU-R BT.2100.*
05: [BT.709 [BT.709 Standard / . Thes.e settings are appropriate for playback on BT.709 compliant
[Video] - monitors, and use a gamma curve that meets ITU-R BT.709
Standard] BT.709]
standards.
. [BT.709 Wide DR / Reproduces the image quality and look of an EOS interchangeable
C6: [EOS Standard] BT.709] [Neutral] N lens DSLR camera with its picture style set to [Standard].
: [BT.709 Wide DR / Reproduces the image quality and look of an EOS interchangeable
C7: [EOS Neutral] BT.709] [Neutral O Jens DSLR camera with its picture style set to [Neutral].
(C8: [User08] to [BT.709 Wide DR / Neutral] B These settings use a gamma curve with a very wide dynamic
C20: [User20] BT.709] range, optimized for playback on BT.709 compliant monitors.

* [TU-R BT.2100 is a standard for a color bit depth of 10 or 12 bits. When the video configuration is set to one of the 8 bit color
options, the gamma curve is approximately equivalent to this standard.
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(i) notes

About the logarithmic gamma curves (Canon Log settings)
- These gamma curves require post-production processing. They were designed to make the most of the
imaging sensor characteristics in order to obtain impressive levels of dynamic range.

- In CAMERA mode, you can apply a LUT to the LCD screen, viewfinder or the video output from the HDMI
OUT terminal to use gamma curve settings more suitable for viewing on a monitor screen.

- There are also other LUTs available that can be applied for processing in post-production. For the latest
information on available LUTs, please visit your local Canon website.

Editing a Custom Picture File’s Settings

In CAMERA mode, adjust the image quality to your preference and save the settings as part of a custom picture
file.

1 Select a custom picture file ([J] 125).
2 Select MENU > [[@@ Custom Picture] > [Edit File].
e Select an unprotected custom picture file.

3 Select a setting you wish to change and select the desired option.
¢ Refer to Available Custom Picture Settings ([11 129) for details on the various settings.

Renaming Custom Picture Files
1 Select a custom picture file (11 125).

2 Select MENU > [[@ Custom Picture] > [Edit File] > [Rename] > [Input].
¢ Enter the desired file name (16 characters long) (1] 25).

Protecting Custom Picture Files
Protecting a custom picture file prevents its settings from being accidentally changed.
1 Select a custom picture file (11 125).
2 Select MENU > [[@d Custom Picture] > [Edit File] > [Protect] > [Protect].
e [od will appear next to the file name.
e To remove the protection, select [Unprotect] instead.

Resetting Custom Picture Files
1 Select a custom picture file (1] 125).
2 Select MENU > [[@ Custom Picture] > [Edit File] > [Reset].

3 Select a preset custom picture setting and then select [OK].
e The custom picture file will be reset to the selected values.
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Look Files

You can register 3D LUT files (.cube format) created with Blackmagic Design’s DaVinci Resolve or other software
as Look Files in the custom picture file. Using a Look File allows you to adjust the video quality of the recorded
video. These adjustments apply also to proxy clips, photos, and screen/output terminals.

1 Insert the SD card with the desired Look File (.cube format, located in the root directory of the SD
card) into the camera’s card slot 2.

2 Select a custom picture file. (] 125)
3 Select MENU > [[@@ Custom Picture] > [Edit File] > [Gamma/Color Space] > Desired option.

4 Select MENU > [[@ Custom Picture] > [Edit File] > [Look File Setup] > [Register].
e The Look Files in the SD card will be displayed.

5 Select the desired Look File.
6 Select the [Gamma/Color Space] setting to use after the Look File is applied.

7 Select [OK] twice.
® The selected Look File will be loaded and registered to the custom picture file.
e The image quality adjustments set in the Look File will be applied, and will appear on the screen.

¢ When disabling the image quality adjustments set in the Look File, select MENU > [[@d Custom Picture] >
[Edit File] > [Look File] > [Off].

(i) notes

About Look files
- The camera supports Look Files (.cube format) in 17 grid or 33 grid format created with Blackmagic
Design’s DaVinci Resolve or other software.
- Look Files with input ranges outside the 0 to 1 range in the header (“‘LUT_3D_INPUT_RANGE”) are not
supported.
- Look Files 2 MB and larger, as well as files with a name containing over 65 characters are not supported.
- Only the following characters can be used in the file name:
Numbers 0 to 9, upper/lower case letters a to z, underscore (_), hyphen (-), period (.) and a single byte
space.
e |f the correct input/output gamma curve and color space conversion are not selected, video will not be output
correctly.
e A Look File cannot be used if the [Gamma/Color Space], [HLG Color] or [Over 100%] settings are changed
after registering it.
¢ \When the gamma curve component of the [Gamma/Color Space] setting in the custom picture is set to either
[BT.709 Normal], [BT.709 Standard] or [BT.709 Wide DR], super-white (video signal above 100%) and super-
black (video signal below 0%) levels of brightness will be clipped. When the video signal contains super-white
brightness levels, select MENU > [[@d Custom Picture] > [Edit File] > [Other Functions] > [Over 100%] >
[Press] and then activate the Look File to apply it to a signal compressed to 100%.
¢ When playing RAW clips, the Look File registered when the clip was recorded will only be applied to the
thumbnail and not the clip itself.

Deleting a Look File
You can delete Look Files registered in custom picture files.

1 Select a custom picture file (1] 125).
2 Select MENU > [[@ Custom Picture] > [Edit File] > [Look File Setup] > [Delete] > [OK].

e The Look File will be deleted and the image quality adjustments will be reversed to the original settings of the
selected custom picture file.
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Saving a Custom Picture File

Copying Custom Picture Files

You can copy custom picture files between the camera and SD card. Insert in advance into the camera the card
where you want to save your custom picture files or the card that contains the custom picture file you want to
load.

Saving a File from the Camera to an SD Card

1 Select a custom picture file (1 125).

2 Select MENU > [[@d Custom Picture] > [Save File] > [Save to SD Card].
3 Select the destination file on the card and then select [OK].

e Select an existing custom picture file to overwrite it or [New File] to save the settings as a new custom
picture file on the card.

4 When the confirmation message appears, press SET.

(i) NoTES

e Custom picture files are exclusively compatible for use only with the same camera model.

Replacing a File in the Camera with a File on an SD Card

1 Select the custom picture file that you wish to replace (11 125).

2 Select MENU > [[@ Custom Picture] > [Save File] > [Load from SD Card].

3 Select the file with the settings that you want to replicate and then select [OK].
e The file in the camera will be overwritten by the one on the card.

4 When the confirmation message appears, press SET.

Embedding the Custom Picture File in Clips (CAMERA Mode)

When you record in XF-AVC format after having set custom picture settings, you can have the custom picture file
embedded in the metadata and saved along with the clips. When displaying the information screen in MEDIA
mode, you can check the custom picture settings used at the time of recording.

Select MENU > [£% Recording/Media Setup] > [Metadata] > [Add File] > [On].
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Available Custom Picture Settings
Setting options in boldface indicate default values.

Menu items Options / Additional information
[Gamma/Color Space] [Canon Log 3/ C.Gamut], [Canon Log 3 / BT.2020], [Canon Log 3 / BT.709], [PQ / BT.2020], 129
[HLG / BT.2020], [BT.709 Wide DR / BT.2020], [BT.709 Wide DR / BT.709],
[BT.709 Normal / BT.2020], [BT.709 Normal / BT.709], [BT.709 Standard / BT.709]

Combination of gamma curve and color space settings that affects the overall look and color space of
the image.

Gamma curve

[Canon Log 3]: Logarithmic gamma curve that keeps the characteristics of the [Canon Log] setting

— BT709 Normal / while expanding its dynamic range. Requires image processing in post-production.

L svT.d;OS ;ﬁa”da'd [PQ]: HDR (high dynamic range) gamma curve compliant with the PQ standard defined by ITU-R

o hlG BT.2100.*

- g‘;ﬂm Log 3 [HLG]: HDR (high dynamic range) gamma curve compliant with the HLG standard defined by ITU-R

BT.2100.*

[BT.709 Wide DR]: Gamma curve with a very wide dynamic range. Optimized for playback on BT.709
compliant monitors.

[BT.709 Normal]: Gamma curve that produces darker dark areas and reduced contrast in the
highlights, compared to the ITU-R BT.709 standard. Optimized for playback on BT.709 compliant
monitors.

[BT.709 Standard]: Gamma curve that meets ITU-R BT.709 standards, for playback on BT.709
compliant monitors.

* ITU-R BT.2100 is a standard for a color bit depth of 10 or 12 bits. When the video
configuration is set to one of the 8 bit color options, the gamma curve is approximately
equivalent to this standard.

Output

Input

Color space

[C.Gamut]: Color space developed by Canon based on the specific characteristics of the camera’s
imaging sensor. It covers a wider color gamut than that of BT.2020. Use this setting with
workflows that require ACES2065-1 color space.

[BT.2020]: Color space that meets ITU-R BT.2020 standards, which defines parameters for ultra-
high-definition television (4K/8K).

[BT.709]: Standard color space that is compatible with SRGB specifications.

[Color Matrix] [Neutral], [Production Camera], [Video]

The color matrix affects the overall color tonality of the image.
[Neutral]: Reproduces neutral colors.
[Production Camera]: Reproduces colors more suitable for motion picture production.
[Video]: Reproduces colors with a contrast suitable for TV broadcasting.
[Look File] [On], [Off]

Image quality adjustments set in the Look File will be applied.

[Look File Setup]

[Register] Registers a Look File (.cube format) to a custom picture file.
[Delete] Deletes a Look File registered to a custom picture file.
[HLG Color] [BT.2100], [Vivid]

Changes the quality of color reproduction when using the hybrid log gamma (HLG). This setting is

only available when [Gamma/Color Space] is set to [HLG / BT.2020].

[BT.2100]: Color reproduction according to ITU-R BT.2100 specifications.

[Vivid]: More saturated color reproduction according to the ‘Traditional Colour' approach in ITU-R
BT.2390.
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Menu items Options / Additional information
[Black]

[Master Pedestal] —-50 to +50 (x0)
Increases or decreases the black level. Higher settings will make dark areas brighter but decrease
contrast. This setting is not available when the gamma curve component of the [Gamma/Color
Space] setting is set to one of the [Canon Log 3] options.

[Master Black Red], -50 to +50 (x0)

[Master Black Green, These settings correct the color cast in blacks. These settings are not available when the gamma

[Master Black Blue]

curve component of the [Gamma/Color Space] setting is set to one of the [Canon Log 3] options.

[Black Gamma]

[Level]

-50 10 +50 (0)

[Range], [Point]

[Point] A

Level
R
=4

iqRange]»f

Output

Input

~20 10 +50 (0)

These settings control the lower part of the gamma curve (dark areas of the image). These settings
are only available when the gamma curve component of the [Gamma/Color Space] setting is set to
one of the [BT.709 Normal] or [BT.709 Standard] options.

[Level]: Raises or lowers the lower part of the gamma curve.

[Range]: Selects the adjustment range from the selected [Point].

[Point]: Determines the shape of the lower part of the gamma curve.

[Low Key Saturation]

[Activate] [On], [Off]
Set this setting to [On] to enable the adjustment of color saturation in dark areas with the [Level]
setting.

[Level] —50 to +50 (x0)
Specifies how saturated colors are in dark areas.

[Knee]

[Activate] [On], [Off]
Set this setting to [On] to enable the adjustment of the knee point with the following settings. These
settings are only available when the gamma curve component of the [Gamma/Color Space] setting is
set to one of the [BT.709 Normal] or [BT.709 Standard] options.

[Slope] —-35 o +50 (+0)

[Point] 50 to 109 (95)

[Saturation] —10to +10 (x0)

[Slope]

Output

[Point]

Output

Input

These settings control the upper part of the gamma curve (highlights of the image). By compressing
the highlights, you can prevent parts of the image from being overexposed.

[Slope]: Determines the slope of the gamma curve above the knee point.

[Point]: Sets the knee point of the gamma curve.

[Saturation]: Adjusts the color saturation in the highlights.
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Menu items Options / Additional information
[Sharpness]
[Level] -10to +50 (x0)
Sets the sharpness level of the video output signal and the recorded signal.
[Detail Frequency] -8 t0 +8 (x0)

Sets the center frequency of horizontal sharpness. Setting higher values increases the frequency,
which, in turn, increases the sharpness.

[Coring Level]

-30 t0 +50 (+0)

Sets the level of correction of artifacts caused by high sharpness levels (coring). Higher values
prevent sharpness from being applied to minute details, resulting in less noise.

[Limif]

—-50 to +50 (+0)
Restricts how much sharpness is applied.

[Noise Reduction]

[Automatic]

[0ff], [On]

[Spatial Filter]

[0ff], 10 12

Reduces noise by applying a soft focus-like effect on the entire picture. When set to a value other
than [Off], afterimages are not produced but the whole image will have a softer look.

[Frame Correlation]

[0ff], 110 3

Reduces noise elements by comparing the current image to the previous one (field). When set to a
value other than [Off], the perceived resolution will not be affected but an afterimage may appear for
moving subjects.

[Skin Detail]
[Effect Level] [0ff], [Low], [Middle], [High]
[Hue] —16 to +16 (+0)
[Chroma], [Area], [Y Level] 01to 31 (16)

The camera applies a softening filter to areas in the picture with skin tones to give a more pleasant
appearance. By changing these settings, you can determine what areas will be detected as skin
tones. A zebra pattern will appear on the screen or video output terminal over areas of the image that
are detected as having skin tones.

[Effect Level]: Adjusts the level of the filter.

[Hue]: Adjusts the hue for detection of skin tones.

[Chroma]: Adjusts the color saturation for detection of skin tones.

[Area]: Adjusts the color range for detection of skin tones.

[Y Level]: Adjusts the brightness for detection of skin tones.

[Color Matrix Tuning]
[Gain] -50 to +50 (x0)
[Phase] —-18t0 +18 (x0)

These settings adjust the color intensity ([Gain]) and color phase ([Phase]) of the color matrix,
affecting the color tones of the whole image.

[R-G], [R-B], [G-R], [G-B],

[B-R], [B-G]

—-50 to +50 (+0)

Each matrix changes the tint of the picture along the color gradations detailed below, affecting the
color tones of the whole image.

[R-GJ: cyan/green and red/magenta; [R-B]: cyan/blue and red/yellow;

[G-R]: magenta/red and green/cyan; [G-B]: magenta/blue and green/yellow;

[B-R]: yellow/red and blue/cyan; [B-G]: yellow/green and blue/magenta.

131



132

Custom Picture Settings

Menu items
[White Balance]

Options / Additional information

[R Gain], [B Gain]

-50 10 +50 (0)

These settings adjust the amount of white balance throughout the whole image by changing the
intensity of red tones ([R gain]) and blue tones ([B Gain]).

[Color Correction]

[Select Area]

[Off], [Area A], [Area B], [Area A&B]

The camera detects areas with certain color characteristics (color phase, chroma, area and Y level)
and corrects them when recording. You can set the color correction for up to two different areas

(A and B) and apply the color correction to either one ([Area A] or [Area B]) or both of them ([Area
A&BY).

While color correction is activated, parts of the image that are not detected as having the
characteristics specified for area A or B will appear colorless on the screen or the image output from
the output terminals (except when adjusting the [Revision Level]/[Revision Phase] settings).

[Area A Setting Phase],
[Area B Setting Phase]

0to 31 (0)
These settings determine the color phase of the area to be corrected (A or B, respectively).

Area A Setting Chroma],
Area B Setting Chromal],
Area A Setting Area],
Area B Setting Area],
Area A Setting Y Level],
Area B Setting Y Level]

010 31 (16)

These settings determine the following color characteristics of the area to be corrected (A or B,
respectively).

[Area A Setting Chroma], [Area B Setting Chroma]: Color saturation.

[Area A Setting Area], [Area B Setting Area]: Color range.

[Area A Setting Y Level], [Area B Setting Y Level]: Brightness.

[Area A Revision Level],
[Area B Revision Level]

-50 to +50 (x0)

These settings adjust the amount of correction applied to the color saturation in the corrected area
(A or B, respectively).

[Area A Revision Phase],
[Area B Revision Phase]

—18t0 +18 (+0)

These settings adjust the amount of correction applied to the color phase in the corrected area
(A or B, respectively).

[Other Functions]

[Over 100%]

[Through], [Press], [Clip]

Determines how the camera handles video signals exceeding 100%. This setting is not available
when the gamma curve component of the [Gamma/Color Space] setting is set to one of the
[Canon Log 3], [PQ] or [HLG] options.

[Through]: Leave the signal unchanged.

[Press]: Compress a signal of up to 108% down to 100% levels.

[Clip]: Clip the signal at 100%.

(1) notes

* Depending on other menu settings, you may not be able to obtain the desired image effect even after
changing the custom picture settings.
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Saving and Loading Menu Settings

After you adjust settings in the various menus, you can save those settings in the camera or on the SD card in
slot 2. This function only saves settings adjusted in VIDEO mode. You can load those settings at a later date or
on another camera of the same model so that you can use that camera in the same way.

Saving Menu Settings
1 Select MENU > [¥ System Setup] > [Transfer Menu/[€d] > [Save].

2 Select [To Camera] or [To SD Card] and then select [OK].

e The camera’s menu settings will be saved to the selected destination. If menu settings were previously
saved, the old file will be overwritten by the current menu settings.

Loading Menu Settings
1 Select MENU > [¥ System Setup] > [Transfer Menu/[€] > [Load].

2 Select [From Camera] or [From SD Card] and then select [OK].

® The camera’s menu settings will be replaced by the settings in the previously saved file. Then, the screen will
turn black momentarily and the camera will restart.

(i) NoTES

¢ The following menu settings are not saved with this operation.
- MENU > ["® Camera Setup] > [Color Bars]
- MENU > [£% Recording/Media Setup] > [Metadata] > [User Memo], [News Metadata]
- MENU > [ Assistance Functions] > [Magnification], [Magn. Output]

e The root certificate for secure FTP transfers is not saved.

¢ \When menu settings are loaded with this operation, even protected custom picture files in the camera will be
replaced.
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135
Playback

This section explains how to play back files recorded with the camera. For details on playing back recordings
using an external monitor, refer to Connecting to an External Monitor or Recorder ([1] 147).

Displaying the Index Screen

Press the MEDIA button ([ 14)

e The camera is set to MEDIA mode and the clip thumbnails will appear in the index screen.
e Use the joystick or the SELECT dial to move the orange selection frame.

e Flick up/down on the screen or turn the grip control dial to move to the next/previous page.

7 8 9 10

1 Key lock ([1] 25) 11 Power supply level ([11 51)
2 Shot mark’ (M 142) 12 Clip number / Total number of clips
3 [ mark'/M mark' ({0 142) 13 Recording date (month and day only) and time
4 Proxy clip (11 70) 14 Orange selection frame
5 Clip identification (camera index, reel number, clip 15 Clip’s start time code
number and clip/audio file name) (11 40) 16 Clip duration
6 Recording date and time 17 Custom picture file embedded’ (1] 128)
7 Network status / functions ([J1 173) 18 Special recording mode (1] 113)
8 Recording media 19 Color sampling1 and resolution, audio recording
e An orange dot will be displayed next to the card format
currently selected. * For RAW clips, the RAW mode (HQ/ST/LT) and
9 Index screen currently displayed resolution are displayed.
10 Clip thumbnail 20 Frame rate? (Me2)

T XF-AVC clips only.
For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.
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(i) notes

e |f the card contains XF-AVC clips recorded at a system frequency other than the one currently used by the
camera, you will not be able to play back the clips and the clip thumbnails will not appear in the index screen.
To play back such clips, change the camera’s system frequency ([ 61) to match the recordings on the card.

Playing Back Recordings

After selecting the desired index screen, play back the desired clips, photos or audio files. You can use the touch
screen, assignable buttons, or joystick to play back the recordings.
You can select the recording media and recording format using an assignable button.

1 Select the recording media.
¢ In MEDIA mode, press the assignable button set to [Slot Selection] ([1] 121) or touch the orange dot next to
the recording media on the index screen.
2 Select the recording format.

¢ In MEDIA mode, press the assignable button set to [INDEX] (11 121) or touch the recording format on the
index screen.

e The index screen selection menu appears.
Options
[RAW Index]:  Clips in RAW format.
[XF-AVC Index]: Clips in XF-AVC format.
[MP4 Index]:  Clips in MP4 format.
[Photo index]:  Photos recorded on the card (SD card only).
[WAV Index]:  Audio files (WAV format).

3 Touch the thumbnail of the recording you want to play back.
e Playback will start.

¢ You can also move the orange selection frame using the joystick or the SELECT dial, and then press and
hold the SET button (for approximately 1 second) to start playback.

e Touch Il (which appears after touching the screen) or press the joystick to pause/resume playback.

¢ Press the button assigned to [INDEX] or flick the screen down to stop the playback and return to the index
screen.

¢ \While browsing photos, press the joystick left/right to move to the previous/next photo.

Custom picture settings of RAW clips during playback
RAW clips are played back using the following custom picture settings.

e [Gamma/Color Space]: Same setting used for recording

e [Color Matrix]: [Neutral]

e Contour lines are de-emphasized in a way similar to setting [Sharpness] > [Level] to —10.
e Other settings are set to [Off].

(i) NoTES

¢ The following image files may not be displayed correctly.
- Images not recorded with this camera.
- Images edited on a computer.
- Images whose file names have been changed.



Onscreen Displays During Clip Playback
8

18 19 20 21
1 Fan operation ([1] 43) and temperature warning
([ 214)
2 LUT
3 Output onscreen displays ([J] 149)

4 Playback button ®
Advance 10 seconds ©
Go back 10 seconds @

5 Recording date and time'

6 Frame reverse button [4If]
Frame advance button [i»]

7 Base ISO

8 Playback operation
» PLAY Playback
11 PAUSE Playback pause
10 sec P> Advance 10 seconds
<4« 10sec Go back 10 seconds
/1> Frame reverse/Frame advance
F FWD x5 Fast forward (speed: x5)
F FWD x15 Fast forward (speed: x15)
F FWD x60 Fast forward (speed: x60)
F REV x5 Rewind (speed: x5)
F REV x15 Rewind (speed: x15)
F REV x60 Rewind (speed: x60)

Playback

910 1112

00:00:03.29
180.00° 00 00 00 00

22 23

9 Frame rate? ([1] 62)

10 Custom picture file embedded?® (C1J 128)
11 @ mark®/M mark3/ Proxy clip (1 142, 70)
12 Time code ([I] 98)

13 Video format ([1] 61)

14 Color sampling and color bit depth (11 61)
15 Resolution ([1] 62)

16 Headphone volume ([1] 139)

17 Audio level meter”

18 Aperture value® (11 78)

19 1SO speed/Gain® ([1] 74)

20 Progress bar

21 Shutter speed® (1] 72)

22 User bit ([J] 99)

23 Audio output channels ([1] 153)

T Only when (=) Monitoring Setup] > [Custom Display] > [Date/Time] is set to [On).
2 For clips recorded using slow & fast motion recording, the shooting frame rate and playback frame rate will both be displayed.

3 XF-AVC clips only.

4 Only when [(=) Monitoring Setup] > [Custom Display] > [Audio Level Indicator] is set to [On].
Only when [[E]) Monitoring Setup] > [Custom Display] > [Camera Data] is set to [On].

(i) NoTES

¢ You can press the DISP button repeatedly to change the level of onscreen displays ([11 52).
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WAV playback screen
See Onscreen Displays During Clip Playback (11 137) for the description of onscreen displays that are common
on all playback screens.

1l PAUSE

1 5_2201029C_CANON

Jan.2,2022
3114 AM

00:00:00 00:00:04

1 Audio file name 3 Audio level meter
2 Sampling frequency and bit depth

Clip Playback Controls

The following playback types are available using the joystick and the touchs screen.
You can also change the position in the video using the progress bar.

Left side Right side

Playback type Operation

During playback, push the joystick up or down.

Fast playback' ) .
ast playbac Repeat to increase the playback speed to approximately 5x = 15x = 60x the normal speedz.

During playback, touch the right side of the screen twice. During playback pause, touch © on the

Advance 10 seconds right side of the screen.

During playback, touch the left side of the screen twice. During playback pause, touch @ on the left

Go back 10 seconds side of the screen.

Frame advance/reverse During playback pause, push the joystick up or down, or touch <@ll/II»>.

Skip to the beginning of the next clip During playback/playback pause, push the joystick right or flick the screen to the left.

Skip to the beginning of the current clip | During playback/playback pause, push the joystick left.

During playback, push the joystick left twice. During playback/playback pause, flick the screen to the

Skip to the previous clip right

Change the playback/playback pause

position in the video During playback/playback pause, touch or slide the progress bar.

" You may notice some anomalies (blocky video artifacts, banding, etc.) in the playback picture.
2 The speed indicated on the screen is approximate.

(i) NoTES

e There is no audio during any of the playback types listed in the previous table.
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Adjusting the Volume

You can use headphones or the built-in speaker to listen to the audio during
normal playback. When you connect headphones to the ) (headphone)
terminal, the speaker will be muted. The audio signal will also be output
from the HDMI OUT terminal (1] 147).

1 Select MENU > [M) Audio Setup] > [Headphone Volume] or
[Speaker Volume].

2 Select the desired level.

(i) NoTES

e For details on changing the audio channel, refer to Audio Output

(00 1593).

e If you set an assignable button to [Headphones +] or [Headphones -] (11 121), you can press the button to
adjust the headphone volume without using the menu.




File Operations

File Operations

You can perform various operations on the file selected in the index screen using the file menu. Available options
will depend on the type of recording selected.

140

File Menu Operations
1 Select the desired recording.

2 Press SET.
¢ The file menu will be displayed. Available functions will differ depending on the recording.
¢ You can also touch the screen for approximately 1 second to display the file menu.

3 Select a menu item.

File menu options

Menu item Description Index screen
[RAW] [XF-AVC] [MP4] [Photos] [WAV]
[Cancel] Closes the menu. o o o o [ J
[Play] Starts playback. o o @ o o
[Display Clip Info] Displays the information screen (11 141). o o ([ J - -
{Sifete.m';!n al\jl?rﬁ{‘ 2 Adds or deletes an [§ mark (11 142, 142). - o - - -
{Sifet a“r,:gr% 2 Adds or deletes a [ mark ([ 142, 142). - o - - -
[Del. Al Shot Marks]' Deletes all the shot marks ([ 143). - o - - -
[Recover] Recovers a recording. o o o - ([ J
[Delete] Deletes a recording (11 143). o o o o [ J
[Delete User Memo] ?Egiz ;h)e user memo and GPS information of a clip _ Y ° _ _
[FTP Transfer] Transfers a clip using the FTP protocol ([ 174). - o o - -
[Stop] Ends photo playback. - - - o -

1 Excluding proxy clips.
2 fthe clip already contains an [l or mark, the option to delete the mark will appear in the menu.
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Displaying Clip Information
1 Select the desired clip in the clip index screen.
2 On the file menu, select [Display Clip Info].

e The [Clip Info] screen will appear. 141

e Push the joystick left/right or touch §/] on the screen to move to the previous/next clip. Press the CANCEL
button to return to the index screen.

Start
End
Duration

CANCEL MENC)

1 Thumbnail of the selected clip 10 Shot mark (11 142) and [ mark / M mark?
2 Clip geotagged with GPS information (M 142)
3 Thumbnail of the previous clip 11 Proxy clip ([ 70)
4 Thumbnail of the next clip 12 Color sampling and color bit depth ([11 59)
5 Recording date and time e For RAW clips, [RAW] appears instead of the
6 Clip file name ([11 40) color sampling.
7 Compression, bit rate and resolution ([T] 59) 13 Clip’s start time code
8 Special recording mode ([J1 113) / Frame rate’ 14 Clip’s end time code
(62 15 Clip duration

9 Custom picture file embedded? (11 128)

T INT REC, FRM REC or S&F REC will be displayed depending on the special recording mode. For clips recorded using slow & fast
motion recording, the shooting frame rate and playback frame rate will both be displayed.
2 XF-AVC clips only.

Displaying Additional Information (User Memo/News Metadata)

From the [Clip Info] screen, you can push the joystick up or down, or touch [@]/[@] on the screen to display user
memo or News Metadata details. To return to the [Clip Info] screen, push the joystick in the direction displayed to
the left of [Clip Info] at the bottom of the screen ([@]/[@]) or touch [Clip Info] at the top of the screen.

Displaying Custom Picture Settings

If a custom picture file was embedded with the clip, you can push the joystick up or down, or touch [@]/[®] on
the screen to display the custom picture settings used. To return to the [Clip Info] screen, push the joystick in the
direction displayed to the left of [Clip Info] at the bottom of the screen ([@]/[@]) or touch [Clip Info] at the top of
the screen.
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Adding [l Marks or [4 Marks

You can add an OK mark () or check mark (/M) to XF-AVC clips to help you identify particular clips. Since clips
with an [l mark cannot be deleted with the camera, you can use this mark also to protect important clips.

Adding an [l Mark or [ Mark During Playback
You can add an [l mark or [ mark to a clip during playback or playback pause.

1 Set an assignable button to [Add [l Mark] or [Add M Mark] (11 121).

2 During playback/playback pause of an XF-AVC clip, press the assignable button to add the clip mark.
o [MMark] or [MMark] will appear briefly and the selected clip mark will be added to the clip.
¢ Playback will be paused.

Adding an [l Mark or [ Mark from the Index Screen
1 Select the desired clip from the XF-AVC index screen.

2 Press SET (file menu) and select [Add [l Mark] or [Add [ Mark] > [OK].
e The selected clip mark is added to the clip.

(i) NoTES

¢ A clip cannot have both an [l mark and P mark at the same time. When you add a [ mark to a clip with an
[ mark, the i mark will be deleted. Similarly, when you add an [l mark to a clip with a [ mark, the
mark will be deleted.

Deleting [l Marks or 4 Marks
You can delete an [ mark or [ mark added to an XF-AVC clip.

1 Select the desired clip from the XF-AVC index screen.

2 Press SET (file menu) and select [Delete Mark] or [Delete M Mark] > [OK].
¢ The selected mark is deleted.

Adding/Deleting Shot Marks

During the playback of a clip recorded in XF-AVC format, you can add shot marks (H) to particular frames in the
clip that you want to single out. You can also delete all shot marks at once.

Adding Shot Marks during Playback
1 Set an assignable button to [Add Shot Mark] (11 121).

2 During playback/playback pause of an XF-AVC clip, press the assignable button at the point in the clip where
you want to add the shot mark.

e [Shot Mark] will appear briefly and the shot mark will be added to the current frame of the clip.
e Playback will be paused.
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Deleting All the Shot Marks from a Clip
1 Select the desired XF-AVC clip in the index screen.

2 Press SET (file menu) and select [Del. All Shot Marks] > [OK].
e All shot marks in the selected clip are deleted.

Deleting Recordings
You can delete clips, photos and WAV audio files. To delete clips with an il mark, you need to delete the [
mark beforehand (] 142).

1 Select the desired file in the index screen.
e Photos are selectable on the playback screen.

2 Press SET (file menu) and select [Delete] > [OK].
e The file is deleted.
e The operation cannot be canceled.

@ vPoRTANT
¢ Be careful when deleting recordings. Once deleted, they cannot be recovered.

Deleting the User Memo and GPS Information from a Clip
1 Select the desired clip in the index screen.

2 Press SET (file menu) and select [Delete User Memo] > [OK].
e The user memo and GPS information that were recorded in the selected clip’s metadata are deleted.
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Video Output Configuration

The video signal output from the HDMI™ OUT terminal, depends on the clip’s video configuration and on various

menu settings.

External Connections

Video Output Configuration (Recording/Playback)

Main recording video configuration

MENU > [¥ System Setup]

Video output configuration

Recording format Resolution Frame rate HDMI output signal HDMI OUT terminal’
59.94P, 50.00P 4096x2160P/3840x2160P 4096x2160 See note 2
29.97P, 25.00P
24.00P, 23.98P 1920x1080P 1920x1080 See note 2
59.94P, 29.97P .
23.98P 59.94i
8192x4320 50.00P, 25.00P 1920x1080i 1920x1080 50.00i
5952x3140 24.00P 60.00i
59.94P, 29.97P
23'98p 59.94P
50.00P, 25.00P 1280x720P 1280x720 50.00P
24.00P 60.00P
RAW 59.94P, 50.00P
.94P, 50. 3
29.97P, 25.00P 4096"2113234?338’;2160P 19201080 See note 2
24.00P, 23.98P
59.94P, 29.97P .
23.98P 59.94i
1920x1080i 1920x1080 .
2976x1570 50.00P, 25.00P 50.00i
24.00P 60.00i
59.94P, 29.97P
23.98P 59.94P
50.00P, 25.00P 1280x720P 1280x720 50.00P
24.00P 60.00P
4096x2160*
29.97P, 25.00P 4096x2160P/3840x2160P 3840x21 605 See note 2
24.00P, 23.98P
1920x1080P 1920x1080 See note 2
29.97P, 23.98P 59.94i
MP4 8192x4320 25.00P 1920x1080i 1920x1080 50.00i
7680x4320 -
24.00P 60.00i
29.97P, 23.98P 59.94P
25.00P 1280x720P 1280x720 50.00P
24.00P 60.00P
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Main recording video configuration

Recording format

146

XF-AVC
MP4

MENU > [ System Setup]

Video output configuration

Resolution Frame rate HDMI output signal HDMI OUT terminal’
4
50.94P, 50.00P | 4096x2160P/3840x2160P 4096x2160. See note 2
29.97P, 25.00P 3840x2160
24.00P, 23.98P 1920x1080P 19201080 See note 2
59.94P, 29.97P .
23.98P 59.94i
4096x2160 50.00P, 25.00P 1920x1080i 1920x1080 50.00i
3840x2160 .
24.00P 60.00i
59.94P, 29.97P
b2 oap 50.94P
50.00P, 25.00P 1280x720P 1280720 £0.00P
24.00P 60.00P
59.94P, 50.00P 3
2097p, 2500p | 409012 1B0P/SBAON21607 1920x1080 See note 2
24.00P, 23.98P
59.94P, 29.97P .
b2 oap 59.94i
o04exios0 | 50.00P Z5.00F 1920x1080i 19201080 50,00
1920x1080 24.00P 60.00i
59.94P, 29.97P
»2.98p 50.94P
50.00F, 25.00° 1280x720P 1280720 50.00P
24.00P 60.00P
59.94i 4096x2160P/3840x2160P° 59.94i
000 1920x1080P° 19201080 s000
U0I i .OUI
192011080 1920x1080i
59.94i 50.94P
1280x720P 1280720
50.00i 50.00P
50.94P 409612160P/3840.2160° 50.04P
1920x1080P
1280720 50.00p rovalrrm 1280720 50.00p
1280x720P°

1 Color sampling will be YCC422 10 bit. The video signal's effective bit depth will be output.

2 The output signal's frame rate will be the same as that used for the recording. However, when slow & fast motion recording is
activated, the output signal's frame rate will be changed as follows: 59.94P/29.97P/23.98P — 59.94P, 50.00P/25.00P — 50.00P

and 24.00P — 60.00P.

3 Only available during playback (MEDIA mode).
4 When the resolution of the main clip is 8192x4320 or 4096x2160.
5 When the resolution of the main clip is 7680x4320 or 3840x2160.

HDMI RAW Video Output Configuration (Recording)

Main recording video configuration

Recording format

HDMI RAW

Resolution Frame rate

29.97P, 23.98P

8192x4320 25.00P
24.00P

g | AR
2976x1570 D A

24.00P, 23.98P

MENU > [¥ System Setup]
HDMI output signal

Video output configuration
HDMI OUT terminal
59.94P

50.00P

4096x2160 60.00P

See note 1

" The output signal's frame rate will be the same as that used for the recording.



Connecting to an External Monitor or Recorder

Connecting to an External Monitor or Recorder

When you connect the camera to an external device, be it a monitor (to monitor the recording or for playback) or
an external video recorder (for recording), adjust the required settings in the menu. For details about output
signals, refer to Video Output Configuration (11 145). 147

Connection diagram

External
monitor/
digital video
recorder

HDMI OUT terminal

HDMI inputs

HDMI cable (commercially available)

(i) notes

* |t is recommended to use the supplied cable protector when connecting a commercially available HDMI cable
to the camera. For details on the cable protector, refer to the Advanced User Guide (PHOTO edition).

e Powering the camera from a power outlet using the DC coupler and an AC adapter is recommended.

Using the HDMI OUT Terminal

The digital signal that is output from the HDMI™ OUT terminal includes the video signal and audio signal. You
can output also the time code signal, recording command and various assistance displays (onscreen displays,
markers, etc.) in order to check them also on an external monitor.

1 Connect the HDMI cable to the HDMI OUT terminal.
2 Select MENU > [¥ System Setup] > [HDMI Output Signal] > Desired option.

3 To output the time code signal, select MENU > [£% Recording/Media Setup] > [HDMI Time Code] >
[On].

(i) NoTES

* You can set MENU > [ System Setup] > [Linked to HDMI Monitor] to [On] to automatically change the HDMI
OUT terminal’s output resolution according to the capabilities of the connected monitor. When this setting is
set to [Off], the output resolution is set according to the menu settings and if the connected monitor is not
compatible with the signal output from the camera, HDMI output will stop.

e The HDMI OUT terminal is for output only. Do not connect the camera to another device’s output terminal
using the HDMI OUT terminal as this will cause a malfunction.

e Correct operation cannot be guaranteed when connecting the camera to DVI monitors.

e If the camera’s time code is being output and MENU > [ £% Recording/Media Setup] > [Rec Command] is set
to [On], you can use the camera’s REC button to control also the recording operation of an external recorder
connected to the HDMI OUT terminal.
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e During slow & fast motion recording, interval recording or frame recording, the recording command will not be
output.

e The time code will not be output from the HDMI OUT terminal in the following cases.
- In MEDIA mode.

e If MENU > [ System Setup] > [HDMI Output Signal] is set to [1280x720P], when the frame rate is set to
23.98P, the frames value of the time code output from the HDMI OUT terminal will be converted so it runs from
0to 29.

RAW Video Output from the HDMI OUT terminal
You can output video in RAW format from the HDMI OUT terminal while recording video to card 2.

1 Select MENU > [£% Recording/Media Setup] > [Main Rec Format] > [HDMI RAW].

2 Select MENU > [£% Recording/Media Setup] > [2nd Card Rec Functions] > an option other than
[Off].
3 Select MENU > [£% Recording/Media Setup] > [Sensor Mode].

Video Output Configuration

Main recording video configuration HDMI OUT terminal
Main recording format Sensor mode” Frame rate Resolution Frame rate
29.97P 59.94P
24.00P 60.00P
Full frame 23.98P 59.94P
Super 35mm (Cropped) 25.00P 50.00P
59.94P 59.94P
HDMI RAW 4096x2160
50.00P 50.00P
29.97P 29.97P
24.00P 24.00P
Super 16mm (Cropped)
23.98P 23.98P
25.00P 25.00P

* Bit depth will be 10 bit when [Sensor Mode] is set to [Full Frame]/[Super 35mm (Cropped)], and 12 bit when set to [Super 16mm
(Cropped)].

(i) notes

¢ Image will not be displayed correctly when connected to a device that is not compatible with the camera's
HDMI RAW output function.

¢ When the main recording format is [HDMI RAW], the following functions cannot be output from the HDMI OUT
terminal:

- Any of the MENU > [[Z) Monitoring Setup] > [B&W Image:], [Anamorphic:], [OSD Output:], [OSD Opacity:],
[OSD Orientation:] or [Range:] options.
- Any of the MENU > [ Assistance Functions] > [Peaking:], [False Color:], [Zebra:], [WFM:] or [Markers:]
options.
* MENU > [ Recording Media/Setup] > [Recording Mode] is set to [Normal Recording].
¢ MENU > [[Z) Monitoring Setup] > [View Assist:] functions cannot be used.
¢ MENU > [ Assistance Functions] > [Magn. Output] > [HDMI] cannot be used.
¢ MENU > [¥ System Setup] > [HDMI Output Signal] and [Linked to HDMI Monitor] cannot be adjusted.
e [Output: 60=60(24)fps] and [Output: 60<60(30)fps] cannot be used.
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Superimposing Onscreen Displays on Video Outputs

You can output the camera's onscreen displays along with the video output from the HDMI OUT terminal to
check the onscreen displays on an external monitor. You can also adjust the opacity level of superimposed
onscreen displays. This setting will not affect your recordings.

Select MENU > [[Z) Monitoring Setup] > [OSD Output: HDMI] > [On].

. appears on the right of the screen (In CAMERA mode, only if MENU > [[E) Monitoring Setup] >
[Custom Display 2] > [OSD Output] is set to [On]).

(i) NoTES

e If you set an assignable button to [OSD Output: HDMI] (1] 121), you can press the button to turn the
camera’s onscreen displays on and off.

Changing the Opacity Level of Onscreen Displays

You can make onscreen displays more visible or less conspicuous by changing their opacity level. You can select
to which screens to apply the opacity levels.

1 To change the visibility of onscreen displays on individual video outputs, select MENU >
[[=D Monitoring Setup] > Desired [OSD Opacity:] setting > [On].

2 Select MENU > [[Z) Monitoring Setup] > [OSD Opacity Level] > Desired option.
* The smaller the percentage the more transparent the onscreen displays.

3 Select MENU > [([Z) Monitoring Setup] > [OSD Opacity: Appl. Screens] > [All] or [Only Rec/Playback
Screens].

e You can apply the selected opacity level to all onscreen displays (including menus, etc.) or only to onscreen
displays on the shooting and playback screens.

(i) notes

e If you set an assignable button to one of the [OSD Opacity:] ([11 121) settings, you can press the button to
change the opacity level of onscreen displays on the corresponding video outputs.
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Selecting the Output Range

You can select the output range of video signals (when using log gamma or PQ/HLG HDR) output from the HDMI
OUT terminal to determine how the image levels are mapped to code values. Moreover, you can select the
setting independently for Canon Log output and for HDR output.

Applied output range settings

Custom picture file Applied range settings
[Gamma] [Look Filg] [Gamma/Color Space MENU > [Z) Monitoring Setup] > [Range: HDMI]
after the Look File is applied Al =
[0ff] - .
[Canon Log 3] - [During Canon Log Output]
[On] [Conform to Custom Picture]
[0ff] -
(PQ] :
[On] [Conform to Custom Picture]
[During HDR Output]
[0ff] -
[HLG] .

[On] [Conform to Custom Picture]
[0ff] -

[BT.709 Wide DR]
[On] [Conform to Custom Picture]
[0ff] -

[BT.709 Normal]
[On] [Conform to Custom Picture] -
[Off] — (Fixed narrow range)

[BT.709 Standard] -
[On] [Conform to Custom Picture]

[SDR BT.709]
[SDR BT.2020]
- [On]
[HDR PQ(BT.2100)]
[During HDR Output]
[HDR HLG(BT.2100)]

1 Select MENU > [[Z) Monitoring Setup] > [Range: HDMI].
2 Select [During Canon Log Output] or [During HDR Output] > Desired option.

Options

[Full Range Priority]:
The signal output will use full range coding whenever possible but will change the range
automatically according to the capabilities of the connected monitor.

[Narrow Range]:
The signal output will use narrow range (video range) coding.

(i) NOTES

e During playback, the applied range is determined according to the gamma used at the time of recording.



Applying the View Assistance Function to the LCD Screen

Applying the View Assistance Function to the LCD Screen

While recording using special gamma curves, you can apply the View Assistance function to the image displayed
on the LCD screen or video output from the HDMI OUT terminal. This function changes the color space/gamma
curve used, making it easier to check the image on the display device used.

Whether or not the View Assistance function can be used depends on the [Gamma/Color Space] and [Look File]
settings in the custom picture file (11 125).

List of View Assistances

Output settings
Applied View Assistance ~ With View Assistance applied Description
Gamma curve  Color space
Equivalent to Equivalent to View Assistance for viewing on the LCD screen.
[BT.709] or [On (BT.709)]' BT.709 q BT 709
Wide DR '
[HDR Assist. (1600%)] Original Equivalent to V|e\{v Assistance for viewing HDR (high dynamic range) images. The V|‘ew
- ’ amma curve BT 709 Assistance follows the ITU-R BT.2100 transfer function to convert a brightness
[HDR Assist. (400%)] g : range of 1600% or 400% respectively into a linear brightness scale.

" Only MENU > [[ED Monitoring Setup] > [View Assist: HDMI] can be selected.
2 Excluding MENU > [[=)) Monitoring Setup] > [View Assist: HDMI].

Available View Assistances

Custom picture file Available view assistance
3 [Gamma/Color Space] . 0 . 0
[Look File] aftar the Look Filaiis applied [BT.709] [HDR Assist. (1600%)]  [HDR Assist. (400%)]
0 -
o See the following table.
[Conform to Custom Picture]
[SDR BT.709] - - -
[On] [SDR BT.2020] ( J - -
[HDR PQ(BT.2100)] o o [ J
[HDR HLG(BT.2100)] o - [ J

Available View Assistances (when not using a Look File)

[Gamma/Color Space]

Available view assistance

[BT.709] [HDR Assist. (1600%)]  [HDR Assist. (400%)]

[Canon Log 3 / C.Gamut] o o ( J
[Canon Log 3 / BT.2020] @ o o
[Canon Log 3/ BT.709] @ - -
[PQ / BT.2020] o o o
[HLG / BT.2020] M - ®
[BT.709 Wide DR / BT.2020] o - -
[BT.709 Wide DR / BT.709],

[BT.709 Normal / BT.2020],
[BT.709 Normal / BT.709],
[BT.709 Standard / BT.709]
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Applying the View Assistance Function to the LCD Screen

Applying the View Assistance Function

1 Select MENU > [[Z) Monitoring Setup] > one of the [View Assist:] settings > [On] or [On (BT.709)).

¢ The view assistance function is applied and the gamma curve and color space of the displayed image will
change.

¢ The signal output will use narrow range (video range) coding.
¢ You can also adjust this setting using direct touch control ([1] 56).

2 Select MENU > [[Z) Monitoring Setup] > One of the [Select View Assist:] settings.
¢ \When only one option is available, it will be grayed out.

(i) NoTES

¢ Setting [View Assist: HDMI] to [On (BT.709)] disables the MENU > [[E) Monitoring Setup] > [Range: HDMI|
setting.

¢ The colors modified by using this function are an approximation, and differ from the colors obtained when you
set [Gamma/Color Space] in the custom picture file (11 129) to [Wide DR / BT.709].

e The colors in the dark areas / highlights of the image may not be displayed accurately.

Adjusting the Gain Difference When Converting HDR to SDR

When you select a view assistance setting for which the gain value can be set, or a setting that converts the
color of proxy recordings®, you can adjust the difference in gain between the SDR output relative to the HDR
image.

* When the view assistance/[Proxy Rec Color Conversion] is set to [BT.709] and the [Gamma/Color Space] setting in the custom

picture file is set to [PQ / BT.2020] or [HLG / BT.2020], or when the [Gamma/Color space] setting after applying a Look File is set
to [HDR PQ (BT.2100)] or [HDR HLG (BT.2100)].

Select MENU > [[Z) Monitoring Setup] > [Gain for HDR—>SDR Conv.] > Desired option.



Audio Output Channels

Audio Output Channels

The camera can output audio from the HDMI OUT terminal, ) (headphone) terminal or speaker. When recording
or playing back clips recorded with 4-channel audio, you can select which audio channels are output from the
HDMI OUT terminal and headphones.

Audio output configuration

Recorded audio configuration Audio output during recording/playback
Audio format Audio bit depth HDMI OUT terminal () (headphone) terminal
4-channel 2-channel
linear PCM 24 bit Iin?%rrl;i)M 2 channels

To select the audio channels for headphone output

Select MENU > [) Audio Setup] > [Monitor Channels] > Desired audio output option (L/R).

e Options like [CH1+2] indicate that two audio channels (CH1 and CH2 in this example) are mixed and output
from the same side.

To select the audio channels for HDMI output
Select MENU > [ ) Audio Setup] > [HDMI OUT Channels] > [CH1/CH2] or [CH3/CH4].
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Importing Files to a Computer/Smartphone

Importing Files to a Computer/Smartphone

Canon offers software applications as free downloads that allow you to save on a computer/smartphone clips
recorded with the camera, develop RAW clips, and more.

Saving Files

Use Canon XF Utility to save and organize XF-AVC clips and other recorded files on a computer. You can use the
Canon XF plugins to easily use XF-AVC clips directly from Avid non-linear editing (NLE) software. The software
and plugins are available as free downloads from your local Canon website. Check the download page for the
system requirements and latest information.

You will find detailed instructions about installing and uninstalling the software in the "Read This First" file
(Install-XF Utility.pdf) included in the compressed file you will download from the website. For details about using
the software, refer to the instruction manual (PDF file) that is installed with the software.

Canon XF Utility (for Windows/macOS): Software application that allows you to save clips on a computer,
check, play back and organize clips and grab still frames from clips.

Canon XF Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import clips
from a card or a local folder in the computer to the compatible version of Avid Media Composer (an NLE
application compatible with Avid Media Access), directly from within the application.

Saving MP4 Clips

Make sure to save clips recorded with this camera to a computer. To do so, you will need a card reader
connected to a computer or a computer with an SD card slot. For details on transferring files from the SD card,
refer to the computer’s instruction manual or OS’s help modules.

Under certain circumstances, clips may be split and recorded as separate files. Using MP4 Join Tool you can join
the split files of and save them as a single seamless clip.

Transferring Files to a Computer

1 Insert an SD card with the desired clips into the SD card slot of the computer or card reader connected to the
computer.

2 Follow the OS’s onscreen instructions.

3 Copy the clips on the SD card to the computer.

e Recordings on the SD card are located in folders named "XXX_mmdd" under the "DCIM" folder, where XXX
is the folder number (100 to 999) and mmdd stands for the recording date ([11 41).

Joining Clips Split by the Camera

Use MP4 Join Tool to join MP4 clips split by the camera in the following cases.
e When the camera switches to the other SD card while recording video due to the relay recording function

([138).

¢ The video (stream) file in the clip will be split approximately every 4 GB.

MP4 Join Tool is available as a free download (for Windows or macOS) from your local Canon website. Check
the download page for the system requirements and latest information.

You will find detailed instructions about installing and uninstalling the software in the "Read This First" file (Install-
MP4 Join Tool.pdf) included in the compressed file you download. For details about using the software, refer to
the instruction manual (PDF file) that is installed with the software.
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Saving WAV Files

Audio files in WAV format can be saved to a computer in the same way as MP4 files. Copy the desired audio files
(located in the “/PRIVATE/AUDIO” folder of the SD card) to the computer.

Saving Recordings to a Smartphone

You can save MP4 clips and proxy clips recorded with the camera, as well as News Metadata files to a
smartphone. The Content Transfer Mobile application is needed for this operation. You can connect a
smartphone to the camera using a dedicated cable* or the network functions ([1] 184).

* For details on dedicated cables, visit your local Canon website.

Smartphone

Connection port

Dedicated USB cable

1 Select MENU > [¥ System Setup] > [USB Mode] > [Canon App(s) for iPhone].
2 Connect the smartphone to the camera using a dedicated cable.

3 Open Content Transfer Mobile on the smartphone.

4 Use Content Transfer Mobile to save the files.

5 When the connection ends, disconnect the dedicated cable from the camera.

Developing RAW Clips

Use Cinema RAW Development to develop RAW clips shot/recorded with the camera. After you develop the
clips and export them to a full-quality standard file type such as DPX, they will be ready for color grading.
Alternatively, you can use the Canon RAW Plugin to easily use RAW clips unaltered (in RAW format) directly from
major non-linear editing (NLE) applications. The software and plugin are available as free downloads from your
local Canon website. Check the download page for the system requirements and the latest information.

You will find detailed instructions about installing and uninstalling the software in the “Read This First” file
(Install-Cinema RAW Development.pdf) included in the compressed file you will download from the website. For
details about using the software, refer to the instruction manual (PDF file) that is installed with the software.

Cinema RAW Development (for Windows/macOS): Software application that allows you to develop, play back
and export RAW clips.

Canon RAW Plugin for Avid Media Access (for Windows/macOS): Plugin that allows you to easily import RAW
clips to the compatible version of Avid Media Composer (an NLE application compatible with Avid Media
Access), directly from within the application.

Canon RAW Plugin for Final Cut Pro (macOS): Plugin that allows you to easily import RAW clips to Apple’s
Final Cut Pro, directly from the application.
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Network functions and connection types

To be able to use the following function networks, you will need to connect the WFT-R10 Wireless File
Transmitter (sold separately) to the camera.

Wi-Fi
Wired network
Network function Description
P (Ethernet) Infrastructure! e Agcess =
Point
Transfer clips recorded with the camera to
FTP File Transfer another device connected to the network o 174

using the FTP protocol.

Stream the camera’s live video and audio over
IP Streaming IP to a compatible IP video decoder connected - 175
to the network.

Control the camera remotely from the Web

Browser Remote browser of a connected device. * 7
Transfer clips/audio recorded with the camera
Canon App to a smartphone, or apply News Metadata _ S _ 184

(Content Transfer Mobile) | created/edited with Content Transfer Mobile
to the camera.

1 Connection to a Wi-Fi network via an external access point (wireless router, etc.)
2 Direct connection to one Wi-Fi-enabled device where the camera serves as the Wi-Fi access point.

Before using the network functions

¢ The instructions in this chapter assume you already have a correctly configured and working network and
correctly configured network device(s). If necessary, refer to the documentation provided with the network
devices you plan to use.

e Configuring the network settings requires adequate knowledge about configuring and using wired (Ethernet)
and/or wireless (Wi-Fi) networks. Canon cannot provide support regarding network configurations.

@ rorRTANT

e Canon shall not be liable for any loss of data or damage resulting from incorrect network configuration or
settings. Additionally, Canon shall not be liable for any loss or damage caused by the use of network functions.

e Avoid using open networks or networks without sufficiently strong security settings. Using an unprotected
network can expose your data to monitoring by unauthorized third parties.

(i) notes

¢ Do not open the card compartment cover while using network functions.
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Network functions and connection types

Using a Wi-Fi Network
To use a Wi-Fi network, connect the WFT-R10 Wireless File Transmitter (sold separately) to the camera ([T 209).

Wi-Fi Connection Types

You can connect the camera in Infrastructure mode, using an access point (wireless router etc.), or in Camera
Access Point mode, directly to a network device. The type of connection you can use, depends on the network
function you wish to use ([J] 157).

For an Infrastructure connection, the camera offers 4 ways to configure an access point and the method you use
will depend on the type and specifications of the access point and network you plan to use.

Camera Access Point: When shooting in a location where there are no access points available, the camera can
serve as a wireless access point*. Wi-Fi enabled devices will be able to connect to the camera directly.

* Limited only to the connection between the camera and supported Wi-Fi enabled devices. The functionality is not the same as
that of commercially available access points.

Infrastructure connection:

WPS (button): If your wireless router supports Wi-Fi Protected Setup (WPS), setup will be @ pp—

SETUP

easy and require minimal configuring and no passwords. To check if your wireless router
has a WPS button and for details about how to activate the Wi-Fi protected setup, refer to
the instruction manual of your wireless router.

WPS (PIN code): Even if your wireless router does not have a dedicated WPS button, it may support WPS using
a PIN code instead. For setup using a PIN code, you will need to know in advance how to activate the wireless
router’s WPS function. For details refer to the instruction manual of your wireless router.

Searching for Access Points: If your access point does not support the WPS function or you cannot activate it,
you can have the camera search for access points in the area.

Entering the SSID and authentication method: Manually enter the SSID and other information about the access
point.

@ nvrorTANT

® Depending on the country/region of use, some restrictions on outdoor use or Camera Access Point
connections may apply when using the IEEE 802.11b/g/a/n/ac wireless standard. Check the applicable areas
of use and restrictions in advance.
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Using a Wired (Ethernet) Network

Connect the WFT-R10 Wireless File Transmitter (sold separately) to the camera to use a wired network, using the
WFT-R10's RJ-45 Ethernet terminal and a commercially available Ethernet cable. Use Category 5e, shielded

twisted pair (STP) Ethernet cables compatible with Gigabit Ethernet (1000BASE-T) and with good shielding 159
capability. For more details about the Ethernet cables, refer to the manufacturer’s instruction manual.

Connecting
Insert the Ethernet adapter into the WFT-R10's RJ-45 Ethernet terminal.

Ethernet port on a
network device

Ethernet cable
(commercially available)

00D0DO0OO0OOOD

|
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Configuring Connection Settings

To connect to a network you will need to define in advance a connection setting (SET), which is a combination of

one or two communication settings (networks, NW) and one or two network function settings (MODE). You can
160 savein the camera up to 25 individual communication settings and function settings, and up to 20 combinations

— of connection settings (SET1 to SET20).

To configure a connection setting for the first time, you will follow the setup wizard ([J] 161). Using the wizard,

you can set up only one network and one function per connection setting. After having configured multiple

connection settings, you can change them (for example to add a secondary network or second function) and

you can create new ones combining existing communication and function settings (11 169).

If you configure a connection setting with both the [IP Streaming] and [Browser Remote] network functions, you

will be able to use both functions simultaneously.

Configure the necessary connection settings for the networks and network functions
you wish to use.

Connection setting (SET)

Communication Communication Function Function
Setting 1* (NW) Setting 2 Setting 1* (MODE) Setting 2**
* Configured using the wizard.
S ** Only in CAMERA mode.

Wi-Fi —— FTP transfer
—E Camera Access Point —— IP streaming

Infrastructure Browser Remote

WPS (push button) Canon App

WPS (PIN code)
Detected access points

SSID/authentication mode input
\/ L Ethernet

Select a connection setting appropriate for the network function you wish to use and
Step2 | start using the function.

FTP transfer (11 174)

IP streaming ([11 175)

Browser Remote ([J] 177)

Canon App (11 164)

Activating a Network Connection

Activate the desired network connection to use network functions or to configure the connection setting online.

1 Select MENU > [V Network Settings] > [Network] > [Enable].

2 When using connection settings that you saved previously, select MENU > [ Network Settings] >
[Connect] > Desired connection setting ([SET1] to [SET20]) > [OK].

¢ To end the network connection, set [Connect] to [Disconnect] instead.



Configuring Connection Settings

Adding a New Connection Setting Using the Wizard

You can use the wizard to set up a new connection setting. This section uses a connection to a Wi-Fi network
using the WPS push button method as an example. Refer to the instruction manual of the access point for
details about the location and operation of the WPS button. 161

1 Enable the network functions ([J] 160).

2 Select MENU > [V Network Settings] > [New Conn. Setting (Wizard)] > Desired network function >
[OK].

3 Select [Create New Comm. Setting].
e Once you have added multiple communication settings, you can select [Select Existing Setting] to reuse the

settings for a network that you saved previously.

4 Select [Wi-Fi 7].
¢ To configure a wired (Ethernet) network (1] 165).

5 Select [Connect with WPS] > [WPS (Push Button)].

¢ To use a different configuration method, complete the corresponding procedure.
Camera Access Point ([J] 165)
WPS using a PIN code ([I] 166)
Detected access points ([I] 166)
SSID/authentication mode input (11 167)
Manual setup without connecting to the network ([1 167)

6 Press and hold the WPS button on the wireless router and then, on the camera, select [OK].
7 To configure the IPv4 settings automatically and not use IPv6 settings, select [Automatic Setting] >
[Disable].
¢ To configure IPv4 settings manually (1] 167).
e To use the default IPv6 settings, select [Enable] instead. After completing the wizard, change the IPv6
settings as necessary (1] 171).
8 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 162), IP streaming (1] 163), Browser Remote ([1] 164), Canon App (11 164)

(i) notes

e The [WPS (Push Button)] method may not work correctly depending on the devices used or the surrounding
conditions. In such case try using [WPS (PIN Code)] (11 166) or selecting one of the detected networks
([ 166).
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Function Settings
FTP Transfer

This section continues the connection settings wizard. In the function settings you will configure the FTP server
162 settings and other settings related to the handling of folders and files. If necessary, consult the network
—— administrator in charge of the FTP server.

1 Select [Create New Func. Setting].

e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse the
settings for an FTP server that you saved previously.

2 Select the desired transfer mode.
3 Configure the destination FTP server. Select [Server] and [Port No.] > [OK].

e Enter the FTP server’s IP address or host name using the keyboard screen. Enter the port number using the
data entry screen ([ 25).

e Usually, the port number used is 21 (FTP or FTPS transfers) or 22 (SFTP transfers).

¢ Depending on the FTP mode selected in step 2, perform either step 4 or steps 4-5 and then continue to
step 6.

SFETP transfers

4 Enter the user name and password for the SSH protocol’s authentication. Select [User Name] and [Password]
> [OK].
¢ Enter the desired user name and password using the keyboard screen ([1] 25).

FTP/FTPS transfers
4 Select [Enable] to use passive mode or [Disable] to use active mode.
¢ In most cases, select [Disable].

5 Enter the user name and password for the FTP server. Select [User Name] and [Password] > [OK].
¢ Enter the desired user name and password using the keyboard screen ([1] 25).

All transfer modes
6 Select the destination folder on the server.
7 Select [OK]
e The function settings are saved to a [MODE] file.
8 Select the connection setting (SET1 to SET20) where to save the settings and then select [OK].
¢ The camera will connect to the network and will be ready to use the FTP transfer function (11 174).

Options for [FTP Mode]

[FTP]: Transfer method where the data is not encrypted.
[FTPS]: Secure transfer method using a root certificate (1] 168).
[SFTP: Secure transfer method using an SSH secure channel.

Options for [Destination Folder]

[Root Directoryl:
Files are saved on the root directory of the destination FTP server.

[Select Folder]: Enter the desired path using the keyboard screen ([11 25). If the folder does not exist on the
destination FTP server, it will be created automatically.
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IP Streaming

This section continues the connection settings wizard ([J] 161). In the function settings you will configure the
streaming video bit rate and resolution, the protocol used and the receiver’s settings. For details refer to the
instruction manual of the decoder device or software you will use.

163
1 Select [Create New Func. Setting]. -

e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse IP
streaming settings that you saved previously.

2 Select the desired protocol.
3 Configure the receiver’s settings. Select [Destination Server] and [Dest. Port No.] > [OK].

e Enter the receiver’s IP address using the keyboard screen. Enter the port number using the data entry
screen ([ 25).

e Using the default port number is recommended.

* Depending on the streaming protocol selected in step 2, perform step 4 if necessary and then continue to
step 5.

RTP+FEC] streaming

4 Configure the settings used to send FEC packets. Select [FEC Port No.] and [FEC Interval] > [OK].
e Enter the port number using the data entry screen ([1] 25).
® Using the default settings is recommended.

[RTSP+RTP] streaming

4 Enter the user name and password of the RTSP client. Select [RTSP: User Name] and [RTSP: Password] >
[OK].

e Enter the desired user name and password using the keyboard screen ([1] 25).

All streaming protocols

5 Select the video streaming configuration.
6 Select the audio channels.

7 Depending on the resolution and frame rate, a screen may prompt you to change other settings. Change the
settings as necessary.

8 Select [OK].
¢ The function settings are saved to a [MODE] file.

9 Select the connection setting (SET1 to SET20) where to save the settings and then select [OK].
e The camera will connect to the network and will be ready to start streaming.

10 Connect the decoder to the network and complete any necessary configurations on the receiving side so the
decoder is ready to receive video over IP.

e To start streaming, refer to IP Streaming (11 175).

Options for [Protocol]

[UDPY: This protocol prioritizes transfer speeds but does not guarantee the reliability/integrity of the
data. Lost or delayed IP packets are ignored.

[RTP: Standard protocol for video/audio broadcasts over the Internet. Lost or delayed IP packets are
ignored.

[RTP+FEC]: This setting uses the RTP protocol and adds a layer of FEC error correction so the receiving

side* can recover lost or delayed IP packets.

[RTSP+RTP]:  This setting uses the RTSP (real time streaming) protocol to control the streaming server
(camera) in real time and the RTP protocol for the broadcast over IP. With the RTSP protocol,
the receiver can control when to start and stop the broadcast.

* A decoder compatible with FEC error correction is required.
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Browser Remote
This section continues the connection settings wizard ([J] 161). A user name and password are required to log
in to the Browser Remote application.
1 Select [Create New Func. Setting].
¢ Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Browser
Remote settings that you saved previously.
2 Enter the user names and passwords as necessary.
3 Select [OK] twice.
e The function settings are saved to a [MODE] file.
4 Select the connection setting (SET1 to SET20) where to save the settings and then select [OK].

e The camera will connect to the network and will be ready to accept commands from the Browser Remote
application (11 177).

Canon App (Connecting to a Smartphone)

This section details the necessary settings to connect the camera to a smartphone through a network. Be sure
to connect both the smartphone and the camera to the same network in advance.

The Content Transfer Mobile application is necessary to connect the camera to a smartphone. For details on
downloading Content Transfer Mobile, refer to Transferring Recordings to a Smartphone ([1] 184). For more
details, refer to the smartphone's instruction manual.

1 Select [Create New Func. Setting].

e Once you have added multiple function settings, you can select [Select Existing Setting] to reuse Canon App
settings that you saved previously.

2 Select [OK].
3 As indicated on the screen, open Content Transfer Mobile on the smartphone.
4 Select the camera using Content Transfer Mobile.

e |f the camera and the smartphone are connected to the same network, the camera will be detected
automatically.

5 Select [OK].
e The connection will be completed.
¢ The function settings are saved to a [MODE] file.
6 Select the connection setting (SET1 to SET20) where to save the settings.
7 Select [OK].
e The connection will be completed and the camera will be ready to operate with the connected smartphone

(T 184).
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Other Connection Methods
This section explains how to configure communication settings using methods other than the WPS push button.

Ethernet Settings 165
1 In the [Network Type] screen, select [Ethernet ==5].
2 Make sure the Ethernet cable is correctly connected (1] 159) and select [Setup with Network Connection].

e Select [Setup without Network Connection] to only configure the settings, without connecting to the
network.

3 Set the IP address ([1] 167).
4 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (1] 162), IP streaming (1] 163), Browser Remote ([1] 164)

Camera Access Point

Connect a network device with the camera’s access point. Two configuration methods are available: easy
connection and manual connection.

1 In the [Select a network] screen, select [Camera Access Point Mode].
2 Select the configuration method.
¢ Depending on the selected method, perform either step 3 or steps 3-7 and then continue to step 8.

Easy Connection

3 The camera will assign the network name (SSID) and password automatically. Review the settings for the
camera’s Wi-Fi access point and select [OK].

* These settings are necessary to connect a network device to the camera.

e QR code connection is also possible. Touch [QR] on the screen to display a QR code to be read with a
network device.

[Manual Connection]

3 Enter the SSID (network name) for the Camera Access Point and then select [OK].
¢ Enter the desired network name using the keyboard screen (11 25).
4 Select the Wi-Fi channel.

e Select [Automatic Setting] to have the camera select the channel automatically, or select [Manual Setting] >
Desired channel.

5 Select the encryption settings.
e Select [AES] to use AES encryption, or [Disable] to use no encryption.
e |f you selected [Disable], skip to step 7.

6 Enter the password for the Camera Access Point and then select [OK].
e Enter the desired password using the keyboard screen ([] 25).

7 Set the IP address ([1] 167).
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Both configuration methods

8 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

166 ¢ Continue with one the following procedures to configure the selected function’s settings.
. FTP transfer ([J] 162), Browser Remote ([] 164)

9 Before you can save the connection setting, connect the network device to the camera.

e Activate the device’s Wi-Fi function, select the camera’s SSID (network name) from the list and enter the
password to connect to the camera.

WPS using a PIN Code

Connect to an access point using a PIN code. For most wireless routers, you must use a Web browser to
access the setup screen. For details on how to set up the access point, refer to the access point’s user manual.

1 In the [Select a network] screen, select [Connect with WPS] > [WPS (PIN Code)].
e The camera will generate and display an 8-digit PIN code.

2 Enter the PIN code into the wireless router’s WPS (PIN code) setup screen and then, on the camera, select
[OK].

3 Set the IP address ([1] 167).

4 Select [OK] to continue to configure the function settings.
e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 162), IP streaming ([J1 163), Browser Remote ([11] 164), Canon App ([11 164)

Detected Access Points

The camera will automatically detect access points in the vicinity. After you select the desired access point, you
only need to enter the selected network’s password to connect the camera. For details about the access point’s
network name (SSID) and password refer to the wireless router’s instruction manual or consult the network
administrator in charge of the access point.

A list of active networks detected in the vicinity
will appear after the menu settings

Network name Encrypted access point
(SSID, only ASCII characters)

1 In the [Select a network] screen, scroll through the list of detected networks and select the desired network.

e If the access point is encrypted, enter the password of the access point using the keyboard screen ([1] 25).
2 Set the IP address ([ 167).
3 Select [OK] to continue to configure the function settings.

e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (1] 162), IP streaming ([ 163), Browser Remote ([11 164), Canon App (11 164)
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SSID/Authentication Mode Input

You can connect to a specific access point by manually entering its details. For details about the access point’s
network name (SSID) and password refer to the wireless router’s instruction manual or consult the network
administrator in charge of the access point.

167
1 In the [Select a network] screen, select [Enter SSID/Authentication Method]. -
2 Enter the SSID (network name) of the desired network and then select [OK].
¢ Enter the desired network name using the keyboard screen (11 25).
3 Select the network’s authentication method.

¢ |f you select [Open System], select [Disable] (no encryption) and skip to step 6, or select [WEP] and continue
the procedure.

e |f you select [Shared Key] or [Open System] > [WEP], select the key index.
4 Enter the password of the desired network and then select [OK].

¢ Enter the desired password using the keyboard screen ([1] 25).
5 Set the IP address ([11 167).
6 Select [OK] to continue to configure the function settings.

e The communication settings are saved to an [NW] file.

e Continue with one the following procedures to configure the selected function’s settings.
FTP transfer (11 162), IP streaming (11 163), Browser Remote ([1] 164), Canon App ([11 164)

Offline Configuration without Connecting to a Network
1 In the [Select a network] screen, select [Configure Offline].

2 Select the network type.

e |f you select [Infrastructure], continue with the procedure to enter the SSID and authentication mode, from
step 2 ([ 167).
If you select [Camera Access Point Mode], continue from that procedure, from step 2 ([1] 165).

Configuring the Camera’s IP Address

This section explains how to configure the IP address. Available settings will change depending on the network
function selected.

1 Select the method used to configure IPv4 settings, [Automatic Setting] or [Manual Setting].

¢ \When using the wizard to add a new connection setting, make the selection in the [IP Address Settings
(IPv4)] screen.

e |f you select [Automatic Setting], skip to step 4.

Manual Setting

2 Select [IP Address] and [Subnet Mask] and enter the desired addresses using the data entry screen ([11] 25).
e To use a default gateway, select [Use Gateway] > [Enable] and then select [Gateway] and enter the address.
e To use a DNS address, select [Use DNS Address] > [Manual Setting] and enter the address.

3 Select [OK].

Both methods

4 Select whether to use TCP/IPv6 settings or not.
e To use IPv4 settings, select [Disable].
¢ To configure IPv6 settings (1 171).
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Other Network Settings

Reading/Deleting a Root Certificate for FTP Transfer

When you use the [FTPS] transfer mode, you will need to read onto the camera the same root certificate saved
on the FTP server. You can also check the content of a previously loaded root certificate or delete it.

1 Set the camera to MEDIA mode.

2 Save the desired root certificate file onto the root directory of a card and insert it into card slot 2.

3 Select MENU > [#W Network Settings] > [Advanced Settings] > [FTP Transfer Settings] > [Read Root
Certificate] > [OK].
¢ The root certificate file is read from the card.

e After reading a root certificate file, you can select [Root Certificate Details] to check the certificate’s issuer
and expiration date, or select [Delete Root Certificate] to delete the root certificate in the camera.

(i) NoTES

¢ Only one root certificate, with one of the following file names, can be read by the camera: “ROOT.CER”,
“ROOT.CRT” and “ROOT.PEM”.

e |f you transfer files using FTPS transfer with a self-signed certificate, you may not be able to trust the
destination server.

802.1X Authentication

The camera is compatible with the following protocols.
EAP-TLS: X.509 supported
EAP-TTLS, PEAP: MS-CHAP v.2 supported

Select MENU > [V Network Settings] > [Advanced Settings] > [802.1X Authentication] > [Setup

Wizard].

e Follow the wizard to complete the authentication settings.
When you select the [EAP-TLS] protocol, the root certificate, client certificate and private key will be read from
the card.
When you select the [EAP-TTLS] or [PEAP] protocol, select [User Name] and [Password] and enter the
information using the keyboard screen ([11 25). Then, read the root certificate from the card.

e After reading the authentication files, select [Check Settings] to check their content. Select [Delete Settings] to
delete the authentication files in the camera.

Giving a Nickname to the Camera
You can give the camera a nickname that is used on network connections and network devices to make it easier
to identify.

Select MENU > [V Network Settings] > [Nickname].
¢ Enter the desired nickname using the keyboard screen (11 25).
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Checking and Changing Connection Settings (SET)

You can check and, if necessary, change the settings of connection settings (SET) registered in the camera. In
addition to deleting and renaming connection settings, you can also add to a connection setting a secondary
network or second function.

Checking the Content of a Connection Setting

Select MENU > [#W Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20])
> [Check Settings].

¢ The detailed content of the connection setting is displayed.

e Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to
return to the menu.

Changing Settings using the Wizard
1 Select MENU > [#8 Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to
[SET20Q)) > [Change with Wizard].

2 Select the desired network function and then follow the wizard as described in the previous procedure (from
step 3, [1] 161) and make any changes as necessary.

Changing Connection Settings using Existing Settings

You can use previously registered communication settings ([NW] files) or function settings ((MODE] files) to easily
replace the content of a connection setting or to add a second network or network function in addition to those
registered using the wizard.

1 Select MENU > [ Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to
[SET20Q)) > [Select Existing Setting].

To add/replace a communication or function setting
2 Select the setting you want to change > [Select Existing Setting] > Desired NW or MODE file.

¢ |n the list of communication settings and function settings registered in the camera, only those that can be
selected will be displayed in white and others will be grayed out.

3 Select [Set].

¢ |f necessary, select [Check Comm. Settings] or [Check Function Settings] to check the content of the
selected file before making the change.

To delete a communication or function setting
2 Select the setting you want to remove > [Clear Selected] > [OK].

(i) NoTES

e A connection setting can have two communication settings (primary/secondary network) and up to two
function settings (only for [IP Streaming] and [Browser Remote]).

¢ |f both communication settings are deleted, the connection setting itself will be reset and will appear as
[Unspecified)].
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Renaming Connection Settings
You can rename connection setting (SET) files to make them easier to identify from the list.

Select MENU > [#W Network Settings] > [Connection Setting] > Desired connection setting ([SET1] to [SET20])
> [Settings Name].
¢ Enter the desired name (up to 12 characters) using the keyboard screen ([1] 25).

Deleting Connection Settings

Select MENU > [V Network Settings] > [Connection Setting] > Desired connection setting ((SET1] to [SET20])
> [Delete Settings] > [OK].
e The connection setting will be deleted.

(i) NoTES

e Even if you delete a connection setting, the individual communication/function settings stored in it are not
deleted. You can reuse these settings to configure other connection settings.

Checking and Changing Communication Settings (NW)/Function Settings (MODE)

You can check the content of communication settings ((NW] files) and function settings ((MODE] files) saved in
the camera and change or delete them as necessary.

Checking the Content of a Communication Setting/Function Setting
1 Select MENU > [ Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].
2 Select the desired communication setting ((NW1] to [NW25]) or function setting ((MODE1] to [MODE25]).
3 Select [Check Settings].
¢ The detailed content of the selected setting is displayed.

e Push the joystick left/right or turn the SELECT dial to review all the settings and press the CANCEL button to
return to the menu.

Changing/Deleting Communication Settings/Function Settings

1 Select MENU > [ Network Settings] > [Advanced Settings] > [Communication Settings] or [Function
Settings].

2 Select the desired communication setting ((NW1] to [NW25]) or function setting ((MODE1] to [MODE25]).

3 Select [Change Settings] and change the various settings as necessary.
e |f in step 2 you selected an [Unspecified] settings file, the only option available is [Create New with Wizard]

(1 161).

e Select [Delete Settings] > [OK] to delete the communication setting/function setting.
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Configuring TCP/IPv6 Settings
If in the wizard you selected [Enable] to use IPv6 settings, change the settings as necessary after completing the
wizard.

1 After step 3 in the previous procedure, select [TCP/IPv6] > [TCP/IPv6 Settings] > [Enable].
e This step is not necessary if you selected [Enable] when you used the wizard to add a new connection
setting.
e Continue the procedure to change the default IPv6 settings.
2 To configure the IPv6 settings manually, select [Manual Setting] > [Enable].
e [DNS Server] changes to [Manual Setting].
3 Select [DNS Server] > Desired option.
e |f you selected [Disable] in step 2, you can set [DNS Server] to [Auto Assign].
¢ \When not using a DNS server, select [Disable].
4 If you set [DNS Server] to [Manual Setting] in step 3, configure the [DNS Address].
¢ Enter the IP address using the data entry screen ([1] 25).

When [Manual Setting] is set to [Enable]

5 Select [Manual Address] (manually entered IPv6 address), [Prefix Length] (bits available for the network
address) and [Gateway] (gateway’s IP address) and enter the necessary information.

¢ Enter the IP addresses and prefix length using the data entry screen ([11] 25).

Individual settings available for manual change (communication settings)

Menu item Setting options and additional information
[Wi-Fi]
[SSID] -
[Advanced Settings] [Authentication Method], [Password]
[TCP/IPv4]
[IP Address Settings]* [Automatic Setting], [Manual Setting]
[DNS Server] [Disable], [Auto Assign], [Manual Setting]

[DNS Address]*, [IP Address]*,
[Subnet Mask]*, [Gateway]*

[TCP/IPv6)
[TCP/IPv6 Settings]* [Disable], [Enable]
[Manual Setting] [Disable], [Enable]

[DNS Server] [Disable], [Auto Assign], [Manual Setting]
[DNS Address],
[
[

Manual Address], Enter the desired address using the data entry screen (1] 25).
Prefix Length], [Gateway]
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Menu item

[FTP Transfer]

Configuring Connection Settings

Individual settings available for manual change (function settings)

Setting options and additional information

[Destination Server]

[Server]*, [Port No.]*

[User Name/Password]

[User Name]*,
[Password]*

[Destination Folder]*

[Dest. Folder Structure]

[Default], [Camera]

[Overwrite Files]

[Skip], [Save As (New Name)], [Overwrite]

Determines how to deal with files to be transferred when files with the same name already exists in the
destination folder.

[Skip]: The file will not be transferred.

[Save As (New Name)]: The file will be transferred and “_1” will be added to the end of the file name.
[Overwrite]: The file will be transferred, overwriting any file with the same name on the FTP server.

[Passive Mode]*

[Disable], [Enable]

[New Folder by Date] [Enable], [Disable]
[Enable]: A new subfolder under the transfer destination folder “YYYYMMDD\HHMMSS” will be created for every
transfer operation.
[Disable]: All the files will be transferred to the folder specified for the [Destination Folder] setting.
[IP Streaming]
[Protocol]* [UDP], [RTP], [RTP+FEC], [RTSP+RTP]

[Destination Server]*,
[Dest. Port No.J*,
[FEC Port No.J*

[FEC Interval]

10 to 100 (intervals of 5)

[RTSP: User Name]*,
[RTSP: Password]*

[Video Output Conf.J* [9Mbps/1920x1080 59.94P], [4Mbps/1920x1080 59.94P], [9Mbps/1920x1080 50.00P],
[4Mbps/1920x1080 50.00P], [9Mbps/1920x1080 59.94i], [4Mbps/1920x1080 59.94i],
[9Mbps/1920x1080 50.00i], [4Mbps/1920x1080 50.001]

[Audio Out Channels]* [CH1/CH2], [CH3/CH4]

* Change these settings as explained in the wizard ((J] 161).

Changing Browser Remote Settings
1 Select MENU > [ Network Settings] > [Advanced Settings] > [Browser Remote Settings].

2 Change the various settings as necessary.
e You can select [Port No. (HTTP)] or [Port No. (HTTPS)] to change the port numbers used for each

connection. Using the default port numbers (HTTP: 80, HTTPS: 443) is recommended.

e To use an HTTPS connection, select [HTTPS] > [Enable].

To use a secure HTTPS connection, use a Camera Access Point connection setting and connect the
network device to the camera using a normal HTTP connection ([1 177) and download the necessary
certificate from the Browser Remote’s settings tab (1] 183). After you import the certificate you
downloaded to your Web browser, you will be able to use a secure HTTPS connection.
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Checking the Network’s Status

Unless you selected to configure a connection setting offline (without connecting to the network), immediately

after configuring a new connection setting, the camera will connect to the network automatically and the

selected function settings will be activated. The icons displayed on the screen will indicate the type of network 173
selected and the connection status. When you disable the network functions or disconnect from the network, —
the icons will disappear.

b [i] 66min N3
min

15min  [EN

Network connection icons

= Wi-Fi (Infrastructure):
In yellow — the camera is connecting to or disconnecting from the network. In white — the
network function can be used.

Wi-Fi (Camera Access Point):
In yellow — starting the camera’s access point. In white — the camera’s access point is ready.
Connect the Wi-Fi enabled device to the camera.

Ethernet:  In yellow — the camera is connecting to or disconnecting from the network. In white — the
network function can be used.

Network function icons
FTPE FTP file transfer ([11 174)
T N& IP streaming ([11] 175)
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FTP File Transfer

In MEDIA mode, you can transfer clips from the camera to another device connected to the network, using the
FTP protocol.
174  The following explanations assume that the FTP server is on, ready and correctly configured.

Transferring a Single Clip

1 Connect the camera to the desired network and activate the network functions (11 160).
e Select a connection setting with the [FTP Transfer] function setting.

2 Select the desired clip in the [XF-AVC] or [MP4] index screen ([1] 135).
3 Press SET to open the file menu and select [FTP Transfer] > [OK].

e The camera will connect to the FTP server and the file will be transferred.
e Select [Cancel] to interrupt the file transfer in progress.

Transferring All Clips

1 Connect the camera to the desired network and activate the network functions (11 160).
e Select a connection setting with the [FTP Transfer] function setting.

2 Open the [XF-AVC] or [MP4] index screen ([1] 135).

3 Select MENU > [V Network Settings] > [FTP Transfer All Clips] > [OK].
e The camera will connect to the FTP server and all the files will be transferred.
e Select [Cancel] to interrupt the file transfer in progress.

@ wPoRTANT

¢ Observe the following precautions when transferring files. Failing to do so may interrupt the transfer and
incomplete files may remain at the transfer destination.
- Do not open the card compartment cover.
- Do not remove the power source or turn off the camera.

e |f incomplete files remain at the transfer destination, check the content and make sure they are safe to delete
before deleting them.

(i) NoTES

* Depending on the access point’s settings and capabilities, it may take some time to transfer files.
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IP Streaming

*

In CAMERA mode, you can stream the camera’s live video and audio over IP to a compatible IP video decoder
connected to the network. You can use IP streaming for live broadcasts or to send video reports from a location
with poor network connectivity. 175

* This can be a dedicated video transfer device or decoder software on a computer. For details about compatible decoders,
please visit your local Canon website.

Configuration of video streamed over IP

Main recording video configuration Streamed video configuration
_ . Video Audio
Video format Resolution Frame rate - - - -
Bit rate Resolution Frame rate Audio format Bit rate
59.94P 59.94P, 59.94i
- 59.94i 59.94i _
XF-AVC, 3840x2160, 4 Mbps, 19201080 . MPEG-2 AAE: 256 Kbps
MP4 (H.264) 1920x1080 50.00P 9 Mbps 50.00P, 50.00i 2 channels
50.00i 50.00i

* When the audio of the primary clip uses 4 channels, you can select which channels to stream over IP.

1 On the receiver’s side: Connect the decoder to the network and complete any necessary
configurations so it is ready to receive video over IP.

e For details refer to the instruction manual of the decoder device or software you will use.
2 On the camera: Connect the camera to the desired network and activate the network functions

(T 160).
e Select a connection setting with the [IP Streaming] function setting.
3 Select MENU > [#\V Network Settings] > [Activate IP Streaming] > [Enable].
e The camera will start streaming video over the selected network.
e You can press the REC button to simultaneously record the same image in the camera.

4 On the receiver’s side: Only when the streaming protocol is [RTSP+RTP], access the following URL
and log in using the RTSP user name and password (] 163).

rtsp://XXX.XXX.XXX.XXx/stream
bbbl

Camera’s IP address

5 On the camera: To end the streaming, select MENU > [#\* Network Settings] > [Activate IP
Streaming] > [Disable].

@ vPoRTANT
e Streamed data is not encrypted.

(i) NoTES

e Except when the streaming protocol is [RTSP+RTP], once IP streaming is activated, the camera will continue
to broadcast video and audio data over the network, regardless of the status of the receiver. Be careful to set
up the correct IP address and test in advance that the receiving decoder can indeed receive the signals.
Depending on the network used and the connection conditions, you may experience lost or delayed IP
packets.

After streaming continuously for 24 hours, the camera will stop the IP streaming momentarily and then restart
it automatically.

When using IP streaming together with the Browser Remote function, you may experience stuttering issues in
the streamed video or audio. When the two functions are used simultaneously, it is recommended not to log
out from/reconnect to Browser Remote.



IP Streaming

e Opening the card compartment cover and removing a card while IP streaming is activated may cause brief
stops in the streamed video and audio.
¢ |P streaming cannot be used in the following cases:
- When using a recording mode other than [Normal Recording].
- When [2nd Card Rec Functions] is set to an option other than [Off].
- When using the web camera function (1] 120).
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Browser Remote: Controlling the Camera from a Network Device

In CAMERA mode, you can operate the camera remotely using Browser Remote, an application that can be

accesses on a connected network device. Using Browser Remote you can check the camera’s live image and

control various recording settings*. You can also set and change metadata (only for XF-AVC clips) and check 177
other important indications, such as remaining recording time on the card, remaining battery charge/power —
source details, time code, etc.

* White balance, ISO speed/gain, shutter speed, aperture, focus and zoom.

Starting Browser Remote

After connecting the camera to the network In CAMERA mode, you can start the Browser Remote application
on the Web browser* of any network device* connected to the same network.

* A Web browser that supports JavaScript and is enabled to accept cookies is required.
** For details about compatible devices, operating systems, Web browsers, etc., please visit your local Canon website.

Preparations on the Camera

1 Connect the camera to the desired network and activate the network functions ([J] 160).
e Select a connection setting with the [Browser Remote] function setting.

2 Check the Browser Remote’s URL in the [#W Network Settings] status screen ([1] 205).
¢ \When using IPv6 settings, check the camera’s IP address instead ([1] 204).
e Write down the URL or IP address if necessary.

On the Network Device
1 Connect the network device to the camera or to the same access point as the camera.
2 Start the Web browser on the network device.
3 Enter Browser Remote’s URL.
e Enter the URL / IP address you checked previously into the Web browser’s address bar as follows.

http://XXX.XXX.XXX.XXX:nNN
) W
Camera’s IP address Port No. (can be omitted when using the default port no.)

* To use an HTTPS connection, enter "https:" instead of "http:".
¢ \When using IPv6 settings, enter the camera's IPv6 IP address instead.
4 Enter the user name and password.

e Be sure to log in with the user name and password of one of the
users that were set on the camera ([J] 164). If necessary, consult
the administrator who configured the camera’s settings.

* The Browser Remote screen will appear. The screen displayed may — Example of the login screen. The screen may

be different depending on the user information used to log in. 3";‘;[0‘165:5'”9 on the Web browser and

Login o 192.168.0.5

User Name

5 To change the application’s language, select [ ¢ ] > [Language &3] >
Desired language.

e Most buttons and controls emulate physical controls on the camera
and are labeled in English only, regardless of the language selected.

6 Use the Browser Remote controls to operate the camera.
¢ Descriptions of the controls are given in the following pages.

7 When you have finished using Browser Remote, select [ ¢ ] > [Log Out] on the Browser Remote screen to end
the application.
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(i) NoTES

e \When not using TCP/IPv6 settings, the Browser Remote URL (QR code) will appear on the MENU >
[ Network Settings] > [IPv4 address name] screen. You can access Browser Remote by reading the QR
code with a device such as a smartphone.

¢ Depending on the network used and the connection performance, you may notice delays in the refreshing of
the live view image and other settings. If the delay is too long, changing the resolution of the live view image is
recommended ([] 183).

¢ |f Browser Remote is set to a language other than the language set on the network device, the application may
not be displayed correctly.
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Using Browser Remote

(i) noTes

e Browser Remote does not support multi-touch gestures.

The Main Remote Operation Screen

- RSC
<. CN10x25 IAS S/E1

LIVE VIEW OFF
Enable

ON

Cancel Tracking

is Manual T5.0

(il 330 min Push Auto Iris
30 min 00:13:55.10

Auto
Slot Select
IS0 Manual 200

1213 14 15 16 17 18
1 Network connection indicator 8 Addan [ mark
While Browser Remote is correctly connected to 9 Camera’s nickname ([1] 168) and lens model
the camera, the dots will keep turning on and off name

in a loop.
10 [LIVE VIEW] button

2 Live view screen Touch the button to display the camera’s live view

Shows the camera's live view image. image on the Browser Remote screen.

3 Double slot recording 11 [Touch Focus] button

4 Recording operation ([J] 51) and recording Touch the button to unlock (enable) the touch
command ([J] 188) (same as on the camera) focus mode.

5 Time code (same as on the camera) 12 IP streaming
Add a shot mark Available only when using a connection setting

with both the [Browser Remote] and [IP

7 Adda mark Streaming] function settings.
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13 [REC] button

Touch the button to start recording. The recording
operation indicator changes to [@REC] and the
180 center of the button turns red.

— The time code will advance while recording.
Touch the button again to stop recording. The
recording operation indicator changes back to
[STBY].

14 Card selection and approximate remaining
recording time

15 [SLOT SELECT] button
Touch to select the other card when both card
slots contain a card.

16 Assignable buttons
17 Assignable functions check
18 Remaining battery charge (11 51)
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19 Continuous AF
20 Face detection & tracking

29 30 31

21 Cancel tracking

22 Aperture value 181

23 Push auto iris

24 Base ISO

25 1SO speed/gain value
26 Shutter mode

27 AE shift

28 White balance method selection
When the white balance mode is set to [[ll}, touch [AWB
LockK] to lock the current white balance settings. Touch
again to resume the automatic white balance (AWB).
When the white balance mode is set to 1A or B,
touch =4 to register a custom white balance.

tis Manual 5.0 29 Full Ctrl (full controls) switch (1] 182)

Detailed settings for AF operations, aperture, ISO
speed/gain, AE operations and custom picture

Push Auto Iris

so Auto 30 Key lock button
SO Manual 200 Touch the icon to lock the Browser Remote screens in
order to prevent settings from being changed
Speed 1/60 inadvertently. Controls on the camera are not locked.

31 Browser Remote settings ([11 183)

32 Manual zoom slider
Touch to adjust the zoom.

33 Manual focus controls
When [Focus] is active, touch [Rd], [IEl] or [IEHl] to
focus closer or [IE], [IEA] or [BA] to focus farther.
There are three levels of adjustment - [IEll]/[IEll] is the
smallest and [IB4]/[BA] the largest. Keep touching the
button (long press) for a continuous operation.

34 [Focus Guide] switch

Touch to display the focus guide ([1] 86).
35 Tracking
36 Color temperature

37 Color compensation
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Full Controls

182

o O~ W N =

Zoom

Enable

ame Selectable

Face
ON Priority

OFF Cancel Tracking

ON

Manual T5.0
13

Push Auto Iris

AF frame position
AF response
One-Shot AF button
Eye detection
Aperture increment

Function shortcut button

Displays the various adjustable functions. Touch
the function you wish to adjust.

AF frame
AF speed

Auto

I1SO Manual

12 = 3

Speed 1/60

13 — SRR

14 — Normal

mum 10

15 —

9 AF lock

10 Face AF
Select the desired Face AF setting.

11 Fine aperture adjustment

12 1SO/Gain increment

13 Shutter increment

14 AE response

15 Custom picture file

16 Custom picture file protection status
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{ Browser Remote Settings Tab

1

Language selection

Changes the language used for controls in the [§] (metadata input) screen
and for error messages. Still, most of the application’s controls emulate
physical buttons on the camera and appear in English only, regardless of the
language selected.

Settings

Display style
Touch to select the background color of the Browser Remote screens.

Secured connection

Touch to download the certificate required to use a secure HTTPS connection.

Live view resolution

Select [Large] (higher resolution) or [Small] (lower resolution) depending on the quality of the connection.

Log out
Touch to log out from the Browser Remote application.
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Transferring Recordings to a Smartphone

You can transfer and save MP4 clips or proxy clips recorded with the camera, audio in WAV format and News
Metadata files to a smartphone (connected to the same network as the camera) (1] 155).

184

1 Install Content Transfer Mobile on your smartphone.
e Download and install Content Transfer Mobile from the App Store.
e There is no need to repeat this step after the first time.

2 Connect the smartphone to the same network (access point) as the camera.
¢ Be sure to activate tethering in advance when using a smartphone as an access point.
e For details, refer to the smartphone's instruction manual.

3 Activate the desired network connection ([1] 160).
e Select a connection setting with the [Canon App] function setting.

4 As indicated on the screen, open Content Transfer Mobile on the smartphone.

5 Operate the smartphone to connect to the camera.

6 Select [OK].

7 Using Content Transfer Mobile, transfer recordings from the camera.

8 When you finish the procedure, set MENU > [#M Network Settings] > [Network] to [Disable].
e You can also set MENU > [#8W* Network Settings] > [Connect] to [Disconnect].

¢ When you end the connection from the smartphone, MENU > [#8* Network Settings] > [Network] will be
set to [Disable].

(i) NOTES

¢ When setting up a connection with the [Canon App] function setting using the GP-E2 GPS Receiver, connect
the receiver to the multi-function shoe.



Menu Options

Additional Information

For details about how to select an item, refer to Using the Menus ([11 22). For details about each function, see
the reference page or the explanation accompanying the menu entry. Setting options in boldface indicate default

values.

Depending on the camera’s operating mode and the settings, some menu items may not be available. Such
menu items do not appear or appear grayed out in menu screens.

To skip directly to the page of a specific menu:

["™ Camera Setup] menu 11185 (%4 Assistance Functions] menu 192
[[@d Custom Picture] menu 11186 [snr Network Settings] menu 11193
[£% Recording/Media Setup] menu 187 [€ Assignable Buttons] menu 11194
[d) Audio Setup] menu 11189 [ System Setup] menu 1194
[ED Monitoring Setup] menu 1190 [ My Menu] customized menu 11196
["™ Camera Setup] menu (CAMERA mode only)

Menu item Setting options and additional information
[Iris Mode] [Automatic], [Manual] (3 78)

This setting is available only when a compatible lens ([ 234) is attached to the camera.

[Iris Increment] [1/2 stop], [1/3 stop] (A 78)
[Fine Increment] [On], [Off]
[Zoom-Iris Correction] [On], [Off]

If you are using a compatible lens, when this setting is set to [On], the camera will adjust as needed to
keep the selected aperture value while zooming. Because of this adjustment, the brightness of the image
might flicker slightly or you may hear the operation sound. When the setting is set to [0ff], there will be no
flickering or operation sounds but the aperture value will gradually increase (the picture will get darker) as
you zoom.

[Shutter Mode] [Speed], [Angle], [Clear Scan], [Slow], [Off] (M72)
[Shutter Increment] [1/3 stop], [1/4 stop]
[Base IS0] Available options depend on the [Gamma/Color Space] settings and recording format.
[ISO/Gain] [1S0], [Gain] (@74
[ISO/Gain Mode] [Automatic], [Manual] (A 76)
[ISO/Gain Extended Range] [On], [Off] (74
[ISO/Gain Increment] [ISQ]: [1 stop], [1/3 stop] (74
[Gain]: [Nermal], [Fine]
[Limit for Auto Mode] [ISO]: ISO 160 to Off/ISO 25600 (0ff/102400) (T 76)
[Gain]: -2 dB to 0ff/42 dB (0ff/54 dB)
Available options vary depending on the [Base ISO] settings.
[Light Metering] [Backlight], [Standard], [Spotlight] (7 81)
[AE Shift] —2.0 to +2.0 in 0.25 point intervals (+0) (3 81)
[AE Response] [High], [Normal], [Low] (17 80)
Determines how quickly the exposure (aperture, shutter speed and gain) changes when using the
automatic adjustment mode.
[Shockless WB] [On], [Off] (82
[AWB Response] [High], [Normal], [Low] (@84
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Menu item Setting options and additional information
[C. Temp. Increment] [Mired], [Kelvin] (a83)
[Continuous AF] [Disable], [Only Around Focus Point], [Enable] (17 85)
[AF Frame] [Large], [Small], [Whole Area]* (T 90)

* Available when [Continuous AF] is set to [Enable] or [Disable].

[AF Frame Position] [Selectable], [Center Frame]
[AF Speed] —7 10 +2 (0) (T 89)
[AF Response] -3t0+3(0)
[Focus Mode] [AF], [MF] (12 85)
[Face Det. & Tracking] [On], [Off] (@ 91)
[Face AF] [Face Priority], [Face Only]
[Eye Detection] [On], [Off] (9
[Camera Grip Zoom] [On], [Off] (94)
[Camera Grip Zoom Speed] 11016 (8)
[ABB] - (M 44)
[Color Bars] [On], [Off] (T3 1086)
[Color Bar Type] [SMPTE], [EBU]*, [ARIB]
[Periph. lllum. Corr)], [On], [Off] (17 28)
[Chromatic Aberr. Corr.],
[Diffraction Correction],
[Distortion Aberr. Corr.]
[EF-S Lens] [On], [Off] (07 26)

If peripheral brightness fall-off or vignetting occurs when using an EF-S lens, you can set [EF-S Lens] to
[On] to slightly crop the imaging area. The image is enlarged digitally by a factor of about 1.04x, affecting
image quality. In most cases, leaving the [Off] option is recommended.

[Digital 1] [On], [Off] (T 93)
[Digital IS Mode] [High], [Standard]
[Lens Focal Length] 1 to 1000 (50)
[Anamorphic Corr.] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.3], [Off]
* The default value depends on the country/region of purchase.
[[@@ Custom Picture] menu (CAMERA mode only)
Menu item Setting options and additional information
[Select File] [C1: BT.709 Wide DR], [C2: Canon Log 3], [C3: PQ], [C4: HLG], [C5: BT.709 Standard], (T 125)
[C6: EOS Standard)], [C7: EOS Neutral], [C8: User08] to [C20: User20]
[Edit File]
[Rename] - (1 126)
[Protect] [Unprotect], [Protect]
[Reset] [BT.709 Wide DR], [Canon Log 3], [PQ], [HLG], [BT.709 Standard], [EOS Standard],
[EOS Neutral], [User (BT.709 Wide DR)]
Detailed custom picture Refer to the tables in the Available Custom Picture Settings section. (2129
settings
[Save @3 File] (@ 128)
[Save to SD Card], -

[Load from SD Card]




[£% Recording/Media Setup] menu

Menu Options

Menu item Setting options and additional information
[Initialize Media] [CFexpress], [SD Card] (1 35)
[Sensor Mode] [Full Frame], [Super 35mm (Cropped)], [Super 16mm (Cropped)] (3 e1)
[System Frequency] [59.94 Hz], [50.00 Hz]', [24.00 Hz] (3 61)
[Main Rec Format] [RAW HQ], [RAW ST], [RAW LT], [HDMI RAW], [XF-AVC YCC422 10 bit], (T61)
[MP4(HEVC) YCC422 10 bit], [MP4(HEVC) YCC420 10 bit], [MP4(H.264) YCC420 8 bit]
[Main Recording Destination] [CFexpress], [SD Card] (62
[Main Resolution/Bit Rate] RAW: (62
[8192x4320], [5952x3140], [2976x1570]
XF-AVC:
[4096x2160 Intra-frame], [4096x2160 Long GOP], [3840x2160 Intra-frame],
[3840x2160 Long GOP], [2048x1080 Intra-frame], [2048x1080 Long GOP],
[1920x1080 Intra-frame], [1920x1080 Long GOP], [1280x720 Long GOP]
MP4:
[8192x4320], [7680x4320], [4096x2160], [3840x2160], [2048x1080], [1920x1080],
[1280x720]
Available options vary depending on the sensor mode and frame rate.
[Frame Rate] When [System Frequency] is set to [59.94 Hz]: (162
[59.94i]*, [59.94P]", [29.97P], [23.98P]
When [System Frequency] is set to [50.00 Hz]:
[50.00i]*, [50.00P]", [25.00P]
When [System Frequency] is set to [24.00 Hz]:
[24.00P]
* Only available when the main resolution is 1920x1080 and the main recording format is
XF-AVC. Not available when slow & fast motion recording, frame recording or interval
recording is activated.
Available options vary depending on the main resolution/bit rate.

[Main Audio Format (MP4)] [AAC 16 bit 2CH], [LPCM 16 bit 4CH] (@102
[Recording Mode] [Normal Recording], [Slow & Fast Motion], [S&F Clip / Audio (WAV)], (1138, 113)
[Pre-Recording], [[1]Main / [2)Continuous Rec], [Frame Recording],

[Interval Recording]
[Slow & Fast Frame Rate] 1210180 (M 113)

Available options and default value vary depending on other settings. See the tables on the reference

page.
[Continuous Recording] [REC], [STBY] (@11y)
[Frame Rec: Frame Rate] [11, 131, [6], [9] (M 116)

[Interval Rec: Time Interval]

[1 sec], [2 sec], [3 sec], [5 sec], [10 sec], [15 sec], [30 sec], [1 min], [2 min], [3 min], [5 min], (31 117)

[10 min]

[Interval Rec: Frame Rate]

(11, (31, (61, [9]

[2nd Card Rec Functions]

[0ff], [[1]Main / [2)Proxy Rec], [[1]Main / [2)Sub Rec], [[1]Main / [2)Audio Rec],
[Relay Recording], [Double Slot Recording], [[1]---( (R Main) / [2)Proxy Rec]*,
[[4]---(GBID Main) / [2Sub Rec]*

* Only available when [Main Rec Format] is set to [HDMI RAW].

(139

[[2) Rec Format]

[XF-AVC YCC422 10 bit], [XF-AVC YCC420 8 bit], [MP4 (HEVC) YCC 422 10 bit], [MP4 (HEVC) (11 63)

YCC 420 10 bit], [MP4 (H.264) YCC 420 8 bit]
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Menu Options

Menu item
[[2) Resolution/Bit Rate]

Setting options and additional information

Main recording: RAW, Sub recording: [XF-AVC YCC422 10 bit] (1 63)
[4096x2160 Intra-frame], [4096x2160 Long GOP], [2048x1080 Intra-frame], (M70)
[2048x1080 Long GOP]

Main recording: RAW, Sub recording: [XF-AVC YCC420 8 bit]

[2048x1080 Long GOP]

Main recording: RAW, Sub recording: [MP4(HEVC) YCC422 10 bit] /
[MP4(HEVC) YCC420 10 bit] / [MP4(H.264) YCC420 8 bit]
[4096x2160], [2048x1080]
Main recording: XF-AVC, Sub recording [XF-AVC YCC422 10 bit]:
[4096x2160 Long GOP], [3840x2160 Long GOP], [2048x1080 Intra-frame],
[2048x1080 Long GOP], [1920x1080 Intra-frame], [1920x1080 Long GOP],
[1280x720 Long GOP]
Main recording: RAW, Sub recording: [XF-AVC YCC420 8 bit]
[2048x1080 Long GOP], [1920x1080 Long GOP], [1280x720 Long GOP]
Main recording: XF-AVC, Sub recording [MP4(H.264) YCC420 8 bit]:
[4096x2160], [3840x2160], [2048x1080], [1920x1080], [1280x720]

Main recording: MP4, Sub recording [MP4(HEVC) YCC422 10 bit]:
[2048x1080], [1920x1080], [1280x720]

Main recording: MP4, Sub recording [MP4(HEVC) YCC420 10 bit]:
[4096x2160], [3840x2160], [2048x1080], [1920x1080], [1280x720]

Main recording: MP4, Sub recording [MP4(H.264) YCC420 8 bit]:
[2048x1080], [1920x1080], [1280x720]

Available options vary depending on the main recording’s video configuration.

[[2) Frame Rate] [Same as Main Recording], [59.94i], [50.00i] (1 63)
[[2) Audio Format (MP4)] [AAC 16 bit 2CH], [LPCM 16 bit 4CH] (102
[Proxy Rec Color Conversion] [Conform to Custom Picture], [BT.709] (7o)
[Metadata]
[Camera Index] [A]to [Z] (071 40)
[Reel Number], [Clip Number] ~ [001] to [999]
[User Defined] User defined string up to 5 characters ([CANON]) (M 41)
[Scene], [Take] Scene description up to 16 characters / Take description up to 8 characters (112
[Lens Squeeze] [x2.0], [x1.8], [x1.3], [Off] (M 119)
[Add XML File] [On], [Off] (@110,
[XML File Format] [News Metadata], [User Memo] 111)

[News Metadata] [Off], list of available News Metadata files

[News Metadata Reset All] - (112
[User Memo] [Off], list of available user memo files (@110
[Country Code], [Organization], Identifiers up to 4 characters ([00__] default for [Organization] only)

[User Code] [Country Code]: This identifier is the country code defined by ISO-3166-1 and is to be entered starting

from the left.
[Organization]: This identifier represents the organization that owns or operates the camera and can be
obtained by registering with the SMPTE Registration Authority. If the organization is not registered,

enter [0000].
[User Code]: This identifier designates the user. Leave this blank if [Organization] is set to [0000].
[Add File] [On], [Off] (11128)
[Clip Numbering] [Reset], [Continuous] (17 40)
[Rec Command] [On], [Off] (T147)

When this setting is [On] and you connect the camera to an external recorder, if you start or stop recording
with the camera, the external recorder will also start or stop recording. To output the recording command
from the HDMI OUT terminal, you will need to set also [HDMI Time Code] to [On].




Menu Options

Menu item Setting options and additional information
[HDMI Time Code] [On], [Off] (@147)
[MP4 Clip/Photo Numbering] [Reset], [Continuous] (3 41)
[Volume Label] [Canon], [Canon + Metadata] (12 36) 189

" The default value depends on the country/region of purchase.

[d) Audio Setup] menu

Menu item Setting options and additional information
[CH1/CH2 ALC Link], [Linked], [Separated] (T 104)
[CH3/CH4 ALC Link]
[Audio Rec Level CH1], [Automatic], [Manual] (2 104)

[Audio Rec Level CH2],
[Audio Rec Level CH1/CHZ2],
[Audio Rec Level CH3],
[Audio Rec Level CH4],
[Audio Rec Level CH3/CH4]

[CH1 Level], [CH2 Level], 0to 100 (50)
[CH1/CH2 Level],
[CH3 Level], [CH4 Level],
[CH3/CH4 Level]
[MIC Att)] [on], [Off] (@104)
[MIC Low Cut] [0ff], [LC1], [LC2] (@ 105)
[Shoe Mic Attenuator] [On], [Off] (d104)
[Shoe Mic Low Cut] [on], [0ff] (@M 109)
[Shoe Mic Directionality] [Shotgun (Monoaural)], [90°(Stereo)], [120°(Stereo)] (2 105)
[1 kHz Tone] [-12 dB], [-18 dB], [-20 dB], [0ff] (T 106)
[Headphone Volume] [0ff], 1t0 15 (8) (139)
[Speaker Volume] [Off], 1 to 15 (8)

In MEDIA mode only, this setting is an alternative way to adjust the built-in speaker's volume.
[Monitor Channels] [CH1/CH2], [CH1/CH1], [CH2/CH2], [CH1+2/CH1+2], [CH3/CH4], [CH3/CH3], [CH4/CH4], (T 153)

[CH3+4/CH3+4], [CH1/CH3], [CH2/CH4], [CH1+3/CH2+4]
[HDMI OUT Channels] [CH1/CH2], [CH3/CH4]
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[(=D Monitoring Setup] menu

Menu item Setting options and additional information
[LCD Brightness], —-50 10 50 (=0) (19
[LCD Contrast]
[LCD Color] —20 to 20 (=0)
[LCD Sharpness] 1104 (2)
[LCD Luminance] [Normal], [+1], [+2]
[LCD Mirror Image] [On], [Off]
[LCD/VF Qutput] [Auto1 ( @ "J: LCD Only)], [Auto2 ( @gy"]: Auto Switching)], (@ 31)
[LCD Only], [VF Only (Eye Sensor ON)], [VF Only (Eye Sensor OFF)]
[VF Brightness], -50 to +50 (+0) (13 30)
[VF Contrast]
[VF Color] —20 to +20 (+0)
[VF Sharpness] 1t04(2)
[VF Luminance] [Normal], [High]
[Run VF at x2 speed] [On], [Off] (M 31)
[Anamorphic: LCD], [On], [Off] (@M119)
[Anamorphic: VF],
[Anamorphic: HDMI]
[Anamorphic Desqueeze] [Lens Squeeze Factor], [x2.0], [x1.8], [x1.3]
[Desqueeze for S&F] [Reduced Display], [0ff]
[B&W Image: LCD], [On], [Off] (19
[B&W Image: VF],
[B&W Image: HDMI]
[OSD Output: HDMI] [On], [Off] (T 149)
[DISP Level 1] [All Displays], [All Displays (Periph. Border)] (52
[DISP Level 2] [Main Recording Displays], [Only FUNC/MENU]
[DISP Level 3] [Only REC/STBY], [No Displays]
[Apply Peripheral Border] [DISP Level 1/2/3], [DISP Level 1/2], [DISP Level 1], [DISP Level 2], [DISP Level 3], [Off] (53
[Custom Display 1] (1 49)

[Light Metering],
Custom Picture],

[View Assist], [Lens]

Focal Length], [Focus Mode],
Key Lock], [White Balance],
AE Shift], [Iris], [ISO/Gain],
Shutter], [Base IS0], [Peaking],
Digital IS], [Magnification],

[On], [Off]

Object Distance (Bar)]

Object Distance (Numeric)],

[Always On], [Only in MF Mode], [Off]

Level]

[Tilt+Roll], [Roll], [Tilt], [Off]

Exposure Bar]

[On], [Disable During AE], [Off]




Menu Options

Menu item Setting options and additional information
[Custom Display 2] (T 49)

[Remaining Battery], [Only Warnings], [Normal], [Off]

[Remaining Rec Time] 191
[Recording Mode], [On], [Off] I
[Interval Counter],

[Time Code],

[Reel/Clip Number]

[Photo] [Only Warnings], [Normal], [Off]

[Temperature/Fan], [On], [Off]
[Sensor Mode],

[Resolution/Color Sampling],

[Frame Rate],

[Output Terminals Status],

[OSD OQutput]*,

[Rec Command],

[User Memo]*, [User Bit]*,

[Monitor Channels]*,

[Audio Level Indicator],

[Multi-Function Shoe],

[Network Functions], [GPS] ¢ The default setting for items marked with an asterisk (*) is [Off].

[Date/Time] [Date/Time], [Time], [Date], [Off]
[Custom Display] (M137)

These settings are available only in MEDIA mode and determine whether the following onscreen displays
will appear on the playback image.

[Audio Level Indicator] [On], [Off]
[Date/Time], [Camera Data] [On], [Off]

[Audio Level Indicator]: The audio level meter (clips only).
[Date/Time]: The date and time when the clip/photo was recorded.
[Camera Data]: The aperture value, shutter speed and ISO speed/gain value used to record the clip (clips

only).
[Displayed Units] [Meters], [Feet]1
Changes the distance units used in camera displays between meters and feet.

[0OSD Opacity: LCD], [On], [Off] (T 149)
[OSD Opacity: VF]
[0SD Opacity: HDMI]
[OSD Opacity Level] [75%)], [62.5%)], [50%)], [37.5%)], [25%]
[OSD Opacity: Appl. Screens] [All], [Only Rec/Playback Screens]
[OSD Orientation: LCD/VF] [0 Degrees], [ ¢ 90 Degrees Left], [ x=), 90 Degrees Right] (3 54)
[OSD Orientation: HDMI] [Linked to LCD/VF], [ ¢ 90 Degrees Left], [ »=), 90 Degrees Right]
[View Assist: LCD], [View Assist: VF]  [On], [Off] (@ 151)
[Select View Assist: LCD], [BT.709], [HDR Assist. (1600%)], [HDR Assist. (400%)]
[Select View Assist: VF]
[View Assist: HDMI] [On (BT.709)], [0ff] (@152
[Gain for HDR—SDR Conv.] —7.5dB to +7.5 dB in 0.5 dB intervals (-3.0 dB) (152
[Range: HDMI] (T 150)

[During Canon Log Output] [Full Range Priority], [Narrow Range]

[During HDR Qutput] [Full Range Priority], [Narrow Range]

" The default value depends on the country/region of purchase.
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[B Assistance Functions] menu

Menu item Setting options and additional information
[Focus Guide] [On], [Off] (17 86)
[Peaking: LCD], [Peaking: VF], [On], [Off] (Mma)
[Peaking: HDMI]
[Peaking] [Peaking 1], [Peaking 2]
[Peaking 1]
[Color] [White], [Red], [Yellow], [Blue]
[Gain] [Off], 1 t0 15 (8)
[Frequency] 1t04(2)
[Peaking 2]
[Color] [White], [Red], [Yellow], [Blue]
[Gain] [0ff], 1 to 15 (15)
[Frequency] 1to4 (1)
[Magnification] [On], [Off] (M 87)
[Magn. Outpuf] [LCD], [VF], [HDMI]
[B&W during Magn.] [On], [Off] (T 87)
[False Color: LCD], [False Color: VF], [On], [Off] (M97)
[False Color: HDMI]
[False Color Index] -
[Zebra: LCD], [Zebra: VF], [On], [Off] (M7
[Zebra: HDMI]
[Zebra] [Zebra 1], [Zebra 2], [Zebra 1+2]
[Zebra 1 Level] [5 +5%)] to [95 +5%)] in 5 percentage point intervals ([70 £5%])
[Zebra 2 Level] 0% to 100% in 5 percentage point intervals (100%)
[WFM: LCD], [WFM: VF], [On], [Off] (m107)
[WFM: HDMI]
[WFM Function] [Waveform Monitor], [Vectorscope]
[Waveform Settings] (@m107)
[Position] [Right], [Left]
[Type] [Line], [Line+Spot], [Select Line], [RGB], [YPbPr]
[Gain] [1x], [2X]
[Vertical Scale for HDR] [IRE], [PQ/HLG]
[Y Position] [0%], [15%], [30%], [45%)], [50%)]
[Select Line] 0to 719 in 1-line increments (720 recording) (360),
01to 1079 in 1-line increments (2K recording) (540),
0to 2158 in 2-line increments (4K recording) (1080),
0 to 3138 in 2-line increments (5.9K recording) (1570),
0to 4318 in 2-line increments (8K recording) (2160)
Available options depend on the resolution and operating mode (CAMERA/MEDIA mode).
[Vectorsope Settings] (@ 108)
[Position] [Right], [Left]
[Type] [Normal], [Spot]
[Gain] [1x], [2x]
[Markers: LCD], [Markers: VF], [On], [Off] (@ 95)

[Markers: HDMI]




Menu Options

Menu item Setting options and additional information
[Center Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (11 96)
[Center Marker Type] [Cross 1], [Cross 2], [Dot 1], [Dot 2]
[Horizontal Marker], [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off]
[Vertical Marker], [Grid Marker]
[Aspect Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%)], [Mask 75%], (132 96)
[Mask 50%], [Mask 25%)], [Off]
[Marker Aspect Ratio] [4:3], [13:9], [14:9], [16:9], [1.375:1], [1.66:1], [1.75:1], [1.85:1], [1.90:1], [2.35:1], [2.39:1],
[9:16], [Custom]
[Marker Custom Asp. Ratio] 1.00:1 t0 9.99:1 (1.00:1)
[Safe Area Marker] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Mask 100%)], [Mask 75%], (132 96)
[Mask 50%], [Mask 25%)], [Off]
[Basis for Marker Safe Area] [Whole Picture], [Selected Aspect Marker]
[Marker Safe Area %] [80% (Side Length)], [88% (Side Length)], [90% (Side Length)], [93% (Side Length)],
[95% (Side Length)], [80% (Area)], [90% (Area)], [92.5% (Area)], [95% (Area)]
[User Marker 1], [User Marker 2] [Yellow], [Blue], [Green], [Red], [Black], [Gray], [White], [Off] (13 96)
[User Marker 1 Size], 2x2 to 2048x1080 only even numbers (100x100)
[User Marker 2 Size]
[User Marker 1 Position], (—1024, -540) to (1024, 540) (0, 0)
[User Marker 2 Position]
[im Network Settings] menu
Menu item Setting options and additional information
[Network] [Enable], [Disable] (@ 160)
[Connect] [Disconnect], [SET1] to [SET20]
[Connection Setting] [SET1] to [SET20] (T 169)
[Check Settings] -
[Change with Wizard] -
[Select Existing Setting] -
[Settings Name] File name up to 12 characters
[Delete Settings] -
[New Conn. Setting (Wizard)] [FTP Transfer], [IP Streaming], [Browser Remote], [Canon App] (T 161)
[Activate IP Streaming] [Enable], [Disable] (C175)
[FTP Transfer All Clips] In MEDIA mode only. (D 174)
[IPv4 address name] Displays the current IPv4 address information.
[View Error Info] Displays the latest network related error message.
[Advanced Settings] (170
[Communication Settings] [NW1] to [NW25]
[Function Settings] [MODE1] to [MODE25]
[Browser Remote Settings] [User Name/Password], [Port No. (HTTP)], [Port No. (HTTPS)], [HTTPS] (172
[802.1X Authentication] [Setup Wizard], [Check Settings], [Delete Settings] (T 168)
[Nickname] User defined string up to 16 characters ([R5C]) (@1 168)

[Battery Charging Order]

[Camera First], [WFT First]

When charging a battery pack inside the optional WFT-R10 Wireless File Transmitter (attached to the
camera) using the optional PD-E1 USB Power Adapter, you can use this setting to choose which battery to
charge first, the one supplying power to the camera or the one supplying power to the WFT-R10.

193



194

Menu Options

[@ Assignable Buttons] menu

Following are the default settings for each assignable button. For a complete list of the functions that can be
assigned, refer to the detailed table ([11 122).

Menu item
[Camera]

Setting options and additional information
1: [One-Shot AF], 2: [Magnification], 3: [DISP], 4: [MENU], 5: [Push Auto Iris],
6: [AF Lock], 7: [Assignable Button Setting], 8: [Display Panel Info], 9: [Key Lock],
10: [(NONE)], 11: [FUNC], 12: [(NONE)], 13: [Set White Balance]

[Browser Remote]

1: [Magnification], 2: [Peaking: All], 3: [Zebra: All], 4: [WFM: All]
[Key Lock] is not available as an assignable button for Browser Remote.

[¥ System Setup] menu

Menu item Setting options and additional information
[Power Source Navigation] [Check the required power source.], [Check the available recording settings.], [Cancel] (29
[Reset] [All Settings], [Assignable Buttons]
These settings reset the following camera settings to default values/settings.
[All Settings]: All the camera’s settings (in VIDEO mode) except for the hour meter.
[Assignable Buttons]: Only the assignable buttons.
[Transfer Menu/ [@] (133)
[Save] [To Camera], [To SD Card]
[Load] [From Camera], [From SD Card]
[Time Zone] List of world time zones. (13 20)
[UTC-05:00 New York] or [UTC+01:00 Central Europe]1
[Date/Time] -
[Date Format] [YMD], [YMD/24H], [MDY], [MDY/24H], [DMY], [DMY/24H]'
[Language &3 | [Deutsch], [English], [Espafiol], [Frangais], [Italiano], [Polski], [Portugués], (@ 21)
[Pycckuin], [YkpaiHebka], [f5 14k s 3z], [E-=01], [BAE]
[HDMI Output Signal] [4096x2160P/3840x2160P], [1920x1080P], [1920x1080i], [1280x720P] (M 147)
[Linked to HDMI Monitor] [On], [Off]
[Time Code Mode] [Preset], [Regen.] (298)
[Time Code Run] [Rec Run], [Free Run]
[Time Code DF/NDF] [DF], [NDF] (M 99)
[Set Time Code] [00:00:00:00] to 59.94 Hz: [23:59:59:29] (T 98)
50.00 Hz: [23:59:59:24]
24.00 Hz: [23:59:59:23]
[TC In/Out] [In], [Out] (A 100, 101)
[User Bit Recording Mode] [Internal], [External] (2 100)
[User Bit Type] [Setting], [Time], [Date] (T 99)
[Grip Control Dial], [Iris], [ISO/Gain], [White Balance Mode], [White Balance (K)], (M 75,
[Top Control Dial], [White Balance (CC)], [Off] 79, 83)

[Control Ring]

Determines the function assigned to the respective control dial/control ring.
e The default function for the top control dial and for the control ring is [Off].

[Grip Control Dial Dir.],
[Top Control Dial Dir.],
[Control Ring Dir.],
[SELECT Dial Dir.]

[Reverse], [Normal]

Changes the direction of the adjustment when operating the front/top control dial, the control ring on the
lens/adapter or the SELECT dial, respectively.




Menu item
[Ctrl Dial in Menus]

Menu Options

Setting options and additional information
[Disable], [Enable] (22

Enables or disables the use of the front and top control dials to navigate the setup menus, direct touch
control, direct setting mode and status screens.

[Focus Ring Operation]

[Enable During AF], [Disable During AF]

[Focus Ring Direction]

[Reverse], [Normal]
Changes the direction of the adjustment when operating the focus ring on an RF lens.

[Focus Ring Response]

[Varies with Rotation Speed], [Linked to Rotation Degree]

[Keep Key Lock at Shutdown] [On], [Off] (25
[Key Lock] [All Buttons], [All Except REC Button] (1 25)
[REC Button] [Disable], [Enable] (T 47)
Enables or disables the use of the REC buttons.
[Assign. Button 10 as REC], [On], [Off] (M121)
[Assign. Button 13 as REC]
This setting turns assignable button 10/13 to an alternative REC button.
[Onscreen REC/STBY Button] [On], [Off] (7 47)

When this setting is set to [On], the recording operation indicator (REC/STBY) on the CAMERA mode
screen becomes an onscreen button you can touch to start/stop recording.

[Touch Screen Response] [Normal], [Low] (19
[Tally Lamp], [On], [Off]
[Card Access LED] These settings determine whether the following LEDs and indicators will illuminate.
[Tally Lamp]: The tally lamp ([J1 12) when the camera starts up and while recording.
[Card Access LED]: The card access indicator ([ 34) when the camera is accessing the card.
[Fan Mode] [Automatic], [Always On] (7 43)
[Fan Speed (STBY)] [Maximum], [High], [Middle], [Low]
[Fan Speed (REC)], [High], [Middle], [Low]
[Fan Speed (Always)], [Fan Speed]
[Review Recording] [Entire Clip], [Last 4 sec] (T 55)

[GPS Auto Time]?

[On], [Off]

When this setting is set to [On], the camera automatically adjust its date and time settings according to

the information received from the GPS signal.

» While the automatic date/time adjustment is activated, the MENU > [¥ System Setup] > [Date/
Time] setting will not be available.

e The time will not be updated while recording video.

[USB Mode]

[Video Output (UVC)], [Canon App(s) for iPhone], [PTP Connection/GP-E2] (T 120)

Select [PTP Connection/GP-E2] when connecting the GP-E2 GPS Receiver to the camera's accessory
shoe.

[Retract Lens]

[On], [Off]

When a compatible lens ([ 235) is attached to the camera and the focus mode switch on the lens is set
to AF, if this setting is set to [On], the lens will retract fully when the camera is turned off.

When this setting is set to [On], turning off the camera will move the focus position. To prevent this, set
this setting to [Off]. Note that there is no guarantee that the focus position will not move, so checking the
focus position is recommended when turning on the camera.

[Shutter at Shut Down]

[Close], [Open]

This setting allows you to choose whether the shutter closes or remains open when the power switch is

set to OFF.

¢ The [Close] setting is recommended during normal use in order to protect the camera's sensor from
dust or dirt when changing lenses.

o Select the [Open] setting when you want to reduce the sound caused by setting the power switch from
VIDEO to OFF or from OFF to VIDEO.
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Menu Options

Menu item Setting options and additional information

[Sensor Cleaning] [At Power ON/OFF], [At Power OFF], [Off] (11 45)
The camera has two “hour meters” — the first keeps track of total operation time* and the second keeps
196 track of operation time* since the last time the second hour meter was reset with this function.

* Only operation time in VIDEO mode.

This displays select certification information that apply to this camera.

[Reset Hour Meter]

[Certification Information]
[Firmware]

[Camera], [Lens],
[Mount Adapter], [Accessory]

Check/update the firmware version of the camera, lens ([ 27), accessory or mount adapter.

1 The default value depends on the country/region of purchase.
2 Only when the GP-E2 GPS Receiver is connected to the camera.

[ My Menu] menu (CAMERA mode only)

Menu item
[CAMERA-1: Edit] to [Register], [Move], [Delete], [Reset All], [Rename]

[CAMERA-5: Edit]

Setting options and additional information
(24




Displaying the Status Screens

Displaying the Status Screens

You can use the status screens to check the camera’s various settings. You can also output the status screens
to an external monitor.

1 Set an assignable button to [Status] ([11 121).

2 Press the assignable button to open the status screens.

e The status screen most recently displayed will appear unless you turned off the camera or changed the
operating mode.

¢ You can also press the button assigned to AUDIO STATUS to open directly only the [ M) Audio Setup] status
screen.

3 Scroll through the status screens to check the desired settings.
¢ Bring the cursor to a page number and push the joystick left/right to move between the status screens.
e You can also use grip/top control dials and the SELECT dial to navigate the status screens in the same way
as the setup menus.
4 Press the assignable button again or select [X CLOSE] to close the status screens.
® You can also press the MENU button to close the status screens and open the menu instead.

To skip directly to the page of a specific status screen:

[ Gamma/Color Space/Range] ( ) [d) Audio Setup] ( )
[[€3] (custom picture file in use) (1 198) [ System Setup] (1 202)
("™ Camera Setup] ( ) [£% Recording/Media Setup] ( )
[@ Assignable Buttons] ( ) [snvr Network Settings] ( )

[ Gamma/Color Space/Range] status screens (CAMERA mode only)

A @ ¢ M 2
Gamma/Color Space/Range N | Gamma/Color Space/Range
Gamma : Color Space : Range : Output : Gamma : Color Space : Range :
1 _[ X S BT.709 Wide DR  BT.709 Narrow HDMI BT.709 Wide DR  BT.709 Narrow
- LCD BT.709 Wide DR  BT.709 5
VF B de DR BT.709
IP Strm. (8 bit) BT.709 Wide DR BT.709 Narrow
—l— ook File Off Look File Off
=G ain for HDR—SDR Conv. Gain for HDR—SDR Conv.
4 — Y HLG Color
1 Gamma curve, color space ([J] 129) and range 5 Gamma curve, color space ([J] 129, 151) and
used for clips recorded on the cards range (11 150) used for video outputs/monitoring
2 Look File applied ([11 127) devices
3 Gain for HDR-to-SDR conversion ([11 152) [HDMI]: Video output from the HDMI OUT
4 HLG color quality ([J] 129) terminal

[LCD]: LCD screen
[VF]: Image output from the viewfinder.
[IP Strm. (8 bit)]: IP streaming signal ([(J1 175)
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[[€d] status screens (CAMERA mode only)

1 | C1:BT.709 Wide DRE
Sharpness Lvl =0 Frq =0 Coring vl =0
Lim +0
NR Automatic On
Spatial Filter Off
Frame Correlation  Off
Skin Detail off
H 0

198 S W =

C1:BT.7609 Wide DREd

Gamma BT.709 Wide DR
Color Space BT.709
2 Color Matrix Neutral
HLG Color -
Look File
With Look File

C1:BT.709 Wide DREd

MP Color Matrix Tuning Gain
R 0 0 +0 R-G
2 Black Gamma  Lvl 0 Range =0 0 R-B
Low Key Satur. Off vl +0 White Balance R Gain

Color Correction Off
Area A Setting P
Area A Revision Lvl
Area B Setting
Area B Revision

Other Functions

Knee Oon
Slp +0 P

1 Custom picture file name ([J] 125)
2 Custom picture settings (11 129)



Camera Setup

1SO/Gain
Auto Selection
Select 1SO
ISO/Gain Extended Range Off
I1SO Increment 1/3 stop
Gain Increment
Limit for Auto Mode

Camera Setup

| R Camera Setup

utter

Shutter Increment
Focus

Continuous AF

AF Frame

AF Frame Position

AF Speed

AF Response

ISO speed/Gain (11 74)

Base ISO, Selected mode, extended range, ISO

increment, gain increment and limit for automatic
adjustment

Aperture (1] 78)

Iris increment, fine increment, aperture correction
while zooming

Shutter speed increment ([1] 72)

Focus ([11] 85)

Continuous AF, AF frame settings, AF speed and
AF response settings

Automatic exposure (AE)

AE shift (11 81), AE response ([1] 80)

["™ Camera Setup] status screens (CAMERA mode only)

9

Displaying the Status Screens

3 . 5 6
AE

AE shift

AE Response
White Balance

Shockless WB

AWEB Response Normal
Periph. lllum. Corr. Off
Chromatic Aberr. Corr. Off
Diffraction correction Off
Distortion Aberr. Corr.

Anamorphic: LCD Off
Anamorphic: VF Off
Anamorphic: HDMI off
Anamorphic Desqueeze Lens Squeeze Factor
Desqueeze for S&F Off
Metadata
Lens Squeeze Off
Digital IS off
Lens Focal Length
Anamorphic Corr.

cP}
345

Lens Info
RF24-105mm F4 L 1S

White balance ([1] 82)

Shockless white balance, auto white balance
(AWB) response

In-camera lens correction ([1] 28)

Peripheral illumination, chromatic aberration, lens
diffraction and distortion aberration
Anamorphic correction ([J] 119)

On the LCD screen/viewfinder/video output,
desqueeze ratio (for most clips/for slow & fast
motion clips), lens squeeze factor saved in the
metadata

Image stabilization ([T 93)

Lens’s focal length and anamorphic correction

10 Lens model name ([ 26)
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[@ Assignable Buttons] status screens

@ = @& » 2 A 2 @ = @ »

2 3 Assignable Buttons 12l

Camera Browser Remote
One-Shot AF 1 Magnification
Magnification Peak

DISP Ze

MENU WEM: All
Push Auto Iris

1
2
3
4
5)
6
7
8

Assignable Buttons
Camera
9 Key Lock
10 (NONE)
1 FUNC
12 (NONE)
13 Set White Balance

Current functions of the assignable buttons (11 121)
1 On the camera’s body
2 Browser Remote

Assignable Buttons




[P)) Audio Setup] status screens

CAMERA mode:

Audio Setup

|
30 <20 -0 0
Built-in Mic HITHIH
1 Built-in Mic

Built-in Mic

Built-in Mic
2 IR \onitor Channels

3 Headphone Volume
MEDIA mode:
¢ M
Audio Setup
Output : Audio Format :

4 HDMI LPCM / 16 bit /2CH (CH1/CH2)
2 ™ \onitor Channels CH1/CH2
3 Headphone Volume 4]

1 Audio source input, audio level adjustment mode 4
and audio level indicator for each audio channel
(1102

2 Audio channels output from the headphones/ 5
speaker ([J] 153)

3 Headphone volume ([1] 139)

Output :

CFexpress

HDMI

Displaying the Status Screens

Audio Format :

LPCM / 24 bit /4CH

SD Card

LPCM / 16 bit /2CH (CH1/CH2)

HalAudio Setup

Audio configuration used for recording on the
cards ([11 102) and for output (HDMI OUT
terminal, [1] 153)

Press SET to open the [M) Audio Setup] menu
(only when the status screen was opened using
as assignable button set to [Audio Status])
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[¥ System Setup] status screens

System Setup

10 min

System Setup
HDMI 1920x1080 YCC422
59.94i 2CH/PCM
Off

1 Card slot temperature

2 HDMI OUT terminal status (1 147): Signal type,
video output, frame rate, audio output

3 Time code output from the HDMI OUT terminal’

(0 147)

Onscreen displays ([1] 149)

User bit! (00 99)

USB mode

Total operation time, operation time (in VIDEO

mode) since using [Reset Hour Meter] (1] 196)

~N o o

T CAMERA mode only.

2 Only when the GP-E2 GPS Receiver is connected to the camera.

About the card slot temperature graph

| System Setup
Remaining Battery 10min

0%
Battery Life (AN}

2 3 0 System Setup
Latitude N35°39'30.9"

Longitude E139°44'43.5"
Elevation 32.8ft
uTtc Feb.3,2022 9:20 AM

Satellite Reception 3D &

Information about the Canon battery pack ([11 15)
8 Remaining recording time

9 Remaining charge level (visual bar)

10 Battery life indicator

11 GPS information'2
Latitude, longitude, elevation, coordinated
universal time (UTC)

You can check the temperature of the CFexpress card slot. This is useful when recording, since the camera may
stop recording if the CFexpress card slot reaches a determined temperature.

White line: Temperature distribution.*
Yellow area: Temperature warning range.

Red line: Temperature reached the last time recording was stopped due to high temperature.
* If you set the power switch to OFF, the line graph will be interrupted.



[£% Recording/Media Setup] status screens

Pages [2] to [7] are displayed only in CAMERA mode.

Displaying the Status Screens

= Y
Recording/Media Setup
512GB  Recorded 1.74GB Camera Index 203
Available 260 min Reel Number -
-1 Clip Number
63.8GB  Recorded 1.36GB User Defined
Available min Scene
9999 Photos Take
Country Code
QOrganization
User Code
Add [@ File
¢ 22 A
Recording/Media Setup Recording/Media Setup I_
ode Full Frame
File Name TANZO1 Recording Mode Normal Recording
Title ) Frame Rec: Frame Rate
Fantastic Trips Interval Rec: Time Interval
2 Creator Interval Rec: Frame Rate -
E. Lubeski 2nd Card Rec Functions off
LD_?“E‘” Clip Numbering Continuous
B CL L) MP4 Clip/Photo Numbering Continuous
escription
B @ = &
123 4s5R7
Main Rec Format C422 10 bit
File Name Main Resolution/Bit Rate 60 260Mbps L.GOP
Story Title Frame Rate
Description Main Audio Format (MP4)
3 Key Words(Tags)

Test run 1.1

Source / Originator Test Creator
Copyright Holder  CANON 5

¢ Format
[EResolution/Bit Rate
[EFrame Rate
[@Audio Format (MP4)
Proxy Rec Color Conversion

Restrictions UsageTerms

1 Information about memory cards (CFexpress/SD) 9 Recording mode ([1] 38)

Visual bar, total capacity, used (recorded) space, 10 Frame recording frame rate ([J] 116)
approximate available recording time, speed class 11 Interval recording time interval ((J1 117)
and number of remaining photos (SD card only) 12 Interval recording frame rate ([J1 117)

2 User memo ([I1 110) 13 Second card recording function ([T 38)
User memo file name, title, creator, location and 14 Clip numbering (17 40)
description 15 MP4 clip/photo numbering ([11 41)

3 News Metadata ([I] 110) 16 Main recording video configuration ([] 61)

File Name, Story Title, Description, Keyword Video format, color sampling, resolution and bit
(Tags), Category, Contributor, Source/Originator, rate, frame rate and audio format (only MP4 clips)
Copyright Holder, Restrictions. (T 102)

4 Clip name information ([J] 40) 17 [2) recording video configuration ([ 63)
Camera index, reel number, clip number, Video format, resolution and bit rate, frame rate,
user-defined field [2) audio format (only MP4 clips) (1] 102), color

5 Scene and take information ([J] 112) conversion for proxy clips

6 Unigue material identifier (UMID) code (11 110):
country, organization, user

7 Custom picture file embedded ([ 128)

8 Sensor mode ([I1 61)

(i) NoTES

¢ Depending on the card, the total space displayed on the screen may differ from the nominal capacity printed
on the card itself.
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[ia2 Network Settings] status screens

%
Network Settings

Network
Connection Setting
Settings Name

Comm. Settings 1
Comm. Settings 2
Function Settings 1
Function Settings 2

Network connection used ([1] 160)

1 Network functions activated/deactivated

2 Connection setting in use
Connection setting (SET) number, name,
communication settings (primary network and

B @
103 a5
Comm. Settings 1

Connection Method
SsSID

Network Settings

Wi-Fi T
Infrastructure

Channel
Authentication Method WPA/MPAZ-PSK
Encryption Method T \ES

Key Index -

3 Communication settings of the primary/
secondary network
Network type, connection method, SSID (network
name), Wi-Fi channel, authentication, encryption

secondary network) and function settings and key index

Network Settings

Setting
4

MAC Address (Wi
MAC Address (Et|

5 Network Settings
TCP/IPv6 Settings
Gateway

TCP/IPv6 Settings
Manual Setting
Link-Local Address

DNS Server

Stateless Address DNS Address

DHCPv6 Address

IP Address

TCP/IP settings of the current network connection ([I] 167)

1 IP address assignment method 5 DNS server

2 IP address 6 Camera’s MAC address
3 Subnet mask 7 IPv6 settings (11 171)
4  Default gateway



3 4 ¢ ¢ Network Settings
IP Streaming

Activate IP Streaming Disable

Protocol UDP

Destination Server
http://hostwith.most

Dest. Port No. 5000

FEC Port No.
FEC Interval

IP streaming settings (CAMERA mode only, [T] 163)

1 IP streaming activated/deactivated ([J] 175)
2 Streaming protocol and receiver settings
3 Error correction settings

Network Settings

80
443
Disable

http:/192.168.0.4/

Displaying the Status Screens

IP Streaming
RTSP: User Name

Video Output Conf. 9\ 205

Audio Out Channels

RTSP user name required to control streaming
sessions

Streaming video configuration and audio
channels

3 45
Browser Remote

User Name
CANONet

Settings for Browser Remote (CAMERA mode only, []177)

1 Port number (HTTP)
2 HTTPS connection ([1] 172)
Port number, HTTPS activated/deactivated

2 ¥ &£ v
2 3456 8
FTP Transfer
FTP Mode
User Name
1 FTPUser
Destination Server
192.168. 0. 150/24

FTP transfer settings (MEDIA mode only, [T]162)

1 Transfer mode, user name and FTP server (or
host) name

3 Camera’s URL
4 User names

X
Network Settings
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Canon App
6 Network Settings
Canon App
206 Connection device name
1 USB Mode PTP Connection/GP-E2
1 Canon App

Connection device name, USB mode



Using a USB Power Adapter

Using a USB Power Adapter

Using the PD-E1 USB Power Adapter (sold separately), you can charge the LP-E6NH/LP-E6N Battery Pack

without removing it from the camera. The camera can also be powered. Note that the LP-E6 Battery Pack

cannot be charged this way. For details such as how to attach the power adapter to the camera, refer to the 207
Advanced User Guide (PHOTO Edition). B
The USB power adapter is used when a battery pack is attached to the camera. When recording, using a fully

charged battery is recommended.

e |f the power switch is set to VIDEO, you will be able to power the camera but charging will not be possible.
e Setting the power switch to OFF will switch from powering the camera to charging.
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Using a Battery Grip

Using a Battery Grip

Equipped with buttons and dials for vertical shooting, the BG-R10
Battery Grip is an optional camera accessory that can power the camera
with two batteries. For details on how to attach the battery grip to the
camera, refer to the Advanced User Guide (PHOTO Edition).

Button and Dial Operations

To use the buttons and dials, turn the vertical-grip on/off switch
to ON.

When the power switch is set to VIDEO, the buttons and dials are used the same way as corresponding buttons
and dials on the camera in VIDEO mode.

PHOTO Mode VIDEO Mode
1 | Shutter button REC (start/stop recording) button
2 | <M-Fn> Multi-function button FUNC button/Assignable button Camera 11
3 | <% > Main dial Grip control dial
4 | Vertical-grip On/Off switch Vertical-grip On/Off switch
5 | <3t > Multi-controller Joystick
6 | <Q > Magnify/Reduce button MAGN. (magnification) button/Assignable button Camera 2
7 | <[> AF point selection button AF LOCK button/Assignable button Camera 6
8 | <> AE lock/FE lock button AUTO IRIS button/Assignable button Camera 5
9 | < AF-ON> AF start button AF-ON button/Assignable button Camera 1
10 | <&%> Quick control dial 2 Top control dial

(i) notes

e Battery information is also displayed when using the battery grip.
¢ Available recording conditions are the same when using a battery pack or the battery grip.



Using the WFT-R10 Wireless File Transmitter

Using the WFT-R10 Wireless File Transmitter

By attaching the WFT-R10 Wireless File Transmitter (sold separately) to the camera, you can expand the
camera's LAN functions. Operation of the WFT-R10 when attached to the EOS R5 C will differ in PHOTO mode
and VIDEO mode. Additionally, when supplying power from a household outlet, the power-related accessories

used will differ.
For details on how to attach the WFT-R10 to the camera and how to operate it in PHOTO mode, refer to the

WFT-R10's instruction manual.

Supplying Power from a Household Outlet

To supply power from a household outlet, attach the DR-E6C DC Coupler (sold separately, for use with the
EOS R5 C) to the WFT-R10.

1 Attach the DC coupler.

@: Attach the DR-E6C DC Coupler (sold separately) the same way
as the batteries.

@: Attach the DR-E6C/DR-E6 DC Coupler (sold separately).

® Pass the DC coupler cord through the battery magazine cord groove.
¢ Insert the battery magazine all the way in to secure it.

2 Attach the battery magazine.
e Guide the end of the cord out of the cord hole.
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Using the WFT-R10 Wireless File Transmitter

3 Connect the DC coupler to the AC adapter.

e Securely connect the plug of the CA-946 AC Adapter (sold separately) y
to the connector of the DR-E6C DC Coupler. | %@ﬁ(((f({({(
|

210 e When using the DR-E6 DC Coupler, securely connect the plug to the
— connector of the AC-EBN AC Adapter (sold separately).

4 Connect the power cord.

e Connect the power cord to the AC power adapter and
insert the power plug into a power outlet.

<

Button and Dial Operations

Button and dial operations are the same as those of the camera. For details, refer to the Advanced User Guide
(PHOTO edition or VIDEQ edition).

To use the buttons and dials, turn the vertical-grip on/off switch
(4) to ON.

L&
{\\J/
5 6 7 8

PHOTO Mode VIDEO Mode
1 ‘ Shutter button ‘ REC (start/stop recording) button

2 ‘ <M-Fn > Multi-function button ‘ FUNC button/Assignable button Camera 11




Using the WFT-R10 Wireless File Transmitter

PHOTO Mode VIDEO Mode
3 | <% > Main dial Grip control dial
4 | Vertical-grip On/Off switch Vertical-grip On/Off switch
5 | <%&> Multi-controller Joystick 211
6 | <Q > Magnify/Reduce button MAGN. (magnification) button/Assignable button Camera 2 —
7 | <[=)> AF point selection button AF LOCK button/Assignable button Camera 6
8 | <> AE lock/FE lock button AUTO IRIS button/Assignable button Camera 5
9 | < AF-ON> AF start button AF-ON button/Assignable button Camera 1
10 | <=F > Quick control dial 2 Top control dial




Troubleshooting

Troubleshooting

If you have a problem with your camera in VIDEO mode, refer to this section. Consult your dealer or a Canon
Service Center if the problem persists.

212

Power source

Refer also to the Power-related problems section of the Troubleshooting Guide in the Advanced User Guide
(PHOTO edition).

The camera will not turn on or it turns off by itself.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Shortly after turning it on, the camera turns off on its own.
- You are using a battery pack that is not compatible for use with this camera. Use a recommended battery pack
(T 228).
The battery pack is depleted extremely quickly even at normal temperatures.

- Check the [ System Setup] status screen ([11 202) to check if the battery pack has reached the end of its battery
life. If so, buy a new battery pack.

Recording

The camera’s controls are not responsive/disabled.
- When key lock is activated, all buttons (or all buttons with the exception of some REC buttons) are locked and cannot
be operated. Press the LOCK button to disable key lock. You can change which controls are locked with the MENU >
[§ System Setup] > [Key Lock] setting.

Performing a recording operation (pressing a button/touching the onscreen button) will not start recording.

- The card is full or it already contains the maximum number of clips (999 clips). Delete some clips (11 143) or save your
recordings and initialize the card ([J1 35) to free some space. Alternatively, replace the card.

- The REC button was pressed while all the camera's controls were locked (key lock, [1] 25). Unlock the controls or set
MENU > [ System Setup] > [Key Lock] to [All Except REC Button].

- The REC button that was used may be disabled. Change the MENU > [§ System Setup] > [REC Button], [Assign.
Button 10 as REC)/[Assign. Button 13 as REC] and [Onscreen REC/STBY Button] settings to enable the use of the
desired button or onscreen button.

- Power supply to the camera has reached the level set for the power level warning. Check the power source.

- The camera cannot record while the [Color Correction] settings in the custom picture file (11 132) are being adjusted
(except for the [Revision Level]/[Revision Phase] settings).

The point when the recording operation was performed does not match the beginning/end of the recording.
- There may be a slight interval between pressing the REC button (or touching the onscreen button) and the actual start/
end of recording. This is not a malfunction.

The lens will not function.
- Turn off the camera and correctly attach the lens again ([I1 26).
- A lens that cannot be used with the camera is attached ([11] 26).
- Check the content of the error message when it appears on the screen and proceed as suggested ([11 218).
- Use the MENU > [9 System Setup] > [Power Source Navigation] function to check the availability of lenses,
accessories, recording settings and power sources depending on the configuration of the camera.

The camera will not focus.
- The camera may not be able to focus on certain subjects using autofocus. Focus manually ((] 85).
- When [Continuous AF] is set to [Only Around Focus Point], start focusing manually until the AF frame changes from
yellow to white (automatic adjustment range).
- The lens is dirty. Clean the lens with a soft lens-cleaning cloth.
- The viewfinder is not adjusted. Use the dioptric adjustment lever to make the proper adjustment ([1] 30).



Troubleshooting

When a subject flits across in front of the lens, the image appears slightly bent.
- This is a phenomenon typical of CMOS image sensors. When a subject crosses very quickly in front of the camera, the
image may seem slightly warped. This is not a malfunction.

Bright red, green or blue dots appear on the screen.

- Try adjusting the black balance ([1] 44). The camera’s CMOS sensor is a delicate piece of precision engineering. Direct
exposure of the sensor to ion rays or other types of cosmic radiation may affect it and this may rarely appear as bright colored
dots on the screen. This is the nature of CMOS image sensors and does not represent a malfunction.

- The effects of the damage may be more noticeable when the camera is used in places subject to high temperatures,
when a high ISO speed or gain level is used and when slow shutter speeds are used.

Abnormal images appear on the screen and the camera cannot record properly.
- While recording using an almost empty battery pack together with an AC adapter, the AC adapter was inadvertently
disconnected or the power supply was suddenly interrupted. Reconnect the AC adapter and turn the camera off and
then on again or replace the battery pack with a fully charged one.

Changing between recording (@ REC) and record standby (STBY) takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings
and initialize the card ([T] 35). Alternatively, replace the card.

Clips or photos cannot be recorded properly.
- This may occur as clips and photos are recorded/deleted over time. Save your recordings and initialize the card
(135).
After using the camera for a long time, it becomes hot.
- The camera may become hot after using it continuously for long periods of time; this is not a malfunction. If the
camera becomes unusually hot or it becomes hot after using it only for a short while, it may indicate a problem with
the camera. Consult a Canon Service Center.

Playback

Cannot delete clips/photos
- XF-AVC clips with an mark cannot be deleted with the camera. Remove the [ mark (0 142).
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.
- Photos that were protected using other devices cannot be deleted with this camera.

Deleting clips takes longer than usual.
- When the card contains a large number of clips, some operations may take longer than usual. Save your recordings
and initialize the card (1 35).

Indicators and Onscreen Displays

appears in red on the screen.
- Battery pack is depleted. Replace or charge the battery pack.

appears on the screen.
- The camera cannot communicate with the battery pack attached so the remaining battery time cannot be displayed.

The power indicator/tally lamp does not illuminate.
- Set MENU > [§ System Setup] > [Tally Lamp] to [On].

The power indicator/tally lamp flashes quickly. |- ¢-| (4 flashes per second)
- The battery pack is depleted. Replace or charge the battery pack.
- There is not enough available space on the cards. Delete recordings ([11] 143) to free some space or replace the card.
- A system error has occurred. Turn the camera off and then on again. If this does not solve the problem, consult a
Canon Service Center.

The power indicator/tally lamp flashes slowly. (1 flash per second)

- The combined available space on the cards is Iov;/. Delet'e recordings ([11 143) to free some space or replace the card.

[i® or [2 appears in red on the screen.
- A card error occurred. Remove and reinsert the card. If the display does not change back to normal, save your
recordings and initialize the card ([1 35).
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Troubleshooting

[1] / [2) appears in red on the screen followed by [END].
- The indicated card is full. Delete recordings ([1] 143) to free some space or replace the card.

Even after stopping recording, the access indicator stays illuminated in red.
- The clip is being recorded on the card. This is not a malfunction.

appears in yellow on the screen.
- The camera’s internal temperature has reached a predetermined level. You can continue using the camera.

appears in red on the screen.
- The camera’s internal temperature has risen further while E3 appeared in yellow on the screen. Turn off the camera
and wait until the temperature has decreased.

XA appears in red on the screen.
- The cooling fan may not be working properly. The camera will automatically turn off after a few minutes. Consult a
Canon Service Center.

[lA\N appears in red on the screen.
- The camera and lens cannot communicate normally. Clean the lens’s contacts and reattach the lens.

The aperture value (T value) appears in gray on the screen.
- When using a compatible EF Cinema lens ([1] 234), the aperture value will appear in gray when the camera detects
that the aperture may be close to fully closed. As you continue to close down the aperture further, the display will
change to [closed].

Picture and Sound

There is no picture or sound from an external monitor/recorder connected to the HDMI OUT terminal
- Disconnect the HDMI cable and then restore the connection or turn the camera off and then on again.
- Check that the settings of the external monitor/recorder match the configuration of the output signal selected on the
camera ([] 145).
- Replace the HDMI cable.

An assistance display (peaking/zebra pattern/video scope/onscreen markers/false color/magnification/B&W image/
anamorphic desqueeze/view assistance) does not appear or is not applied on the screen.

- These assistance displays have separate settings that allow you to turn the display on/off on individual monitoring
devices/video outputs. Check the settings to see that the desired function is enabled on the desired monitor/video
output.

- Onscreen displays output has not been enabled. Activate the output of the camera’s onscreen displays ([1] 149).

Screen displays turn on and off repeatedly.
- The battery pack is depleted. Replace or charge the battery pack.
- Remove the battery pack and reattach it correctly.

Abnormal characters appear on the screen and the camera does not operate properly.
- Remove all the cards and disconnect the power source. After a moment, reconnect the power and reinsert the cards.
If the problem still persists, use the MENU > [§ System Setup] > [Reset] > [All Settings] function. This resets all the
camera’s settings to default values, except for the VIDEO mode hour meter.

Video noise appears on screen.
- Keep a distance between the camera and devices that emit strong electromagnetic fields such as near powerful
magnets and motors, MRI machines or high-voltage power lines.

The picture appears distorted at the top of the screen.
- Select a main recording format other than HDMI RAW.

Horizontal bands appear on the screen.

- This is a phenomenon typical of CMOS image sensors when recording under some types of lighting. This is not a
malfunction. You may be able to reduce the symptoms by setting the shutter speed mode to [Speed] and the shutter
speed to a value matching the frequency of the local electrical system: 1/50* or 1/100 for 50 Hz systems, 1/60 or 1/120
for 60 Hz systems.

*May not be available depending on the frame rate.

Audio is not recorded.
- The external microphone is not turned on or its battery is depleted.
- To record audio for slow & fast motion clips, set the recording mode to [S&F Clip / Audio (WAV)] ([11 38).
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Sound is distorted or is recorded at lower levels.
- This may happen when the appropriate audio level is not set correctly. Adjust the audio recording level manually
([T 104). You can also activate the microphone attenuator ([J1 104) to reduce the audio level.
- The audio level is adjusted manually and the recording level is set too low. Check the audio level meter on the screen
and adjust the audio level correctly (11 104).

The picture is displayed correctly but there is no sound from the built-in speaker.

- Speaker volume is turned off. Adjust the volume (1] 139).
- Disconnect any cables/external devices connected to the () (headphone) terminal.

Cards and Accessories

Cannot insert the card.
- The card you are trying to insert is not facing the correct direction. Turn it over and insert it.

Cannot record on the SD card.

- A compatible card must be used ([11] 33).

- Initialize the card ([1] 35) when you use it with the camera for the first time.

- The card is full or it already contains the maximum number of clips (999 clips). Delete recordings ([1] 143) to free some
space or replace the card.

- The clip number has reached its maximum value. Save your recordings and initialize the card ([T] 35) or delete all the
clips ([11 143).

- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.

- The folder and file numbers for MP4 clips and photos have reached their maximum value. Set MENU >
[£¥ Recording/Media Setup] > [MP4 Clip/Photo Numbering] to [Reset] and insert a new card.

Recording to and playing back from a card is slow.
- This may occur as recordings are made and deleted repeatedly over time. Save your recordings and initialize the card

(C7D 35).

Connections with External Devices

Video noise appears on a nearby TV screen.
- When using the camera in a room where a TV is located, keep a distance between the AC adapter and the power or
antenna cables of the TV.

Network Functions

Check This First

¢ Are the camera, computer or other network devices all turned on?
e |s the network working and correctly configured?
¢ Are all network devices correctly connected to the same network as the camera?

* When using a Wi-Fi network, are there any obstructions between the camera and the access point or
between the network device used and the access point?
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Cannot connect with an access point.

Cannot establish a Camera Access Point connection with a network device.
- Check that the WFT-R10 Wireless File Transmitter is correctly attached to the camera.
- If the network connection icon ([T1] 173) does not turn white, turn off the camera, remove the Wi-Fi adapter and

correctly attach it again.
216 - When connecting to an access point, check that the settings on the network device the camera is trying to connect
— with are correct.

- When you reset all the camera settings, all network settings are lost as well. Configure the network settings again

165).

- %112 wire)less signal is not strong enough or there are other devices in the vicinity interfering with the wireless signal.

Refer to Precautions Regarding Wi-Fi Networks ([1] 216).
Cannot connect with a wired (Ethernet) network.

- Check that the WFT-R10 Wireless File Transmitter is correctly attached to the camera.

- Turn off the camera, disconnect the Ethernet cable from the WFT-R10 and connect it again.

- Use a category 5e or better shielded twisted pair (STP) Ethernet cable.

- Try replacing the Ethernet cable.

- When you reset all the camera settings, all network settings are lost as well.

- Check that the network device to which the camera is connected is on and functioning properly. To use 1000BASE-T
connection speeds, make sure to use network devices compatible with Gigabit Ethernet (1000BASE-T).

The Browser Remote application will not start on the Web browser.
- Make sure to use a connection setting with the [Browser Remote] function setting.
- The URL entered into the Web browser’s address bar is incorrect. Select MENU > [#A# Network Settings] >
[Connection Setting] > Connection setting in use > [Check Settings] and check the camera’s IP address. Use this IP
address as the URL (1 177).

The Browser Remote screen is not displayed correctly on the Web browser.
- The device, operating system or Web browser used may not be supported. For the latest information about supported
systems, visit your local Canon website.
- Enable JavaScript and cookies in your Web browser’s settings. For details, refer to the help modules or online
documentation of the Web browser used.

Cannot start IP streaming.
- Make sure IP streaming was activated on the camera ([11 175).
- If the IP streaming protocol is set to an option other than [RTSP+RTP], make sure the [Destination Server] is set
correctly ([I] 163).
- IP streaming cannot be used in the following cases. Check the settings.
¢ When slow & fast motion recording, pre-recording, frame recording, interval recording, continuous recording, second
card recording functions, relay recording or double slot recording is activated.
¢ When the system frequency is set to 24.00 Hz.
¢ When the main recording format is set to one of the [MP4(HEVC)] or [RAW] options.When using the camera as a web
camera.

Cannot connect to a smartphone.
- Connect the camera and the smartphone to the same network if they are connected to different networks.
- Enable the tethering (sharing a mobile connection) function on the smartphone if it is disabled.

Precautions Regarding Wi-Fi Networks

When using a Wi-Fi network, try the following corrective actions if the transmission rate drops, the connection is
lost, or other problems occur.

Positioning a network device (access point, mobile device, etc.)
- When using a Wi-Fi network indoors, place the network device in the same room as the camera.
- Place the network device in an open, unobstructed location, where people or objects do not come between it and the
camera.
- Place the network device as close as possible to the camera. Change the height or facing of the network device, as
necessary.
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Nearby electronic devices

- If the transmission rate over a Wi-Fi network drops because of interference from the following electronic devices,
switching to the 5 GHz band or to a different channel may solve the problem.

- Wi-Fi networks using the IEEE 802.11b/g/n protocol operate in the 2.4 GHz band. For this reason, the transmission
rate may drop if there are nearby microwave ovens, cordless telephones, wireless microphones and Bluetooth or
similar devices operating on the same frequency band.

- If another access point operating on the same frequency band as the Wi-Fi adapter connected to the camera is used
nearby, the transmission rate may drop.

Using multiple cameras/Wi-Fi adapters/access points

- Check that there are no IP address conflicts among the devices connected to the same network.

- If multiple cameras are connected to a single access point, connection speeds may be reduced.

- To reduce radio wave interference when there are multiple access points using IEEE 802.11b/g or IEEE 802.11n (in the
2.4 GHz band), leave a gap of four channels between each wireless access point. For example, use channels 1, 6, and
11, channels 2, 7, and 12, or channels 3, 8, and 13.

If you can use IEEE 802.11a/n/ac (in the 5 GHz band), switch to IEEE 802.11a/n/ac and specify a different channel,
leaving an appropriate gap between channels according to the wireless standard and frequency band used. For
example, when using IEEE 802.11ac (VHT80), leave a gap of 8 channels between access points.
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List of Messages

Refer to this section if a message appears on the screen. The messages in this section appear in alphabetical
order. Note that for some messages, an indication of the card involved may appear above the message itself:

o [CFexpress], [[1]]: CFexpress card (card 1, slot 1)
e [SD Card], [[@]: SD card (card 2, slot 2)

60 minutes have elapsed. Audio (WAV) recording will stop.
- Recording of the audio file will stop after 60 minutes but video recording will continue unaffected.

Accessing <...> Do not remove
- You opened the card compartment cover while the camera was recording on the card. Be sure to stop the recording
before removing the card.

An error has ocurred Turn the camera off, then on again
- An error has occurred. Turn off the camera. If the error persists, when the error message appears, turn off the camera
while you press and hold the MENU button. All the camera’s settings will be reset except for the hour meter. Turn on
the camera again.

Attach a battery pack or DC Coupler.
- Usage of the USB power adapter has reached a determined period of time. Attach a battery pack or DC coupler to the
camera.

Attached lens accessory not supported by the camera. It may not work properly.
- The attached lens accessory is not supported. Some functions may not work correctly.

Attached lens not supported by the camera. It may not work properly.
- The attached lens is not supported.

Attached lens not supported by the camera. It may not work properly.
- The attached lens is not supported. Some functions may not work correctly.

Attached lens’s firmware must be updated for the lens to work properly with this camera.
- For details about available firmware updates for the lens used, visit your local Canon website.

Battery communication error. Does this battery display the Canon logo?
- You attached a battery pack that is not recommended by Canon for use with this camera.
- If you are using a battery pack recommended by Canon for use with this camera, there may be a problem with the
battery pack or camera. Consult a Canon Service Center.

Buffer overflow. Recording was stopped.
- Recording was stopped because the card's write speed was too slow. Use a recommended card ([T1] 33).
- Save your recordings and initialize the card ([1] 35).

Camera & Lens communication error. Clean the lens’s contacts and reattach the lens.
- The camera cannot correctly communicate with the lens due to dirty lens contacts. After the message disappears, the
1AM icon appears on the screen. Clean the lens contacts with a soft cloth and reattach the lens.

Cannot play back
- The XF-AVC clip’s file control information is corrupted or there was a decoder error. Turn the camera off and then on
again. If this does not solve the problem, consult a Canon Service Center.

* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information
cannot be read by the software (Canon XF Utility).

- Playback was stopped because the card's read speed was too slow. Use a recommended card for recording/playback
(33).
Cannot switch card slots
- There was an attempt to switch card slots while the camera is recording. Wait until recording is finished to change the
selected card slot.

CFexpress— SD Card / SD Card— CFexpress Switched

- This message appears when you switch the card slot in use or recording continued from one card to the other.
CFexpress— SD Card / SD Card—> CFexpress Will switch in a moment

- The card is almost full so recording will continue on the other card in approximately 1 minute.
CFexpress is getting hot. Recording may stop.

- CFexpress card became hot during recording. Recording may stop if the temperature rises further.

CFexpress is hot. Be careful when taking it out.
- CFexpress card became hot. Be careful not to drop the card when removing it.



Troubleshooting

CFexpress is too hot and stopped recording. Check [Card Slot Temp. Info] and restart recording.
- CFexpress card’s temperature has risen and reached a predetermined level, causing recording to stop. Check the card
slot temperature on the [ System Setup] status screen. If the temperature exceeds the red line on the graph, turn off
the camera and wait until the temperature has decreased.

Check the memory card

- Cannot access the card. If the card is correctly inserted, remove it. Check it has no defects or other problems and then
reinsert it.

- A card error occurred and recording/playback is not possible. Try removing and reinserting the card or replace it.

- You inserted a MultiMedia Card (MMC) into the camera. Use a recommended SD card ([] 33).

- If after the message disappears, [1§ or [29 appears in red, perform the following: Turn off the camera and remove and
reinsert the card. If [1] or [2] turns back to green you can resume recording/playback. If the problem persists, save your
recordings and initialize the card ([11 35).

Cover is open
- The card compartment cover was open when the camera was turned on or switched to CAMERA mode. Insert a card
and close the card compartment cover.

Currently, the accessory cannot be used
- There was a communication error between the camera and the accessory attached to the multi-function shoe. Turn
the camera off and then on again.

Currently, the accessory cannot be used
Please check the accessory power status
- Low remaining battery charge for the accessory attached to the multi-function shoe. Use a fully charged battery.

Fan error
- The cooling fan may not be working properly. The camera will turn off automatically after a few minutes. Consult a
Canon Service Center.

File name error
- RAW/XF-AVC clip numbers or MP4 clip/photo numbers have reached their maximum value. Save your recordings and
initialize the card ([1 35) or delete all the recordings (11 143).

If you change this setting, you will not be able to use the current Look File.

- The Look File’s adjustments to the image quality cannot be applied because the [Gamma/Color Space], [HLG Color],
[Over 100%] settings in the custom picture file are different from those registered with the Look File. Change these
settings or register a different Look File.

Insufficient power. The lens does not work.

- The selected combination of power source and recording settings cannot be used with the attached lens. Use the
MENU > [¥ System Setup] > [Power Source Navigation] function to check the available power source/recording
settings combination ([ 29).

Invalid operation
- The following are not valid operations and cannot be performed.
¢ In MEDIA mode, during playback, trying to add a shot mark to a frame that has one already.
e Trying to add an [ mark and a mark to the same clip.
® Pressing the REC button when no cards are inserted in the camera.
Lens error Turn the camera off, then on again.
- There was a communication error between the camera and the lens. Turn the camera off and then on again.
Lens firmware update Firmware update failed. Try updating again.
- The lens’s firmware could not be correctly updated. Try updating the firmware again.
Low Power Warning Check the power supply.

- The input power supplied to the camera (DC coupler) or the remaining recording/playback time for the battery has
reached the level set for the power level warning. Check the power source.

- The message appears every time you press the REC button when the power supply is too low (as described above).

Magnification is not available when recording MP4 video with 7680x4320 or higher resolution.
- Magnification is not available when recording video in MP4 format with a resolution of 8192x4320/7680x4320.
Management file error

- Cannot record because the camera cannot write to the file control information. This may occur if the files on the card

were accessed using another device. Save your recordings and initialize the card ([1] 35).
May not be possible to record clips on this media
- The card used does not meet the camera's requirements. Use a recommended card ([11] 33).
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Media full
- The card is full. Replace the card or delete recordings ([1] 143) to free some space on the card.
- Recording will not start because the card is full. Switch to the card in the other card slot to record.

Media is almost full
- Available space on one or both cards is insufficient as described below. Replace the relevant card(s) or delete
recordings ([11 143) to free some space on the card.
¢ During normal recording, the space available on the card being used for recording is low.
e During relay recording, the combined space available on cards 1 and 2 is low.
e During sub recording or double slot recording, the space available on card 1 or 2 (the fullest one) is low.
e During proxy recording, the space available on card 1 (primary clips) is low. Otherwise, when recording only on
card 2 (proxy clips), the space available on card 2 is low.
¢ During continuous recording, the space available on card 2 (continuous) is low.

Memory card is write-protected
- The LOCK switch on the SD card is set to prevent accidental erasure. Change the position of the LOCK switch.

Mount Adapter firmware update = Firmware update failed. Try updating again.
- The mount adapter’s firmware could not be correctly updated. Try updating the firmware again.

No clips
- There are no clips of the selected video format on the selected card.

No photos
- There are no photos on the SD card.

Noise levels will rise on the image of the sub recording and on video outputs not in RAW.
- The main recording format is set to RAW and the gamma curve component of the [Gamma/Color Space] setting in the
custom picture file is set to an option other than [Canon Log 3]. Under such conditions, there may be more noise on
the recorded proxy clips (SD card) and on video output from the various terminals.

Number of clips already at maximum
- The card selected for recording already contains the maximum number of clips (999 clips). Replace the card or use the
card in the other card slot.

- Because both cards reached the maximum number of clips, double slot recording is not available.

Number of Shot Marks at maximum
- The shot mark could not be added because the clip already contains 100 shot marks.

Power Zoom Adapter Check the power supply.
- The power zoom adapter’s remaining battery charge is low. Replace the power zoom adapter’s batteries.

Power Zoom Adapter Temperature too high. Cannot perform task.
- The power zoom adapter cannot be operated because its temperature is too high. Stop using the power zoom adapter
and let it cool down before using it again.

Recommend checking the data and initializing
- The card cannot be used for any of the following reasons. Save your recordings and initialize the card ([1] 35).
e A problem has occurred with the card.
e The camera cannot read the data on the card.
* The card was initialized using a computer.
e The card is partitioned.

Recorded at 24.00 Hz/50.00 Hz/59.94 Hz Recommend checking the data and initializing
- The card contains clips that were recorded using a system frequency different from the one currently used by the
camera. To record on this card, save your recordings and initialize the card with the camera ([1 35). To play back the
XF-AVC clips recorded on the card, change the camera's system frequency ([I1 61) to match the recordings on the
card.

Recording was stopped.
- The file control information is corrupted or there was an encoder error. Turn the camera off and then on again. Then,
remove the card being used and reinsert it. Alternatively, replace the card. If this does not solve the problem, consult a
Canon Service Center.

* Corrupted file control information cannot be recovered. Cards or XF-AVC clips with corrupted file control information
cannot be read by the software (Canon XF Utility).
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SD Card
Cannot record at current bit rate.
- It is not possible to record to the SD card with the current recording format or resolution/bit rate. Change the recording
settings to record on the SD card.

SD Card
The memory card is not compatible with the current recording settings.

- Slow & fast motion recording was activated and a shooting frame rate corresponding to slow motion was set while
using a card with a speed class rating lower than V90. Replace the card with one rated V90.

- The main recording format was set to [XF-AVC YCC422 10 bit], or to [MP4(HEVC) YCC422 10 bit] with a 4K resolution
(4096x2160 or 3840x2160), while using a card with a speed class rating lower than V60. Replace the card with one
rated V60 or V90.

- The recording format was set to [XF-AVC YCC422 10 bit] and the bit rate was set to Intra-frame, while using a card
with a speed class rating lower than V60. Replace the card with one rated V60 or V90.

Set the lens to the shooting position.
- The collapsible lens attached to the camera is not set to the shooting position (with the barrel extended and locked).
Set the lens to the shooting position.

Shutting down the camera. The DR-E6 DC coupler is not supported with this camera.
- The attached power source (DR-E6 DC coupler) is not supported. Use a supported power source instead.

Some audio files require data recovery.
- The power may have been suddenly turned off or the card may have been removed while the camera was recording.
As a result, one or more audio files contain corrupted data. You can try to recover the files (11 37).

Some clips require data recovery
- The power may have been suddenly turned off or the card may have been removed while the camera was recording.
As a result, one or more clips contain corrupted data. You can try to recover the clips (11 37).

The following settings were changed.
- The settings displayed on the screen were changed automatically due to a change in one of the [ £% Recording/Media
Setup] settings. Check the settings before you continue recording.

The lens does not work with the current recording setting and attached power source. Check [Power Source
Navigation] for more details.
- Use the MENU > [¥ System Setup] > [Power Source Navigation] function to check the available lens/power source/
recording settings combination ([1] 29).

This photo cannot be displayed
- You may not be able to display photos taken with other devices or image files created or edited on a computer.

When [Slow & Fast Frame Rate] is set higher than 60 (fps), the Magnification function cannot be used.
- You attempted to use the magnification function with the sensor mode set to [Full Frame] or [Super 35mm (Cropped)]
and slow & fast motion recording activated with a shooting frame rate higher than 60. To use magnification, change the
sensor mode or set a shooting frame rate of 60 or lower.

With the current [Gamma/Color Space] settings, setting the main recording format to one of the 10 bit options is
recommended.
- The main recording format is set to one of the options using 8 bit color but the color space component of the [Gamma/
Color Space] setting in the custom picture file is set to [C.Gamut] or [BT.2020]. Using a 10 bit color bit depth is
recommended to fully realize the characteristics of the selected color space.

With the current combination of lens and mount adapter, some functions' performance may not be precise. Visit your
local Canon web site for details.
- With the current combination of lens and mount adapter used, the focal length and aperture value displayed by the
camera may not be accurate and should be considered only as a reference. Additionally, some functions may not work
as precisely.
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Network Functions

Along with this list, refer also to the instruction manuals of the access point or other external devices you are
using.
A user with the same login name is already accessing the camera.
- This message appears on the screen of the connected device. Another device connected to the network is already
operating the camera. To use this device, first end the connection on the device accessing the camera.
Another device has set the same IP address.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting
device or the camera.
Another device with the same IP address already connected to the network.
- Another device on the same network has the same IP address as the camera. Change the IP address of the conflicting
device or the camera.
- When using a network with a DHCP server, if the camera’s IP address assignment is set to [Manual Setting], change it
to [Automatic Setting] (11 167).
Connection refused by FTP server.
- The FTP server is set to allow connections only with specific IP addresses. Check the camera’s IP address (1] 167),
and add it to the FTP server’s permission list settings.
Error code returned from the FTP server for the data session.
- The FTP server terminated the connection. Restart the FTP server.
- Change the file access permission settings on the FTP server to allow reading, writing and accessing logs.
- Allow access permissions to the selected destination folder on the FTP server.
- Check that the FTP server is turned on and working properly.
- Check that there is enough available space on the storage device (hard disk drive, etc.)
Ethernet connection lost.
- You attempted to use an Ethernet (wired) network connection but the Ethernet cable is not connected. Check that the
Ethernet cable is correctly connected to the WFT-R10 Wireless File Transmitter and to the network device.
- Check that any network hubs, routers and servers are turned on and working properly.
File transfer completion was not confirmed by FTP server.
- The camera did not receive a transfer completion notification from the FTP server for an unknown reason. Turn the
camera and FTP server off and then on again and try the file transfer again.
Incorrect Wi-Fi password.
- Set the correct encryption key on the camera and the access point.
Multiple access points detected. Unable to connect. Retry from the beginning.
- Other Wi-Fi devices are using the WPS function (push button method) to connect. Try the operation again or use other
methods to configure the network ([11 165).
No address assigned by the DHCP server.
- The camera is set to automatic IP address assignment. If the selected network does not use a DHCP server, change
the camera’s IP address assignment to [Manual Setting] and configure the IP address ([1] 167).
- Check the DHCP server.
e Check that the DHCP server is turned on and working properly.
* Make sure the DHCP server has enough IP addresses to assign.
- Check the network.
* Check if a router with an active gateway function is not being used on the network you are trying to connect to.
* Set the correct gateway address on the camera and on all the devices connected to the same network.
e Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the
camera’s network settings.
No connectable device found
- Check that Content Transfer Mobile is open.
- Check that the camera and the smartphone are connected to the same network.
No response from access point.
- Check that the access point is working properly.
- Refer to Precautions Regarding Wi-Fi Networks ([1] 216) and check if there are applicable steps you can take.
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No response from DNS server.
- The camera is set to automatic IP address assignment. If the selected network does not use a DNS server, change the
camera’s DNS address to [Disable] and configure the IP address (11 167).
- Enter the same IP address of the DNS server used in the camera’s network settings.
- Check the DNS server.
® Check that the DNS server is turned on and working properly.
* On the DNS server, set the correct IP address and the name corresponding to the same address.
- Check the network.
® Check if a router with an active gateway function is not being used on the network you are trying to connect to.
¢ Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the
camera’s network settings.
e Set the correct gateway address on the camera and on all the devices connected to the same network.

No Wi-Fi network found with the selected SSID.

- Check the access point’s SSID (network name) and make sure the same name is used in the camera’s settings.
- Check that the access point is working properly and try again.

Security of server connection cannot be verified. To always trust this server and connect, set [Trust Destination
Server] to [Enable].

- Check that the necessary certificate is correctly configured.

- To trust and use this server even without the proper certificate, set [Trust Destination Server] to [Enable].

The camera's temperature is too high. Network connection terminated.
- The network connection has been lost because the internal temperature of the camera is too high. Turn off the camera
and let it cool down before using it again.

Unable to connect to access point.
- The camera’s encryption method is different from that of the access point. Change the settings on the camera to
match the access point.

Unable to connect to access point. Retry from the beginning.
- To configure a new network connection using the WPS function (push button method), refer to the access point’s
instruction manual and check how to activate the WPS function on the wireless router.

Unable to connect to FTP server.
- Enter the correct address for the FTP server in the camera’s network settings.
- The authentication method is set to [Open System] but the encryption key is incorrect. Check uppercase/lowercase
letters and other characters and make sure to enter the correct encryption key.
- The default port number is 21 (or 22 for SFTP transfers). Check the FTP server’s port number and enter the same port
number in the camera’s network settings.
Check that the server name of the selected FTP server is correctly configured on the DNS server and that the same
name is used also in the camera’s network settings.
Check the FTP server.
® Check that the FTP server is turned on and working properly.
* Check that the correct IP address assigned to the FTP server is the same as the FTP server’s IP address in the
camera’s network settings.
e Access to the FTP server may be protected by a firewall due to security software or broadband routers. Change the
firewall’s settings to allow connection to the FTP server.
* You may be able to access the FTP server by setting the camera’s passive mode to [Enable] (11 162).
¢ Contact the network’s administrator and obtain the correct IP address and port number for the FTP server. Enter the
same information in the camera’s network settings.
- Check the network.
* Check if a router with an active gateway function is not being used on the network you are trying to connect to.
e Contact the network’s administrator and obtain the correct gateway address. Enter the same address in the
camera’s network settings.
¢ Set the correct gateway address on the camera and on all the devices connected to the same network.

Unable to connect to FTP server. Error code returned.
- The maximum number allowed of connections to the FTP server was reached. Reduce the number of network devices
connected to the FTP server or increase the number of connections allowed.

Unable to disconnect from FTP server. Error code returned.
- The camera could not disconnect from the FTP server for an unknown reason. Turn the camera and FTP server off and
then on again.
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Unabile to log in to FTP server. Error code returned.
- Check the FTP server’s [User Name] and [Password] in the camera’s network settings.
- Change the file access permission settings on the FTP server to allow reading, writing and accessing logs.
- Change the destination folder so the path includes only ASCII characters.

Wi-Fi authentication unsuccessful
- The camera’s authentication mode and/or encryption key are different from those of the access point. Change the
settings on the camera to match the access point.

Wi-Fi connection lost.
- The camera could not connect to the access point or network device.
- The wireless signal may be affected by nearby cordless telephones, microwave ovens, refrigerators or other devices.
Operate the camera in a place more distant from such interference.

Wi-Fi error. Incorrect encryption method.
- Make sure the camera and access point are using the same authentication/encryption method.
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Handling Precautions

Camera

Be sure to observe the following precautions to ensure maximum performance.

e Do not use or store the camera in dusty or sandy places. The camera is not waterproof — avoid also water,
mud or salt. If any of the above should get into the camera it may damage the camera and/or the lens. Consult
a Canon Service Center as soon as possible.

Be careful to avoid dust and dirt particles accumulating on the lens or entering the camera. When you finish
using the camera, make sure to attach the body cap to the lens mount and the lens cap and dust cap to the
lens.

Do not use the camera near strong electromagnetic fields such as near powerful magnets and motors, MRI
machines or high-voltage power lines. Using the camera in such places may cause anomalies in the video, or
audio/video noise.

¢ Do not point the camera/viewfinder toward an intense light source, such as the sun on a sunny day or an
intense artificial light source. Doing so may damage the image sensor or the camera’s internal components.
Be especially careful when using a tripod or shoulder strap. When you are not using the camera, make sure to
attach the lens cap to the lens.

Do not touch the lens contacts on the lens mount. Dirty contacts may cause a poor
contact between the camera and the lens resulting in incorrect operation of the
camera. After removing the lens, make sure to attach the body cap to the lens mount
and the lens cap and dust cap to the lens.

Do not carry the camera by the LCD monitor or store the camera in a forced position,
without returning the LCD monitor to its correct position. This may damage to the
monitor’s joints.

Do not apply excessive force when touching the screen. This may cause irregularities in the display quality or
damage to the monitor’s joints.

Do not apply protective film to the touch screen. The camera features a capacitive touch screen that may stop
working correctly with a protective overlay.

Long-term storage
If you do not intend to use the camera for a long time, store it in a place free of dust, in low humidity, and at
temperatures not higher than 30 °C (86 °F).

Battery Pack

DANGER!

Treat the battery pack with care.
e Keep it away from fire (or it might explode).

¢ Do not expose the battery pack to temperature higher than 60 °C (140 °F). Do not leave it near a heater or
inside a car in hot weather.

e Do not try to disassemble or modify it.
e Do not drop it or subject it to shocks.
* Do not get it wet.

¢ Dirty terminals may cause a poor contact between the battery pack and the camera. Wipe the terminals with a
soft dry cloth.
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Handling Precautions

Be sure to attach the terminal cover (Figure 1) to transport or store the battery
pack. Do not allow any metal objects to touch the terminals (Figure 2), as this
can cause a short circuit and damage the battery pack.

* Deplete the battery pack completely before charging it fully. The correct time
may not be displayed if a fully charged battery pack is used continuously in
high temperatures or is left unused for long periods of time. Also, the correct
remaining time may not be displayed, depending on the battery life. Use the
time shown on the screen as an approximation. Figure 1 Figure 2
The battery terminal cover has a [[C_1]-shaped hole. This is useful when you

wish to differentiate between charged and uncharged battery packs.

You can use the battery charger and AC adapter to charge battery packs in any country/region with power
supply between 100 and 240 V AC, 50/60 Hz. Consult a Canon Service Center for information on plug
adapters for overseas use.

Long-term storage
e Store battery packs in a dry place at temperatures no higher than 30 °C (86 °F).
¢ \When charging the battery, aim to charge it to approx. 50% instead of fully charging it.

e At room temperature (23°C) (73°F), it takes approx. 60 min. to charge a depleted battery to about approx.
50%. Battery charging time varies greatly depending on ambient temperature.

e Charge and deplete all your battery packs fully at least once a year.

Recording Media

® Periodically backing up recordings from the cards used to a computer is recommended. Data may be
corrupted or lost due to defects or exposure to static electricity. Canon shall not be liable for lost or corrupted
data.

e Do not touch or expose the terminals to dust or dirt.

* Do not use cards in places subject to strong magnetic fields.

¢ Do not leave cards in places subject to high humidity and high temperature.

¢ Do not attach any labels or stickers on the cards.

¢ Do not disassemble, bend, drop, or subject cards to shocks and do not expose them to water.

Disposal

When you delete data on a card, only the file allocation table is altered and stored data is not physically erased.
Take the necessary precautions when you dispose of the card, for example by physically damaging it to prevent
the leakage of private data.

If giving the card to another person, initialize it. Fill it up with unimportant recordings, and then initialize it again.
This makes recovering the original recordings very difficult.

Built-in Backup Battery

The camera has a built-in rechargeable lithium battery to keep the date/time and other settings. The built-in
backup battery is recharged while you use the camera; however, it will be depleted completely if you do not use
the camera for about 3 months.

To recharge the built-in backup battery: Turn off the camera and attach a power source (such as a sufficiently
charged battery or DC coupler). The built-in backup battery will be fully charged in approx. 24 hours.
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Maintenance/Others

Condensation

Moving the camera rapidly between hot and cold temperatures may cause condensation (water droplets) to form
on its internal surfaces. Stop using the camera if condensation is detected. Continued use may damage the
camera. Condensation may form in the following cases:

e \When the camera is moved quickly from cold to warm places
e \When the camera is left in a humid room
e \When a cold room is heated rapidly

When condensation is detected
The precise time required for water droplets to evaporate will vary depending on the location and weather
conditions. As a general rule, wait for 2 hours before resuming use of the camera.

To avoid condensation
Remove the battery pack and any cards. Then, place the camera in an airtight plastic bag and let it adjust
gradually to temperature changes before removing it from the bag.

Cleaning

Camera body

e Use a soft dry cloth to clean the camera’s body. Never use chemically treated cloths or volatile solvents such
as paint thinner.

Lens
e Remove any dust or dirt particles using a non-aerosol type blower.
e Use a clean, soft lens-cleaning cloth to gently wipe the lens. Never use tissue paper.

LCD screen

e Clean the LCD screen using a clean, soft lens-cleaning cloth and commercially available cleaning fluid for
eyeglasses.

e Condensation may form on the surface of the screen when the temperature changes suddenly. Wipe it with a
soft dry cloth.
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System Map
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(1) DM-E1D Directional Stereo Microphone (19) PD-E1 USB Power Adapter 3

(2) DM-E1 Directional Stereo Microphone (20) BG-R10 Battery Grip

(3) DM-E100 Stereo Microphone (21) WFT-R10 Wireless File Transmitter*

4) Headphones' (22) CB-570 Car Battery Cable

(5) GP-E2 GPS Receiver (23) CBC-E6 Car Battery Charger

(6) RS-80N3 Remote Switch (24) HDM!I cabled

(7) TC-80N3 Timer Remote Controller (25) TV/monitor

(8) RF lenses (26) IFC-100U Interface Cable (approx. 1 m/3.2 ft.)8:7
(9) EF lenses (27) Wireless LAN access point

(10) EF-S lenses (28) IFC-400U Interface Cable (approx. 4 m/13.1 t)% 8
(11) Mount Adapter (29) CFexpress card

(12) Strap (30) SD/SDHC/SDXC memory cards

(13) E2 Hand Strap (31) Card reader

(14) PC-E1/E2 Protecting Cloth (32) USB port

(15) LP-E6NH Battery Pack? (33) Card slot

(16) LC-E6/LC-E6E Battery Charger (34) Ethernet port

(17) CA-946 AC Adapter (35) Wireless LAN adapter
(18) DR-E6C DC Coupler (36) Computer

1 Cables connected to the () (headphone) terminal should be no longer than 2.5 m (8.2 ft.).

2 LP-EBN/LP-E6 Battery Pack can also be used.

3 Charging with PD-E1 USB Power Adapter is only available for LP-E6BNH/LP-E6N (not LP-E6).
You can power the camera by connecting the power supply to the attached WFT-R10. When powering the camera through a
household electrical outlet, use the DR-E6C DC Coupler and the CA-946 AC Adapter (the DR-E6 DC Coupler and the AC-E6N
AC Adapter cannot be used). The DR-EBC is attached inside the WFT-R10's battery magazine to the side closest to the
camera's battery compartment.
Use a cable no longer than 2.5 m (8.2 ft.). The camera end is Type D.



System Map

6 Camera and computer end: USB Type-C™.
" The transmission rate when IFC-100U is used is equivalent to SuperSpeed USB (USB 3.1 Gen 1).
8 The transmission rate when IFC-400U is used is equivalent to Hi-Speed USB (USB 2.0).

For our customers in the USA: Call or visit your local retailer/dealer for genuine Canon video accessories. You
can also obtain genuine accessories for your Canon camera by calling: 1-800-828-4040, Canon U.S.A.
Information Center.

@ wPoRTANT

¢ Use of genuine Ganon accessories is recommended.
This product is designed to achieve optimum performance when used with genuine Canon accessories.
Therefore, using this product with genuine accessories is highly recommended.
The message [Battery communication error] is displayed if you use a non-genuine Canon battery pack, and
user response is required. Note that Canon shall not be liable for any damages resulting from accidents, such
as malfunction or fire, that occur due to use of non-genuine Canon battery packs.

cANOy,
& o This mark identifies genuine Canon video accessories. When you use Canon video equipment, we
o . .
e\ § recommend Canon-brand accessories or products bearing the same mark.

"Jv E)
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Specifications

Specifications

R5C
System

¢ Recording System
Clips:

RAW
Video format:
Audio format:
File format:

XF-AVC
Video compression:
Audio format:
File format:

MP4
Video compression:
Audio format:

File format:

WAV
Audio format:

File format:

Cinema RAW Light
Linear PCM, 24 bit, 48 kHz, 4 channels
CRM (Canon RAW Movie; Canon proprietary file format)

MPEG-4 AVC / H.264
Linear PCM, 24 bit, 48 kHz, 4 channels
MXF

H.265 / HEVC, MPEG-4 AVC / H.264

Linear PCM, 16 bit, 48 kHz, 4 channels
MPEG-2 AAC-LC, 16 bit, 48 kHz, 2 channels
MP4

Audio files for slow & fast motion recording
Linear PCM, 24 bit, 48 kHz, 4 channels

Audio files for second card recording functions
Linear PCM, 16 bit, 8 kHz, 1 channel

BWF

Photos: DCF (Design rule for Camera File system), compatible with Exif Ver. 2.31, JPEG compression

¢ Video Configuration (recording/playback)

Primary clips:
RAW

Bit rate:

Resolution:

Color bit depth:

Frame rate:
XF-AVC

Bit rate:

Resolution:

Color sampling:

Frame rate:
MP4

Bit rate:

Resolution:

Color sampling:
Frame rate:

2570 Mbps, 2140 Mbps, 2120 Mbps, 2090 Mbps, 1980 Mbps, 1770 Mbps,
1750 Mbps, 1700 Mbps, 1650 Mbps, 1580 Mbps, 1360 Mbps, 1290 Mbps,
1140 Mbps, 1080 Mbps, 1070 Mbps, 1050 Mbps, 1030 Mbps, 896 Mbps,
871 Mbps, 836 Mbps, 679 Mbps, 566 Mbps, 544 Mbps, 537 Mbps, 529 Mbps,
448 Mbps, 441 Mbps, 430 Mbps, 344 Mbps, 287 Mbps, 265 Mbps, 221 Mbps,
212 Mbps, 172 Mbps, 144 Mbps, 138 Mbps

8192x4320, 5952x3140, 2976x1570

12 bit

59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

810 Mbps, 410 Mbps, 310 Mbps, 160 Mbps / Intra-frame,

260 Mbps, 160 Mbps, 50 Mbps, 24 Mbps / Long GOP
4096x2160, 3840x2160, 2048x1080, 1920x1080, 1280x720
YCbCr 4:2:2, 10 bit

59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P

540 Mbps, 400 Mbps, 225 Mbps, 170 Mbps, 150 Mbps, 135 Mbps, 100 Mbps,
50 Mbps, 35 Mbps, 12 Mbps, 9 Mbps, 8 Mbps / Long GOP

8192x4320, 7680x4320, 4096x2160, 3840x2160, 2048x1080, 1920x1080,
1280x720

YCbCr 4:2:2 10 bit, 4:2:0 10 bit, 4:2:0 8 bit

59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P



Sub recording clips:

XF-AVC

MP4

Bit rate:

Resolution:

Color sampling:

Frame rate:

Bit rate:

Resolution:

Color sampling:

Frame rate:

Proxy clips:
XF-AVC

MP4

Bit rate:
Resolution:

Color sampling:

Frame rate:

Bit rate:
Resolution:

Color sampling:

Frame rate:

Specifications

410 Mbps, 310 Mbps, 160 Mbps / Intra-frame,

260 Mbps, 160 Mbps, 50 Mbps, 24 Mbps / Long GOP
4096x2160, 3840x2160, 2048x1080, 1920x1080, 1280x720
YCbCr 4:2:2 10 bit

59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P

231

225 Mbps, 170 Mbps, 150 Mbps, 135 Mbps, 100 Mbps, 50 Mbps, 35 Mbps,
12 Mbps, 9 Mbps, 8 Mbps / Long GOP

4096x2160, 3840x2160, 2048x1080, 1920x1080,

1280x720

YCbCr 4:2:2 10 bit, 4:2:0 10 bit, 4:2:0 8 bit

59.94P, 50.00P, 29.97P, 25.00P, 24.00P, 23.98P

35 Mbps, 24 Mbps, 17 Mbps / Long GOP

2048x1080, 1920x1080, 1280x720

YCbCr 4:2:0, 8 bit

59.94P, 59.94i, 50.00P, 50.00i, 29.97P, 25.00P, 24.00P, 23.98P

9 Mbps, 6 Mbps / Long GOP
2048x1080, 1920x1080, 1280x720
4:2:0 8 bit

59.94P, 50.00PR, 29.97P, 25.00P, 23.98P

¢ Recording Media (not included)

Main clips: CFexpress cards compliant with CFexpress 2.0 Type B specifications, SD,
SDHC (SD High Capacity) or SDXC (SD eXtended Capacity) cards

Proxy clips/photos: SD, SDHC (SD High Capacity) or SDXC (SD eXtended Capacity) cards'
1 Used also to save/read other files in addition to proxy files.

Image Sensor

Full frame CMOS sensor

Effective pixels (approximate, with [Full Frame] sensor mode):

35,400,000 pixels (8192x4320) when the resolution is 8192x4320 / 4096x2160 / 2048x1080
33,200,000 pixels (7680x4320) when the resolution is 7680x4320 / 3840x2160 / 1920x1080
Effective pixels (approximate, with [Super 35mm (Cropped)] sensor mode):

18,700,000 pixels (5952x3140) when the resolution is 5952x3140 / 4096x2160 / 2048x1080
17,500,000 pixels (5580x3140) when the resolution is 3840x2160 / 1920x1080

Effective pixels (approximate, with [Super 16mm (Cropped)] sensor mode):

4,700,000 pixels (2976x1570) when the resolution is 2976x1570 / 2048x1080

4,400,000 pixels (2790x1570) when the resolution is 19201080 / 1280x720

LCD Touch Screen

8.01 cm (3.2 in.) color LCD, 3:2 aspect ratio, approx. 2,100,000 dots, 100% coverage, capacitive touch

screen operation

- View assistance (Gamma: equivalent to BT.709 Wide DR / original, Color space: equivalent to BT.709) and
assistance displays can be output (onscreen displays, peaking, zebra pattern, magnification, B&W image,
video scope, false color, anamorphic desqueeze).

Viewfinder

1.29 cm (0.5 in.) organic LED display, approx. 5,760,000 dots, 100% coverage

- View assistance (Gamma: equivalent to BT.709 Wide DR/original, Color space: equivalent to BT.709)

- Assistance displays can be output (onscreen displays, peaking, zebra pattern, magnification, B&W image,
video scope, false color, anamorphic desqueeze).
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Specifications

Lens Mount
Canon RF lens mount compatible with Canon RF and EF? lenses
2 One of the available Canon EF-EOS R Mount Adapters is required for using EF lenses (including EF-S and EF Cinema lenses).

Approximate lens multiplication factor (for 35mm equivalent focal length)
[Super 35mm (Cropped)] sensor mode:

1.460 when the horizontal resolution is 5952/4096/2048

1.5634 when the horizontal resolution is 3840/1920/1280
[Super 16mm (Cropped)] sensor mode:

2.920 when the horizontal resolution is 2976/2048

3.069 when the horizontal resolution is 1920/1280

Lens Correction

Peripheral ilumination/chromatic aberration/diffraction correction is available for Canon RF, EF and EF Cinema
lenses®

Distortion aberration correction is available only for Canon RF lenses
3 Some lenses are not compatible with in-camera correction.

Shutter Speed
Speed (1/3-stop increments, 1/4-stop increments), angle, clear scan, slow, off

3

Iris
Manual (1/2-stop increments, 1/3-stop increments, fine adjustment available), push auto iris, automatic
aperture

ISO Speed/Gain

Manual, automatic adjustment
ISO Speed ([1 stop], [1/3 stop]): 100 to 102400
Gain ([Normal], [Fine]): -6dB to 54dB

Exposure
AE shift, light metering modes (standard, spotlight, backlight)

White Balance

Custom white balance (two sets, A and B); two preset settings (daylight, 5,600 K* and tungsten lamp,

3,200 K%; color temperature setting (2,000 K to 15,000 K); automatic white balance (AWB)

Color temperature (K) and color compensation (CC) adjustment available for all settings except custom white
balance and AWB.

4 Color temperatures are approximate and given only as a reference.

Focus

Manual focus, autofocus (one-shot AF, continuous AF ([Only Around Focus Point], [Enable]), Face AF); face
detection and subject tracking available

AF type: Dual Pixel CMOS AF

Sensor Sensitivity (ISO 800, 2000 lux, 89.9% reflection)
59.94 Hz: F10 (2048x1080 at 59.94P), F14 (1920x1080 at 29.97P)
50.00 Hz: F11 (2048x1080 at 50.00P), F16 (1920x1080 at 25.00P)

Built-in Microphone
Monaural microphone

Size of Photos
8192x4320, 7680x4320, 4096x2160, 3840x2160, 2048x1080, 1920x1080

Terminals

HDMI OUT Terminal

HDMI micro terminal (Type D), output only

View assistance (Gamma: equivalent to BT.709 Wide DR, Color space: equivalent to BT.709)

- Assistance displays can be output (onscreen displays, peaking, zebra pattern, magnification, B&W image,
video scope, false color, anamorphic desqueeze).
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e MIC Terminal
& 3.5 mm stereo mini-jack
Sensitivity:
—72 dBV (volume center, full scale —18 dB) / microphone attenuator: 20 dB
Plug-in power supply: 2.0 V DC 233

¢ () (Headphone) Terminal
@ 3.5 mm stereo mini-jack, =17 dBV (32 Q load, Max volume)

TIME CODE Terminal
DIN 1.0/2.3 jack, input/output
Input setting: 0.5 Vp-p to 18 Vp-p / 100 kQ; Output setting: 1.3 Vp-p / 50 Q or less

¢ Digital Terminal
USB Type-C™ receptacle equivalent to SuperSpeed Plus USB (USB 3.1 Gen 2)

Others

¢ Operating Temperature
0-40°C (32-104 °F)

e Dimensions (W x H x D)°
Camera body only: 142 x 101 x 111 mm (5.6 x 4.0 x 4.4 in.) (excluding protrusions)

o Weight5 (including tape measure hook and grip belt)
Camera body: 680 g (1.5 Ib.)
Camera with LP-E6NH Battery Pack, a CFexpress card and an SD card: 770 g (1.7 Ib.)

Accessories

LC-E6/LC-E6E Battery Charger

e Rated Input: 100-240 V AC (50/60 Hz)

e Rated Output: 8.4V DC, 1.0A

e Operating Temperature: 5 — 40 °C (41 — 104 °F)

e Dimensions® (W x H x D): 69.0 x 33.0 x 93.0 mm (2.7 x 1.3 x 3.7 in.)

o Weight®
LC-E6: 110 g (8.9 0z.)
LC-EBE: 100 g (3.5 0z.) (excluding power cord)

LP-E6NH Battery Pack

¢ Battery Type: Rechargeable lithium ion battery

¢ Rated Voltage: 7.2V DC

e Battery Capacity: 2,130 mAh

e Operating Temperature: 0 — 40 °C (32 — 104 °F)

e Dimensions® (WxHxD):38.4x21.0x56.8 mm (1.51 x0.83 x2.24 in.)
¢ Weight®: 80 g (2.82 0z.) (excluding protective cover)

5 All dimensions and weights are approximate.

Errors and omissions excepted.



Compatible Lenses and Functions

Compatible Lenses and Functions

Following is a list of lenses compatible with this camera and the various functions that can be used depending
on the lens. Depending on the lens’s purchase date, you may need to update the lens’s firmware to use these

234  functions. For details, visit your local Canon website.

Lens Iris control from the camera Zoom control
Manual Pushautoiris  Automatic ~ from the camera

RF lenses o' o' o' -
EF lenses? o () - -

EF lenses compatible with auto iris o o o o’
EF Cinema lenses?

CN7x17 KAS S/E1*

CN10x25 IAS S/E1* ] ] [ )  J

CN20x50 IAS H/E1*

CN-E18-80mm T4.4 LIS KAS S ° PY PY PY

CN-E70-200mm T4.4 L ISKAS S

Manual focus lenses compatible with focus guide
CN-E15.5-47mm T2.8L S

CN-E15.5-47mm T2.8 L SP -
CN-E30-105mm T2.8 L S
CN-E30-105mm T2.8 L SP

1 Except for the RF600mm F11 IS STM, RF800mm F11 IS STM.
2 One of the available Canon EF-EOS R Mount Adapters is requi
3 Only lenses with the PZ-E1 Power Zoom Adapter attached.

red for using EF lenses (including EF-S and EF Cinema lenses).

4 The AE response setting (11 185) is not supported (not applicable).

e EF lenses compatible with auto iris:
EF24-105mm /3.5-5.6 IS STM
EF70-200mm /4L IS Il USM
EF70-300mm f/4-5.6 IS Il USM
EF85mm f/1.4L IS USM
EF400mm f/2.8L IS Il USM
EF600mm /4L IS Il USM

EF-S10-18mm /4.5-5.6 IS STM
EF-S18-556mm 1/3.5-5.6 IS STM
EF-S18-56mm /4-5.6 IS STM
EF-S18-135mm 1/3.5-5.6 IS STM
EF-S18-135mm /3.5-5.6 IS USM
EF-S35mm /2.8 MACRO IS STM
EF-S55-250mm /4-5.6 IS STM
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Focus control from the camera

Lens i Focus guide
Manual One-shot AF Cont:::uous Face AF Tracking g
RF lenses / EF lenses' o2 o2 o2 o2 ®? ]
EF lenses not compatible with autofocus
while slow & fast motion recording is [ J - - - - o
activated
EF Cinema lenses'
CN7x17 KAS S/E1
CN10x25 IAS S/E1 * * ® ® * *
CN20x50 IAS H/E1 [ J - - - - -
CN-E18-80mm T4.4 LISKAS S
CN-E70-200mm T4.4 L IS KAS S ® ® ® ® * *
Manual focus lenses compatible with _ _ _ _ _ °
focus guide

1 One of the available Canon EF-EOS R Mount Adapters is required for using EF lenses (including EF-S and EF Cinema lenses).
2 Except for the RF5.2mm F2.8 L Dual Fisheye lens

* Manual focus lenses compatible with focus guide:

CN-E14mm T3.1 LF CN-EBOmMm T1.3LF
CN-E20mm T1.5LF CN-E85mm T1.3LF
CN-E24mm T15LF CN-E135mm T2.2L F

CN-EB5mm T1.5LF

EF lenses not compatible with autofocus while slow & fast motion recording is activated:

EF24-105mm /3.5-5.6 IS STM EF-S18-135mm 1/3.5-5.6 IS STM
EF70-300mm /4-5.6 IS Il USM EF-S18-135mm 1/3.5-5.6 IS USM
EF-S10-18mm /4.5-5.6 IS STM EF-S35mm /2.8 MACRO IS STM
EF-S18-556mm 1/3.5-5.6 IS STM EF-S55-250mm /4-5.6 IS STM

EF-S18-56mm /4-5.6 IS STM

Lenses compatible with automatic retraction when the camera is turned off (1] 195).
RF35mm F1.8 MACRO IS STM EF50mm /1.8 STM

EF40mm /2.8 STM EF-S24mm /2.8 STM

RF85mm F2 MACRO IS STM RF50mm F1.8 STM
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Reference Tables

Approximate Recording Time on a Card

236 Approximate times, for reference only, based on a single recording that continues until the card is full.

CFexpress card

Main recording format Bit rate 512 GB
2570 Mbps 24 min.
2120 Mbps 30 min.
2090 Mbps 30 min.
1980 Mbps 32 min.
1700 Mbps 37 min.
RAW 1580 Mbps 40 min.
1360 Mbps 47 min.
1290 Mbps 49 min.
1080 Mbps 59 min.
1030 Mbps 62 min.
836 Mbps 76 min.
810 Mbps 79 min.
410 Mbps 156 min.
XF-AVC 310 Mbps 207 min.
260 Mbps 246 min.
160 Mbps 401 min.
540 Mbps 118 min.
400 Mbps 160 min.
225 Mbps 285 min.
170 Mbps 377 min.
m,’j ((HHEz\ﬁ) 150 Mbps 428 min.
135 Mbps 475 min.
100 Mbps 642 min.
50 Mbps 1,284 min.
35 Mbps 1,834 min.




SD Card
Recording format Bit rate 128 GB 512 GB
544 Mbps 29 min. 118 min.
537 Mbps 29 min. 119 min.
529 Mbps 30 min. 121 min.
430 Mbps 37 min. 149 min.
RAW 344 Mbps 46 min. 186 min.
265 Mbps 60 min. 242 min.
212 Mbps 75 min. 302 min.
172 Mbps 93 min. 373 min.
138 Mbps 116 min. 465 min.
410 Mbps 39 min. 156 min.
310 Mbps 51 min. 207 min.
260 Mbps 61 min. 246 min.
YE-AVC 160 Mbps 100 min. 401 min.
50 Mbps 321 min. 1,284 min.
35 Mbps 458 min. 1,834 min.
24 Mbps 668 min. 2,675 min.
17 Mbps 944 min. 3,776 min.
540 Mbps 29 min. 118 min.
400 Mbps 40 min. 160 min.
225 Mbps 71 min. 285 min.
170 Mbps 94 min. 377 min.
,'\w"ﬁf (('I_'I'.Ez‘é% 150 Mbps 107 min, 428 min.
135 Mbps 118 min. 475 min.
100 Mbps 160 min. 642 min.
50 Mbps 321 min. 1,284 min.
35 Mbps 458 min. 1,834 min.

Reference Tables
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Approximate Continuous Video Recording Times

Refer to the following table for the approximate continuous recording times when using the supplied LP-E6NH
Battery Pack (fully charged).
238 The values were measured while recording to a CFexpress card (second card recording functions turned off),
with an RF 50mm F1.2 USM lens attached and using the LCD screen (with [LCD Luminance] set to [Normal]).

Video configuration Approximate continuous
Power consumption recording times
Sensor mode Resolution Frame rate Bit rate (LP-EBNH)
RAW
29.97P 1980 Mbps 1.7 45
Full frame 8192 x 4320
25.00P 1650 Mbps 10.5 50
59.94P 2090 Mbps 15.8 30
Super 35mm 5952 x 3140 P
(Cropped) 50.00P 1750 Mbps 139 35
59.94P 1080 Mbps 9.1 65
Super 16mm 2976 x 1570 P
(Cropped) 50.00P 896 Mbps 8.4 70
XF-AVC
59.94P 14.8 30
Full frame 4096 x 2160 810 Mbps
50.00P 13.3 35
Super 35mm 59.94P 14.8 35
4096 x 2160 810 Mbps
(Cropped) 50.00P P 13.3 35
Super 16mm 59.94P 85 70
2048 x 1080 310 Mbps
(Cropped) X 50.00P P 8.0 75
MP4 (HEVC)
29.97P 127 40
8192 x 4320 540 Mbps
25.00P 11.2 45
Full frame
59.94P 145 35
4096 x 2160 225 Mbps
50.00P 129 40
Super 35mm 59.94P 147 35
4096 x 2160 225 Mbps
(Cropped) 50.00P P 12.9 40
Super 16mm 59.94P 8.4 70
2048 x 1080 50 Mbps
(Cropped) 50.00P P 7.7 80
MP4 (H.264)
59.94P 144 35
Full frame 4096 x 2160 150 Mbps
50.00P 12.8 35
Super 35mm 59.94P 144 35
4096 x 2160 150 Mbps
(Cropped) 50.00P P 12.8 40
Super 16mm 59.94P 8.2 75
2048 x 1080 35 Mbps
(Cropped) 50.00P P 7.7 80




Reference Tables

Charging Times
Charging times are approximate and vary according to charging conditions, ambient temperature and initial
charge of the battery pack.

Battery pack LP-E6NH 239
Charging time using the supplied
LC-E6/LC-E6E Battery Charger

150 min.
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Unless indicated with the " (inch) mark, all units are in mm. J represents the depth of a hole or socket.
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AWB (auto white balance) ................. 84
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Camera Access Point ................... 165
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Canon App .« 164, 184
Canon Log 3 (gammacurves) ............. 129
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Inserting/Removing . ... ............ 34
Recordingmethod . ............... 38
Switchingcardslots ............... 36
Cardvolumelabel ............. ... ... ... 36
Check marks (M) . ................. 109, 142
Cinema RAW Development (download) . .. .. 155
Clips
Adding [ marks/M marks . ... 109, 142
Addingshotmarks ........... 109, 142
Clipinformation . ................. 141
Clipnameformat ................. 40
Clipnumbering ................ 40, 41
Deleting ......... .. ... .. 143
Playback . ...................... 136
Proxyclips ...................... 70
Recording .......... ... .. a7
Recovering ...................... 37
Colorbars ... .. 106
Colorbitdepth . ........ . 59
Color compensation (CC) value ............ 82
Colorsampling ... ... 59
Colorspace . ........cooviiiii.. 129, 151
Computer ... 154
Condensation .......... ... ... . ... ... 227
Connection to external devices ........... 147
Continuousrecording . . ..« .o o 118
Controldials .. ............c i 194
Controlring (RFlens) ................... 194
Customdisplays . .................. 49, 190
Custompicture ......... ... ... .. .. .... 125
Detailed custom picture settings . . . . . 129
LookFile ....... ... ... L. 127
Presetsettings .................. 125
D
Data entry / keyboard screen .. ............ 25
Dateandtime ........... .. ... .. ... .... 20
Deleting recordings . .......... ... .. ..., 143
Desqueeze . ... 119
Detection of access points . .. ............ 166
Developing RAW clips . ................. 1565
Digital IS . .. ... ... 93
Digital terminal .. .......... ... ... ... . ... 13

Direct settingmode . .................... 57
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Direct touch control .. .................... 56
Double slotrecording . .. ... .o 38
Drop frame (timecode) ................... 99
E
EF Cinemalenses ................... 26, 234
Encryption ........ .. ... ... L. 165, 167
Ethernet .. ... ... .. 159
Exposurebar ....... .. .. 81
Exposure compensation .................. 81
F
Face detection . .......... ... ... ... . ... 91
Falsecolor ........ .. ... .. ... .. ... ... ... 97
Fan ... . 43
FEC error correction . ................... 163
Flemenu ........ ... ... .. .. ... ... ... 140
Filenames ... ... .. ... .. .. ... ... 40
File numbering (MP4 clips/photos) . .......... 41
File operations . .......... .. ... ... ... ... 140
Firmware ......... ... ... ... ... ... ... 196
Focus ... ... .. . 85
AFlock ... 90
AFspeed ........ ... ... ... . ... 88
Continuous AF . ................... 88
Face-only AF ... ....... ... ... .. ... 91
Focus assistance functions .......... 86
Manualfocus ............ .. ... ..., 85
One-shot AF ...................... 88
Tracking ... ..o 92
Focusguide ......... ... . ... .. .. . ... 86
Focusring(lens) .......... ... ... ... ..... 85
Framerate ........... ... ... ... .. ... .... 62
Framerecording ........... ... .. ... .... 116
Frame recordingmode .................. 116
Free-run (timecode) ..................... 98
FTPtransfer .......... ... ... ... .. ..... 174
Full range/Video range (level mapping) .. ... .. 150
FUNCbutton ........... ... ... ... ..... 57
G
Gain .. 74
Gammacurve ........ 129, 151
GPS information ............... 110, 143, 202
GPS receiver (optional) . .............. 50, 195

H

HDMI OUT terminal .. ............... 145,147
HDR (high dynamic range) . ....... 129, 151, 152
Headphones ...................... 105, 139
HLG (hybrid loggamma) ............. 129, 151
Hourmeter ......... .. ... .. ... .. ..... 196
HTTPS . 172
|

Image stabilizer ........ ... ... ... . 93
Indexscreens .............. .. 135
Infrastructure . ....... ... ... . L 158
Initializingacard ....... ... ... .. oL 35
Intervalrecording .. ......... .. ... . ... 117
Interval recordingmode .. ................ 117
IP address (IPv4 settings) . ... ............. 167
IPstreaming .......... ... .. .. . . ... 175
IPv6 settings . ........ .. .. 171
IS o 78
ISOspeed .......... .. ... . 74
J

Joystick . ... 22,94
L

Language . ............ i 21
LCDmonitor . ... 19
LCDpanel ........c 54
Lens ... . 26, 234

Lens correction (chromatic aberration/
peripheral illumination/diffraction/

distortion aberration) .................. 28
Lensfirmware ......... ... .. ... ... ...... 27
Lensmount . ........ . ... 26, 232
Level ... . 32
Light meteringmode ..................... 81
LookFile ... ... 127
M
Magnification . ......... ... ... ... .. ... 87
Main recording (primary clips) ........... 38, 61
Main recording format . ................... 59
Maintenance .......... ... .. .. .. 227
Manual network configuration . ............ 167

MEDIAbutton ....... ... ... ... .. 14



MEDIAmode . ......... ... i 14
Menusettings ............ ... .. .... 133, 185
Messagelist ......... ... .. ... . ... .. .. 218
Metadata . ......... ... .. ... ... ... ... 110
MIC terminal . ....... ... .. ... .. ... 13
Microphone
External ......... .. ... .. ... .. .. 103
Sensitivity / Attenuator / Low cut filter . .104
MP4 . 61
MP4 Join Tool (download) . ............... 154
Multi-functionshoe ............. ... ..... 32
MXF (file format) .......... ... .. ... ..... 230
My Menu ... 24
N
Network
Communication setting (NW) . ...160, 170
Configuration . ................... 160
Connection setting (SET) ....... 160, 169
Connection status . ............... 173
Function setting (MODE) . ....... 160, 170
Network functions . ............... 157
Network connection
Wi-Fioo 158
Wired (Ethernet) . ................. 159
News Metadata . ....................... 111
Non-drop frame (timecode) . ............... 99
o)
OKmarks (M) ..................... 109, 142
Onscreendisplays . .................. 49, 137
Display level . ..................... 52
Opacity/transparency .............. 149
Output ... 149
Peripheral border display . ........... 53
Onscreenmarkers . ......... .. ... 95
Outputrange .......... ... .. 150
P
Peaking ........ .. 87
Photos
Photo numbering .................. 41
Recording . ........... ... . i 48
Viewing ... 136
PIN code connection mode (WPS) .......... 166
Playback ........... ... ... ... .. .. ... 135

Portrait orientation (vertical video) . ... ....... b4
Power indicator ........... ... .. ... . ... 47
Power navigation .............. ... .. .... 29
Powersupply . ... 15
Canon battery packs .............. 15
Checking power levels/remaining
batterycharge ... .......... 51, 202
Pre-recording .. .......... ... L 115
Progress bar (playback) ................. 137
Proxyrecording ........... ... ... ... ... 70
R
RAW 59
Real-time streaming (RTSP) . ............. 163
RECbutton ........ ... .. .. 12
Recrun(timecode) ..................... 98
Recording
Photos ........ ... ... ... .. .. .. 48
Primaryclips ............ .. ... .... 47

Proxy clips (simultaneous recording) ... 70
Sub recording clips

(simultaneous recording) . ........ 63
Recordingcommand . .................. 147
Recordingmedia ................... 33, 226
Reference tables (charging, usage and

recording times) .................... 236
Relay recording .......... ... .. ... .... 38
Remote operation . .................... 177
Resetting all camera settings . ............ 194
Resolution (frame size) . .................. 62
Reviewingaclip ........... ... .. ... .... 55
Root certificate (FTPS) . ................. 168
Router ....... ... 158
Running mode (timecode) . ............... 98
S
Safearea . ....... . 95
Saving recordings to a computer .......... 154
Second card recording functions ........... 38
Secure FTP (SFTP,FTPS) ............... 162
Sensormode . ... 61
Setupmenus ................ ... 22,185
Shooting framerate .................... 113
Shotmarks ...................... 109, 142
Shutterspeed ........... ... .. ... ... 72

Slate information ...................... 112
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Slow & fast motion recording . .. ........... 113
Speaker ........ .. 13, 139
Special recordingmodes . ......... ... .. 113
Specifications . ........ ... o oL 230
SSID .. 167
Statusscreens . . ... 197
Subrecording .......... . 63
Synchronization . ........... .. ... .. ..... 100
Systemfrequency .............. ... ...... 61
T

Tallylamp ... 47
Timecode ........ .. i 98
Time code synchronization ............... 100
TIME CODE terminal . ................... 100
Tracking .. ... 92
Tripod ... 14
Troubleshooting . .. ..................... 212
Turning the cameraon/off . ................ 12
U

Userbit ..... .. .. . 99
USermemo . ..........oviiiininennon. 110
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Vectorscope ... 108
Video configuration . ..................... 59
Video format (RAW, XF-AVC, MP4) . ......... 59
Video output configuration . ............... 145
Video recording method . ................. 38
VidEeO SCOPES . . . v v v v 107
View assistance . ......... .. ... . 151
Volume ... 139
Volumelabel .......... ... .. ... .. ... ... 36
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WAV audiofiles . ........ .. .. .. . . 113
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WideDR ......... .. 129, 151
WPS (Wi-Fi Protected Setup) . ... .. 158, 161, 166
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Trademark Acknowledgements
e SD, SDHC and SDXC Logos are trademarks of SD-3C, LLC.

e Microsoft and Windows are trademarks or registered trademarks of Microsoft Corporation in the United
States and/or other countries.

¢ Apple, macOS are trademarks of Apple Inc., registered in the U.S. and other countries.

¢ Avid and Media Composer are trademarks or registered trademarks of Avid Technology, Inc. or its
subsidiaries in the United States and/or other countries.

¢ Wi-Fiis a registered trademark of the Wi-Fi Alliance.
o Wi-Fi Certified, WPA, WPA2, and the Wi-Fi Certified logo are trademarks of the Wi-Fi Alliance.

¢ WPS as used on the camera’s settings, onscreen displays and in this manual signifies Wi-Fi Protected Setup.

e JavaScript is a trademark or registered trademark of Oracle Corporation, its affiliates or subsidiaries in the
United States and other countries.

e HDMI, the HDMI logo and High-Definition Multimedia Interface are trademarks or registered trademarks of
HDMI Licensing Administrator, Inc. in the United States and other countries.

e DaVinci Resolve™ is the trademark of Blackmagic Design Pty Ltd.
e USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum.
e QR Code is a trademark of Denso Wave Inc.

e Other names and products not mentioned above may be trademarks or registered trademarks of their
respective companies.

Licensing Information
¢ This device incorporates exFAT technology licensed from Microsoft.

e This product is licensed under AT&T patents for the MPEG-4 standard and may be used for encoding
MPEG-4 compliant video and/or decoding MPEG-4 compliant video that was encoded only (1) for a personal
and noncommercial purpose or (2) by a video provider licensed under the AT&T patents to provide MPEG-4
compliant video. No license is granted or implied for any other use for MPEG-4 standard.

e THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE
OF A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE
VIDEO IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (i) DECODE AVC VIDEO THAT
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM
A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C.
SEE HTTP:// WWW.MPEGLA.COM

245



246

CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN THE UNITED STATES

The limited warranty set forth below is given by Canon U.S.A., Inc. (‘Canon USA') with respect to (a) the Canon Cinema EOS Product, and (b) the accessories
for the Canon Cinema EOS Product (if any), packaged with this limited warranty (collectively the “Products”)* and purchased in the United States. This limited
warranty is only effective upon presentation of your Bill of Sale or other proof of purchase. The Products are warranted to the original end-user purchaser,
when delivered in new condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At Canon USA's
option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the date of original purchase. Labor: For a
period of ONE YEAR from the date of original purchase, labor will be provided free of charge by Canon USA's factory service centers or designated service
facilities located in the United States. When returning Products under this warranty, you must pre-pay the shipping charges, and you must enclose a copy of
the Bill of Sale or other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period, repairs will be made and the
Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be given an estimate of the cost of repair and an
opportunity to approve or disapprove of the repair expense before it is incurred. If you approve, repairs will be made and the Products will be returned to you
at your risk and expense. If you disapprove, we will return-ship the Products to you at no charge to you to an address within the United States.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as
to which items Canon USA will have no responsibility. Canon USA shall have no responsibility under this limited warranty for use of the
Products in conjunction with incompatible peripheral equipment and/or incompatible software. Non-Canon brand peripheral equipment and
software which may be distributed with, or factory loaded on, the Products, are sold ‘AS IS’ without warranty of any kind by Canon USA,
including any implied warranty regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such non-
Canon brand items is given by the manufacturer or producer thereof.

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the Products or contact the CANON
INFORMATION CENTER AT 855-CINE-EOS (855-246-3367) or on the internet at pro.usa.canon.com/support. You will be directed to the nearest service
facility for your Products.

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon accessories or failure to follow
operating, maintenance or environmental instructions prescribed in Canon USA’s user’s manual;

B. If the Products are defective as a result of leaking batteries, sand, dirt or water damage;

C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon USA) that cause damage to the Products or that
cause abnormally frequent service calls or service problems;

D. If defects or damages are caused by service other than Canon USA'’s factory service centers or authorized service facilities;

E. Any internal modification to product hardware or firmware;

F. Any applicable fee for Maintenance of the Products;

G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside the United States. This Limited Warranty does not apply to accessories or
consumables not originally packaged with the Product. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This
card ensures that you are contacted promptly should there be a safety inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE PRODUCTS AFTER THE
APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON, FIRM OR CORPORATION
WITH RESPECT TO THE PRODUCTS SHALL BIND CANON USA (SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED
WARRANTY LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON USA SHALL NOT BE LIABLE FOR LOSS OF
REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE PRODUCTS OR SERVICE, STORAGE CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING
WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’ HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON
WHICH THE CLAIM IS BASED, AND EVEN IF CANON USA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY
OF ANY KIND AGAINST CANON USA BE GREATER THAN THE PURCHASE PRICE OF THE PRODUCTS SOLD BY CANON USA AND CAUSING THE
ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND
YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE, MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED
DIRECTLY BY THE NEGLIGENCE OF CANON USA (SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE
OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from state to state.

CANON U.S.A., INC


http://pro.usa.canon.com/support

CANON CINEMA EOS LIMITED WARRANTY FOR PRODUCTS PURCHASED IN CANADA

The limited warranty set forth below is given by Canon Canada Inc. (‘Canon Canada’) with respect to (a) the Canon Cinema EOS product, and (b) the
accessories for the Canon Cinema EOS Product (if any), packaged with this limited warranty (collectively the “Products”)* and purchased in Canada. This
limited warranty is only effective upon presentation of your Bill of Sale or other proof of purchase. The Products are warranted to the original end-user
purchaser, when delivered in new condition in its original container, under normal use against defective materials or workmanship as follows: Parts: At
Canon Canada’s option, defective parts will be exchanged for new parts or comparable rebuilt parts for a period of ONE YEAR from the date of original
purchase. Labor: For a period of ONE YEAR from the date of original purchase, labor will be provided free of charge by Canon Canada’s factory service
center or designated service facilities located in Canada. When returning Products under this warranty, you must pre-pay the shipping charges, and you
must enclose a copy of the Bill of Sale or other proof of purchase with a complete explanation of the problem. During the ONE-YEAR warranty period,
repairs will be made and the Products will be return-shipped to you free of charge. For repairs after the warranty period is over, you will be given an
estimate of the cost of repair and an opportunity to approve or disapprove of the repair expense before it is incurred. If you approve, repairs will be made
and the Products will be returned to you at your risk and expense. If you disapprove, we will return-ship the Products to you at no charge to you to an
address within Canada.

This limited warranty only applies if the Products are used in conjunction with compatible computer equipment and compatible software, as to
which items Canon Canada will have no responsibility. Canon Canada shall have no responsibility under this limited warranty for use of the
Products in conjunction with incompatible peripheral equipment and/or incompatible software. Non-Canon brand peripheral equipment and
software which may be distributed with, or factory loaded on, the Products, are sold ‘AS IS’ without warranty of any kind by Canon Canada,
including any implied warranty or condition regarding merchantability or fitness for a particular purpose. The sole warranty with respect to such
non-Canon brand items is given by the manufacturer or producer thereof.

* Except for the battery pack packaged with the Products, which carries a separate ninety (90) day limited warranty.

In order to obtain warranty service, please contact the authorized Canon retail dealer from whom you purchased the Products or contact the CANON
PROFESSIONAL SERVICE CENTRE 1-800-667-2666 or on the internet at www.canon.ca/pro. You will be directed to the nearest service facility for your
Products.

This Limited Warranty covers all defects encountered in normal use of the Products and does not apply in the following cases:

A. Loss or damage to the Products due to abuse, mishandling, accident, improper maintenance, use of non-Canon accessories or failure to follow
operating, maintenance or environmental instructions prescribed in Canon Canada’s user's manual;

B. If the Products are defective as a result of leaking batteries, sand, dirt or water damage;

C. If defects or damages are caused by the use of parts or supplies (other than those sold by Canon Canada) that cause damage to the Products or
that cause abnormally frequent service calls or service problems;

D. If defects or damages are caused by service other than Canon Canada’s factory service centers or authorized service facilities;

E. Any internal modification to product hardware or firmware;

F. Any applicable fee for Maintenance of the Products;

G. If the Product has had its serial number or dating altered or removed.

This Limited Warranty does not apply to Products purchased outside Canada. This Limited Warranty does not apply to accessories or consumables not

originally packaged with the Product. Please retain this warranty card and your Bill of Sale as a permanent record of your purchase. This card ensures

that you are contacted promptly should there be a safety inspection, modification or Product recall under applicable laws or regulations.

NO IMPLIED WARRANTY OR CONDITION, INCLUDING MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE APPLIES TO THE
PRODUCTS AFTER THE APPLICABLE PERIOD OF EXPRESS WARRANTY OR GUARANTY (EXCEPT AS MENTIONED ABOVE) GIVEN BY ANY PERSON,
FIRM OR CORPORATION WITH RESPECT TO THE PRODUCTS SHALL BIND CANON CANADA (SOME PROVINCES DO NOT ALLOW LIMITATIONS ON
HOW LONG AN IMPLIED WARRANTY OR CONDITION LASTS, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU). CANON
CANADA SHALL NOT BE LIABLE FOR LOSS OF REVENUES OR PROFITS, EXPENSE FOR SUBSTITUTE PRODUCTS OR SERVICE, STORAGE
CHARGES, LOSS OR CORRUPTION OF DATA, INCLUDING WITHOUT LIMITATION, LOSS OR CORRUPTION OF DATA STORED ON THE PRODUCTS’
HARD DRIVE, OR ANY OTHER SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES CAUSED BY THE USE, MISUSE OR INABILITY TO USE THE
PRODUCTS, REGARDLESS OF THE LEGAL THEORY ON WHICH THE CLAIM IS BASED, AND EVEN IF CANON CANADA HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES. NOR SHALL RECOVERY OF ANY KIND AGAINST CANON CANADA BE GREATER THAN THE PURCHASE PRICE OF
THE PRODUCTS SOLD BY CANON CANADA AND CAUSING THE ALLEGED DAMAGE. WITHOUT LIMITING THE FOREGOING, YOU ASSUME ALL RISK
AND LIABILITY FOR LOSS, DAMAGE OR INJURY TO YOU AND YOUR PROPERTY AND TO OTHERS AND THEIR PROPERTY ARISING OUT OF USE,
MISUSE OR INABILITY TO USE THE PRODUCTS NOT CAUSED DIRECTLY BY THE NEGLIGENCE OF CANON CANADA (SOME PROVINCES DO NOT
ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU).
THIS LIMITED WARRANTY SHALL NOT EXTEND TO ANYONE OTHER THAN THE ORIGINAL PURCHASER OF THE PRODUCTS OR THE PERSON FOR
WHOM IT WAS PURCHASED AS A GIFT.

This warranty gives you specific legal rights, and you may also have other rights which vary from province to province.

CANON CANADA INC.
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Canon

Canon Inc. 30-2, Shimomaruko 3-chome, Ohta-ku, Tokyo 146-8501, Japan
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